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1-Introduction a Pixlnsight et a son Interface

PixIinsight est sans doute le standard de facto des logiciels de pré et post-traitement pour
I'astrophotographie, applicables au ciel profond. Plusieurs caractéristiques du logiciel prouvent
aisément ses performances exemplaires, bien que certaines personnes soient facilement rebutées
par son interface (tres différente par rapport a un logiciel plus connu tel que Adobe
Photoshop ). D'autres se plaignent de son prix, mais il faut savoir que Pixlnsight peut remplacer
tous les autres logiciels de pré-traitement et de post-traitement, pour un codt total inférieur a Adobe

Photoshop seul et qu'Adobe Photoshop seul ne peut pas exécuter tout ce dont vous avez besoin.

PixInsight offre un essai de 45 jours a quiconque est intéressé. Ce tutoriel sert faciliter la prise en
main de I' interface PixInsight . Il est concret et peut également offrir des informations a certains des
utilisateurs les plus expérimentés. Je considére ce tutoriel comme une lecture essentielle si vous
étes nouveau ou relativement nouveau dans PixInsight , et en particulier si vous souhaitez suivre
mes autres tutoriels. Mes autres tutoriels utiliseront une grande partie des connaissances acquises
grace a celui-ci.

1. Breve Introduction a I'Interface

En bas, nous trouvons des raccourcis vers difféerents espaces de travail, qui ressemblent
essentiellement a des bureaux . Ceux-ci vous permettent de travailler sur différentes choses au sein
d'un projet. Pour plus d'informations sur les espaces de travail voir plus loin dans ce tutoriel.

En cliquant sur ces boutons, vous basculez entre les différents espaces de travail. Sur la gauche,
nous trouvons divers boutons contextuels alignés de haut en bas. Le premier est Process Console .

Cette fenétre contextuelle est essentiellement un historigue des opérations effectuées
par PixInsight . Lorsque PixIlnsight démarre ou qu'un processus s'exécute sur une image, cette
fenétre contextuelle affiche automatiquement les informations de progression et d'état. Cela peut étre
important pour certains aspects de votre traitement des images. Un clic en dehors de cette fenétre
pop-up la fermera automatiquement. Vous pouvez cliquer sur le bouton Coller dans son coin
supérieur droit si vous souhaitez le garder ouvert.

Cela peut toujours étre caché a volonté en cliquant sur le bouton Cachera droite
du bouton Coller. Vous trouverez ces boutons Stick et Hide sur les
fenétres contextuelles de PixInsight et vous pourrez les utiliser de la méme maniere.

Le deuxieme a gauche de PixInsight est View Explorer .

Voici la liste de toutes les images que vous avez ouvertes dans Pixlnsight . En cliquant dessus,
vous affichez des informations sur chaque image. Double-cliquez dessus pour ouvrir I'espace de
travail contenant l'image elle-méme.



https://pixinsight.com/trial/index.html
http://pixinsight.com/

Le troisiéme point qui mérite d’étre abordé a ce stade est celui qui se trouve tout en bas, History
Explorer . Une fois que vous avez appliqué certains processus de PixInsight aux images, History
Explorer conserve un journal de ce qui a été appliqué et dans quel ordre.

Si vous double-cliquez sur I'un des processus répertorié€s, le processus s'ouvrira dans |'état ou il a été
appliqué. Cela peut étre trés utile si vous souhaitez réappliquer les mémes parametres sans avoir a
les refaire. Plus d'informations sur les processus plus loin dans ce tutoriel.

En haut de Pixinsight, nous trouvons les éléments communs a tous les programmes:
des barres d’ outils avec de nombreux raccourcis.

Tout d’abord, ils peuvent étre personnalisés facilement, comme dans la plupart des
programmes. Cela se fait via le menu View - Toolbars en haut.

Marqué comme actifs sont ceux actuellement dans vos barres d'outils. Vous pouvez cliquer pour
désactiver I'un d'entre eux et la barre d'outils correspondante sera supprimée. Vous pouvez
eégalement cliquer sur ceux qui sont actuellement désactivés pour les ajouter a la barre d'outils. Les
barres d'outils peuvent étre déplacées et redimensionnées une fois placées dans
votre interface PixInsight . Pour ce faire, maintenez le bouton gauche de la souris appuyé sur la
colonne de séparation et faites-la glisser vers la gauche ou la droite.

Si vous souhaitez réorganiser les barres d'outils pour en placer une avant l'autre, vous pouvez
réellement faire glisser la colonne de séparation de la barre d'outils que vous souhaitez déplacer
en dehors de la zone de la barre d'outils et la faire glisser ailleurs dans la zone de la barre d'outils.

La zone de la barre d’outils peut également étre étendue. La fine ligne qui apparait directement au-
dessus de la barre d' outils flottante sur la premiere capture d'écran ci-dessus signifie que I'utilisateur
peut réellement déposer la barre d'outils dans cette zone pour créer une deuxieme zone de barre
d'outils sous la zone par défaut.

La personnalisation des barres d’outils peut certainement optimiser vos flux de travail de pré et post-
traitement. Une expérience des différentes barres d’outils est essentielle pour déterminer celles qui
vous conviennent le mieux. Personnellement, je trouve que le jeu par défaut fonctionne bien pour
moi. Plus loin dans ce didacticiel, nous examinerons certains des raccourcis de barre d’outils les plus
utiles qui existent par défaut.

2. Mise a jour, parametres et gestion des couleurs

Bien qu’il semble que nous arrivions au point ou PixInsight semble mature, il est sujet aux mises a
jour de ses divers processus et scripts, ainsi que du programme principal lui-méme. Les mises a jour
du programme principal lui-méme sont installées manuellement. Des courriers électroniques sont
recus pour signaler une nouvelle version de PixInsight , qui nécessite de désinstaller votre version
actuelle, puis de télécharger et d'installer la nouvelle version.

Cependant, de temps en temps, les processus et les scripts sont mis a jour dans PixInsight , ce qui
ne nécessite pas de réinstaller Pixinsight a partir de zéro. Au lieu de cela, lorsque vous
démarrez PixInsight , il recherchera automatiquement les mises a jour et vous avertira s’il en
existe. Vous pouvez également veérifier manuellement en allant dans le menu Resources -> Updates
-> Check for Updates .




Les mises a jour peuvent étre téléchargées et installées automatiguement.
PixInsight vous invitera a fermer le programme une fois les mises a jour téléchargées et vous
demandera si vous souhaitez que PixInsight se redémarre automatiquement une fois les mises a
jour installées. Les mises a jour téléchargées sont appliquées a la fermeture du programme. S'il n'y a
actuellement aucune mise a jour de votre installation actuelle de PixInsight , vous en serez averti.

Garder votre installation de PixInsight entierement a jour peut étre d’'une importance capitale en
fonction des corrections de bugs et des fonctionnalités supplémentaires apportées. Dans tous les
cas, les mises a jour sont gratuites et ne prennent pas beaucoup de votre temps, il est donc inutile de
ne pas les appliquer.

Bien que les paramétres par défaut fonctionnent trés bien dans PixIlnsight, vous pouvez
éventuellement explorer les paramétres actuels (certains d’entre eux n’auront peut-étre pas
beaucoup de sens si vous étes débutant, mais vous pourrez les revoir plus tard). Les paramétres
sont accessibles via le menu Edit -> Global Preferences..

Passer en revue ces catégories de parameétres et parametres individuels peut intéresser certains. Si
vous n'étes pas slr de ce que fait un paramétre particulier, passez simplement votre souris sur le
parametre et une info-bulle apparaitra pour vous en informer.

Le seul parametre que je trouve utile d'activer est Translucid workspacec top-level windows dans
Special GUI Effects.

Comme l'explique linfo-bulle, cela vous permet de superposer une image sur une autre et que
lorsque vous faites glisser une image, celle-ci devient semi-transparente, vous permettant ainsi de
voir l'image en dessous. Lorsque vous étes satisfait de votre choix de paramétres, cliquez sur le
bouton Apply global en bas.

Maintenant que nous examinons les parametres de PixInsight, le moment est venu d'explorer ses
parametres de profil de couleur. Ceci est accessible via le menu Edit-> Color Management Setup .

Par défaut, PixInsight utilisera le profil de couleur défini par défaut dans votre systeme
d'exploitation. Les profils de couleur définissent ce qui constitue les couleurs et des normes
internationales régissent des profils de couleur spécifiques. Par exemple, le profil de couleur sRGB
IEC61966-2.1 que vous voyez ci-dessus est un profil de couleur standard utilisé sur Internet. Il régit
donc la maniere dont les images couleur sont affichées sur Internet et les navigateurs Web prennent
donc en charge ce profil de couleur.

Pour travailler avec des images couleur, le profil de couleur le plus approprié est en réalité Adobe
RGB . Ceci peut étre sélectionné pour les profils RVB et Gray Scale ci-dessus en tant que profils par
défaut.

Encore une fois, un clic sur le bouton Apply Global applique les nouveaux paramétres
a PixInsight .

Bien entendu, cela signifie que lors de [I'édition dimages, nous allons travailler dans
I'espace colorimétrique Adobe RVB . Etant donné que vos images seront sans aucun doute publiées
sur Internet ultérieurement et que le profil de couleur standard sur Internet est SRGB IEC61966-2.1,
nous pouvons conserver cette sélection dans la fonctionnalité Color proofing . Color proofing est une
fonctionnalité qui vous permet de prévisualiser l'aspect de I'image sous un profil de couleur différent.




Bien que nous travaillions généralement avec des images ayant le profil de couleur Adobe RVB , lors
de [lenregistrement de la publication en ligne, nous pouvons facilement convertir
'espace colorimétrique  de I'image en profii de couleur standard SRGB IEC61966-2.1
d’ Internet . Cela se fait facilement avec leProcessus ICCProfileTransformation , qui sera traité
ultérieurement.

3. Utilisation des images, auto-étirement, duplication, zones de
prévisualisation, mode de lecture et formats d’'images.

Etant donné que I'objectif principal est de travailler avec des images, nous allons maintenant explorer
cet aspect. Pour ouvrir des images, il suffit simplement d’ ouvrir le menu Files -> Open ou de double-
cliquer sur I espace de travail PixInsight (I'arriere-plan gris).

PixIlnsight prend en charge une grande variété de formats de fichiers d'image sans plugins
supplémentaires.

C'est une liste impressionnante de formats de fichiers d'image pris en charge - a peu prés tous les
formats de fichier dimage DSLR RAW existants ainsi que le standard FITS , utilisé par les caméras
CCD. Les formats de fichier dimage numeérique courants tels que JPEG, TIFF , PNG , etc. sont
également naturellement pris en charge. Il est fortement recommandé de pré-et post-traiter des
images qui sont des images DSLR RAW ou des images FITS , en fonction de la caméra de capture
utilisée. Les autres formats de fichier ne doivent étre utilisés que lorsque le post-traitement de I'image
est terminé et que vous publiez I'image quelque part, comme sur Internet.

Gardez a l'esprit que contrairement a JPEG et PNG qui sont des formats 8 bits, TIFF peut étre
enregistré en format 8 bits , 16 bits ou méme 32 bits . Cela signifie que le format TIFF peut étre
utilisé la ou vous souhaitez conserver une plus grande précision des couleurs, méme si la plupart
des moniteurs ne peuvent pas afficher au - dela de 8 bits (les moniteurs professionnels vont
généralement jusqu'a 10 bits a I'heure actuelle). Il convient de noter a ce stade que, bien
gue PixInsight prenne en charge un grand nombre de formats de fichiers d'image, il ne sauvegarde
gue dans un certain nombre de formats.

Si vous travaillez avec des images FITS pour commencer, je conserverais ce format de fichier sans
exception, sauf si vous souhaitez enregistrer une autre version de votre image finalisée pour une
publication ultérieure. Si vous travaillez avec des images DSLR RAW, je vous recommande
de commencer par enregistrer au format FITS , puis a partir de ce format.

Si nous inspectons le menu File de prés, nous remarquons deux options, Open et Open a copy .

Tous deux réalisent ce quils sont supposés accomplir:  ouvrir une image
dans PixInsight . Cependant, Open ouvre le fichier image que vous avez indiqué. Si vous modifiez
ensuite I'image et allez dans File -> Save , cela écrasera littéralement I'image que vous avez ouverte
avec la version modifiée. Pour éviter cela, vous devez utiliser File -> Save as et I'enregistrer comme
un autre fichier avec un nom différent, dans un dossier différent ou les deux. Cependant, si nous
utiisons Open a Copy, PixIlnsightlit le fichier image mais crée seulementune copie
dans PixInsight. Lorsque des modifications sont apportées a cette image, l'option File -> Save reste
grisée (désactivée) car PixInsight ne reconnait pas I'image en tant que fichier existant déja sur votre
ordinateur. Cela vous oblige a utiliser File -> Save as pour le sauvegarder en tant que nouveau
fichier image. Vous pouvez bien sar choisir d’écraser I'image d’origine avec File -> Save as, tout de
méme. Certains utilisateurs peuvent trouver cette fonctionnalité utile.

( )
C J 9




Comme la plupart des programmes modernes, PixInsight stocke une liste des fichiers récents qui
ont été ouverts et est accessible via le menu File -> Open Recent .

Vous pouvez naturellement [l'utiliser pour ouvrir des fichiers image qui ont été ouverts auparavant,
sans avoir a les chercher dans vos dossiers. L'option de menu File -> Delete Files Recents est
également disponible pour effacer cette liste et la renouveler a son état vierge.

Lorsque vous apportez des modifications a vos images, vous souhaiterez peut-étre annuler ou
rétablir une modification récente. Cela fonctionne dans PixInsight comme dans pratiquement
n'importe quel programme moderne et est accessible via les menus Image -> Undo et Image ->
Redo ou via les boutons de raccourci situés sous les menus. Les raccourcis clavier indiqués dans
le menu Image s'appliquent également.

Vous pouvez effectuer un zoom avant ou arriere sur les images a l'aide de la molette de la souris
lorsque le curseur de la souris se trouve sur lI'image ouverte dans PixInsight . Effectuer un zoom
avant ou arriere a l'aide de la molette de la souris sélectionne automatiquement l'image actuellement
sous le curseur de la souris et effectue le zoom.

Par défaut, PixInsight a une barre d’outils Zoom au-dessus des images ouvertes. Vous pouvez
également cliquer sur les raccourcis de cette barre d’outils pour effectuer un zoom avant ou arriére,
ainsi que pour zoomer sur I'image a un niveau ou elle sera affichée dans sa résolution maximale, ou
une résolution moiti€ ou double. Les mémes raccourcis sont disponibles dans le menu Affichage ,
mais leur acces via les menus est plus fastidieux.

Cette méme barre d'outils Zoom contient quelques autres raccourcis utiles que jutilise
régulierement. A savoir Zoom to Fit et Zoom to Optimal Fit

La premiére option (a gauche), Zoom to fit , agrandit la fenétre de l'image afin qu'elle tienne aussi
largement que possible dans I'espace disponible sur I'espace de travail.

La deuxiéme option (a droite), Zoom to optimal Fit , réduit la taille de la fenétre de I'image a celle par
défaut lorsque Pixinsight ouvre I'image.

De plus, il est possible d’agrandir une fenétre d’'image pour s’adapter a I'ensemble de la zone de
visualisation de I'espace de travail. Pour ce faire, cliquez sur le bouton Agrandir situé dans le coin
supérieur droit de la fenétre de l'image.

Notez que la fenétre d'image n'a été agrandie que jusqu’au point ou la fine ligne orange verticale se
trouve a droite de I espace de travail PixInsight . Il s'agit d'une ligne de séparation qui vous donne
une zone de travail , la zone a droite étant libre d'images maximisées. Cette zone dégagée peut
ensuite étre utilisée pour répertorier des icbnes de processus ou d’autres images, réduites au
minimum. Nous explorerons les icbnes de processus plus loin dans ce tutoriel.

Avec l'image agrandie, vous pouvez faire glisser la ligne de séparation d’espace de travail vers la
gauche ou la droite pour augmenter ou réduire la zone de visualisation de l'image a votre
guise. L'image maximisée sera forcée de tenir dans cette zone de visualisation.

Les images maximisées peuvent étre remis en mode fenétré en cliquant sur le tiret en haut & droite
de l'image ou en cliquant soit sur le Zoom to Fit ou Zoom To Optimal Fit

Les images peuvent également étre réduites en icbnes qui flottent autour de I'espace de travail. Ceci
est fait en cliquant sur le bouton Iconize en haut a droite de la fenétre d'image.
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Ces icones sont toujours au premier plan. Si vous ouvrez une autre image ou essayez de placer une
image au-dessus de celle-ci, I'icbne sera apparente au-dessus.

Un double-clic sur ces icbnes ouvrira la fenétre d'image normalement, a la taille a laquelle elle était
définie avant qu’elle ne soit réduite a une icéne. En état réduit, vous pouvez cliquer avec le bouton
droit de la souris sur l'icone et aller a Set Image Identifier si vous souhaitez modifier le nom de cette
image dans PixInsight . Cela peut étre tres utile si vous souhaitez renommer une image dans
I environnement de travail PixInsight pour faciliter la sélection ultérieure (par exemple pour un
masque). S'il vous plait noter que les espaces ne sont pas autorisés. Aussi utiliser des capitales ou
des soulignés ou des tirets

L' identifiant d'une image peut également étre modifi€é via le menu File -> Set Image
Identifier. Veuillez noter que changer I' identifiant d' une image de cette maniére ne changera pas le
nom de fichier physique de limage sur votre ordinateur. L' identifiant fait uniquement référence a la
facon PixInsight désigne cette image.

Jusqu'ici, nous avons couvert I'ouverture des images ainsi que le contréle du zoom, la taille de la
fenétre et la facon de renommer son identifiant dans PixInsight.. Cependant, vous saurez déja (ou
trés rapidement) que les brutes que vous venez de capturer sont extrémement sombres et peu
contrastées. Avant qu'un post-traitement ait réellement lieu, il serait idéal d'inspecter l'aspect des
données. Pixinsight est capable d’ étirer automatiquement une image, sans modifier réellement
image elle-méme. Tout ce que cela change, c’est I'aspect de I'image pour l'utilisateur.

Pour effectuer un étirement automatique, nous utilisons le bouton STF AutoStretch de la barre
d’outils Screen Transfer Function en haut.

Veuillez noter que l'image n'a pas du tout été modifiée. Si vous enregistrez l'image en tant que
nouveau fichier, vous réaliserez rapidement que son apparence est identique a celle que nous avions
avant I'étirement automatique. Cette fonction est disponible dans Pixlnsight pour nous permettre de
travailler avec I'image alors qu'elle se trouve dans ce que nous appelons son état linéaire - avant
gu'elle ne soit étirée pour augmenter le contraste. Pour un étirement automatique beaucoup plus
spectaculaire, utilisez le bouton situé immédiatement a droite de celui-ci, appelé STF AutoStretch
(Boosted) . Veluillez noter que si vous apportez des modifications a une image, méme si elles sont
subtiles (par exemple, une réduction du bruit a petite échelle), vous devrez réappliquer Il'auto-
étirement pour voir les modifications qu'elle a apportées au contraste.

Vous pouvez réinitialiser I'étirement automatique pour le supprimer en cliquant sur le bouton Reset
de Screen Transfert Function dans la méme barre d'outils, a gauche du bouton utilisé pour
I'étirement automatique.

Ce bouton réinitialise I'étirement automatique de chaque Iimage actuellement ouverte
dans PixInsight . Si vous souhaitez uniquement réinitialiser I'étirement automatique sur la fenétre
d'image sélectionnée, utilisez le bouton situé a droite de celle-ci, intitulé Reset Screen Transfer
Functions: Active Window.

Si vous souhaitez rapidement copier une image, vous pouvez le faire en cliquant avec le bouton droit
de la souris sur I'image elle-méme et en sélectionnant Duplicate .

Pour ce faire, vous pouvez également simplement faire glisser l'identificateur d’image de la fenétre
d’'image vers I'espace de travail pour créer automatiquement un clone.




Vous pouvez utiliser des images clonées pour toutes sortes de choses, y compris pour tester
différents parameétres de processus et comparer les résultats, ou simplement pour utiliser le clone (ou
un clone modifié) en tant que masque pour l'image d'origine. Des techniques liées a cela seront
discutées dans d'autres tutoriels. Avec un étirement automatique appliqué a la fois a lI'image d'origine
et au clone, nous pouvons créerdes zones de prévisualisation dans PixInsight afin
de n'englober qu'un petit segment de votre image. Pour ce faire, il suffit de cliquer sur le bouton de
raccourci New Preview dans la barre d'outils Preview .

Avec ce mode sélectionné, nous pouvons créer une zone de prévisualisation dans notre image.

Des que la zone d'apergu est créée, Pixinsight sera en mode Edit Preview . Cela vous permet de
faire glisser la zone d'apercu créée autour de l'image pour la positionner plus soigneusement. Vous
pouvez également la redimensionner en faisant glisser I'un de ses coins ou c6tés. Une fois que vous
étes satisfait, vous pouvez cliquer sur le bouton de raccourci du mode Readout dans la barre d’outils
de Preview afin de ne pas déplacer accidentellement la zone de prévisualisation.

Les zones de prévisualisation peuvent étre incroyablement utiles pour diverses choses que nous
explorerons plus en détail dans d’autres didacticiels. Vous pouvez notamment sélectionner la zone
de prévisualisation a laquelle appliquer les processus, accélérant ainsi le traitement (la surface
traitée étant beaucoup plus petite) et donnant un apercu des effets de I'application de votre
processus. En fait, nous pouvons regarder la zone d'apercu comme s'il s'agissait de I'image entiére
en cliquant sur le nouvel identifiant Preview01 qui apparait sous l'identifiant de I'image.

Comme nous le voyons ci-dessus, si vous passez le curseur de la souris sur I' identifiant Preview01 ,
un petit apercu apparait pour nous indiquer la zone de l'image principale que la zone d'apercu
englobe réellement. Cliquez dessus pour afficher uniquement la zone de prévisualisation de l'image
dans la fenétre d'image. Cela peut étre agrandi ou réduit (Zoom To Fit ou Zoom to Optimal) de la
méme maniére que peut I'étre I'image principale. Si vous cliquez sur l'identifiant de l'image principale,
la fenétre d'image s'affichera pour afficher I'image principale dans son ensemble. La zone de
prévisualisation restera toutefois en place.

Nous pouvons transférer des zones de prévisualisation créées dans une image sur une autre image
ouverte, par exemple un clone. Cela est utile pour pouvoir comparer directement de petites zones
d’'images. Pour ce faire, il suffit de cliquer pour sélectionner l'identifiant de la boite d'apercu, dans ce
cas-ci Preview01 , et une fois que la zone d'apercu de limage est affichée, glissez-déposez cet
identifiant de boite d'apercu vers l'autre image, juste en dessous de l'identifiant d'image principal de
cette autre image. .

Si, au lieu de cela, lidentifiant de la zone de prévisualisation est glissé dans [' espace de
travail PixInsight , il créera une nouvelle fenétre d'image avec la zone de la zone de prévisualisation
de limage qui y est affichée.

Les images peuvent contenir de nombreuses zones de prévisualisation. Ces zones de
prévisualisation peuvent également étre renommeées. Par exemple, ci-dessous, j'ai utilisé le bouton
de raccourci New Preview de la barre d'outils Preview pour créer trois zones d'apercu dans l'image.

Supposons que je souhaite supprimer la premiere zone de prévisualisation, intitulée Preview01 ,
mais je souhaite également renommer les plus petites zones de prévisualisation en quelque chose
de plus significatif que Preview02 et Preview03 . Pour supprimer Preview01 , je reste en mode Edit
Preview (voir la barre d'outils Preview - ce mode est sélectionné par défaut dés que vous créez une
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zone d'apercu), je clique pour sélectionner Preview01 dans l'image principale et son contour passe
au vert une fois sélectionné.

Nous allons maintenant dans le menu Preview -> Delete pour supprimer cette boite de
prévisualisation.

Il est important d'éviter I'option de menu Preview -> Delete All sauf si nous voulons vraiment que
chaque boite de prévisualisation disparaisse! Maintenant que Preview01 est effacé, je vérifie que je
suis toujours en mode Edit Preview , puis je sélectionne Preview02 pour le renommer. Pour ce faire,
une fois sélectionné, je vais dans le menu Preview -> Modify Preview . Ici, nous pouvons entrer un
nouvel identifiant pour la zone de prévisualisation et confirmer les modifications. Notez que
les espaces ne sont pas autorisés. Utilisez des capitales, des sous-lignés ou des tirets .

Remarquez comment d'autres parametres peuvent également étre modifiés. Vous pouvez entrer des
coordonnées de pixel particulieres et une taille de pixel de zone de prévisualisation pour modifier la
zone de l'image que la zone de prévisualisation englobe. N'hésitez pas a jouer avec cela si vous
voulez vraiment étre spécifique. Toutes les zones de prévisualisation peuvent étre supprimées sans
avoir a en sélectionner aucune en utilisant simplement I'option de menu Preview-> Delete All .

Jusqu'ici, nous avons découvert le nouveau mode de prévisualisation et son utilisation pour créer des
zones de prévisualisation sur les images. Readout a été mentionné comme étant le mode par
défaut utilisé par PixInsight pour l'interaction de l'utilisateur avec les images, mais ses possibilités
ne sont pas détaillées. Readout est le mode par défaut car il donne a I'utilisateur des informations sur
le pixel sur lequel se trouve le curseur de la souris, ainsi que sur les pixels environnants. Pour voir ce
gu'il peut réellement faire, cliquez simplement avec le bouton gauche de la souris sur votre image
ouverte et maintenez le bouton gauche de la souris enfoncé.

La fenétre contextuelle est /a sortie du mode Readout. Il montre a l'utilisateur une vue tres agrandie
du pixel sur lequel ils sont superposés et des pixels environnants, avec I'emplacement précis du pixel
sur lequel ils se trouvent. Il fournit également une valeur pour la luminosité du pixel survolé par
l'utilisateur dans la sortie du Readout , au format normalisé ( 0 en noir et 1 en blanc). Pour une image
couleur, cette luminosité de pixel est donnée pour les trois canaux de couleur individuels
(rouge , vert et bleu ). Readout peut étre personnalisé via l'option de menu Edit -> Readout mode.

Ici, vous pouvez décider si la valeur de luminosité donnée par la sortie du mode de lecture est
effectuée sur le pixel survolé ou sur une zone de pixels en tant que Moyenne , Médiane , Maximum
ou Minimum . La taille de la sonde en pixels peut étre définie sur un seul pixel ou sur un carré
de 3x3jusqu'a un carré de 15x15.Vous pouvez également modifier la taille de sortie du mode
Readout en pixels et le facteur de zoom. La personnalisation dépend de votre choix et ce que vous
sélectionnez doit certainement refléter la facon dont vous souhaitez travailler. L'expérimentation est
la clé. Pour définir de nouveaux parametres, cliguez simplement sur l'icbne représentant un
cercle Apply Global et fermez la fenétre. Je trouve que les parametres par défaut, avec une taille de
sortie en mode Readout de 51 pixels, sont idéals pour moi.

Juste avant de terminer la section, nous parlons de formats dimage et nous abordons ici tres
brievement les processus dans PixInsight . Le nombre de bits des images peut étre modifié sans
avoir a lenregistrer. Cela peut se faire par lechoix du processus appelé
SampleFormatConversion . Cela se trouve dans le menu Processus -> <All Processes> ->
SampleFormatConversion ou plus précisément dans le menu Processus -> Image ->
SampleFormatConversion .




Par défaut, le processus SampleFormatConversion a le format de profondeur de bit de l'image
sélectionnée. Il suffit de sélectionner un autre format et de cliquer sur le bouton Apply pour convertir
I'image actuelle.

Bien s0r, en enregistrant I'image par le menu File -> Save as, invite l'utilisateur a sélectionner un
format de résolution en bits si le format d'image choisi le requiert, sauf pourJPEG ou PNG, par
exemple, car il s'agit simplement de formats d'image 8 bits . Si vous sélectionnez toutefois le format
TIFF ou FITS , Pixinsight vous demandera dans quel format de profondeur de bit enregistrer.

En sélectionnant JPEG , PixInsight demandera quel paramétre de qualité utiliser. Je recommande
d'utiliser 100 sans exception. Veuillez noter que si vous utilisez File -> Save as pour modifier le
format de résolution de votre image, vous devez fermer Ilimage et la rouvrir afin
que Pixinsight utilise larésolutionde la nouvelle image. C'est pourquoi le processus
SampleFormatConversionpeut étre utile: il modifie le format de résolution de votre image sur-le-
champ et vous permet de la manipuler immédiatement sans devoir rien enregistrer ni rouvrir.

Enfin, nous pouvons inspecter les informations d'en-téte FITS d' une image ouverte dans PixInsight
. Les images contiennent généralement des informations saisies par le logiciel de capture. Ces
informations comprennent généralement le temps d'exposition ou le temps total d'intégration, la
caméra utilisée, la monture utilisé, les coordonnées de la cible dans le ciel nocturne, etc. Ces
informations sont accessibles via le menu File -> FITS Header . Sélectionnez cette option de menu
avec une image actuellement ouverte et sélectionnée dans PixInsight .

Tout en haut de la fenétre d'en-téte FITS se trouve une liste déroulante. Vous trouverez ici les
identifiants de toutes les images actuellement ouvertes dans PixInsight . Vous pouvez sélectionner
une autre image dans ce menu déroulant pour afficher les informations d’en-téte FITS .

4. Processus et Scripts

PixInsight fonctionne avec des processus et des scripts - c'est la facon dont PixInsight traite les
images. Sans eux, il s'agirait simplement d'un programme de visualisation d'images, par opposition a
un programme de traitement d'images. La différence entre un processus et un script est une pure
formalité. Les nouvelles fonctions codées dans PixInsight peuvent commencer sous forme de
scripts et sont ensuite transformées en processus lorsque la fonction et son code sont formalisés
comme une caractéristique essentielle de PixInsight. Il existe des processus et des scripts pour tout
ce que vous devez faire sur vos images.

~

Cette section n'a pas pour but de vous apprendre a utiliser chaque processus et script que
PixInsight propose - ce serait extrémement exhaustif et cela dépasse largement la portée de ce
tutoriel. L'utilisation de processus et de scripts particuliers fait I'objet d'autres tutoriels plus ciblés.
Cette section traite plutét de la maniére d'accéder et d'interagir avec les processus et les scripts,
ainsi que de la maniére d'optimiser votre flux de travail avec eux.

Les processus sont accessibles via I'explorateur de processus situé dans la barre latérale gauche de
Pixinsight.

lls sont répertoriés par catégories, mais je trouve qu'il est beaucoup plus facile de les trouver via la
catégorie "All Processes", qui contient chacun d'entre eux par ordre alphabétique. Une fois que vous
avez une idée de la catégorie que vous souhaitez et de son nom, c'est le moyen le plus simple de
trouver le processus que vous souhaitez. Je trouve qu'un moyen plus rapide d'accéder aux

processus est de passer par le menu ProcessPs. \
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Ici, tous les processus sont a nouveau listés dans leurs différentes catégories, ou listés ensemble par
le menu <All Processes>. Ce menu est plus accessible que I'explorateur de processus, car il les
répertorie tous dans un seul écran sans avoir a les faire défiler. lls sont également classés par ordre
alphabétique.

Les scripts sont accessibles de la méme maniere, mais ils ne sont malheureusement pas aussi
rapides a trouver, sauf si vous savez a quelle catégorie appartient le script qui vous intéresse. Pour
acceéder aux scripts, il suffit d'aller dans le menu Script.

Il existe des scripts tres utiles déja fournis avec PixInsight et certains des utilisateurs les plus
avanceés ont codé leurs propres scripts, qui sont généralement téléchargeables par les utilisateurs.
L'un des scripts les plus utiles pour les utilisateurs de reflex numériques est le script
CanonBandingReduction, qui est extrémement efficace pour supprimer les horribles bandes dont
peuvent souffrir les images RAW des reflex numériques.

En raison du formalisme des processus, ils ont tous une présentation spécifique avec des
caractéristiques et des fonctions trés communes. En revanche, les scripts peuvent varier
considérablement, en fonction de la personne qui les a codés . Par exemple, ouvrons le processus
HistogramTransformation.

Ce processus particulier est utilisé pour étirer les images de facon permanente (contrairement a
I'étirement automatique mentionné ci-dessus), pour faire ressortir les détails des images et
augmenter massivement le contraste. Ce a quoi nous devons cependant préter attention pour ce
tutoriel, c'est a la barre en bas avec les différents boutons. Si nous ouvrons d'autres processus a
c6té de HistogramTransformation, nous commencgons a remarquer les similitudes.

Plusieurs processus sont présentés ci-dessus. |l y a deux types de processus - dynamigue et non
dynamique. La grande majorité des processus sont non dynamiques. Cela signifie qu'ils ne sont qu'une
petite fenétre d'outil que vous pouvez garder ouverte sur le c6té et appliquer a une image sans avoir
besoin d'interagir avec l'image elle-méme. De ce fait, vous pouvez avoir autant de processus non
dynamiques ouverts a un moment donné. Les processus dynamiques sont cependant différents. lls
fonctionnent en démarrant une session sur une image. Cette session permet a l'utilisateur d'appliquer le
processus a l'image en interagissant avec l'image. Par exemple, le DynamicCrop présenté ci-dessus est
un processus dynamique (d'ou son nom !) et, lorsqu'il est initialisé sur une image, il affiche un rectangle
blanc a l'intérieur de l'image que l'utilisateur peut faire glisser pour le redimensionner afin de choisir la
quantité de rognage a effectuer sur limage. Ceci difféere des processus non dynamiques qui ne
nécessitent aucune interaction entre l'utilisateur et I'image elle-méme. C'est également la raison pour
laquelle vous ne pouvez avoir qu'un seul processus dynamique ouvert a la fois.

Remarquez ci-dessus comment DynamicCrop a un ensemble de boutons Iégerement différent le long de
la barre inférieure par rapport aux quatre autres. Concentrons-nous d'abord sur les processus non
dynamiques (c'est-a-dire pas DynamicCrop). Les deux principaux boutons dont vous devez tenir compte
sont les boutons Apply et Reset. Le bouton Apply est le petit carré a gauche et le bouton Reset est la
petite croix a droite.

Ces boutons font ce que vous pensez qu'ils devraient faire - le bouton Apply appliqgue physiqguement
le processus avec les parametres définis sir limage qui est sélectionnée, et le bouton Reset
réinitialise completement les paramétres du processus aux valeurs par défaut. Le petit bouton en
forme de triangle tout a fait a gauche, appelé New Instance, est également extrémement utile. Par
exemple, disons que vous effectuez le post-traitement d'images monochromes et que vous avez
recadré votre image Luminance d'une certaine maniére et que vous effectuez le post-traitement
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complet de celle-ci. Beaucoup plus tard, votre intention est de post-traiter votre image couleur RVB
completement et seule, avec une combinaison de Luminance et RVB a suivre. Cependant, vous
craignez que le recadrage que vous avez appliqué a la Luminance ne soit pas identique au
recadrage appliqué au RVB plus tard, ce qui pourrait poser de sérieux problémes ! C'est la que New
Instance peut vous aider.

Utilisons ici les exemples HistogramTransformation et ATrousWaveletTransform. Supposons que
vous appliquiez un étirement spécifique avec HistogramTransformation et que vous accentuez
ensuite la netteté de I'image avec ATrousWaveletTransform. Le tableau ci-dessous indique les types
de réglages qui peuvent étre utilisés.

Pour sauvegarder les parametres de chaque processus, il suffit de faire glisser et de déposer le bouton
"New Instance" de chacun de ces processus dans l'espace de travail. Cela créera une icbne de
processus PixInsight.

Il est possible de les renommer pour leur donner un nom plus significatif en cliquant avec le bouton
droit de la souris et en allant sur Set Icon Identifier, en le renommant a cet endroit et en le confirmant.
Veuillez noter que les espaces ne sont pas autorisés, alors mettez des majuscules ou utilisez des
traits de soulignement ou des tirets.

Les processus HistogramTransformation et ATrousWaveletTransform peuvent maintenant étre
réinitialisés, fermeés, etc. - ces icbnes de processus ont stocké mes parametres pour chacun d'entre
eux. Les icbnes de processus peuvent étre mises de c6té en les faisant glisser ou vous le souhaitez.
Pour les appliquer a une image, il suffit soit de double-cliquer dessus pour ouvrir le processus auquel
elles sont liées et de cliquer ensuite sur Apply dans ce processus, soit simplement de faire glisser
I'icobne de processus elle-méme sur les images auxquelles vous voulez I'appliquer. Il est intéressant
de noter que, sans créer d'icbne de processus, vous pouvez faire glisser le bouton "New instance"
d'une fenétre de processus ouverte sur une image pour appliquer le processus a l'image. Cela ne
crée pas d'icbne de processus - il s'agit simplement d'une autre fagcon d'appliquer un processus a
une image. Cela semble faciliter les choses lorsque vous devez appliquer un processus a plusieurs
images, car sélectionner chaque image individuelle et cliquer sur Apply prend plus de temps que de
simplement glisser-déposer le bouton Nouvelle instance sur chague image, une par une.

Une bonne chose a propos de ces nouvelles instances de processus est qu'une fois que vous avez
une bonne idée de la maniere de post-traiter les images, avec certaines des variations que l'on peut
avoir dans un certain nombre de processus en raison de la qualité des données ou du contenu cible,
on peut avoir une longue liste d'icbnes de processus. Celles-ci sont préparées pour que vous
puissiez les appliquer directement aux images ou mieux, les ouvrir en double-cliquant dessus, les
modifier si nécessaire et ensuite les appliquer. Le fait d'avoir ces listes pourrait méme vous rappeler
ce que vous devez faire en premier lieu.

Plus loin dans ce tutoriel, nous parlerons des projets PixInsight - a quoi ils servent et comment les
utiliser. Nous pouvons toutefois sauvegarder nos icbnes de processus elles-mémes,
indépendamment des images ou des projets que nous traitons. Pour ce faire, nous créons les icbnes
de processus et nous les disposons selon nos voeux. Une fois que nous sommes satisfaits, il nous
suffit d'aller dans le menu Process -> Process Icons -> Save Process Icons.

Un fichier sera créé avec le nom de fichier choisi et dans le dossier choisi, contenant toutes les
informations a charger ultérieurement dans le projet dans lequel vous choisissez de les charger. Les
possibilités sont infinies, car vous pouvez préparer un ensemble différent d'icbnes de traitement pour
différents types de cibles (par exemple, petit?s galaxieis et grandes nébuleuses étendues), ou pour
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différents types d'imagerie (par exemple, bande étroite ou LRGB, monochrome ou One Shot Colour).
Les icOnes de processus peuvent étre chargées dans votre espace de travail Pixlnsight via le menu
Process -> Process Icons -> Load Process Icons, en pointant sur le fichier d'icbnes de processus
sauvegardé que vous avez choisi. Il est intéressant de noter qu'il est également possible de
fusionner des icones de processus. Par exemple, vous pouvez charger un fichier d'icones de
processus et décider d'ajouter un autre ensemble d'icbnes de processus que vous avez dans un
autre fichier. Il suffit de charger I'un des fichiers et d'utiliser le menu Process -> Process Icons ->
Merge Process Icons pour le fusionner avec le jeu actuel (plutét que le remplacer). La fusion elle-
méme peut ensuite étre enregistrée dans un autre fichier d'icbnes de processus, si vous le souhaitez.

Si vous en avez assez de certaines icones de processus, vous pouvez les supprimer en cliquant
avec le bouton droit de la souris et en sélectionnant I'option de suppression correspondante.

Naturellement, les fichiers des icones de processus peuvent étre sauvegardés et méme partagés
entre les utilisateurs. Vous trouverez des personnes qui partagent leurs icOnes de processus
librement, ou pour aider d'autres personnes sur des forums, par exemple. Vous ne souhaiterez peut-
étre pas utiliser cette fonctionnalité de PixInsight, mais savoir comment gérer les processus New
Instancesfor est extrémement bénéfique pour la plupart des flux de travail.

Sans étre spécifigue a des processus particuliers, nous avons jusqu'a présent couvert de maniére
adéquate la plupart des processus non dynamiques. Veuillez noter que certains processus non
dynamiques disposent de fonctionnalités supplémentaires, comme la fourniture d'un apercu en
temps réel des modifications qui seraient apportées si les paramétres étaient appliqués tels que
choisis. L'un de ces processus est en fait HistogramTransformation. Il est accessible par licbne en
forme de cercle creux sur la gauche.

Les prévisualisations en temps réel sont extrémement utiles pour les processus pour lesquels elles
sont disponibles, donc si vous les voyez disponibles, vous devriez probablement les utiliser ! Une fois
gue vous étes satisfait de ce que vous voyez, vous devez cliquer sur "Apply" sur le processus pour
appliquer réellement les paramétres a l'image. La fenétre de prévisualisation en temps réel peut alors
étre fermée une fois que vous avez terminé.

Les processus dynamiques different quelgue peu en ce qui concerne les boutons disponibles.
Comme ils fonctionnent en initialisant une session sur une fenétre d'image, ils fonctionnent seuls et si
vous essayez d'ouvrir plus d'un processus dynamique a la fois, PixInsight ne vous laissera pas faire.
Dans les processus dynamiques, l'option Apply est plus justement appelée Execute, symbolisée par
un bouton vert coché.

Le bouton en forme de croix rouge situé a droite, appelé "Cancel”, fait exactement cela : il ferme la
session sur l'image active et ferme ainsi entierement le processus. Les processus dynamiques
peuvent initialiser une session simplement en interagissant avec une image pendant que le
processus est ouvert, ou en sélectionnant une image et en cliquant ensuite sur le bouton "Reset".
Cela activera la fenétre du processus et fournira tous les paramétres qu'elle offre.

Tout comme les processus non dynamiques, les processus dynamiques peuvent étre sauvegardés
en créant une nouvelle instance (en faisant glisser son bouton "New instance" vers l'espace de
travail). On peut ensuite interagir avec eux de la méme maniére - en double-cliquant pour ouvrir le
processus lui-méme (cela activera une session sur l'image actuellement active) ou en glissant et
déposant l'icbne du processus lui-méme sur une image.




Avant de conclure cette section, sur le sujet du glisser-déposer des icones de processus, nous
pouvons en fait transférer des parametres d'un processus a un autre de cette maniere. Par exemple,
vous pouvez utiliser le processus ScreenTransferFunction pour étirer automatiguement une image,
exactement comme le fait le bouton AutoStretch de la barre d'outils du STF (ils sont identiques).
Vous pouvez prendre ces parameétres d'étirement automatique et les appliquer a une image de fagon
permanente - pour étirer physiquement l'image, plutét que de I'étirer automatiquement pour voir a
quoi elle ressemble tout en la maintenant linéaire. Cet exemple illustre le concept de transfert de
parametres entre processus par glisser-déposer. Nous commengons avec une image linéaire qui n'a
pas été étirée ou auto-étirée.

Nous pouvons effectuer un étirement automatique pour en avoir un apercu, bien sar, mais que faire
si nous voulons utiliser cet étirement automatique mais pour étirer réellement l'image ? Pour cela,
nous utilisons les processus ScreenTransferFunction et HistogramTransformation. En regle générale,
je clique aussi sur Reset pour m'assurer que les deux processus sont a leur valeur par défaut.

Pour étirer automatiguement l'image, je maintiens la fenétre de l'image sélectionnée et je clique
ensuite sur le bouton Etirement automatique dans ScreenTransferFunction.

Passons maintenant a la procédure - le transfert des paramétres calculés par la fonction
ScreenTransferFunction vers HistogramTransformation (qui effectuera I'étirement permanent de
notre image). Pour ce faire, nous glissons et déposons le bouton "New Instance" de
ScreenTransferFunction sur la barre inférieure de HistogramTransformation, entre tous les boutons
standard du bas.

Vous remarquez immédiatement que HistogramTransformation a changé pour afficher I'étirement
appligué. Cliquer sur Reset dans ScreenTransferFunction supprime I'étirement automatique de notre
image, puis cliquer sur Apply dans HistogramTransformation applique les mémes parameétres, mais
sous la forme d'un étirement permanent de lI'image.

L'image peut sembler la méme qu'avant, mais c'est la tout l'intérét - elle a été étirée de la méme
maniere, mais de fagcon permanente pour la sortir de I'état linéaire dans lequel elle se trouvait
auparavant.

Cette technique de transfert de parameétres d'un processus a l'autre a ses limites. Tous les processus
ne sont pas compatbles les uns avec les autres, pour des raisons évidentes. SCT et
HistogramTransformation sont compatibles car ils sont basés sur les mémes parametres d'étirement
d'une image. Par exemple, ScreenTransferFunction et ChannelExtraction ne sont pas compatibles
parce que ChannelExtraction est utilisé pour séparer les canaux RGB/luminosité/chrominance d'une
image. Lorsque vous essayez de transférer des parametres d'un processus a un autre en faisant
glisser le bouton "New Instance" d'un processus a un autre, vous obtenez un retour d'information
vous indiquant si cela fonctionne ou non. Lorsque cela fonctionnera, l'icbne de la nouvelle instance
gue vous faites glisser sera entourée d'un petit carré indiquant qu'elle peut étre transférée. Si elle ne
fonctionne pas, une petite croix apparaitra sous l'icone. Cette petite croix apparait également si vous
essayez de la déposer ailleurs que dans la barre inférieure du processus vers lequel vous transférez
les parametres. Une erreur se produira si vous déposez l'icbne "New instance" sur un processus
avec lequel elle n'est pas compatible.

Un point intéressant pour conclure cette section est que si les processus peuvent étre appliqués aux
images elles-mémes, ils peuvent également étre appliqués aux boites de prévisualisation a l'intérieur
des images. Pour ce faire, il suffit de cliquer sur l'identifiant de la boite de prévisualisation a gauche,
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juste en dessous de l'identifiant de limage. Une fois que la fenétre de l'image n'affiche que la zone
de la boite de prévisualisation, l'application du processus se limitera a la seule boite de
prévisualisation. Votre image réelle est laissée intacte, sans rien avoir été appliquée (ne pensez pas
gue le processus n'a été appliqué gu'a cette seule zone de limage - c'est un sujet pour les
masques !) ). Cela est utile car certains processus prennent du temps, méme sur des ordinateurs
puissants, en particulier lorsque les images sont massives (par exemple les mosaiques). Il est utile
d'appliguer des processus de ce type a des boites de prévisualisation pour observer les
changements qui se produiront dans les zones d'intérét. Une fois satisfait, vous pouvez appliquer le
processus a lI'image réelle et en avoir fini avec elle.

Certains de mes autres tutoriels aborderont ['utilisation de certains des scripts les plus utiles. La
plupart des scripts ont simplement des boutons OK et Cancel pour appliquer ou fermer le script, avec
guelques parametres qui peuvent étre modifiés. Cependant, comme certains d'entre eux ne sont pas
codés par I'équipe de PixInsight, leurs interfaces varieront naturellement d'un a l'autre. Cependant,
comme elles sont fournies avec PixInsight, il est prouvé gu'elles fonctionnent suffisamment bien
pour étre incluses dans l'installation par défaut.




5. Travalller avec les espaces de travalil

Les espaces de travail dans PixInsight sont essentiellement des ordinateurs de bureau. Dans un
projet, vous pouvez post-traiter une image pour un canal dans un espace de travail tout en
conservant l'image d'un autre canal dans un autre espace de travail (cela peut étre la luminance
dans un espace de travail et le RGB dans un autre). Les espaces de travail peuvent également
conserver temporairement certaines images que vous avez ouvertes, comme les masques. Les
espaces de travail sont les plus utiles lorsque vous travaillez avec des images en tant que projets, ce
qui est un sujet de discussion plus loin dans ce tutoriel.

Comme mentionné précédemment, les différents espaces de travail sont accessibles via les
raccourcis d'espace de travail en bas de PixInsight.

En cliquant sur I'un de ces boutons, vous serez transféré vers I'espace de travail correspondant, tout
en gardant également actif I'ensemble de votre espace de travail actuel. Comme indiqué ci-dessus,
si vous passez le curseur de la souris sur un bouton de raccourci de I'espace de travail, un apercu du
contenu actuel de cet espace apparaitra. Les espaces de travail sont également accessibles via le
menu Workspace -> Select Workspace, en sélectionnant I'espace de travail correspondant qui y est
répertorié.

Par défaut, les nouveaux projets PixInsight sont lancés avec quatre espaces de travail disponibles.
Vous pouvez supprimer des espaces de travail en allant sur I'espace de travail que vous souhaitez
supprimer et en accédant ensuite a l'option de menu Workspace -> Destroy Workspace.

Il vous sera demandé de confirmer que vous souhaitez effectivement supprimer cet espace de
travail, car cela supprimera les images et les processus (ou les icones dimages/de processus)
ouverts dans cet espace de travail. Vous pouvez également créer de nouveaux espaces de travail
via l'option de menu Workspace -> Create Workspace.

En cliquant sur "Create Workspace", vous créez immédiatement un nouvel espace de travail, sans
confirmation, et vous y étes transféré. Vous pouvez également renommer les espaces de travail en
leur donnant un nom plus significatif que les noms par défaut de Workspace01, Workspace02, etc.
Pour ce faire, sélectionnez d'abord l'espace de travail que vous souhaitez renommer, puis
sélectionnez I'option de menu Workspace -> Rename Workspace, en saisissant un nouveau nom ici
et en confirmant.

Veuillez noter que les espaces ne sont pas autorisés, alors mettez des majuscules ou utilisez des
traits de soulignement ou des tirets. Le fait de renommer les espaces de travail rend la navigation
tres efficace.

Le contenu des espaces de travail peut également étre rapidement transféré d'un espace de travail a
l'autre. Cela se fait par le menu Workspace -> Move Workspace Contents.

Sous Workspace -> Move Workspace Contents, vous trouverez quatre options :
« Entire Contents: Transfere tout - images, interfaces de processus et icOnes de processus
» Image Windows : Transfere uniguement les images

» Process Interfaces : Transfere les interfaces de processus (ouvrir les fenétres de processus)
uniquement
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» Icons : Transfére les Icones de processus (celles créées avec New Instance) uniquement

Veuillez noter que cela permet de déplacer littéralement des objets, et non des copies. Le
déplacement s'effectue a partir de lI'espace de travail dans lequel vous vous trouvez actuellement,
vers celui que vous sélectionnez dans la liste des espaces de travalil.

Les images individuelles, les fenétres de traitement et les icones de traitement peuvent en fait étre
transférées (déplacées) vers un autre espace de travail a partir de I'espace de travail dans lequel
vous vous trouvez actuellement par différents moyens. Vous pouvez cliquer avec le bouton droit de
la souris sur la barre de titre de la fenétre d'image ou de la fenétre de traitement et sélectionner
l'option Vers l'espace de travail, suivie d'un espace de travail qui y est répertorié. Si vous
sélectionnez un espace de travail autre que celui dans lequel vous vous trouvez actuellement,
I'image ou la fenétre de traitement correspondante y sera déplacée.

Cela fonctionne également si la fenétre d'image ou de traitement est réduite a une icone, car un clic droit
sur l'icbne fait apparaitre le méme menu, bien que pour les fenétres d'image réduites, cela semble alors
s'appeler "Move To Workspace" par opposition a "To Workspace" (il n'y a pas de différence de fonction !).
Les icbnes de processus qui flottent dans votre espace de travail peuvent également étre transférées
(déplacées) de la méme maniére.

Veuillez noter que les images stockées dans les différents espaces de travail sont toujours
accessibles a partir de chaque espace de travail. Par exemple, vous pouvez avoir plusieurs images
de masque dans un espace de travail et travailler sur votre image réelle dans un autre espace de
travail. Ces images de masque peuvent toujours étre sélectionnées dans l'espace de travail qui
contient I'image sur laquelle vous travaillez, méme si les images de masque se trouvent dans un
autre espace de travail. Il n'y a aucune différence dans la maniére de travailler avec elles - elles
apparaitront tout de méme dans la liste des images compatibles.

L'utilisation que vous faites des espaces de travail peut varier. Personnellement, je l'utilise trés
rarement car je garde simplement les images et les processus dont je n'ai pas besoin
immédiatement, en les minimisant sur le coté.

6. Travailler avec les masques

Tout comme dans Adobe Photoshop, PixInsight peut utiliser des masques pour protéger certaines
parties d'une image. Cette partie du tutoriel n'expliquera pas nécessairement comment créer des
masques particuliers, car c'est le sujet d'un autre tutoriel. Toutefois, elle sert d'introduction a la
fonction des masques et a la maniére de les utiliser.

Un masque est une image qui est superposée a une autre image et qui est utilisée pour définir les
zones qui sont protégées contre les altérations et celles qui sont laissées sans protection afin que les
altérations y soient appliquées. Par exemple, un masque peut protéger l'arriere-plan et les étoiles
mais laisser la nébulosité sans protection. Cela signifie qu'un renforcement du contraste serait
appliqué uniguement a la nébulosité, plutdét qu'au fond ou aux étoiles. Cela permet d'obtenir un
meilleur résultat dans la nébulosité sans nuire au fond, qui est généralement dominé par le bruit.

Les masques peuvent étre créés par une multitude de méthodes. Une simple copie d'une image peut
servir de masque, surtout si elle est monochrome. La copie peut étre étirée et découpée en blanc et
noir avec la transformation d'histogramme pour accentuer davantage les zones claires et sombres,
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afin de maximiser l'efficacité du masque. La fonction RangeSelection peut également étre utilisée
pour sélectionner les zones les plus claires afin de créer une image de masque. Les masques
d'étoiles peuvent également étre créés a l'aide de StarMask, afin de protéger les étoiles des
modifications. Les images peuvent étre combinées pour produire une image de masque plus
appropriée, ou des morceaux peuvent étre peints avec CloneStamp pour personnaliser une image de
masque en fonction de vos besoins plus spécifiques. Je vous rappelle cependant que la création et la
personnalisation des différents types de masque font l'objet d'un autre tutoriel, qui aborde ce sujet
plus en profondeur.

L'image ci-dessus montre une image monochrome ouverte et auto-étirée (elle est toujours linéaire).
A co6té, il y a une image dupliquée étirée et découpée en blanc et noir, qui a été nommeée
Mask_Image car nous l'utiliserons comme masque pour l'image originale. Le fait d'avoir étiré I'image
pour l'utiliser comme masque donne un contraste beaucoup plus €élevé aux zones claires qu'aux
zones sombres. Cela signifie que l'image du masque elle-méme est plus précise lorsqu'il s'agit de
protéger les zones a protéger. Le découpage en blanc et noir a encore accentué ce phénomene. En
I'état actuel des choses, le masque peut étre congu pour protéger les zones sombres ou les zones
claires. Pour ce faire, on peut choisir de laisser le masque tel quel ou de l'inverser.

Appliquons le masque a notre image. Pour ce faire, il suffit de cliquer pour sélectionner l'image elle-
méme, puis de faire un clic droit et de sélectionner I'option Mask -> Select Mask. On peut également
y accéder en sélectionnant I'image elle-méme puis en choisissant I'option de menu Mask -> Select
Mask en haut de PixInsight (plutét que de cliquer sur lI'image avec le bouton droit de la souris). Le
raccourci clavier correspondant est également utilisable a cette fin.

Les images compatibles seront affichées sur la liste de Nouveau Masque dans la fenétre pop-up. Si
image de votre masque ne correspond pas aux dimensions de limage elle-méme, elle est
considérée comme incompatible et n'apparaitra pas en option. Nous sélectionnons notre
Mask_Image et nous pouvons alors cliquer sur OK pour I'appliquer. Veuillez noter I'option Inverser le
masque dans la fenétre pop-up. Nous n‘avons pas besoin de nous en préoccuper car nous pouvons
de toute facon inverser le masque lorsqu'il est appliqué.

Vous remarquerez que l'image elle-méme est devenue trés rouge. Les zones marquées en rouge
sont protégées par le masque. Tout ce que nous faisons a I'image ne sera pas appliqué aux zones
couvertes de rouge, essentiellement. Comme l'image du masque n'est pas binarisée (purement noire
ou purement blanche) et qu'elle est plutét en tons de gris (monochrome), la protection a des degrés
d'application variables. Les zones purement noires sont complétement protégées, mais les zones
gris tres foncé sont moins protégées, tandis que les zones purement blanches sont complétement
non protégees (naturellement, les zones claires mais non blanches sont principalement non
protégées).

Bien sir, lI'image du masque ne nous permet pas de voir ce que nous faisons réellement a l'image
elle-méme. Pour y remédier, Pixinsight nous permet de cacher un masque sans le désactiver. Cela
donne a votre image son aspect original mais conserve la protection du masque. Pour ce faire, il
suffit de faire un clic droit sur I'image et de sélectionner l'option Mask -> Show Mask. Cette option est
également accessible par le menu Mask -> Show Mask de PixInsight, ou par son raccourci clavier
correspondant.




L'option "Enable Mask" présentée ci-dessus n'est pas celle a utiliser si vous essayez de masquer le
masque car la sélection de "Enable Mask" le désactivera et supprimera donc sa protection. Il sera
toujours appliqué a I'image, mais il ne fonctionnera pas tant que l'option Enable Mask n'aura pas été
sélectionnée a nouveau. N'oubliez pas d'utiliser I'option Show Mask pour masquer le masque. Dans
ce méme menu, nous voyons qu'il est possible d'inverser le masque en sélectionnant Invert Mask.
Son raccourci clavier correspondant fonctionne également.

Nous montrons maintenant le masque pour voir la différence en l'inversant. Les zones sombres sont
maintenant sans protection tandis que les zones claires sont protégées. Cela nous permettrait en
théorie d'attaquer l'arriere-plan, peut-étre en réduisant son contraste pour le rendre plus sombre et
plus neutre sans gacher l'image avec des bords prononceés. L'application du masque original, qui
consiste a laisser les zones claires sans protection, est idéale pour attaquer la nébulosité, peut-étre
pour améliorer son contraste sans toucher l'arriere-plan.

Les images des masques peuvent étre combinées, bien sir. Par exemple, nous pouvons créer un
masque comme ci-dessus, mais ensuite créer un masque d'étoile (contenant uniquement des
étoiles) et soustraire le masque d'étoile de notre image de masque. Cela nous donne une image de
masque résultante qui nous permet d'attaquer la nébulosité brillante sans attaquer également les
étoiles. Ceci est tres utile pour certains processus, car certains d'entre eux peuvent provoquer des
anneaux autour des étoiles (introduire des halos légerement sombres autour des étoiles et, dans les
cas graves, brller le coeur des étoiles avec une tache sombre au centre). Comme nous l'avons déja
dit, les spécificités de la création de masques font I'objet d'un autre tutoriel.

Si vous souhaitez modifier la couleur utilisée pour afficher les zones de I'image qui sont protégées
par le masque, vous pouvez rapidement passer a une sélection de couleurs fournie par Pixinsight. Il
vous suffit de cliquer avec le bouton droit de la souris sur l'image protégée par le masque et de
consulter le menu Masque -> Mode de rendu. Une sélection de couleurs est fournie.

Naturellement, cela est également accessible via le menu Mask -> Rendering Mode de PixInsight. Il
n'y a cependant pas de raccourcis clavier pour cette fonction. L'utilisation d'une couleur différente
peut aider a voir ce que le masque protege, en fonction de l'image en post-traitement, des yeux de
l'utilisateur, du moniteur utilisé, etc. Vous pouvez ne pas utiliser cette fonction du tout, mais elle est la
au cas ou vous souhaiteriez I'utiliser.

Une fois que vous avez utilisé un masque, il peut étre retiré plus facilement qu'il n'a été appliqué.
Pour ce faire, cliguez avec le bouton droit de la souris sur le masque et sélectionnez I'option Mask ->
Remove Mask. Cela peut également étre fait par le biais de l'option du menu Pixinsight Mask ->
Remove Mask . Il n'y a pas de raccourci clavier pour cette fonction.

En général, si le masque n'est plus utilisé, il est possible de le fermer sans le sauvegarder, car il ne
s'agissait que d'un outil temporaire permettant d'améliorer soigneusement l'image réelle. Si vous
fermez sans enregistrer le masque, sans le supprimer au préalable en tant que masque, Pixinsight
VOous en avertira et si vous confirmez, il supprimera automatiquement le masque.

Si vous avez plusieurs masque a utiliser sur une méme image, vous pouvez en sélectionner un,
effectuer vos améliorations puis en appliquer un autre sans avoir a supprimer le courant au
préalable.




7. Projets

Les projets dans PixInsight peuvent étre incroyablement utiles s'ils sont utilisés souvent. lls
permettent en fait de sauvegarder I'état de fonctionnement complet de PixInsight. Cela inclut vos
images ouvertes, vos parametres de processus, vos icbnes de processus et vos espaces de travail. Il
sauvegarde également un aspect tres important de vos images - leur historique de traitement. Cela
signifie que vous pouvez charger le projet plus tard et toujours annuler et refaire comme si vous
veniez d'appliquer ces processus ou scripts. C'est I'un des principaux avantages de l'utilisation des
projets dans PixInsight. Un projet peut étre créé pour une image sur laguelle vous travaillez et il peut
étre chargé a tout moment.

Lorsque vous démarrez PixInsight, il sera automatiquement vide - ne contenant rien d'autre que les
parametres par défaut pour les processus et aucune image ou icone de processus ouverte. Ces
derniers peuvent étre chargés, bien sdr, mais c'est généralement le début de votre projet vide. Si a
un moment donné vous souhaitez effectuer cette opération sans fermer et rouvrir PixInsight, il vous
suffit de sélectionner I'option de menu File -> Load Empty Project.

A ce stade, vous pouvez charger les icones de processus si vous avez sauvegardé une configuration
gue vous utilisez habituellement. Vous pouvez également procéder a la configuration de vos espaces
de travail, charger vos images et généralement commencer le pré ou le post-traitement de vos
images. A un certain stade, aprés avoir configuré votre projet, vous souhaiterez peut-étre
I'enregistrer pour le créer pour la premiere fois. Pour ce faire, il vous suffit d'utiliser I'option de menu
File -> Save Project.

Par défaut, sous Project Generation, tout est sélectionné, sauf Purger les fichiers existants. Vous pouvez
activer cette option si vous souhaitez que le projet soit completement remplacé s'il ne s'agit pas de votre
premiére sauvegarde de l'avancement du projet. C'est probablement une bonne idée de laisser tout
activé, sauf si vous avez une bonne raison de ne pas sauvegarder un aspect particulier de votre projet.

Pour la premiére fois que vous enregistrez un projet, cliquez sur le bouton de l'icbne de dossier a
droite de Project File pour sélectionner un dossier dans lequel enregistrer votre projet et lui donner
un nom.

Dans la rubrique Auteur, vous pouvez naturellement saisir votre propre nom. Dans Description, vous
pouvez entrer ce que vous souhaitez. Il peut s'agir d'une description de ce que le projet d'image
implique - une mosaique de 4 panneaux de la nébuleuse Gamma Cygni peut-étre ? L'auteur et la
description sont des champs entierement facultatifs et vous n'avez pas a entrer quoi que ce soit si
vous ne le souhaitez pas.

Cela permettra de créer les fichiers du projet dans le dossier que vous aurez choisi.

Le dossier lui-méme contient les données du projet telles que les images ouvertes, I'historique du
traitement des images, les icbnes de traitement, les paramétres du processus, les espaces de travail,
etc. Le fichier avec I'extension XOSM est le fichier principal du projet que vous allez charger a
l'avenir.

Si vous apportez des modifications a votre projet et que vous souhaitez les enregistrer, vous pouvez
simplement accéder a la méme option de menu File -> Save Project. La méme fenétre de
sauvegarde s'ouvrira, mais avec les détails déja remplis.




Vous pouvez modifier ce que vous souhaitez ici, mais il suffit de cliquer sur OK pour enregistrer les
modifications apportées, bien qu'il vous soit demandé si vous souhaitez les écraser. Vous devez
répondre Oui si vous souhaitez enregistrer les modifications.

A l'avenir, vous pourrez charger le projet via I'option de menu File -> Load Project. Ici, vous pouvez
parcourir votre ordinateur pour trouver le fichier XOSM de votre projet et il suffit de double-cliquer
dessus pour ouvrir le projet.

Tout se chargera et sera comme la derniére fois que vous avez enregistré le projet, dans la position
ou vous les avez laissés dans les espaces de travail.

A tout moment pendant qu'un projet est ouvert, vous pouvez consulter les données relatives a
l'auteur et a la description (les métadonnées du projet) en sélectionnant lI'option de menu File -> View
Project Metadata.

Ceci conclut la section sur les projets PixInsight. Gardez-les a I'esprit en ce qui concerne I'utilité de
pouvoir feuilleter I'historique du traitement d'une image et de stocker les paramétres et les icones de
traitement utilisés dans le post-traitement d'une image particuliere. Les projets peuvent éviter
beaucoup de frustrations.




II. Prétraitement (calibrage et empilement) des images
dans PixInsight

Depuis longtemps, des logiciels comme DeepSkyStacker sont utilisés pour le prétraitement des
images. Ce processus implique ce qui suit :

1. L'empilage de nombreuses images de bias pour produire un bias maitre.
2. Empilage de nombreuses images dark pour produire un dark maitre.

3. Empilage de plusieurs flats pour produire un flat maitre.

4. Calibrer le master flat avec le master bias et le master dark.

5. Calibrage des images brutes avec les images maitres, suppression des pixels chauds et froids,
enregistrement et empilage des images brutes calibrées résultantes.

6. Application d'un algorithme de rééchantillonnage tel que Drizzle pour améliorer le résultat final.

Ce processus peut sembler exhaustif, mais il n'est en aucun cas trop long. DeepSkyStacker rend les
choses tres simples a cet égard, car tout est exécuté automatiquement. PixInsight peut également
étre utilisé pour le prétraitement des images et, bien que le processus puisse sembler intimidant pour
les débutants, sa réalisation se traduit par une bonne compréhension de la science qui sous-tend le
prétraitement.
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Veuillez garder a l'esprit que PixIlnsight dispose d'un script appelé BatchPreprocessing qui
automatise une grande partie de ce processus. Cependant, ce script n'est idéalement utilisé que
jusqu'au moment ou vous empilez vous-méme les images brutes calibrées et enregistrées. Cela
s'explique par le fait qu'il faut faire des essais pour obtenir la meilleure image possible de I'empilage,
ce que le script ne peut pas faire automatiquement. De plus, I'empilage manuel est nécessaire si
vous devez utiliser I'algorithme Drizzle pour obtenir un résultat final plus précis. De plus, il ne produit
pas de super bias maitre lors de la premiere étape (seulement un bias maitre). Vous pouvez
cependant produire vous-méme le super bias maitre d'abord et ensuite demander au script de
l'utiliser. L'utilisation du script peut vous faire gagner du temps, mais pas beaucoup non plus, donc
son utilisation est vraiment facultative. Ce tutoriel traite de l'utilisation du script, mais vers la fin, il y a
guelques éléments des étapes manuelles que vous devrez néanmoins connaitre.

Pré-supposé pour ce tutoriel ;

e Connaissance de base de l'objectif des bias, des darks et des flats dans le calibrage des
brutes.

e Connaissance du fonctionnement de PixInsight, en rapport avec le traitement des images et
des processus (lire ce qui suit, sections 3 et 4).




1. Le flux de travail de préetraitement PixInsight

Cette section sert d'introduction simple & ce que nous allons couvrir et, comme référence future, de
ce qu'il faut faire, dans quel ordre. Nous devons d'abord préparer nos maitres, en commencant par le
bias. Nous en ferons également un super bias sans bruit. Les darks individuels sont calibrés avec le
superbias maitre et le dark maitre est ensuite formé a partir de ces darks calibrés. Les flats
individuels sont calibrés avec le superbias maitre et le dark maitre avant de former le flat maitre a
partir des flats calibrés. Cela nous donne des maitres qui peuvent étre utilisés pour calibrer les

images que nous voulons empiler.

Les images que nous voulons empiler sont d'abord et avant tout calibrées avec les maitres. Elles
sont ensuite corrigées cosmétiquement pour éliminer autant de pixels chauds et froids que possible.
A ce stade, les images sont propres et calibrées et elles sont ensuite alignées les unes avec les
autres (pour corriger les légers désalignements, y compris les désalignements intentionnels effectués
par dithering), puis empilées les unes sur les autres. Pour améliorer le résultat final, nous appliquons
ensuite le Drizzlealgorithm, qui crée une image résultante dont la résolution est deux fois plus élevée
et améliore la pixellisation par interpolation. A ce stade, nous avons terminé. Pour résumer :

1. Empiler les bias pour produire un bias maitre. Transformez cela en un super bias maitre sans
bruit.

2. Calibrer les darks avec le superbias maitre. Empilez ces darks pour produire un dark maitre.

3. Calibrez les flats avec le superbias maitre et le dark maitres Empilez ces frames plates pour
produire un master flat.

4. Calibrez les brutes pour les empiler avec le superbias, le dark et le flat maitre.
5. Appliquer une correction cosmétique aux brutes calibrés pour les empiler.

6. Débayériser les images brutes s'il s'agit d'images en couleur comme celles capturées a l'aide
d'un appareil photo CCD ou DSLR couleur a une seule prise.

7. Sélectionner les meilleures images brutes et optimiser leur pondération.
8. Enregistrer les images brutes pour les empiler les unes sur les autres.
9. Empiler les brutes.

10. Appliquer l'algorithme de Drizzle pour obtenir un résultat final.
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Nous passons maintenant a chacune de ces étapes, suivies d'une introduction au script
BatchPreprocessing qui peut étre utilisé pour alléger un peu la charge de travail (si vous le souhaitez
- personnellement, je ne l'utilise pas). Les données utilisées pour ce tutoriel sont 8 images brutes H-
Alpha de la nébuleuse du Croissant, avec les bias, les darks et flats correspondants.

Au-dessus, quatre dossiers vides sont présentés. Le dossier "Masters" permet simplement de
stocker nos superbias maitre, nos master dark et nos master flat aprés leur création. Lights_Cal
stockera les images apres qu'elles aient été soumises a I'étalonnage avec ImageCalibration.
Lights_Cal_CC stockera ces images calibrées aprés qu'elles aient été corrigées cosmétiquement

avec CosmeticCorrection. Lights_Cal_CC_Reg stockera les images résultantes aprés qu'elles aient

{ } 27



également été enregistrées les unes avec les autres a l'aide de StarAlignment. A ce stade, elles
peuvent étre empilées avec Imagelntegration et DrizzleIntegration apres cela.

Les dossiers appelés Lights_Cal, Lights_Cal_CC et Lights_Cal_CC_Reg peuvent étre supprimés une
fois que limage a été empilée et que l'algorithme Drizzle lui a été appligué. Ces dossiers ne
constituent qu'un stockage temporaire pendant que nous prétraitons les images. Vous pouvez
conserver le dossier Masters, en particulier pour les superbias master et master dark car ils
s'appliquent a d'autres images que vous pouvez avoir.

Si vous avez affaire a des images couleur RAW de reflex numériques, vous devez modifier certains
parametres de format de fichier image sur PixInsight avant de commencer. Pour accéder aux
parametres appropri€s, cliquez sur I'explorateur de formats a gauche de PixInsight et double-cliquez
sur lI'entrée DSLR_RAW en haut de la page.

Par défaut, PixInsight lit les images couleur RAW des DSLR comme des images Debayerisées, ce
qui signifie qu'il les modifie artificiellement pour les afficher en couleur dans PixInsight. Cela peut
sembler pratique car cela se fait automatiquement, mais techniguement, les images couleur RAW
des reflex numériques doivent étre calibrées alors gqu'elles sont purement RAW, avant toute
modification telle que la débayeérisation. Il suffit de cliquer sur le bouton "Pure Raw" en bas a gauche
de la fenétre de paramétrage et vous serez paramétré - cliguez ensuite sur OK.

PixInsight se souviendra de ces parameétres a l'avenir, vous n'‘aurez donc pas besoin de les modifier
a nouveau. Veuillez noter que l'ouverture des images couleur RAW des reflex numériques dans
PixInsight les affichera en monochrome. Une fois les images calibrées, nous les convertirons en
images couleur en les débayérisant, donc ne vous inquiétez pas de cela.

Avant de commencer, il convient de mentionner que le format dimage natif de PixInsight est le
format XISF. Juan Conejero de I'équipe PixInsight a présenté ce format a la communauté dans ce fil
de discussion du forum. Bien que I'équipe de Pixinsight ait déclaré que le format populaire FITS est
obsolete, il est toujours pleinement pris en charge et le sera toujours afin de garantir une
compatibilitt maximale avec d'autres logiciels. Etant donné que les caméras CCD produisent
actuellement des images au format FITS, c'est le format que je continue a utiliser. Non seulement
dans les tutoriels que vous lirez ici, mais aussi pour mon traitement personnel des images dans
PixIlnsight. Si vous choisissez d'utiliser le format XISF de PixInsight, n'hésitez pas car Il
fonctionnera tout de méme, bien qu'a ce jour je n'ai pas remarqué d'avantage pour l'utilisateur final a
utiliser XISF plutét que FITS. Il convient toutefois de noter qu'a partir de la version 1.8.5 de
PixInsight, les processus de prétraitement et les scripts n'offrent plus la possibilité de définir le
format de sortie de l'image et que, par conséquent, ils produisent tous par défaut au format XISF.
Vous pouvez cependant enregistrer vos images finales prétraitées au format FITS si vous le
souhaitez, ou conserver le format XISF. L'un ou l'autre de ces formats convient parfaitement.

2. Générer un Master Superbias et un Master Dark

Ce n'est pas un secret mathématique que "plus il y en a, mieux c'est" s'applique a
I'astrophotographie - pour tout - les bias, les darks, les flats et les images brutes. Il y a cependant
une limite & ce que nous pouvons et voulons capturer. Une image de bias est utilisée pour supprimer
le signal de bias du capteur produit lorsque I'image est produite aprés la fin de I'exposition. Ainsi, le
bias maitre est soustrait des brutes. Un bias ne devrait techniqguement pas contenir de bruit, puisque
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ce gue nous essayons de soustraire est le bias du capteur, et non un bruit aléatoire. Cependant, la
production de bruit est mathématiquement inévitable. Pour cela, plus nous empilons de trames de
biais, mieux c'est, bien sdr, mais il y a des limites personnelles. Comme les images de bias sont
rapides a capturer (le temps d'exposition typique est de 0,001 seconde, bien que le temps de
téléchargement des images soit beaucoup plus élevé), il n'y a guére de probleme pour en capturer,
disons 200 a empiler. Nous en utiliserons 20 dans ce tutoriel a des fins d'illustration.

Une image de bias que j'utilise ressemble a ce qui suit une fois auto-étirée dans PixInsight (a des
fins d'illustration uniquement) :

Le bruit aléatoire est assez clair. L'empilement des 20 trames de biais devrait donner un meilleur
résultat, plus représentatif du signal de bias réel du capteur que le bruit aléatoire. Nous allons
procéder de la sorte. Pour cela, nous ouvrons le processus d'intégration d'images.

L'intégration est un terme utilisé pour I'empilement, et c'est ce que nous devons faire - intégrer les 20
images de bias dans un bias maitre. Avant tout, nous cliquons sur Add Files en haut a droite de
Imagelntegration, nous recherchons les bias et nous les ajoutons.

Avec l'ajout des 20 bias, nous configurons maintenant Imagelntegration pour faire le travail de
maniere adéquate pour un bias maitre. Nous veillons d'abord a sélectionner Average dans
Combination, No normalization dans Normalization et Don't care (tous les poids = 1) dans Weight.
Nous désactivons également Evalute noise. Cela nous donne un empilage de base des bias en un
bias maitre.

Nous passons maintenant aux algorithmes de rejet des pixels. Le choix dépend du nombre de bias
empilés dans un bias maitre. Sous la rubrique Rejection algorithm, choisissez en fonction de ces
directives générales :

- Averaged Sigma Clipping pour < 10 images
- Winsorized Sigma Clipping pour 10 a 20 images
- Linear Fit Clipping pour > 20 images

Comme j'empile exactement 20 bias, je vais opter pour le Winsorized Sigma Clipping. Pour les bias,
vous utiliserez généralement le Linear Fit Clipping car il est facile de capturer plus de 100 trames de
biais pour un bon bias maitre. La encore, sélectionnez également No normalization dans
Normalization. Maintenez les options Clip low pixels et Clip high pixels activées, mais vous pouvez
désactiver les options Clip low range et Clip high range.

Nous pouvons maintenant procéder a l'intégration, donc nous cliquons sur Apply Global et les bias
sont empilés pour produire un bias maitre. Ce bias maitre se présente automatiguement comme une
nouvelle image dans PixInsight, avec l'identifiant d'intégration.

Ce qui précéde est mon résultat, qui a été auto-étiré a des fins d'illustration. Il s'agit d'un bias maitre
et il est clair qu'apres avoir empilé 20 images de bias, le résultat est une meilleure représentation du
signal de bias du capteur avec moins de bruit dominant. Cependant, le bruit subsiste. Il est évident
que 20 images de biais est trop peu, mais méme avec 200 images de bias et un capteur CCD a
faible bruit comme le capteur ICX694 de Sony, le bruit reste. C'est la qu'intervient le processus
Superbias, qui transforme un bias maitre, comme on I'a vu plus haut, en un bias qui semble étre le
résultat d'une pile de milliers d'images de bias. Nous fermons le processus Imagelntegration et nous
ouvrons le processus Superbias.
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Les parametres par défaut du Superbias fonctionnent trés bien dans la plupart des cas, mais si votre
biais maitre provient d'environ 50 trames de bias individuelles ou plus, réduisez le nombre de
couches multi-échelles a 6, sinon maintenez-le a son niveau par défaut de 7. Une fois le réglage
effectué, appliquez simplement le processus Superbias a votre bias maitre.

Le résultat final devrait étre beaucoup plus lisse et pratiquement sans bruit. Ce qui précede a été
étiré automatiquement a des fins d'illustration, mais il a également été étiré automatiquement en
mode 24 bits en cliquant sur le bouton encerclé de la barre d'outils Pixlnsight. Comme pour les
étirements automatiques normaux, cela n'altere pas l'image, mais nous donne un bon apercu des
données lorsqu'elles sont a I'état linéaire. Notre superbias principal est maintenant prét et peut étre
sauvegardeé. Enregistrez-la au format FITS. Nous pouvons également fermer le bias maitre sans
I'enregistrer.

La recommandation générale est d'empiler 100 trames de biais ou plus au départ, puis d'appliquer le
processus Superbias. Le résultat final sera toujours meilleur si vous utilisez plus de bias au départ,
mais il y a un rendement décroissant et I'existence du processus Superbias nous permet d'atteindre
ce rendement décroissant beaucoup, beaucoup plus rapidement.

Maintenant que le super bias maitre a été généré, nous devons générer le dark maitre. Ceci est mis
dans la méme section dans le tutoriel parce que les parameétres d'intégration dans Imagelntegration
sont identiques a ceux du biais maitre. Mais tout d'abord, nous allons calibrer nos images darks
individuelles avec le superbias maitre afin d'éliminer le signal de polarisation du capteur de chaque
image dark et ainsi faire en sorte que notre dark maitre soit purement représentatif du signal de
courant de dark produit par la caméra pendant les expositions. Ceci est particulierement important si
le noir maitre est mis a I'échelle (ceci est fait lorsque vos images darks proviennent d'expositions plus
longues que vos brutes). Pour calibrer les images dark, on ouvre le processus ImageCalibration.

Nous cliquons maintenant sur le bouton Add files et ajoutons les darks ici.

Nous devons attribuer un dossier de sortie pour chaque image dark calibrée. Pour cela, nous
cliquons sur le bouton a co6té de la zone de texte pour le répertoire de sortie et sélectionnons un
dossier de sortie. J'en ai créé un appelé Calibrated dans le dossier pour mes images darks.

Comme nous ne calibrons qu'avec le superbias maitres, nous désactivons Master Dark et Master
Flat.

Nous cliquons maintenant sur le bouton a c6té de la zone de texte pour Master Bias et recherchons
notre fichier master superbias et le sélectionnons.

Avec l'option Calibrate désactivée (puisque nous n'‘avons pas besoin de calibrer les superbias
maitres), nous cliquons simplement sur Apply Global dans le processus ImageCalibration et tout un
ensemble de darks calibrés apparait dans notre dossier Calibrated.

Nous avons maintenant des images darks dont le signal de polarisation du capteur de la caméra a
été soustrait et qui sont prétes a étre empilées pour former une image dark maitre adéquate. Pour ce
faire, nous rouvrons le processus Imagelntegration et cliquons sur le bouton "Clear" (pas le bouton
"Reset") afin de conserver tous les parameétres, mais en supprimant les images de biais de la liste.

Nous cliqguons maintenant a nouveau sur Add Files et ajoutons cette fois-ci les darks calibrés.




Nous conservons les parameétres de Imagelntegration comme auparavant, mais nous veérifions que
notre choix d'algorithme de rejet est correct pour notre nombre d'images. Comme il y a 20 images
sombres dans la mienne, je garde le Winsorized Sigma Clipping. Une fois que tout est vérifié, nous
cliguons a nouveau sur Apply Global et le master dark apparait automatiguement comme une
nouvelle image dans PixInsight, avec intégration comme identifiant.

C'est notre dark maitre et il peut maintenant étre sauvé en tant que tel. Assurez-vous qu'il est au
format FITS, ce qu'il devrait étre par défaut selon les paramétres de sortie du processus de calibrage
d'image.

A ce stade, nous en avons fini car nous avons réussi a générer un superbias maitre et un dark
maitre.

3. Générer un Flat Maitre

Comme pour le master dark, avant de procéder a I'empilage des flats, nous devons les calibrer
individuellement avec le master superbias et le master dark. Pour ce faire, nous revenons au
processus ImageCalibration. Pour éviter toute confusion, nous pouvons cliquer sur le bouton Reset
pour rétablir les valeurs par défaut du processus.

Nous procédons maintenant a I'ajout des flats a ImageCalibration en cliquant sur Add Files et en les
sélectionnant.

Comme nous calibrons les flats avec un master superbias et un master dark, nous désactivons
simplement le Master Flat cette fois-ci.

La encore, un dossier de sortie doit étre défini. Pour cela, nous cliquons sur le bouton a c6té de la
zone de texte pour le répertoire de sortie et nous en définissons un. J'ai simplement créé un dossier
appelé Calibrated dans le dossier contenant mes images flats.

Nous sélectionnons maintenant nos Master Superbias et Master Dark dans leurs sections
appropriées (Master Bias et Master Dark), par la méme méthode.

L'optimisation a été laissée activée sous Master Dark afin de permettre a PixInsight de mettre a
I'échelle le master dark pour s'adapter au temps d'exposition des flats. Ceci est nécessaire car les
flats ont généralement un temps d'exposition d'environ 1 seconde alors que le master dark dans mon
cas provient d'images dark qui ont un temps d'exposition de 600 secondes (10 minutes). Comme le
signal de courant d'obscurité est acquis linéairement pendant I'exposition d'une image sombre, il peut
étre facilement mis a I'échelle par PixInsight tant que 'option Optimiser est laissée activée. Veuillez
noter que PixInsight peut indiquer gu'il n'y a pas de corrélation entre le courant d'obscurité principal
et vos images flats. Cela se produit généralement si vos flats ont un temps d'exposition trés faible (1
seconde ou moins). Ne vous inquiétez pas de cela car c'est normal - cela signifie simplement que la
soustraction de l'obscurité n'est pas nécessaire pour ces images flats. Maintenant, en cliquant sur
Apply Global, notre dossier Calibrated se remplit de flats calibrés.

Une fois les flats calibrés, ils peuvent maintenant étre empilés pour former un flat maitre. Cela se fait
a nouveau avec Imagelntegration. Cliguez sur Reset quand il est ouvert car nous devons utiliser
différents paramétres ici.




Avant tout, nous cliquons sur Add Files pour ajouter nos flats calibrés a la liste.

Nous procédons maintenant aux réglages nécessaires a la réalisation d'un master flat. Nous
choisissons Average dans la Combination, Multiplicative dans Normalization et encore une fois
"Don't care" (tous les poids = 1) dans les poids. Cette fois-ci, nous laissons cependant la fonction
Evaluate noise activée.

Pour l'algorithme de rejet, il suffit de sélectionner ici Percentile Clipping, puis Equalize fluxes dans
Normalization. Clip low pixels et Clip high pixels sont activés a gauche, Clip low range et Clip high
range étant désactivée.

Il se peut que nous devions maintenant modifier les réglages du Percentile low et Percentile high ci-
dessous. Ces parametres définissent les seuils a partir desquels les pixels doivent étre rejetés lors
de la génération flat maitre. Si vous avez utilisé une boite a lumiére, un générateur de flats ou un
panneau électroluminescent, vous pouvez utiliser les parameétres par défaut - ils fonctionnent
généralement parfaitement. Mais, si vous avez capturé ces flats en pointant le télescope sur le ciel
de l'aube, vous avez peut-étre capturé par inadvertance certaines étoiles, qui doivent étre
supprimées. Vous devez abaisser le centile inférieur et le centile supérieur a une valeur minuscule
telle que 0,010 afin de maximiser le rejet et d'éliminer les étoiles et autres aberrations que vous avez
pu capturer. Comme les miennes sont capturées a l'aide d'un générateur de flat, je laisse mes
parametres par défaut.

Une fois le réglage effectué, cliquez sur Apply Global et le master flat apparaitra automatiquement
comme une nouvelle image dans PixInsight, avec l'identifiant intégration.

Comme on I'a vu plus haut, si le parameétre "Generate rejection maps" est activé, vous obtiendrez
deux autres images que vous pourrez inspecter avec un auto-stretch. Elles vous donnent une idée
des pixels qui ont été rejetés. Comme toujours, étirez automatiguement le master flat généré et
inspectez-le bien pour vous assurer qu'il a l'air bien (c'est-a-dire qu'il ne reste pas d'éléments
aberrants comme des étoiles si vous avez capturé les flats sur le ciel). Les poussiere doivent
évidemment rester dans votre master flat car c'est I'une des raisons principales de l'utilisation des
flats.

Une fois que vous vous étes satisfait du flat maitre, il est enregistré comme tel. Assurez-vous qu'il est
au format FITS, ce qu'il devrait étre par défaut selon les parametres de sortie du processus de
calibrage d'image. Les images de la carte de rejet peuvent toutes deux étre fermées sans étre
sauvegardeées, car elles ne sont pas vraiment nécessaires, si ce n'est pour votre inspection.

Ce qui précede, pour moi, concerne le filtre h-alpha. Si vous avez utilisé une caméra CCD
monochrome et que vous avez des images avec d'autres filtres, vous aurez naturellement des flats
pour chacun de ces filtres. Par conséquent, vous devrez répéter cette section du tutoriel pour les flats
de chacun de vos filtres. Si vous avez utilisé un appareil photo couleur comme un DSLR (ou
équivalent, une caméra CCD couleur), vous devriez avoir terminé maintenant, car vous n‘aurez qu'un
seul jeu d'images flats.




4. Calibrage des brutes et correction des pixels chauds et froids

Cette section du tutoriel prépare nos images brutes pour l'alignement et I'empilement, en les calibrant
avec nos maitres, puis en corrigeant les pixels chauds et froids restants. Nous commencons par le
calibrage. Comme nous avons préparé nos superbias, dark et flat maitre, nous pouvons continuer.
ImageCalibration est le premier processus a utiliser. Nous cliquons sur Reset une fois ouvert pour
nous assurer qu'il est aux parametres par défaut.

Nous commencons par ajouter les brutes a la liste en cliquant sur Add files et en les sélectionnant
dans notre dossier Brutes.

Tout d'abord, définissez le dossier de sortie en cliquant sur le bouton situé a coté de la zone de texte
du répertoire de sortie et sélectionnez un autre dossier dans lequel vous pouvez stocker les images
lumineuses calibrées. J'ai choisi d'utiliser mon dossier Lights_Cal comme mentionné précédemment
dans ce tutoriel.

Veuillez noter qu'a partir de la version 1.8.5 de PixInsight, I'option Output extension n'est plus
présente ici ni dans aucun des autres processus de prétraitement que nous utiliserons et le format
par défaut de toutes les images traitées sera le format XISF natif de Pixlnsight. Ce n'est pas un
probleme, donc ne vous inquiétez pas. Il ne nous reste plus qu'a sélectionner nos master superbias,
master dark et master flat dans leurs sections respectives, en gardant les trois activés. Encore une
fois, si comme moi a I'heure actuelle, vous n'utilisez pas les darks pour la calibration, vous pouvez
garder Master Dark désactivé a ce stade.

Toutes les options de calibrage doivent étre maintenues désactivées si vous avez suivi ce tutoriel de
pres, car le dark maitre et le flat maitre ont déja été calibrés. Le master superbias n'a pas besoin
d'étre calibré. Je maintiendrais I'option Optimiser activée sous Master Dark afin de m'assurer que
PixInsight fait correspondre le master dark a vos images brutes.

Une fois prét, cliquez sur le bouton Apply Global et votre dossier de sortie sera rempli avec les
images lumineuses calibrées.

Ci-dessus, nous voyons une seule image brute auto-étirée dans PixInsight apres qu'elle ait été
calibrée comme ci-dessus. Comme nos images brutes sont maintenant calibrées, nous pouvons
procéder a la suppression d'autant de pixels chauds et froids que possible. Nous commencerons par
ouvrir le processus de CosmeticCorrection.

Nous commencons par ajouter nos brutes calibrés ici, a nouveau en cliquant sur Add files et en les
sélectionnant.

Si vos images brutes sont des images en couleur provenant d'une CCD couleur ou d'un appareil
photo DSLR, activez ici le réglage des images CFA (Colour Filter Array). Ces images seront
débalayées plus tard dans le processus de prétraitement. Une fois que les images en couleur ont été
débayérisées vous n'aurez plus besoin d'utiliser cette option par la suite. Toutefois, si vos images
brutes sont monochromes, laissez I'option des images CFA désactivée.

Définissons un dossier de sortie en cliquant sur le bouton a coété de la zone de texte pour le
répertoire de sortie. J'ai sélectionné mon dossier Lights _Cal_CC, mentionné plus haut dans ce
tutoriel.




Une fois le dossier de sortie défini, nous procédons a la correction cosmétique proprement dite. Si
vous avez un master dark, vous pouvez activer l'option Use Master Dark et PixInsight vous
demandera de pointer vers votre master dark.

Comme nous avons un Master Dark avec lequel travailler, il n'est peut-étre pas nécessaire d'activer
l'option Use Auto detect sous Use Master Dark. Cette option est particulierement réservée aux
personnes qui ne s'embétent pas du tout avec les darks, comme moi, grace a mon capteur Sony
ICX694 a faible bruit. Nous aborderons un peu plus loin 'option Use Auto detect, car elle est utile
pour un nettoyage supplémentaire.

Pour voir avec quoi nous travaillons, il suffit de double-cliquer sur I'une des images brutes de la liste
pour I'ouvrir sur le cété. Un étirement automatique est nécessaire a ce stade.

Pour optimiser notre vitesse de travail, nous devons définir une fenétre de prévisualisation autour
d'une zone de l'image qui présente un nombre important de pixels chauds (clairement considérés
comme des aberrations, comme des pixels blancs isolés qui ne sont clairement pas des étoiles).
Activez également la nouvelle fenétre de prévisualisation afin que nous ne voyions que la zone de la
fenétre de prévisualisation.

Avec cette configuration, nous cliquons sur Real-Time Preview sur CosmeticCorrection pour obtenir
une fenétre qui nous montre ce qui arrive aux pixels chauds et froids lorsque nous modifions les
parameétres, mais seulement dans la zone de notre boite de prévisualisation (ce qui accélere la mise
a jour lorsque nous modifions les parametres !)

D'abord, nous cliquons sur "Enable" sur "Hot Pixel Threshold" et ensuite nous diminuons la valeur
Sigma en utilisant le curseur. Ce faisant, nous observons la fenétre de prévisualisation en temps réel
pour voir comment nos pixels chauds disparaissent. Evitez les valeurs Sigma trop faibles, car cela
supprimerait une quantité inutile de pixels. Vous pouvez également augmenter la valeur Qty en
utilisant le curseur pour supprimer plus de pixels chauds.

Vous pouvez vérifier s'il y a des pixels froids qui méritent d'étre supprimeés en cliquant sur Enable on
Cold Pixel Threshold et en le modifiant par la suite. Gardez toutefois a I'esprit que cela peut ne pas
étre nécessaire, comme c'est le cas dans mon image ci-dessus.

Vous remarquerez peut-étre, comme je le fais ci-dessus, que le fait d'avoir utilisé le master dark pour
supprimer les pixels chauds n'a pas suffi, car il reste un bon nombre de pixels chauds. Lorsque cela
se produit, vous pouvez également utiliser la fonction de détection automatique. Pour ce faire, il suffit
de cliquer pour activer la fonction Auto Detect. Vous pouvez alors activer Hot Sigma et modifier la
valeur avec le curseur ou en entrant une nouvelle valeur manuellement. Une valeur inférieure est
plus agressive pour supprimer les pixels chauds, donc évitez généralement les valeurs inférieures a
1,0. Plus la valeur est élevée, mieux c'est, a condition que cela fasse l'affaire pour votre image.
Quant aux pixels froids, vous pouvez activer Cold Sigma pour vous aider davantage.

L'option Use Defect list peut étre utilisée pour signaler les colonnes ou lignes défectueuses de votre
image. Je trouve que ce n'est pas nécessaire si vous avez un bon master superbias et un master
dark qui présentent essentiellement ces mauvaises colonnes et lignes aussi, car elles seraient
supprimées lors de la calibration

Vos parametres de CosmeticCorrection devraient nettoyer vos images de maniere adéquate, comme
cela:




Une fois que vous étes satisfait, n'hésitez pas a fermer la fenétre de prévisualisation en temps réel et
votre image elle-méme. Avec CosmeticCorrection toujours ouvert, cliquez sur Apply Global pour
appliquer ces réglages de correction cosmétique a vos images lumineuses et les sortir dans le
dossier Lights_Cal _CC.

Nous en avons maintenant fini avec I'étalonnage et la correction cosmétique des images brutes et
pouvons maintenant procéder a leur enregistrement (alignement) et a leur intégration (empilage).
Toutefois, si vos images brutes sont des images en couleur provenant d'une caméra couleur a prise
unique, vous devrez d'abord les débayerisées. Ce processus convertit une image brute avec des
informations de matrice de couleurs en une image couleur réelle et doit étre effectué si vos images
lumineuses sont des images couleur. La procédure de déblayage est trés simple grace a l'utilisation
du processus Debayer.

Ce procédé est trés simple a utiliser. Il suffit de cliquer sur "Add Files" pour ajouter vos brutes
calibrés et corrigés cosmétiqguement. Une fois fait, sélectionnez dans la liste le motif Bayer/mosaique
correct pour votre capteur d'appareil photo (vérifiez en ligne si vous n'étes pas sdr, bien que RGGB
semble étre le cas avec les appareils reflex numériques Canon EOS), définissez un répertoire de
sortie comme d'habitude et cliquez le bouton Apply global pour continuer. En quelques secondes,
toutes vos images lumineuses devraient étre correctement débayérisées. Si vos images brutes sont
toutes monochromes, vous pouvez ignorer complétement la procédure ci-dessus et continuer a
partir de la.

Si, en revanche, vos brutes sont monochromes, vous en aurez sans doute d'autres a calibrer et a
corriger. Cette section devra étre répétée pour chacune de ces séries d'images brutes. Cependant,
avant d'enregistrer et d'intégrer les brutes, nous utiliserons d'abord le script SubframeSelector pour
nous aider a déterminer quelles expositions sont les meilleures et quelles expositions sont a
supprimées. Nous pouvons également utiliser le script SubframeSelector pour calculer les
pondérations optimales de nos images brutes, en fonction de ce que nous souhaitons prioriser.

5. Sélection des meilleures brutes et calcul des pondérations optimales

Les conditions d'imagerie varient tout au long de la nuit, notamment en raison du changement de
position de la cible (par rapport au méridien et a I'horizon), ainsi que d'éventuels nuages fins et
élevés, des rafales de vent, etc. Pour beaucoup d'entre nous, une grande partie de l'imagerie est
automatisée au point que de nombreuses longues expositions sont capturées au cours de plusieurs
heures. Il est possible de vérifier chaque exposition séparément, mais ce n'est certainement pas une
science précise. Le processus SubframeSelector de PixInsight mesure la qualité de toutes vos
expositions en fonction de nombreuses propriétés importantes telles que la taille moyenne des
étoiles (FWHM - Full-Width Half-Maximum), I'excentricité des étoiles (une mesure de la distorsion par
rapport a une image parfaitement circulaire), le bruit, le rapport signal/bruit (SNR), etc. La mesure
numerique de toutes ces propriétés vous permet de voir comment les expositions se comparent les
unes aux autres, et vous permet d'en exclure certaines et d'en approuver d'autres (pour les empiler
plus tard). En outre, le processus SubframeSelector vous permet de définir la pondération des
expositions les unes par rapport aux autres (en donnant la priorité¢ a certaines d'entre elles par
rapport a d'autres, en raison de propriétés favorables).




Par conséquent, ces pondérations peuvent étre fournies au processus Imagelntegration, qui
effectuera lI'empilage. En raison de tout cela, l'utilisation du processus SubframeSelector est
considérée comme importante pour la qualité globale du résultat final.

Les expositions soumises au processus SubframeSelector devraient idéalement étre calibrées et
corrigées esthétiguement (pour éliminer les pixels chauds). C'est pourquoi nous utilisons le
processus SubframeSelector dés maintenant et non plus tét. Depuis la version 1.8.6 de PixInsight,
SubframeSelector est un processus plutét qu'un script. Par conséquent, nous l'ouvrons comme les
autres processus.

Tout d'abord, nous devons ajouter les images pour lesquelles nous souhaitons mesurer et optimiser
les poids. Les images que nous devons ajouter sont celles qui ont été soumises a un calibrage et a
une correction cosmétique (les résultats de la section précédente). Pour ajouter les images, nous
cliquons sur le bouton Add Files, nous les sélectionnons toutes et nous les ajoutons.

Nous examinons maintenant l'onglet "System Parameters" car nous devons définir certaines valeurs
pour que le processus puisse faire son travail. En premier lieu, nous devons entrer Subframe scale
en secondes d'arc/pixel, qui est une propriété de votre combinaison télescope et caméra. Si vous ne
la connaissez pas, vous pouvez la calculer a I'aide de I'équation suivante :

[Arcsecondes par pixel] = (206,2648 x [Taille du pixel de I'appareil photo sur um]) / [Longueur focale
du télescope en mm]

Vous pouvez également télécharger une brute (non calibrée) sur nova.astrometry.net pour obtenir
I'échelle des pixels une fois que I'image est résolue.

C'est normalement plus précis, car la résolution déterminera avec précision I'exposition que vous
avez capturée et son échelle en arcsecondes/pixel. Une fois que vous avez la valeur correcte de
I'échelle de I'image en arcsecondes/pixel, saisissez-la. Vous devez également entrer le gain de votre
caméra en électrons/ADU. Il s'agit d'une spécification que vous pouvez Soit mesurer vous-méme
(Vair _cet article), soit simplement obtenir auprés du fabricant de I'appareil photo. Une fois que vous
avez la valeur correcte du gain de la caméra, saisissez-la.

Pour moi, Subframe scale était de 1,630 arcsecondes/pixel et le gain de la caméra était de 0,450
électrons/ADU. Vous devez également sélectionner la résolution correcte de la caméra (profondeur
de bits). Si vous utilisez un appareil photo CCD ou RAW avec un appareil photo DSLR, l'option 16
bits [0, 65535] est la bonne a choisir. Si I'image est dans un format 8 bits tel que JPEG, sélectionnez
plutdt ce format. Pour Scale unit, sélectionnez plutét Arcsecondes (arcsec) afin que les mesures
FWHM soient en arcsecondes et non en pixels.

Nous développons maintenant l'onglet Star Detector Parameters pour faire quelques ajustements.
Les parametres par défaut fonctionnent généralement parfaitement bien, mais nous pouvons
généralement nous permettre de réduire Structure layers a 4 et d'augmenter Noise layers a 2.

Cela permet de s'assurer que le processus ne capte pas les plus grosses étoiles pour les mesures,
et ignore les deux premieres couches (dont la premiere est largement dominée par le bruit a petite
échelle). Si vous devez augmenter la sensibilité de détection des étoiles, augmentez légéerement le
parameétre Sensitivity. En général, les autres parameétres peuvent étre laissés aux valeurs par défaut.
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Une fois que vous avez défini Measure Subframes, nous veillons a ce gu'ils soient sélectionnés dans
la section Routine en haut et nous cliquons ensuite sur Apply Global en bas du processus. La
console du processus s'affichera et vous montrera la progression de la mesure des étoiles détectées
dans toutes vos images. Notez qu'elle devrait détecter entre quelques centaines et quelques milliers
d'étoiles. Si ce n'est pas le cas, vous pouvez rétablir les parametres par défaut des couches
Structure et Noise, et/ou augmenter le parametre Sensitivity.

Une fois le processus de mesure terminé, nous prétons attention aux résultats sur la fenétre du
milieu. Sous l'onglet Measurements Table, trois des propriétés les plus importantes sont affichées
sans avoir a défiler vers la droite - FWHM, excentricité et SNRWeight. La troisieme, SNRWeight, est
une mesure du rapport signal/bruit des images. A I'heure actuelle, la pondération est égale a zéro
pour chaque exposition indiquée. Ce paramétre permet de définir la pondération de chaque
exposition lorsqu'elle est empilée, ce qui peut étre utilisé pour donner la priorité aux expositions
particulierement bonnes. Le poids peut étre personnalisé en entrant une expression pour la
pondération dans la fenétre de droite, ce que nous allons faire dans un instant. Tout d'abord,
regardez les graphiques de FWHM, d'excentricité et de pondération SNR, car ils comparent les
expositions les unes aux autres. Il est difficile de donner des valeurs générales a observer, car les
images de chacun sont différentes et, en fait, les cibles et les combinaisons d'équipements sont trés
différentes. En général, cependant, on considéere que des valeurs d'excentricité de 0,42 ou moins
donnent des étoiles parfaitement précises a I'ceil humain, méme en les regardant de pres.
Cependant, on considére généralement que des valeurs d'excentricité de 0,60 ou moins semblent
correctes. Ne vous inquiétez pas trop si les vbtres, comme les miennes ci-dessus, sont loin d'étre
proches de 0,42 ou méme si certaines dépassent 0,60.

En général, plus les valeurs de FWHM et d'excentricité sont basses, meilleure est I'exposition.
Inversement, plus la valeur du SNRWeight est élevée, meilleure est l'exposition. Un mot
d'avertissement cependant : les nuages fins et élevés sont enregistrés comme un signal, de sorte
gue les expositions affectées par ce phénomeéne ou quelque chose de similaire peuvent avoir des
valeurs de pondération SNR élevées alors gu'en réalité, vous pourriez souhaiter vous débarrasser de
ces expositions. A ce stade, tout en inspectant les graphiques de ces trois propriétés, vous pouvez
exclure les expositions en cliquant simplement sur les points de données correspondants sur les
graphiques. Cela transformera le point de données en un X et I'exposition apparaitra exclue du
tableau. Vous pouvez également exclure des expositions manuellement du tableau, en double-
cliguant sur la coche verte a gauche de I'exposition dans la liste, ou en sélectionnant I'exposition
dans la liste et en cliuant sur le bouton "Approve" en haut. Si vous excluez une exposition et
décidez ensuite de l'inclure, une fois qu'elle est réintégrée, assurez-vous de sélectionner I'exposition
dans la liste et de cliquer sur le bouton "Toggle Lock" pour qu'elle soit déverrouillée.

Vous pouvez trouver utile de trier la liste par ordre croissant ou décroissant de FWHM, d'excentricité,
de SNRWeight ou de toute autre propriété. Cela peut étre fait facilement en sélectionnant la propriété
a trier dans la liste tout en haut, au-dessus du tableau. Sélectionnez la propriété que vous souhaitez
trier, puis sélectionnez Asc. pour Ascendant ou Desc. pour Descendant dans la deuxieme liste.

Remarquez ci-dessus que l'exposition exclue apparait dans la liste et a été marquée d'un X dans
tous les graphiques. Remarquez également que cette exposition est clairement pire que les autres
en termes de FWHM mais pas d'excentricité. En général, I'exclusion des expositions est une bonne
idée si vous avez un grand ensemble de données a empiler, ou si vous avez des mauvaises
expositions trés évidentes par rapport au reste. Certaines expositions seront sans doute pires que
d'autres, mais elles ne seront peut-étre pas si mauvaises qu'il faille les exclure (ou comme moi dans
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ce cas, vous n‘aurez peut-étre pas le luxe d'avoir un grand ensemble de données pour commencer a
exclure des expositions !). Comme toutes les expositions de mon ensemble de données sont plus ou
moins égales les unes aux autres en termes de qualité visible, je n'en exclurai aucune, mais je
veillerai a ce que la qualité réduite soit prise en compte dans la pondération de chaqgue exposition.

N'hésitez pas a exclure des expositions a votre guise. Vous pouvez en fait étre assez automatisé a
ce sujet en saisissant une expression dans Approbation dans la fenétre de droite. Par exemple, si
vous souhaitez n'inclure que les expositions dont la FWHM est inférieure a 6, vous pouvez entrer ce
qui suit, puis cliquer sur le bouton en forme de triangle a droite de la case Approbation :

FWHM < 6

Notez ci-dessus que les expositions qui ne répondent pas aux criteres de la FWHM sont
automatiquement exclues. Nous pouvons étendre cette expression pour inclure également d'autres
propriétés. Par exemple, si je veux également que les valeurs d'excentricité supérieures a 0,7 soient
exclues (cette fois-ci, nous incluons 0,7 comme autorisé€), je peux modifier le contenu de la case
Approbation pour (et ensuite cliquer une nouvelle fois sur le bouton en forme de triangle a sa droite) :

FWHM < 6 && Eccentricity <= 0.7

Les expositions exclues l'ont été parce qu'elles ne répondent pas a un ou plusieurs criteres inscrits
dans l'expression dans la case "Approval'. Toutefois, comme je ne veux exclure aucune de mes
expositions, je supprime l'expression et laisse la case "Approval" vide. Je m'assure également de
cliquer sur le bouton du triangle a sa droite pour appliquer lI'absence d'expression (ainsi, toutes mes
expositions sont a nouveau incluses).

Une fois que vous avez exclu certaines expositions ou choisi de n'en exclure aucune, nous pouvons
passer a la pondération appropriée des expositions. Ces pondérations devraient idéalement prendre
en compte les trois propriétés importantes - FWHM, excentricité et SNRWeight. David Ault a
recommandé une expression particuliere a entrer dans la pondération dans his tutorial. Celle
présentée ici est similaire mais a été modifiée pour donner la priorité au SNRWeight plutét qu'au bruit
(car le SNRWeight prend également en compte le bruit). Entrez ce qui suit dans la case Pondération

de la fenétre de droite :

(15*(1-(FWHM-FWHMMin)/(FWHMMax-FWHMMin)) +
15*(1-(Eccentricity-EccentricityMin)/(EccentricityMax-EccentricityMin)) + 20*(SNRWeight-
SNRWeightMin)/(SNRWeightMax-SNRWeightMin))+50

Notez ci-dessus que la FWHM et I'excentricité sont des propriétés négatives - plus elles sont
importantes, plus I'exposition est mauvaise. C'est la raison de 1-FWHM et de 1-Eccentricity dans
I'expression ci-dessus. Par contre, le SNRWeight est une propriété positive - plus il est grand, plus
I'exposition est bonne - donc il est laissé intact. Dans les versions précédentes de Pixinsight, ou
SubframeSelector était un script, nous devions choisir manuellement les valeurs minimales et
maximales de FWHM, d'excentricité et de SNRWeight a entrer dans l'expression. Ces valeurs
devaient étre modifiées pour chaque ensemble de données, car chaque ensemble de données a des
expositions différentes. Heureusement, avec Pixinsight 1.8.6 et le nouveau processus
SubframeSelector, I'expression ci-dessus est universelle et n'a pas besoin d'étre modifiée pour des
ensembles de données particuliers car elle sélectionne automatiquement les valeurs minimales et
maximales.
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A coté de chaque propriété de I'expression se trouvent des valeurs multiplicatrices. Pour FWHM et
I'excentricité, ces valeurs sont de 15 et pour SNRWeight, de 20. Leur total est délibérément fixé a 50.
En gros, si vous voulez privilégier SNRWeight par rapport a FWHM et a I'excentricité, choisissez un
multiplicateur plus élevé que celui des deux autres. Vous pouvez meélanger et faire correspondre les
multiplicateurs (50 au total) a votre guise, en donnant la priorité a une propriété plutdt qu'a une autre,
comme bon vous semble. J'ai choisi de privilégier un peu plus le rapport signal-bruit parce que toutes
mes expositions sont plus ou moins les mémes, visuellement parlant, et je préfere donc que celle qui
a le rapport signal-bruit le plus élevé ait une pondération globale plus importante.

Enfin, parce que les valeurs sont normalisées et que les multiplicateurs s'additionnent a 50, I'échelle
globale de pondération se tournera vers une échelle qui se situe entre 0 et 50. 0 étant une exposition
horrible et 50 étant une exposition incroyable. Cependant, le danger ici est que, bien que 0 puisse
sembler étre une trés mauvaise exposition, cette exposition n'ajouterait pas beaucoup a l'image
globale empilée, alors qu'en réalité elle n'est peut-étre pas si mauvaise. C'est pourquoi nous ajoutons
50 a la toute fin de I'expression - pour porter I'échelle a 50 a 100, plutdt qu'a 0 a 50. Cela signifie que
méme si une exposition est considérée comme assez mauvaise (poids proche de 50), elle ajoutera
guand méme quelque chose a l'image empilée. Gardez a I'esprit que si une exposition est vraiment
mauvaise, vous pouvez simplement I'exclure (en inspectant les graphiques ou la liste manuellement,
Ou en saisissant une expression appropriée dans la case Approbation).

Une fois que vous avez saisi I'expression de pondération ci-dessus, cliquez sur le bouton en forme
de triangle a co6té de la case Pondération pour calculer et appliquer les pondérations a vos
expositions.

Remarquez maintenant que ma propriété Weight a été fixée a une valeur comprise entre 50 et 100,
comme prévu. Le graphique pour Weight montre comment les expositions se comparent les unes
aux autres dans le cadre de cette comparaison. Ce sont nos pondérations optimales pour I'empilage.
J'ai également configuré le tableau pour afficher mes expositions dans l'ordre croissant de la
nouvelle propriété Weight calculée. En bas, donc, se trouve ma meilleure exposition.

Il est maintenant intéressant d'ouvrir votre meilleure exposition dans PixInsight et de ['étirer
automatiquement pour la vérifier. Vérifiez qu'il n'y a pas d'artefacts tels que des traces de satellite ou
d'étoiles épatées provenant de nuages fins et élevés. Si I'exposition est jugée propre, nous pouvons
alors prendre note du nom de cette exposition particuliere car elle servira de référence pour aligner
toutes les autres expositions de la pile, ainsi que de référence pour LocalNormalization (toutes deux
expliquées plus loin). Si vous remarquez que votre meilleure exposition a des traces de satellites ou
des étoiles qui fleurissent dans des nuages fins et élevés, vous devez vérifier votre deuxieme
meilleure exposition (selon la valeur de pondération). Faites-le jusqu'a ce que vous trouviez une
exposition propre de valeur de pondération élevée a utiliser comme référence. Je ne saurais trop
insister sur I'importance pour votre exposition de référence d'avoir le poids le plus élevé possible tout
en étant propre (sans traces de satellite ni étoiles).

Nous passons maintenant a la fenétre de gauche, a I'onglet Output Files en bas, afin d'exporter nos
expositions avec les pondérations optimales qui y sont inscrites. Avant de continuer, sélectionnez
Output Subframes dans la liste Routine en haut de la fenétre de gauche.




Sous l'onglet Output Files, il suffit de définir un dossier dans lequel placer les expositions
approuveées. Vous pouvez créer un sous-dossier appelé Approved ou quelque chose de similaire, si
vous préférez. Le Postfix est ce qui sera ajouté au nom du fichier d'exposition approuvé. Vous
pouvez le supprimer si vous les placez dans un dossier différent et si vous n‘avez pas peur d'avoir
les mémes noms de fichiers que les expositions originales. Vous pouvez également appliquer un
préfixe de nom de fichier de la méme maniére. Cela dépend entierement de vous.

Une fois que vous avez terminé, nous devons définir un mot-clé Weight. Ce sera le mot-clé intégré
dans vos expositions approuvées qui aura les pondérations optimales que nous avons calculées.
C'est important car nous pourrons plus tard demander a Imagelntegration de I'utiliser pour le
processus d'empilage. J'ai entré SSWEIGHT dans le mien.

Une fois que vous avez terminé, il suffit de cliquer sur le bouton "Apply Global" en bas de la page et
votre dossier sera rempli avec les expositions approuvées, avec leur pondération optimale intégrée
sous le mot-clé défini. Vous pouvez ensuite fermer le processus SubframeSelector. Si vous fermez la
fenétre de gauche (simplement intitulée SubframeSelector), les trois fenétres se fermeront car il
s'agit de la fenétre principale du processus.

Ci-dessus, ma meilleure exposition ouverte dans PixInsight et auto-étirée, avec les en-tétes FITS a
c6té. En bas, on trouve le nouveau mot-clé SSWEIGHT, avec la pondération optimale calculée. Nous
pouvons maintenant passer a I'enregistrement et a l'intégration de ces images.

6. Alignement et empilement des brutes

Comme les brutes ont été calibrés et corrigés esthétiquement, elles sont maintenant considérées
comme des brutes propres. De plus, SubframeSelector a été utilisé pour optimiser leur pondération.
Mais avant de pouvoir les empiler, nous devons nous assurer qu'elles sont parfaitement alignées les
unes par rapport aux autres. Pour aligner les images les uns par rapport aux autres, nous utilisons le
processus StarAlignment. Tout d'abord, ajoutons nos images, en particulier celles qui ont été
calibrées, corrigées cosmeétiquement et dont la pondération a été optimisée (et débayérisées si vous
deviez le faire). Pour ce faire, cliquez sur Add Files et sélectionnez-les tous.

Nous devons définir I'une de ces images brutes comme image de référence afin que toutes les
autres soient alignées par rapport a elle. Dans la petite liste qui indique Viewat en haut de
StarAlignment, sélectionnez File , puis cliquez sur la fleche vers le bas a droite de celle-ci.
Sélectionnez l'une de vos images calibrées, corrigées cosmétiquement et optimisées en termes de
pondération (et débayérisées, le cas échéant). Il est généralement recommandé de choisir I'image
qui a la pondération optimisée la plus élevée (SSWEIGHT) car celle-ci servira de meilleure référence,
surtout si FWHM et I'excentricité ont été incluses dans le calcul de la pondération optimisée. Comme
indiqué dans la section précédente, assurez-vous que cette référence est exempte de traces de
satellite et d'étoiles avec défaut.

Sélectionnons maintenant un dossier de sortie pour nos cadres lumineux enregistrés. Comme
toujours, nous le faisons en cliquant sur le bouton a c6té de la zone de texte du répertoire de sortie et
en sélectionnant un dossier approprié. J'ai sélectionné mon dossier Lights_Cal CC_Reg, comme
mentionné précédemment dans le tutoriel.
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Enfin, comme nous allons appliquer l'algorithme Drizzle plus tard, nous devons activer la fonction
Generate drizzle data en haut de StarAlignment.

Il ne reste plus qu'a cliquer sur Apply global (le bouton circulaire). Votre dossier de sortie sera rempli
avec les images brutes enregistrées. Si Pixinsight a du mal a repérer les étoiles avec lesquelles
s'aligner, vous pouvez assouplir les parametres afin qu'il puisse les repérer plus facilement. Comme
les brutes sont maintenant corrigées et calibrées, elles sont essentiellement plus fiables pour
détecter les étoiles plus faibles. La premiere chose a faire pour aider a détecter plus d'étoiles a
aligner est d'augmenter le parametre de tolérance du RANSAC de sa valeur par défaut de 2,00 a
quelgue chose de plus élevé comme 6,00 ou le maximum de 8,00.

Les itérations du RANSAC directement en dessous peuvent également étre Iégérement augmentées,
pour atteindre 3000. En outre, vous pouvez essayer de diminuer le paramétre Log(sensitivity) sous
Stars Détection (comme c'est un parametre logarithmique, si vous le diminuez, la sensibilité
augmente).

Detection layers au sommet de Star Detection peuvent également étre [égerement augmentées a 6
ou 7 afin d'utiliser plus d'étoiles pour l'alignement. Veuillez cependant garder a l'esprit que les
parametres par défaut de StarAlignment font vraiment des merveilles et que vous ne devriez pas
avoir a les modifier. Si vous devez les modifier, il est possible que vos béatis lumineux ne contiennent
tout simplement pas assez d'étoiles en raison d'un temps d'exposition trop faible pour votre systeme
optique, ou gue les étoiles ne soient pas rondes ou relativement rondes. Cela indiqgue généralement
les points a améliorer lors de la prise de vue.

Une fois que vous avez enregistré avec succes toutes vos images brutes, elles rempliront votre
dossier de sortie. Vous trouverez également quelques fichiers supplémentaires, qui sont
essentiellement des fichiers de données Drizzle, un par image lumineuse.

Vos images brutes sont maintenant prétes a étre empilées pour produire un trés beau résultat. Pour
cela, nous reviendrons a Imagelntegration mais d'abord, utilisons la fonction LocalNormalization de
PixInsight (nouvelle a partir de la version 1.8.5). Cette fonction est un algorithme de rejet de pixels
plus robuste qui finit par produire des images empilées d'apparence plus nette, avec moins de bruit
en arriere-plan, un SNR plus fort sur les objets d'intérét et des transitions plus douces. Pour l'utiliser,
nous devons d'abord ouvrir le processus LocalNormalization.

Nous commencons par sélectionner notre image de référence, qui sera a nouveau la meilleure,
comme déterminé précédemment avec le parametre de pondération optimisé SSWEIGHT. Ceci est
particulierement bon si SNRWeight a été inclus dans le calcul de la pondération optimale. Comme
indiqué dans la section précédente, assurez-vous que cette référence est exempte de traces de
satellite et d'étoiles avec défaut. Dans le cas de mes données, la meilleure image était la derniere
image. Notez que selon Juan Conejero of the PixIinsight team, lalgorithme fonctionne
indépendamment des gradients et des variations du signal. Par conséquent, vous n'avez pas besoin
d'éliminer les gradients de votre image de référence avant de l'utiliser (par exemple en utilisant
DynamicBackgroundExtraction). Votre meilleure image apres calibration et correction cosmétique
sera parfaite.

Pour sélectionner I'image de référence, nous vérifions que la liste a coté de Image de référence a
File selected, nous cliquons sur la fleche vers le bas a c6té et sélectionnons le meilleur cadre pour
I'image de référence.
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Nous devons maintenant y ajouter toutes nos brutes pour qu'elles soient traitées. Pour ce faire, il
suffit de cliquer sur Add files et de sélectionner toutes vos armatures légeres.

Nous configurerons le répertoire Output pour qu'il soit le méme que celui ou se trouvent nos brutes
calibrées, corrigées cosmétiquement, optimisées en termes de pondération et alignées, de sorte que
les fichiers de données de normalisation locale y seront également stockés.

Les parametres par défaut fonctionnent généralement trés bien, de sorte que vous n'avez pas
vraiment besoin de toucher quoi que ce soit. Le paramétre qui dicte quelgue peu la qualité finale est
Scale parameter en haut. Il définit la taille de I'échelle de normalisation utilisée par l'algorithme. Les
valeurs recommandées se situent entre 64 et 256. Bien que la valeur par défaut de 128 fonctionne
tres bien dans la grande majorité des cas, je trouve que 256 fonctionne un peu mieux pour mes
données.

Maintenant que LocalNormalization est entierement configurée, il suffit de cliquer sur le bouton
"Apply Global' et Pixilnsight traite les données et produit des fichiers de données
LocalNormalization dans le dossier que nous avons sélectionné. Ce dossier contient maintenant les
brutes calibrés, esthétiquement corrects, optimisées en termes de pondération et alignées, ses
fichiers de données Drizzle et ses fichiers de données LocalNormalization.

Vos images brutes sont maintenant prétes a étre empilées pour produire un trés beau résultat. Pour
cela, nous retournons a Imagelntegration et nous cliquons sur Reset pour revenir aux parametres par
deéfaut.

Nous commencons par ajouter a Imagelintegration les images brutes calibrées, corrigées
cosmeétiquement, optimisées en termes de pondération et alignées (et débayérisées, le cas échéant)
en cliquant sur Add Files et en les sélectionnant.

Encore une fois, puisque nous allons appliquer I'algorithme de Drizzle plus tard, nous devons ajouter
nos fichiers de données Drizzle ici aussi. Pour ce faire, cliquez sur le bouton "Add Drizzle Files",
sélectionnez-les dans le méme dossier que vos cadres lumineux enregistrés et ajoutez-les.

Un symbole <d> apparaitra a coté de chaque image brutes listée, signifiant que les fichiers de
données de Drizzle ont été ajoutés avec succeés. Nous devons maintenant ajouter les fichiers de
données LocalNormalization de la méme maniére. Pour ce faire, cliquez sur Add L. Norm,
sélectionnez-les dans le méme dossier que vos images lumineuses et ajoutez-les.

Un symbole <n> apparaitra a coté de chaque brutes listée, signifiant que les fichiers de données de
normalisation locale ont été ajoutés avec succes. Maintenant, nous sélectionnons Average dans
Combination, Local normalization dans Normalization (notez que sans les fichiers de données de
Normalisation locale utilisés, nous sélectionnerions Additive ici) et le mot-clé FITS dans Poids. Le
mot-clé FITS est choisi parce que nous avons précédemment intégré des pondérations optimisées
avec le script SubframeSelector sous un mot-clé particulier, que j'ai choisi d'étre SSWEIGHT. Pour
cette raison, j'ai entré SSWEIGHT dans le mot-clé Weight. Si vous choisissez de ne pas utiliser de
telles pondérations optimisées, il vous suffit de sélectionner Noise evaluation dans Weight. Nous
maintenons également l'option Noise evaluation activée. Assurez-vous également que l'option
Generate drizzle data est activée - cela mettra a jour les fichiers de données de drizzle que nous
utiliserons dans la prochaine section.

Pour l'algorithme de rejet, nous suivons exactement les mémes directives que nous avons suivies
précédemment pour le biais maitre et I'obscurité maitre, qui sont :
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- Averaged Sigma Clipping pour < 10 images
- Winsorized Sigma Clipping pour 10 a 20 images
- Linear Fit Clipping > 20 images

Comme jai 8 images brutes, je sélectionne Averaged Sigma Clipping. Dans Normalization,
sélectionnez Local normalization. Laissez Clip low pixels et Clip high pixels activés et vous pouvez
désactiver Clip low range et Clip high range.

Nous pourrions tres bien avoir besoin de régler les parameétres Sigma low et Sigma high, surtout Si
nous remarquons qu'apres avoir empilé les images lumineuses, nous voyons encore quelques traits
de rayons cosmiques ou des trainées de satellites sur notre image empilée. Les parametres par
défaut sont un bon point de départ, alors cliquez sur Apply global et votre image empilée apparaitra
automatiguement comme une nouvelle image dans PixInsight, avec l'identifiant d'intégration.

Un étirement automatique permet de révéler les détails cachés dans votre image empilée sans la
modifier. Examinez-la de pres - zoomez, faites un panoramique minutieux, etc. Vérifiez s'il y a des
traces de rayons cosmiques ou de satellites dans l'image. S'il en reste, ce qui est particulierement
fréquent avec un faible nombre d'images brutes utilisées dans le processus d'empilement, vous
devrez étre plus agressif dans vos parametres Sigma low et Sigma high que par défaut. Pour les
modifier, il suffit de fermer votre image empilée et vos cartes de rejet sans les sauvegarder et de
retourner a Imagelntegration. Ici, diminuez tres légerement les parameétres Sigma low et Sigma high.
Si les parametres par défaut de 4.00 et 2.00 ne fonctionnent pas, essayez 3.00 et 2.00. S'ils
n'‘éliminent pas non plus tous les impacts des rayons cosmiques et les trainées des satellites avec
succes, essayez 2,75 et 1,75. Le processus est recursif : vous vérifiez votre image empilée apres
une petite mise au point et vous y revenez si nécessaire. N'oubliez pas que plus vous étes agressif
(valeurs plus faibles utilisées), plus le signal que vous supprimez en vaut la peine. Essayez de garder
ces chiffres aussi proches que possible des valeurs par défaut tout en supprimant ce que vous devez
supprimer. Comme toujours, plus vous devez travailler avec des cadres Iégers, mieux c'est, mais il y
a des limites personnelles a cela.

Si vous avez des problemes avec le processus d'empilement en supprimant d'épaisses traces de
satellite ou davion (qu'elles soient completes ou gu'il en reste des traces), Pixlnsight propose
(nouveau a partir de la version 1.8.5) un algorithme de rejet des pixels a grande échelle intégré dans
le processus Imageintegration a cette fin. Il y a tres peu de parametres a modifier pour cela, alors
n'hésitez pas a activer les deux et a jouer avec ses deux parametres pour obtenir des résultats
optimaux. Cependant, on s'attend a ce que seul le rejet des structures a grande échelle suffise pour
cibler les trainées épaisses des satellites et des avions, car celles-ci ont tendance a étre trés
lumineuses. D'autres commentaires a ce sujet seront faits dans une prochaine mise a jour lorsque
I'équipe de PixInsight documentera correctement cette fonctionnalité.

Une fois que vous étes satisfait de votre image empilée grace a l'utilisation d'Imagelntegration, ne
vous embétez pas a sauvegarder l'image empilée elle-méme ou les cartes de rejet - fermez
simplement les trois et fermez ensuite Imagelntegration. Cela peut sembler contre-productif, mais
nous allons appliquer l'algorithme de Drizzle aux fichiers de données Drizzle. Ces fichiers de
données sont mis a jour a chaque fois que vous exécutez Imagelntegration. Ainsi, une fois que le
résultat final d'Imagelntegration est satisfaisant, nous procédons au traitement des fichiers de
données Drizzle eux-mémes.




Comme auparavant, si vous travaillez avec une image en couleur parce que vous avez utilisé une
caméra couleur a une seule prise, vous avez terminé. En revanche, si vous travaillez avec des
images monochromes, vous aurez tres probablement des images d'autres filtres a prétraiter. Il vous
suffit de répéter cette section pour les images de vos autres filtres.




7. Appliquer le drizzle a la brute empilée.

Les avantages de l'application de l'algorithme de Drizzle ont été bien documentés. Pour appliquer
I'algorithme de Drizzle, nous devons utiliser le processus Drizzlelntegrationprocess.

Les parametres par défaut fonctionnent ici extrémement bien dans tous les cas ou je les ai appliqués.
Ce que Drizzle fait essentiellement, c'est mettre a I'échelle une image empilée pour permettre a
l'algorithme d'interpoler entre les pixels afin de produire des transitions plus douces. C'est
particulierement important lorsque les images lumineuses empilées ont un décalage de rotation entre
elles, car les pixels sont strictement carrés. Le résultat final produit des transitions plus douces et
I'image empilée souffre donc moins de la pixellisation. Pour tous ceux qui lisent ceci et qui sont des

joueurs sur PC ou des amateurs dinfographie, cela s'apparente a [lanti-aliasing par
suréchantillonnage.

Pour utiliser Drizzlelntegration, il suffit d'y ajouter nos fichiers de données Drizzle. Pour cela, nous
cliquons sur Add Files, sélectionnons tous nos fichiers de données Drizzle et les ajoutons.

Comme nous l'avons deéja dit, les paramétres par défaut fonctionnent extrémement bien. Un
parameétre important auquel il faut préter attention est le parameétre Scale. L'échelle détermine la taille
du résultat final. La valeur par défaut de 2 signifie qu'une image de 3000 x 2000 pixels sera agrandie
a 6000 x 4000 pixels et, grace au processus d'interpolation, apparaitra plus lisse (et non floue !). En
général, 2 pour I'échelle suffit et fonctionne bien avec les résolutions actuelles des capteurs CCD.
Gardez également a I'esprit que les grandes mosaiques peuvent devenir lentes a travailler si vous
avez appliqué l'algorithme Drizzle a tous les panneaux (comme je le fais toujours). Tant que votre
ordinateur dispose de suffisamment de mémoire vive, il pourra cependant travailler avec elles, méme
si les processus prennent du temps a s'exécuter.

Avant de continuer, nous utiliserons les fichiers LocalNormalization que nous avons Ccréés
précédemment et avec lesquels nous avons travaillé jusqu'a présent. Il n'est pas nécessaire de
cliuer sur le parametre "Enable local normalization", car il sera automatiquement activé lorsque
nous ajouterons les fichiers de données de LocalNormalization. Pour ce faire, il suffit de cliquer sur le
bouton Add L. Norm. Files, de les sélectionner tous et de les ajouter.

Comme précédemment, un symbole <n> apparaitra a cété de chaque fichier de données Drizzle
listé, signifiant que les fichiers de données de normalisation locale ont été ajoutés avec succes. I
suffit de cliquer sur le bouton "Apply Global" et I'image empilée de Drizzle apparaitra comme une
nouvelle image dans PixInsight, avec l'identifiant drizzle_integration.

Enfin, notre résultat final ! Cette image est le résultat d'images brutes qui ont été calibrées avec un
master superbias, un master dark et un master flat, corrigées cosmétiquement, empilées puis
Drizzled et utilisant également la LocalNormalization. Votre propre image peut également avoir été
débayérisée entre les deux ! Vous pouvez enregistrer cette image car il s'agit de votre image
officiellement prétraitée.

Ci-dessous, nous voyons une comparaison d'une petite zone de la nébuleuse du Croissant elle-
méme (coin inférieur droit), agrandie. La comparaison porte sur le résultat final de l'intégration
d'images (pas de drizzle et pas de normalisation locale), le résultat final de l'intégration de drizzle
mais sans utiliser la normalisation locale et enfin, le résultat final que nous avons travaillé ici, en
utilisant a la fois l'intégration de drizzle et la normalisation locale. Nous pouvons clairement voir une
différence lorsque Drizzle est implémenté, ce?r I'image]est beaucoup plus lisse avec la pixellisation
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supprimée presque entierement (particulierement visible sur les petites étoiles). Avec la
normalisation locale, nous pouvons voir une certaine amélioration du rapport signal/bruit et donc un
contraste plus élevé entre le signal et le fond. La différence apparente d'échelle de l'image entre la
non-utilisation de Drizzle et l'utilisation de Drizzle est purement due a la nature de l'algorithme de
Drizzle, qui augmente la résolution de I'image pour l'interpolation.

Comme précédemment, cette section doit étre répétée pour les images de vos autres filtres, a moins
gue vous ne travailliez avec une image en couleur, auquel cas vous avez terminé a ce stade.

8. Utilisation du script de prétraitement par lots

Raccourcis, raccourcis - qui les veut ? Cette section n'est pas une énumération exhaustive de tout ce
que vous devez faire avec le script BatchPreprocessing, car cette section a été stratégiquement
placée ici de sorte qu'a I'heure actuelle, vous étes un expert du prétraitement manuel. Le script
BatchPreprocessing est disponible dans le menu Script -> Batch Processing -> BatchPreprocessing.

Comme il s'agit d'un script, le fait de le fermer supprime tous vos parametres, d'ou la raison pour
laquelle le script confirme si vous voulez vraiment sortir. Avant d'investir du temps et des efforts pour
tout régler, nous aurons besoin de quelque chose en dehors du script et vous ne pourrez pas y
accéder tant que le script sera ouvert. En principe, le script peut appliquer une correction cosmétique
a vos images, mais il a besoin d'une icbne de processus dans les espaces de travail disponibles pour
la sélection dans le script, avec les paramétres déja définis.

Il faut donc ouvrir le processus de CosmeticCorrection. Nous cliquons sur Reset pour nous assurer
gu'il est aux parametres par défaut.

Comme nous l'avons fait dans la section 4 ci-dessus, nous avons mis en place le processus de
CosmeticCorrection comme nous le jugeons approprié pour nos images. Mais il y a un probléme que
Vous pourriez rencontrer. Si vous utilisez des darks, en théorie le script BatchPreprocessing créera le
master dark pour vous, mais vous en avez besoin maintenant, avant que le script
BatchPreprocessing ne soit utilisé - pour CosmeticCorrection ! Il vous reste donc un choix a faire.
Soit vous oubliez le master dark et utilisez un seul dark pour CosmeticCorrection (ce qui n'est pas
idéal), soit vous faites le master dark manuellement, ce qui nécessite que vous fassiez le master
superbias manuellement aussi, soit le choix final - n'utilisez pas du tout de dark dans
CosmeticCorrection et choisissez simplement Use Auto detect. Les premiere et troisieme options
peuvent ne pas sembler idéales et la deuxieme option annule partiellement I'utilisation du script pour
commencer.

Le choix vous appartient. Si vous choisissez de faire un master dark et donc de le master superbias
manuellement, vous pourrez alors dire au script plus tard qu'ils sont déja maitres et qu'il n'est pas
nécessaire de les modifier de quelque facon que ce soit. Configurez CosmeticCorrection comme
indiqué dans la section 4 ci-dessus, mais c'est a vous de faire ce choix. Vous n'avez pas besoin de
définir un répertoire de sortie pour CosmeticCorrection puisque le script effectuera les sorties
automatiquement. Une fois que vous avez terminé de jouer avec CosmeticCorrection, créez une
icone de processus New Instance sur votre espace de travail.




Vous pouvez ensuite fermer CosmeticCorrection car notre icoOne de processus avec tous ses
parametres sauvegardés a été préparée pour le script a utiliser. Vous pouvez placer cette icbne de
processus sur le coté pour la faire disparaitre.

Nous pouvons maintenant ouvrir le script BatchPreprocessing. 1l y a de nombreux boutons en bas,
mais en théorie, vous pouvez cliquer sur Add Files (bouton en bas a gauche) et ajouter tout ce que
vous voulez sans vous soucier de quoi que ce soit - le script est censé savoir ce qu'est un bias, ce
qgu'est un dark, etc. Cependant, je ne lui fais pas confiance et je préfere ajouter chague chose
manuellement. Il suffit de cliquer sur "Add Bias" et de sélectionner vos propres bias.

Au milieu du script, nous pouvons maintenant modifier les parameétres d'intégration des bias comme
nous l'avons fait manuellement auparavant. Comme j'utilise 20 trames de biais pour I'empilage, je
choisis le Winsorized Sigma Clipping.

Qu'en est-il du master superbias ? Qu'y a-t-il de si génial dans bias maitre que le scénario va générer
? Rien, en fait ! Le scénario n'utilise pas du tout le processus des superbias, donc nous perdons ses
avantages. Vous avez peut-étre déja créé le master superbias vous-méme, pour calibrer le master
dark que vous avez également créé vous-méme afin d'utiliser CosmeticCalibration de maniére
adéquate. Si vous l'avez fait, c'est tres bien, puisque nous pouvons utiliser vos maitres déja faits. Si
vous ne l'avez pas fait, envisagez de le faire, car je préfére utiliser un master superbias que j'ai créé
moi-méme plutbt que le master bias que le scénario me fera. C'est moins important pour le master
dark et le master flat, car ils suivront le méme chemin que votre master superbias si vous fournissez
au script un master superbias déja fait, bien que, comme mentionné précédemment, vous pouvez
aussi avoir un master dark déja utilisé avec CosmeticCorrection.

Si vous avez effectivement un master superbias a fournir au script, au lieu de sélectionner vos bias
individuels lorsque vous cliquez sur Add bias, sélectionnez simplement votre master superbias.
Ensuite, activez Use master bias a droite du script. Cela indiquera au script que votre bias est en
effet déja maitre et qu'il n'a pas besoin d'étre modifié.

Le bias ajouté gagne une petite icbne étoile pour signifier qu'il est traité comme un maitre. Cela
désactive également les parametres d'intégration de I'image car ils ne sont pas du tout nécessaires.
Quel que soit votre choix - des images de bias individuelles ou un super bias maitre - c'est vous qui
décidez. Personnellement, je préfére utiliser un master superbias pré-fabriqué.

Nous passons maintenant aux darks. Cliquez sur Add Darks et sélectionnez les darks que vous
souhaitez ajouter.

Comme précédemment avec les bias, je sélectionne l'algorithme de rejet approprié, qui dans mon
cas avec 20 trames sombres est le Winsorized Sigma Clipping.

Encore une fois, si vous avez déja un master dark que vous souhaitez utiliser a la place des darks
individuels, choisissez simplement d'ajouter ce master dark a la place de vos darks individuels. Une
fois cela fait, activez l'option Use master dark sur le c6té droit du script. Veuillez noter que, le script
soustraira le master bias du master dark. Cela signifie que lorsque vous faites votre master dark
manuellement, vous devez vous assurer que vous ne soustrayez pas le master biais de vos darks
individuelles avant de les intégrer dans un master dark. Il suffit d'intégrer tous vos dark bruts dans
un master dark et c'est tout.




Une fois de plus, le dark ajouté gagne une étoile et les parametres d'intégration sont désactivés
puisqu'ils ne sont pas du tout nécessaires. Si vous ne travaillez pas du tout avec les darks (comme
moi en ce moment), ne vous embétez pas du tout avec cette section - le script vous avertira
gu'aucun dark n'a été sélectionné, mais il peut continuer a travailler quand méme.

Nous passons maintenant aux images flats. Nous cliquons sur Add Flats et sélectionnons nos cadres
plats.

Si, lorsque vous ajoutez les flats, vous remarquez qu'il n'y a pas d'étiquette de filtre sous I'étiquette
Binning de la liste, vous devrez peut-étre ajouter les flats manuellement. Si vous ne le faites pas,
lorsque vous ajoutez les brutes, si les étiquettes de filtre ne correspondent pas, le script n‘appliquera
pas les flats aux brutes. Vous en serez averti lorsque vous cliquerez sur Execute ou sur Diagnostic.
Si vous devez ajouter les flats manuellement parce qu'il n'y a pas d'étiquette de filtre sous I'étiquette
Binning, cliquez sur Clear en haut (a c6té de la liste) et ensuite sur Add Custom en bas.

Ici, cliguez simplement sur Add files, sélectionnez vos flats individuels, sélectionnez Flat field sous
Image Type, entrez le nom du filtre dans Filter Name, tel que HA, réglez Binning sur ce que vous
avez utilisé (1 pour mes images) et cliqguez sur OK (il n'est pas nécessaire d'entrer un temps
d'exposition).

Conformément a ce que nous avons fait dans la section 3, nous avons défini Percentile Clipping
comme algorithme de rejet et nous avons ajusté les paramétres de Percentile low et Percentile high
si nécessaire (laissez les valeurs par défaut si vos flats sont réalisés avec un caisson lumineux, un
générateur de flat ou un panneau électroluminescent ou changez les deux a 0,010 si vos images
flats sont réalisées en utilisant le ciel a I'aube).

Vous savez sans doute maintenant ce qui va se passer - et si nous voulons utiliser un master flat
préfabriqué ? Il suffit d'ajouter ce master flat a la place des différents flats, puis d'activer I'option Use
master flat a droite du script.

Si vous vous rendez compte une fois de plus que l'étiquette du filtre n'est pas apparue sous
I'étiquette Binning, cliquez a nouveau sur Clear, cliquez sur Add Custom, cliquez sur Add Files et
sélectionnez votre master flat, sélectionnez Flat field dans Image Type, entrez le nom du filtre dans
Filter Name, tel que HA, entrez votre mode de binning dans Binning et cliquez sur OK (a nouveau,
pas besoin d'entrer un temps d'exposition). Une fois que le master flat est dans la liste, assurez-vous
d'avoir activer Use master flat a droite du script.

Enfin, nous passons maintenant aux brutes. Nous cliquons sur Add Lights et ajoutons celles-ci.

La encore, faites attention a I'étiquette du nom du filtre sous le label Binning. Si elle ne correspond
pas a celle de vos flats, elle ne sera pas appliquée. Dans ce cas, cliquez sur Clear et ensuite sur Add
Custom. Cliquez sur Add Files et sélectionnez vos brutes Sélectionnez Light frame dans Type
Image , entrez le nom correct du filtre dans Filter name, tel que HA (assurez-vous qu'il correspond au
nom du filtre de vos cadres plats), définissez le mode Binning que vous avez utilisé et entrez le
temps d'exposition correct en secondes. Cliquez sur OK une fois que vous avez terminé.

Maintenant que nos brutes sont correctement répertoriées, nous activons l'option "Apply for
CosmeticCorrection", puis nous sélectionnons notre icone de processus dans la liste.




Cela permettra au script de corriger cosmétiquement nos images en fonction de nos parametres
prédéfinis (dont nous savons qu'ils fonctionnent bien !). Il est important a ce stade d'activer les
images CFA a droite du script si vous travaillez avec des images en couleur capturées avec un
appareil photo couleur en une seule prise. En activant cette option, vous activerez la section
DeBayer sous Lights. Sélectionnez simplement le motif Bayer/mosaic correct dans la liste (une fois
encore, vérifiez en ligne le motif de la matrice Bayer de votre appareil photo et gardez a l'esprit que
RGGB fonctionne pour les reflex Canon EOS avec lesquels j'ai travaille).

Si vous travaillez avec des images monochromes, n'activez pas les images CFA - laissez-les
désactivées ! Pour l'alignement des images, laissez l'option Générer des données de drizzle activée
afin que nous puissions appliquer l'algorithme de drizzle plus tard. Si vous cliquez sur le bouton
Registrationparameters, vous verrez la section correspondante.

Ici, les parametres par défaut fonctionnent tres bien. Si vous rencontrez des difficultés lors de
l'alignement, il se peut que vos brutes ne disposent pas d'un champ d'étoiles adéquat pour
I'alignement, ce qui peut étre d0 & des temps d'exposition trop courts, a des étoiles mal formées, etc.
Si c'est le cas, vous pouvez renoncer a l'alignement des images par le biais du script. Cliquez sur la
croix rouge dans Image Registration pour revenir au menu principal des brutes et si vous souhaitez
effectivement renoncer a l'alignement par le biais du script, activez Calibration Only tout en haut.

Je vous recommande plutdt de désactiver l'option "Apply on Image Integration" et de ne pas intégrer
du tout les brutes dans le script. Ceci est aggravée par le fait que le script lui-méme le recommande,
puisqu'il ne peut pas détecter s'il s'est débarrassé ou non des traits de rayons cosmiques et des
traces de satellite dans votre image empilée. Cliquer sur le bouton Integration parameters vous
permet de personnaliser les parameétres requis tels que Sigma low et Sigma high (voir section 6),
mais cela nécessiterait d'exécuter le script encore et encore. Il serait plus rapide si vous renonciez
simplement a l'intégration par le biais du script et que vous le fassiez manuellement une fois que le
script a fait son travail.

Maintenant que nous avons configuré le script comme il se doit, nous devons sélectionner l'une de
nos brutes pour servir de référence pour le reste a aligner par rapport a elle. Pour ce faire, choisissez
une image particulierement bonne et double-cliquez simplement sur celle-ci dans la liste & gauche du
script.

Il ne nous reste plus qu'a définir un dossier de sortie. Il suffit de cliquer sur le bouton situé a cété de
la zone de texte du répertoire de sortie et de sélectionner un dossier vide. J'en ai créé un appelé
Script Output.

Veuillez noter qu'a partir de la version 1.8.5 de Pixinsight, I'option Output file suffix n'est plus
présente et le script produira donc des images au format XISF par défaut de PixInsight. Ceci n'est
pas un probléme, donc ne vous inquiétez pas. Nous pouvons cliquer sur Diagnostics en bas pour
vérifier si tout est OK avant de continuer.

Le script signale que tout est OK dans le sens ou nous avons des bias, des darks et flats préts et que
les brutes sont également entrées et tout est configuré correctement. Si vous n'utilisez pas du tout de
darks(comme je le fais), vous recevrez un avertissement indiquant qu'aucun dark n'a été saisi. C'est
tres bien et vous n'‘avez pas besoin de préter attention aux avertissements si vous ne le souhaitez
pas. Vous pouvez étre averti qu'aucun flat n'a été sélectionné pour s'appliquer. Cela se produit
lorsque les étiquettes des noms de filtres ne correspondent pas, alors assurez-vous d'avoir bien pris
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en compte ce probleme si vous recevez cet avertissement ! Une fois satisfait, cliquez sur Excute pour
exécuter le script et le laisser faire son travalil.

Dans le dossier de sortie que vous avez défini, vous obtiendrez un certain nombre de dossiers une
fois le traitement du script terminé.

Si vous n'avez pas utilisé de masters prédéfinis pour les trois ensembles dimages de calibrage
(biais, dark et flat) et/ou si vous avez laissé l'intégration d'images activée pour vos brutes, vous aurez
un troisieme dossier appelé masters ou seront stockées toutes vos images empilées (selon le script).
Depuis que j'ai donné au script des master de calibration et que jai choisi de ne pas intégrer mes
brutes, le dossier n'apparait plus. C'est tres bien. Le dossier enregistré est celui auquel il faut faire
attention, puisqu'il contient vos images lumineuses aprés correction cosmétique, calibrage,
Debayering (le cas échéant) et enregistrement.

Les images elles-mémes sont contenues dans un sous-dossier portant le méme nom que le nom de
votre filtre. Vous trouverez également ici les fichiers de données de drizzle depuis que nous avons
activé la fonction Generate drizzle data . Pour procéder a notre prétraitement, nous devons
maintenant passer en mode manuel et utiliser le processus Imageintegration pour empiler les images
brutes produites par le script. La procédure est exactement la méme que celle décrite au point 6 pour
I'intégration des images lumineuses.

Et une fois que vous avez fait le processus Imagelntegration suffisamment pour vous assurer
gu'aucune trace de rayons cosmiques ou de satellite ne subsiste dans votre image empilée, nous
passons au processus Drizzlelntegration exactement comme indiqué a la section 7.

Cela nous donne le méme résultat final que celui que nous avons obtenu en mode entierement
manuel dans les sections précédentes.

La question est maintenant de savoir si vous voulez utiliser le script BatchPreprocessing ou si vous
voulez tout faire manuellement. C'est a vous de décider. Il est peut-étre plus rapide d'utiliser le script
lorsque vous avez beaucoup de données a prétraiter, mais je préfére le contréle de la méthode
manuelle de prétraitement. En outre, comme vous l'avez remarqué, il y a plusieurs choses que vous
devriez faire manuellement de toute fagcon. Pour un résultat idéal, le script BatchPreprocessing ne
donnera peut-étre pas le résultat final beaucoup plus rapidement que si vous faites les choses
manuellement, surtout une fois que vous aurez mémorisé tous les parameétres ou que vous aurez
configuré des icbnes de processus pour tout faire sur la simple sélection des images.

Avant de clore cette section sur le script, il convient de mentionner que vous pouvez profiter des
etiquettes de nom de filtre du script pour lui permettre de faire plusieurs images a la fois (ce qui est
idéal pour ceux qui utilisent des caméras CCD monochromes). Il vous suffit d'ajouter toutes vos
images flats (ou les master-flats préfabriqués), en vous assurant que chague ensemble a le bon nom
de filtre attribué (comme indiqué ci-dessus). Ensuite, faites de méme avec vos images brutes, en
VOous assurant que vous les ajoutez avec les étiquettes de noms de filtres correspondantes (de sorte
gue chaque ensemble d'images lumineuses que vous ajoutez ait la méme étiquette de nom de filtre
gue les images flats ou les master flats qui doivent les accompagner). Lorsque vous exécutez le
script, celui-ci applique alors le bias maitre (ou super bias maitre) et le dark maitre a toutes vos
images, mais n'applique le flat maitre correct qu'aux images brutes auxquelles il appartient. La
guestion est de savoir si les icbnes de votre processus de correction cosmétique s'appliquent aussi
bien a toutes les images brutes que vous placez dans le script, mais cela peut étre testé (ou accepté
comme une perte de contrdle qui ne vous dérange pas, au profit d'un gain de temps).
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9. Traitement de donnees provenant de différentes nuits

Inévitablement, quelqu'un finira par se poser la question suivante : que dois-je faire si je dispose d'un
ensemble de brutesd'une nuit et de leurs flats correspondants si je dois les combiner avec un
ensemble d'une autre nuit ? La réponse a cette question est plus simple gu'il n'y parait. Examinons
les problemes potentiels.

Les flats peuvent souvent changer si les motifs de poussiere changent en les déplacant, en les
supprimant ou en les ajoutant. Vous ne voulez certainement pas utiliser un ensemble de flats qui ne
correspond pas brutes, car vous pourriez éventuellement laisser des taches claires ou foncées en
forme de beignet dans vos brutes aprés le calibrage. Le bias et les dark ne posent pas trop de
problémes, principalement parce qu'ils sont tres, tres faibles et que le biais du capteur et le signal de
courant sombre d'une caméra peuvent ne pas changer de maniere trés appréciable avec le temps.
Cependant, supposons que vous ayez capturé des images brutes d'un objet en 2014 avec un bias
correspondant, des darks et flats, puis que vous ayez répété cette opération en 2015. Vous avez
maintenant deux ensembles de données pour le méme objet. La question est de savoir comment
combiner le tout pour que vos données de 2015 viennent renforcer celles de 2014 afin de produire un
résultat final encore meilleur.

La meilleure fagcon de procéder est d'obtenir votre premier ensemble de données, disons a partir de
2014 et d'appliquer les étapes initiales suivantes du flux de prétraitement de Pixinsight détaillées
dans la section 1 :

1. Empiler les cadres de bias pour produire un biais maitre. Transformez cela en un super bias
maitre pratiguement sans bruit.

2. Calibrez les darks avec le superbias maitre. Empilez ces darks pour produire une master dark.

3. Calibrez les images flats avec le super bias et le master dark. Empilez ces flats pour obtenir
un master flat.

4. Calibrez les brutes avec le superbias, le dark maitre et le flat maitre.
5. Appliquer une correction cosmétique aux brutes calibrés pour les empiler.

6. Débayériser les images brutes s'il s'agit d'images en couleur comme celles capturées a l'aide
d'un appareil photo CCD ou DSLR couleur a une seule prise.

7. Sélectionner les meilleures images brutes et optimiser leur pondération.

Cela vous laissera des images brutes non alignées mais trés propres pour votre premier ensemble
de données. Trés propres, dans le sens ou elles ont été corrigées cosmétiquement et entierement
calibrées avec leurs images de calibrage correspondantes. Une fois que vous avez fait cela pour le
premier ensemble de données, faites la méme chose pour le second ensemble de données, par
exemple a partir de 2015. Cela vous donnera a nouveau un ensemble de brutes trés propres pour
votre deuxiéme ensemble de données.

Maintenant que vous avez deux jeux d'images brutes qui ont été corrigées et calibrées, il ne vous
reste plus qu'a effectuer le reste des étapes de prétraitement de PixInsight de la section 1 :

1. Aligner les brutes.




2. Empilez les brutes.
3. Appliguer I'algorithme de Drizzle pour obtenir un résultat final.

Vous obtiendrez ainsi une belle image combinée et empilée comprenant tout ce qui se trouve dans
vos premier et deuxieme ensembles de données. Si vous avez plus de deux ensembles de données,
le méme flux de travail s'applique.

Il n'est pas recommandé de produire une image empilée pour le premier ensemble de données, puis
une image empilée pour le second ensemble de données, puis de les ajouter (ou plutét, d'empiler
ces deux images empilées ensemble). Cela reviendrait a ignorer la plupart des avantages d'avoir
autant d'expositions a empiler au départ.

Compte tenu de ce flux de travail, vous pourriez simplement conserver une sauvegarde de vos
images lumineuses corrigées et calibrées chaque nuit. Rassemblez autant d'images brutes propres
gue possible au cours de plusieurs nuits, puis, si vous souhaitez retravailler le résultat final, empilez
le tout.




lll.  Préparation des images monochromes pour Ila
combinaison des couleurs et le post-traitement

Commencer avec l'imagerie monochrome peut étre un défi. Si vous construisez une image couleur,
cela implique de capturer des images a travers un certain nombre de filtres, comme le LRGB ou un
certain nombre de filtres a bande étroite (un minimum de deux est nécessaire pour construire une
image couleur). Quoi qu'il en soit, une fois que vous avez prétraité chaque image, vous obtenez un
ensemble d'images monochromes calibrées et empilées qui sont censées s'assembler pour former
une image couleur.

Ces images monochromes empilées doivent subir un certain nombre de traitements avant de pouvoir
étre combinées pour former une image couleur. En effet, ces images ne seront probablement pas
correctement alignées les unes par rapport aux autres au départ. Cela peut étre di a un tres léger
désalignement introduit entre les images par différents filtres au cours d'une nuit ou d'un certain
nombre de nuits, ou par l'utilisation de la technique de dithering. Ce tutoriel décrit ce qu'il faut faire
avant de pouvoir travailler avec les images pour construire une image en couleur. Il vous fera passer
d'images monochromes calibrées et empilées a un ensemble d'images prétes pour le post-
traitement.

Pré-supposé pour ce tutoriel/

e Connaissance du fonctionnement de PixInsight, en rapport avec le traitement des images et
des processus (Lire ce qui suit, sections 3 et 4).

e Vos images monochromes ont déja été entierement prétraitées (Lire ceci).

1. Aligner des images avec StarAlignment

La toute premiere étape pour préparer vos images monochromes calibrées et empilées a la
combinaison des couleurs consiste a les aligner les unes par rapport aux autres. Que ces images
soient LRGB ou a bande étroite. Si ce n'est pas le cas, la combinaison des couleurs peut donner des
résultats non désirables.

Vous remarquerez ci-dessus que les images Rouge, Verte et Bleue semblent tomber sur des
endroits différents. Cela est di a un certain nombre de facteurs, notamment I'erreur relative de
résolution astrométrique d'une nuit a l'autre, la dérive au cours d'une nuit et, bien sdr, I'utilisation
délibérée du dithering. Il est impossible de travailler avec ces images monochromes telles qu'elles
sont - il faudrait qu'elles restent monochromes, et alors a quoi bon ? Pour remédier a ce
désalignement, nous utiliserons le processus StarAlignment dans PixInsight.

Il n'est pas nécessaire qu'une image soit ouverte dans PixInsight pour utiliser StarAlignment. Pour
l'instant, seul le processus est ouvert.




Avant tout, nous devons décider laquelle de nos images monochromes calibrées et empilées servira
de référence. Les autres images seront donc alignée par rapport a celle-ci. D'une maniére générale,
I'image de référence doit étre une image avec un beau champ d'étoiles (plus les étoiles sont rondes,
mieux c'est, bien sdr). J'utilise généralement la luminance pour l'image de référence. Si vous avez
affaire a des images a bande étroite, choisissez celles qui ont un beau champ d'étoiles. Gardez a
I'esprit que vous pouvez aligner vos images sur n'importe quelle image a condition que suffisamment
d'étoiles soient détectées pour l'alignement. Gardez également a I'esprit que les images alignées
auront la méme résolution que l'image de référence. Cela signifie que si vous placez vos images
Rouge, Verte et Bleue en binning 2x2 mais que vous laissez votre Luminance en binning 1x1, en
utilisant la Luminance comme référence dans StarAlignment, vos images Rouge, Verte et Bleue
auront la méme résolution (elles sont mises a I'échelle, c'est-a-dire qu'elles ont la méme taille que si
elles avaient été prises a 1x1).

Une fois que vous avez décidé quelle image servira de référence, nous passons au processus
StarAlignment et sélectionnons File dans la petite liste déroulante a c6té de la zone de texte pour
Reference Image. Ensuite, nous cliquons sur la petite icbne en forme de fleche a coté de celle-ci,
nous trouvons l'image de référence de notre choix et nous la sélectionnons.

Register/Match Images doit déja étre sélectionnées dans Working mode car c'est le mode par défaut
et c'est en effet le mode correct pour aligner les images ensemble. Nous devons maintenant ajouter
toutes les images qui doivent étre alignées avec notre image de référence. Pour ce faire, cliquez sur
le bouton Add Files au milieu a droite de StarAlignment, sélectionnez toutes vos images et ajoutez-
les.

Nous définissons maintenant un dossier de sortie pour les images alignées. Pour ce faire, cliquez sur
le petit bouton situé a cété de la zone de texte du répertoire de sortie, puis sélectionnez un dossier.
Vous pouvez sélectionner un dossier différent de celui ou vos images sont actuellement stockées, ou
garder le Postfix réglé sur quelque chose, comme le _r par défaut. Cela ajoutera _r a la fin du nom
de fichier de chaque image enregistrée. Si vous ne souhaitez pas que les images enregistrées voient
leur nom de fichier modifi€, il vous suffit de supprimer le contenu de Postfix.

Avant de poursuivre, il est recommandé de modifier quelques paramétres de StarAlignment par
rapport a leurs valeurs par défaut. Pour les images standard, j'ai remarqué que ce n'était pas
nécessaire, mais pour les mosaiques, en particulier les grandes (4 panneaux ou plus), j'ai remarqué
que les étoiles aux coins des mosaiques ne s'alignaient pas aussi bien que les étoiles au centre des
mosaiques. Les coins ressemblaient donc a l'image en couleur mal alignée présentée en haut de ce
tutoriel. Pour éviter ce probléme, sélectionnez 2-D Surface Splines dans Registration model en haut,
activez Distortion correction, réglez Distortion iterations sur 100 (pour une bonne mesure, bien que
généralement le défaut de 20 fonctionne bien) et sélectionnez Bicubic B-Spline dans Pixel
interpolation sous la section Interpolation en bas de StarAlignment.

Comme indiqué précédemment, vous devriez faire cela lorsque vous travaillez avec des images qui
sont essentiellement des mosaiques, bien que j'utilise généralement ces parameétres tout le temps,
quoi qu'il en soit.

Il vous suffit de cliquer sur Apply global et le dossier de sortie sélectionné sera rempli de toutes vos
images, enregistrées par rapport a l'image de référence sélectionnée.




Le bon déroulement de la procédure dalignement dépend en fait du nombre d'étoiles qui sont
détectées et de la correspondance entre lI'image de référence et vos autres images. Si le nombre
d'étoiles détectées est insuffisant, cela peut dépendre du temps d'exposition choisi avec votre
systéme optique dans votre ciel nocturne, ainsi que de la rondeur des étoiles (pour les considérer
comme des étoiles et les faire correspondre entre vos images). Vous pouvez assouplir les
parameétres dans PixInsight pour vous aider a capter plus d'étoiles lorsque I'enregistrement échoue.
La premiere chose a faire est d'augmenter la tolérance du RANSAC dans le cadre de la
correspondance d'étoiles. Elle est de 2,00 par défaut, mais vous pouvez essayer des valeurs
comprises entre 6,00 et 8,00. Cette valeur peut étre saisie manuellement ou ajustée a l'aide du
curseur. De plus, vous pouvez augmenter un peu les itérations RANSAC, par exemple 3000, pour
forcer PixInsight a essayer de trouver des étoiles correspondantes de maniere plus approfondie.

De plus, pour permettre a PixInsight de détecter des étoiles plus faibles pour les utiliser dans le
processus d'alignement, vous pouvez diminuer le parametre Log(sensitivity) sous Star Detection.
Cela peut étre fait en entrant une valeur manuellement ou en ajustant le curseur. Comme ce
parameétre est a I'échelle logarithmique, une valeur inférieure entraine une augmentation de la
sensibilité. Une valeur comprise entre -2,00 et -3,00 (le minimum) peut fonctionner correctement.
Vous pouvez également augmenter tres légerement I'échelle de détection, par exemple 6, pour
détecter plus d'étoiles.

Si aprés avoir ajusté les parametres, PixInsight ne parvient toujours pas a repérer suffisamment
d'étoiles pour I'alignement, cela signifie probablement que la qualité de vos images doit étre prise en
compte. Des expositions plus longues peuvent étre nécessaires, ou des images plus hautes au-
dessus de I'horizon, ou dans un ciel plus sombre, ou avec un meilleur suivi/guidage (pour gérer les
étoiles plus rondes). Cela, ou peut-étre que I'exclusion de certaines expositions lors du prétraitement
(calibrage et empilement) est une bonne idée pour obtenir de meilleurs résultats finaux. C'est
particulierement le cas lorsque certaines expositions sont nettement plus mauvaises que la moyenne
pour I'ensemble de vos données.

Il est & espérer qu'a ce stade, vos images ont été alignées les unes avec les autres et que vous étes
prét a poursuivre. Gardez a l'esprit que, comme les images ont été traduites et peut-étre méme
tournées pour correspondre les unes aux autres, en gardant la méme résolution pour toutes (la
résolution de limage de référence est appliquée a toutes les images enregistrées), il y aura
inévitablement des bords noirs sur vos images. Il s'agit de zones des images qui ne contiennent
aucune donnée, car cette partie du ciel nocturne, par rapport a I'image de référence, n'a pas été
saisie. C'est tout a fait normal et nous traiterons des bords noirs dans la section suivante.

2. Recadrer avec DynamicCrop

A ce stade, vos images pourraient déja étre combinées en couleur, puisqu'elles sont alignées, mais
vous voudrez supprimer les bords noirs de vos images avant de le faire. Le recadrage est la voie a
suivre, mais gardez a lI'esprit que si vous recadrez de maniére incontrélée, vous perdrez I'alignement
de vos images, ce qui nous rameéne a la case départ ! L'essentiel est de recadrer toutes vos images
de la méme maniere, méme si l'une d'entre elles n'a pas de bords noirs (ce qui est commun avec
I'image que vous avez utilisée comme référence pour l'enregistrement, puisqu'elle n'a pas été
altérée). Ce qui suit montre mes images LRGB (dans cet ordre de gauche a droite), auto-étirées.




Le processus DynamicCrop est précisément ce dont nous avons besoin, donc nous l'ouvrons.

Les images ont été maintenues ouvertes, étalées et étirées automatiquement, car nous avons besoin
de voir avec quoi nous travaillons pendant le recadrage. Comme son nom l'indique, le DynamicCrop
est un processus dynamique, ce qui signifie qu'il active une session sur une image et que nous ne
pouvons pas nous concentrer sur une autre image a moins d'annuler ce que nous sommes en train
de faire. La meilleure chose a faire est de cliquer pour sélectionner l'image qui a les pires bords noirs
- c'est I'image rouge pour moi. Une fois sélectionnée, cliquez sur le bouton Reset de DynamicCrop
pour démarrer la session sur cette image.

Si la session DynamicCrop semble étre active sur une autre image lorsque vous essayez, il suffit de
fermer DynamicCrop, de la rouvrir et de réessayer. |l vous suffit de faire glisser les quatre cbtés de la
boite de surlignage blanc vers l'intérieur et la taille de la boite de surlignage blanc sera réduite. La
zone délimitée par cette case signifie ce que nous allons conserver. Veillez & placer le curseur de
votre souris précisément sur les bords car sinon, en faisant glisser la souris, vous déplacerez la boite
plutdt que de la redimensionner (nous voulons la redimensionner). Pour le faire avec précision, il est
utile d'agrandir I'image et de zoomer. Si vous souhaitez relancer le processus, il vous suffit de cliquer
sur le bouton "Reset" de DynamicCrop.

Vous pouvez également appliguer une rotation a votre zone cultivée, en saisissant un angle
manuellement ou en le faisant glisser depuis l'extérieur des limites de la case de surbrillance
blanche. DynamicCrop interpolera automatiquement les pixels si vous effectuez une rotation, ce qui
adoucira les choses (car les pixels sont carrés apres tout !).

Vous voudrez peut-étre étre un peu plus agressif avec la quantité de pixels que vous recadrez. Aprés
tout, ce n'est pas parce que mon image rouge est plus mauvaise que les trois autres que je n'ai pas
raté un petit peu de bord noir sur une autre image si je base mon recadrage sur mon image rouge.
Peut-étre que mon image rouge est plus mauvaise dans I'ensemble, mais peut-étre que la partie
inférieure est plus mauvaise sur mon image verte que sur mon image rouge ! Vous pouvez utiliser les
étoiles pour vous guider quant a la quantité a recadrer. Lorsque vous créez ce modéle avec
DynamicCrop, regardez vos autres images et déterminez plus ou moins si vous devez ou non
recadrer davantage. N'oubliez pas qu'en effet, vous pouvez répéter ce processus par la suite si vous
remarquez qu'une image présente encore des bords noirs.

Une fois que vous étes suffisamment satisfait de votre modele DynamicCrop, ne l'appliquez pas a
votre image, faites simplement glisser le bouton "New Instance" de DynamicCrop vers l'espace de
travail pour lui créer une icbne de processus. Vous pouvez ensuite fermer DynamicCrop. Vous
pouvez renommer l'icobne du processus si vous le souhaitez.

Maintenant, appliqguez cette icbne de processus a chacune de vos images en la faisant glisser et en
la déposant sur elles. Cette icbne de processus a tous les parametres sauvegardés, de sorte que le
recadrage que nous appliqguerons a chaque image est identique. Avec un étirement automatique
appligué a toutes vos images, vous verrez rapidement comment le recadrage s'est déroulé. Une fois
le recadrage effectué, vous pouvez redimensionner vos images pour les adapter aux fenétres et
supprimer également l'icobne du processus de DynamicCrop.

Avec les mémes parameétres de recadrage appliqués a toutes nos images, elles conservent leur
alignement les unes par rapport aux autres et elles ne présentent plus de bords noirs, ce qui facilitera
le post-traitement. Nous procédons maintenant a la suppression de tout dégradé de fond dans nos
images.
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3. Soustraction des gradients de fond avec Dynamic Background
Extraction

Les gradients de fond se produisent naturellement dans les images. lls sont dus a la variation de la
luminosité du ciel nocturne dans votre FOV, et peuvent étre dus au clair de lune, a la pollution
lumineuse artificielle, etc. Comme les images ont déja été prétraitées, les gradients d'arriere-plan
restants sont dus a ces phénomenes, par opposition au vignettage de votre systéme optique (ce
phénomene est corrigé par l'utilisation de flats lors du prétraitement). En soustrayant ces gradients
de fond, on obtient des images avec un rapport signal-bruit plus élevé dans les régions importantes
et un fond plus uniforme et plus sombre.

Le processus DynamicBackgroundExtraction permet a l'utilisateur de placer des points échantillons
dans une image (l'intention est de les placer sur le fond). Ces points échantillons sont utilisés par le
processus pour calculer un modeéle pour les gradients de l'arriere-plan, qui peut ensuite étre soustrait
de limage pour la nettoyer. Ce modele sera ensuite appliqué a toutes les autres images
individuellement. Il est utile d'utiliser I'image avec le champ d'étoiles le plus brillant et la plus grande
nébulosité, car le fait de baser notre modele avec des points échantillons sur une telle image nous
permet d'éviter de placer des points échantillons sur des zones qui ne devraient pas étre prises pour
I'arriere-plan. Cela permet d'éviter d'avoir a regarder exhaustivement chaque point échantillon que
vous placez lorsque vous appliquez le méme modele a une image prise avec un filtre différent. La
luminance et I'h-alpha sont donc de bonnes images sur lesquelles baser un modele.

Nous ouvrons le processus DynamicBackgroundExtraction et ne gardons que notre image de
luminance maximisée pour travailler avec. Comme il s'agit d'un processus dynamique, nous cliquons
sur le bouton Reset pour initialiser la session avec l'image de luminance sélectionnée.

Un réticule apparait a l'intérieur de l'image active. On peut le déplacer en les faisant glisser sur
I'image. Son but est de définir 'emplacement du centre de symétrie des dégradés de fond de votre
image. lls sont généralement laissés au centre, sauf si vous avez une vue claire des dégradés
d'arriere-plan et que vous souhaitez les déplacer. En cliquant sur l'image, vous créez un point
d'échantillon. Vous pouvez le faire glisser pour le placer ailleurs également. Vous pouvez faire un
zoom avant et un panoramique de l'image avec votre souris pour obtenir une vue claire. Comme la
couleur par défaut d'un point d'échantillon est le gris, il ne fonctionne pas trés bien avec les images
monochromes, avec lesquelles nous travaillons. Il suffit de cliquer sur le rectangle de couleur pour
Sample color et de le modifier pour obtenir quelque chose de plus visible. Je le rends simplement
turquoise vif.

Nous pouvons faire en sorte que DynamicBackgroundExtraction place automatiquement des points
d'échantillonnage pour nous, et c'est généralement un bon point de départ, a moins que vous ne
vouliez étre trés prudent quant a I'endroit ou vous les placez. Vous devez augmenter Default sample
radius par défaut a une valeur comprise entre 10 et 20. J'utilise généralement 15 mais je trouve que
les points d'échantillonnage de taille 15 sont trop grands pour ces images qui ont tant, tant d'étoiles
serrées les unes contre les autres. 10 fonctionne mieux ici. Pour les échantillons par ligne, nous
pouvons utiliser une valeur entre 15 et 20, ce qui donne un bon nombre de points d'échantillonnage.
Une fois cette valeur modifiée, cliquez sur le bouton Generate.

Des points d'échantillonnage apparaissent maintenant sur toute l'image, bien que votre espacement
varie en fonction de votre image. Si vous en obtenez tres, tres peu, vous devez augmenter la valeur
de Tolérance. L'idéal est de laisser cette valeur & 0,500 mais certaines images ont un fond trop clair
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et donc les points d'échantillonnage que vous placez manuellement sont rejetés (représentés par des
carrés rouges) et si vous choisissez de placer des points d'échantillonnage automatiquement, de
nombreuses zones seront omises. N'augmentez la tolérance que si vous en avez vraiment, vraiment
besoin. Quand en avez-vous vraiment besoin ? Lorsque vous effectuez un zoom avant, placez
manuellement un point d'échantillonnage en cliquant sur une zone dont vous étes sir a 100 % qu'elle
est en arriere-plan et qui apparait sous la forme d'un carré rouge parce que le point d'échantillonnage
est rejeté. Je n'utilise que des valeurs de tolérance d'environ 2 000, mais jamais plus. J'ai tendance a
osciller entre 0,500 et 1,500. Si vous modifiez la valeur de Tolérance, assurez-vous de cliquer sur le
bouton Resize All pour appliquer les paramétres aux points d'échantillonnage actuellement placés.
Ne cliquez pas sur Generate, car cela placera automatiquement les points d'échantillonnage et
annulera tout votre travail de déplacement de certains, de placement manuel d'autres, etc. Bien
entendu, vous pouvez permettre au processus de placer automatiquement les points
d'échantillonnage en fonction d'une nouvelle valeur de tolérance. Si c'est le cas, cliquez sur le bouton
Generate.

Comme jai trés, trés peu de points d'échantillonnage, j'augmente ma tolérance a 1.000 et je clique
sur le bouton Generate pour créer un nouveau placement automatique de points d'échantillonnage.

Un nombre plus adéquat de points d'échantillonnage ayant été placés, je proceéde maintenant a leur
inspection manuelle. Je fais un zoom avant et un panoramique sur l'image, en vérifiant attentivement
chacun d'entre eux. Les points d'échantillonnage qui se trouvent au-dessus d'étoiles ou de nébulosité
sont déplacés a proximité afin qu'ils se superposent strictement a l'arriere-plan. S'ils posent trop de
problemes ou s'il est inutile de les déplacer parce que d'autres points d'échantillonnage a proximité
s'‘occupent de cette zone, il suffit de cliquer dessus pour les sélectionner et les supprimer avec la
touche Suppr de votre clavier.

Maintenant que tous les points d'échantillonnage placés automatiquement sont bien placés, nous
devons regarder notre image et peut-étre en placer d'autres manuellement en cliquant sur des zones
qui sont clairement en arriére-plan. Faites cela dans les zones qui ont été oubliées par le processus
de placement automatique. Parfois, il est utile de faire un zoom arriére sur une grande partie de
l'image pour avoir un apercu global tres rapide des endroits ou les points d'échantillonnage
manguent. Cependant, lorsque vous les placez, n'oubliez pas que la qualité prime sur la quantité :
vous n'‘avez pas besoin d'enduire le fond de points d'échantillonnage, a condition quils soient placés
soient bien placeés et qu'ils couvrent correctement toute votre image, en particulier les quatre cotés et
les quatre coins.

Il ne nous reste plus qu'a appliquer notre modéle a nos images. La luminance étant encore ouverte,
je double-clique sur [licone du processus pour faire apparaitre le processus
DynamicBackgroundExtraction tel qu'il a été configuré précédemment. Comme je sais que tout
fonctionne parfaitement, je clique simplement sur Execute.

Deux nouvelles images vont apparaitre. La premiére est limage souhaitée - I'image mais sans les
gradiants du fond. La seconde est limage modéle avec les dégradés de fond - celle qui a été
soustraite de votre image actuelle. Les deux images ci-dessus sont affichées en mode auto-étiré. Il
est clair qu'il y avait quelque chose a enlever et I'image est en effet meilleure pour cela aussi - un
arriere-plan beaucoup plus propre !

L'image modele a gradients d'arriere-plan n'est la que pour votre inspection et peut étre fermée. Si
vous ne voulez pas qu'elle apparaisse du tout, il suffit d'activer I'option Discard background model
dans DynamicBackgroundExtraction avant de cliquer sur Execute. L'image traitée doit étre
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enregistrée, soit en remplacement de l'image précédente, soit en tant que nouveau fichier - c'est a
vous de décider. Vous pouvez ensuite fermer le processus et cette image. Nous maximisons alors la
prochaine pour appliquer ce modéle d'arriere-plan et nous double-cliquons sur l'icbne du processus
DynamicBackgroundExtraction pour l'initialiser.

Ce faisant, vérifiez que tous vos points d'échantillonnage sont corrects et ne sont pas rejetés. S'ils le
sont, vous devrez peut-étre augmenter la tolérance un peu plus et cliquer sur Resize All. Si tous vos
points d'échantillonnage sont acceptés, il est conseillé de réduire la tolérance petit a petit, en cliquant
a chaque fois sur Resize All pour atteindre la valeur minimale nécessaire pour que tous vos points
d'échantillonnage soient acceptés, sans aller bien trop bas - 0,500 comme strict minimum est une
bonne chose. Vérifiez également qu'aucun point d'échantillonnage ne se trouve sur des zones
importantes telles que la nébulosité. Cela peut arriver lorsque vous faites un modele d'arriere-plan
avec une image Oxygen-lll et que vous l'appliquez ensuite a une image H-Alpha, car H-Alpha capte
généralement beaucoup plus de nébulosité. Cela signifie qu'il pourrait maintenant y avoir quelque
chose d'intéressant juste en dessous d'un de vos points d'échantillonnage - vérifiez-les brievement !

Avec tous mes points d'échantillon a leur place correcte (rien de plus intéressant que le fond), j'ai pu
abaisser ma valeur de tolérance a 0,500 avec tous mes points d'échantillon encore acceptés.

Nous répétons ce processus pour toutes nos images jusqu'a ce qu'elles aient toutes été soustraites
du fond, comme indiqué ci-dessous.

Elles sont maintenant prétes pour I'étape finale, qui consiste a moyenner I arriere-plan moyen et le
signal luminosité avec LinearFit.

4. Corréler les images avec LinearFit

Lorsque nous avons des images calibrées et empilées qui sont censées étre combinées en couleur,
nous devons examiner dans quelle mesure les histogrammes correspondent vraiment les uns aux
autres. Généralement, en raison des conditions variables du ciel nocturne au cours d'une nuit
d'imagerie, ou de plusieurs nuits d'imagerie, ainsi que du filtre utilisé, la luminosité moyenne de
I'arriere-plan et du signal peut ne pas bien correspondre entre les images que nous devons combiner
en couleurs. Dans les zones légerement polluées, il est courant que le fond soit plus brillant a travers
un filtre rouge que vert ou bleu. La luminance a tendance a étre plus forte que les trois pour des
raisons évidentes. La fonction DynamicBackgroundExtraction a certainement aidé a cet égard en
soustrayant les gradients de l'arriere-plan dans chaque image monochrome. Le calibrage des
couleurs peut effectivement corriger cela (c'est le sujet d'un autre tutoriel), il est généralement bon de
faire correspondre le fond moyen et la luminosité du signal entre les images que vous allez combiner
plus tard.

Le processus PixInsight responsable de cette prouesse est LinearFit, qui suppose qu'une fonction
mathématiquement linéaire peut modéliser la différence de luminosité moyenne du fond et du signal
entre une image de référence que vous choisissez et I'image cible a laquelle vous appliquez le
processus. Par conséquent, il fonctionne mieux au tout début de votre post-traitement, lorsque vos
images sont linéaires, mais a proprement parler, il n'a pas besoin que les images soient linéaires
pour faire son travail. Veuillez noter que LinearFit exige que les images auxquelles il est appliqué

soient alignées les unes par rapport aux autres, sinon il n'y a pas de corrélation entre lI'image que
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nous définissons comme référence et I'image a laquelle nous appliquons le processus. Assurez-vous
gue la section 1 ci-dessus est bien suivie.

Nous commengons par ouvrir nos images enregistrées, recadrées et soustraites de l'arriere-plan et le
processus LinearFit.

Le processus lui-méme est tres, trés simple et les parametres par défaut fonctionnent
merveilleusement bien. Il suffit de sélectionner une image de référence ouverte dans Pixinsight, puis
d'appliquer le processus a chacune des autres images. La sélection d'une image de référence est un
processus assez simple. Lorsque nous appliquons le processus a une image, la luminosité moyenne
du fond et du signal est alignée sur celle de I'image de référence. Conformément a cela, il est bon
d'utiliser notre image la plus lumineuse comme référence. Cela permet également de conserver le
contraste dans les histogrammes des autres images. Pour savoir quelle image est la plus lumineuse,
il suffit dinspecter les histogrammes. Pour ce faire, nous utlisons le processus
HistogramTransformation. 1l suffit de l'ouvrir, de faire un zoom horizontal dans l'apercu de
I'histogramme en entrant une valeur telle que 50 dans la zone de texte en haut a gauche, puis de
sélectionner une image dans le menu déroulant.

Ceci nous montre I'histogramme de cette image dans la boite de prévisualisation inférieure, zoomée
horizontalement. Pour comparer les histogrammes, il suffit de sélectionner chaque image une par
une et vous remarquerez immédiatement les différences. Vous trouverez ci-dessous les
histogrammes de mes images, qui sont des LRGB (présentés dans cet ordre) :

On voit rapidement que pour mes images, le Rouge est nettement plus lumineux que la Luminance,
le Vert et le Bleu, car I'histogramme est placé plus vers la droite (vers le blanc). Cela signifie que
l'utilisation du rouge comme image de référence pour LinearFit est une bonne idée. Si vous travaillez
avec des images a bande étroite, H-Alpha est généralement la plus brillante, mais vos résultats
peuvent varier. Veuillez noter qu'il ne s'agit pas d'une exigence stricte.

Pour appliquer le procédé LinearFit, cliquez simplement sur le petit bouton a droite de la zone de
texte de l'image de référence, sélectionnez l'image de référence de votre choix dans la liste, cliquez
sur OK et ensuite appliquez le procédé LinearFit a toutes vos images ouvertes sauf lI'image de
référence (comme s'en plaindra PixInsight !).

Lorsque vous appliquez le procédé LinearFit a vos images, vous pouvez remarquer qu'elles
semblent un peu plus claires (ou plus sombres), selon l'aspect des histogrammes avant et apres
l'application du procédé LinearFit. Ne vous inquiétez pas - un étirement automatique révélera les
mémes détails qu'auparavant. Cependant, toutes vos images sont maintenant identiques en termes
de niveau moyen de luminosité du fond et du signal.

Cette derniere étape a permis de préparer vos images a la combinaison des couleurs et elles sont
donc étiquetées comme étant prétes pour un post-traitement ultérieur. Une combinaison de couleurs
rapide donne un bien meilleur résultat final que celui obtenu au départ :




V. Combinaison d'images R, G et B monochromes en
une image RVB en couleur et application de la
luminance

Les images numériques s'affichent en couleur lorsque l'image est composée de trois canaux de
couleur - rouge, vert et bleu. Les images monochromes sont monochromes jusqu'au moment ou
elles sont combinées en une image en couleurs RVB. Ces images a canaux de couleur rouge, vert et
bleu pourraient littéralement étre rouge, vert et bleu - capturés par les filtres respectifs. Il peut
également s'agir dimages monochromes a bande étroite dont vous souhaitez faire une image en
couleur. Dans tous les cas, les images monochromes doivent occuper les canaux de couleur rouge,
vert et bleu afin de produire une image en couleur.

PixInsight dispose de plusieurs moyens pour combiner des images monochromes en couleur. Une
fois que vous travaillez avec une image couleur, vous pouvez lui appliquer une image monochrome
de luminance. Ce tutoriel couvre a la fois la combinaison des couleurs des images monochromes
(par deux méthodes différentes - en utilisant ChannelCombination et PixelMath) et I'application d'une
image monochrome de luminance a cette image couleur (en utilisant LRGBCombination).

Pré-supposé pour ce tutoriel :

1. Connaissance du fonctionnement de PixInsight, en rapport avec le traitement des images et
des processus (Lire ce qui suit, sections 3 et 4).

2. Vos images ont déja été entierement prétraitées (Lire ceci).

3. Vos images monochromes individuelles a combiner en couleur ont déja été préparées en les
alignant, en coupant les bords noirs, en soustrayant les gradiants d'arriére-plan et en faisant
correspondre leurs niveaux de luminosité (Lire ceci).




2. Combinaison de couleurs avec ChannelCombination

Nous commencgons cette section en ouvrant les images monochromes Rouge, Vert et Bleu dans
PixInsight. Elles ont déja été préparées selon les hypotheses de ce tutoriel. Ci-dessous, ces images
sont montrées en mode auto-étire.

Nous allons combiner les images en couleur avec le processus ChannelCombination.

Le processus est trés simple. Nous gardons le RVB sélectionné dans Color Space car nous allons
créer une image en couleur RVB. Sur le c6té droit, nous gardons, R, G et B activés. Nous devons
sélectionner limage monochrome pour chaque canal. Il suffit de cliquer sur le bouton a c6té de la
zone de texte pour chacun des trois et de sélectionner I'image qui est ouverte dans Pixinsight.

Les captures d'écran ci-dessus montrent I"image pour le canal Rouge. Nous répétons le processus
pour les canaux verte et bleu afin que les trois soient correctement sélectionnés.

Les identificateurs de vos images peuvent varier selon le nom que vous leur donnez. Cela devrait
étre trés facile, a condition que vous identifiiez clairement lequel est le rouge, lequel est le vert et
lequel est le bleu. Il suffit de cliquer sur le bouton circulaire "Apply Global" pour créer une nouvelle
image dans PixInsight, qui est notre image en couleur RVB.

Un étirement automatique révele notre image couleur RVB tout en conservant sa linéarité.

Elle est maintenant préte a étre post-traitte en méme temps qu'une image de Luminance, ou seule.
Normalement, une procédure d'étalonnage des couleurs devrait suivre immédiatement apres la
création de cette image, et c'est ce dont il est question dans un autre tutoriel.

3. Combinaison de couleurs avec PixelMath

Comme pour la section précédente, nous commengons en ouvrant les images monochromes
Rouge, Verte et Bleue dans PixInsight. Celles-ci ont déja été préparées selon les hypotheses de ce
tutoriel. Ci-dessous, ces images sont montrées en mode auto-étiré.

Nous ouvrons le processus PixelMath, que nous utiliserons pour la combinaison des couleurs.

Ce processus est extrémement puissant dans la mesure ou il peut faire a peu pres n'importe quoi - il
est d'ailleurs appelé PixelMath a juste titre | Ce procédé est également un bon moyen de créer une
nouvelle image couleur RVB a partir dimages monochromes. Par défaut, ce processus vous oblige a
travailler en monochrome par le biais de la seule zone de texte RGB/K fournie. Pour activer les
autres canaux de couleur, nous désactivons l'option Use a single RGB/K expression.

Comme nous voulons créer une nouvelle image, plutét que de remplacer celle qui est actuellement
ouverte, nous seélectionnons l'option Create new image, puis nous choisissons RGB Color dans la
liste déroulante Color space. Assurez-vous que l'option Rescale result est laissée désactivée, car
nous ne voulons pas redimensionner notre image en couleurs RVB - nous voulons maintenir les
images monochromes telles quelles, sauf si elles sont combinées a des couleurs.

Il ne reste plus qu'a taper les identificateurs d'images dans les canaux de couleur correspondants.
Dans R/K, nous tapons l'identificateur d'image Rouge. En G, nous tapons l'identificateur d'image vert.
En B, nous tapons l'identificateur d'image bleu. Les miens sont tres simplement appelés R, G et B
dans PixInsight et je tape donc simplement ces identificateurs.

[ } 62




Vos identificateurs peuvent varier, en particulier si vos images ont des noms de fichiers génants et
gue vous n'avez pas pris la peine de modifier manuellement leurs identificateurs dans PixInsight.
Néanmoins, tant que vous savez avec certitude lequel est rouge, lequel est vert et lequel est bleu,
vous étes couvert. Une fois que vous avez entré votre nom, cliquez sur le bouton carré Apply.
Veuillez vous assurer au préalable que vos images monochromes sont actives dans PixInsight
(comme indiqué dans mes captures d'écran) et ne sont pas réduites en icénes , sinon PixelMath
affichera une erreur indiquant qu'il n'y a pas d'image active.

Un étirement automatique révele rapidement notre image en couleurs tout en conservant sa linéarite.

Elle est maintenant préte a étre post-traitée avec une image de type Luminance, ou seule.
Normalement, une procédure d'étalonnage des couleurs devrait suivre immédiatement apres la
création de cette image, et c'est ce dont il est question dans un autre tutoriel.

Vous pouvez choisir de toujours utiliser ChannelCombination plutét que PixelMath, car il est clair que
c'est un peu plus simple. Cependant, lorsque vous travaillez avec des images a bande étroite et que
vous souhaitez les combiner avec des pondérations ou des combinaisons d'images dans chaque
canal de couleur, PixelMath rend les choses extrémement simples puisqu'il vous permet de saisir
des expressions dans chaque canal de couleur. Par exemple, ce qui suit montre rapidement une
palette bicolore a bande étroite combinant H-Alpha et Oxygéne-lll, transformée en une image couleur
RVB avec des pondérations et des combinaisons personnalisées.

Les détails de cette technique et les diverses utilisations des images a bande étroite font I'objet d'un
autre tutoriel, mais ils sont fournis ici pour clarifier les raisons pour lesquelles PixelMath peut étre
plus utile que ChannelCombination. Cependant, lorsque l'on travaille avec des images RVB pures,
ChannelCombination est plus que suffisant.

4. Application d'une image de luminance avec LRGBCombination

Lorsque vous utilisez I'imagerie en LRGB, vous souhaiterez utiliser votre image Luminance pour
améliorer I'image couleur RGB que vous venez de créer avec vos images Rouge, Verte et Bleue.
Ceci est particulierement utile car vous pouvez utiliser votre image Luminance pour faire ressortir des
contrastes et des détails fins, avec un arriére-plan a faible bruit et une résolution spatiale élevée,
pour l'appliquer ensuite a I'image couleur RVB et faire ressortir ces caractéristiques fines. En général,
on post-traite séparément la Luminance et limage RVB, pour les combiner ensuite. Le procédé
LRGBCombinaison est utilisé pour cela, mais ce procédé nécessite que I'image Luminance et I'image
couleur RVB soient non linéaires (aient été étirées). Ce n'est pas un probléme car, apres tout, vous
traitez séparément les images en Luminance et en couleurs RVB et |'étirement de ces derniéres pour
les rendre non linéaires fait partie de ce post-traitement.

Etant donné les exigences de non-linéarité de LRGBCombination, vous trouverez ci-dessous une
image de luminance et une image de couleur RVB qui ont été étirées. Elles ont également fait I'objet
d'un post-traitement rapide, a des fins de démonstration.

Nous les mettons de c6té et nous ouvrons le processus LRGBCombination.

Nous allons sélectionner ici notre image de luminance et I'appliquer a limage RVB. Nous devons
donc désactiver les fonctions R, G et B, car elles seront déja présentes dans notre image couleur
RVB.
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Nous sélectionnons maintenant notre image de luminance pour le canal L. Pour ce faire, cliquez sur
le bouton a coté de la zone de texte pour L et sélectionnez I'image de luminance.

A ce stade, nous examinons les autres fonctions de LRGBCombination. Sous Channel Weights,
nous pouvons définir la valeur de chaque canal une fois que nous combinons la luminance sur
I'image couleur RGB. Ce n'est pas quelque chose qui vaut vraiment la peine d'étre touché et tout
devrait étre laissé a la valeur par défaut de 1,00000, avec Uniform RGB dynamic ranges activées.

Les fonctions de transfert peuvent étre utiles. Avec leur valeur par défaut de 0,500, elles ne font rien
a limage une fois que la luminance est combinée. Si vous réduisez la luminosité a une valeur
inférieure a 0,500, il se produira un étirement de la luminosité dans l'image pour la rendre plus
lumineuse. Si vous augmentez la luminosité & une valeur supérieure a 0,500, une compression se
produira sur la luminosité de l'image pour la rendre moins lumineuse. Le paramétre Saturation
fonctionne de maniere identique. Si vous diminuez la saturation a une valeur inférieure a 0,500, la
saturation globale des couleurs sera améliorée. Si vous augmentez la saturation & une valeur
supérieure a 0,500, il y aura une perte de la saturation globale des couleurs. L'expérimentation avec
VOS propres images est la clé pour trouver de bons réglages. Vous pouvez choisir de les modifier ou
non - normalement, je ne les touche pas du tout et je choisis plutdt d'utiliser quelque chose comme
CurvesTransformation a la toute fin, pour obtenir une plus grande luminosité, un meilleur contraste et
une meilleure saturation des couleurs.

Chrominance Noise Reduction est en fait assez utile. Cette fonction vise a réduire le bruit global des
couleurs dans l'image combinée et les parametres par défaut fonctionnent ici merveilleusement bien.
Il vaut la peine d'activer cette fonction.

Une fois que vous étes prét a combiner, assurez-vous de cliquer sur l'image de couleur RVB pour la
sélectionner, puis cliguez sur le bouton carré Apply de LRGBCombination, ou faites glisser le bouton
New Instance sur l'image de couleur RVB.

Une nette différence dans l'image est observée une fois que la luminance est combinée, selon ce
gue votre image de luminance post-traitée apporte a la table. Dans la mienne, elle a apporté des
étoiles plus serrées, un contraste plus élevé des détails, des détails plus fins et une augmentation de
la luminosité globale dans la nébulosité.

Numeériquement parlant, vous travaillez toujours avec une image couleur RVB, puisque les images
couleur sont identifiées par trois canaux de couleur (rouge, vert et bleu) combinés en une seule
image. Cependant, en termes plus généraux, il s'agit maintenant d'une image LRGB. Quoi qu'il en
soit, LRGBCombination a permis de remplacer la luminosité d'origine de votre image couleur RVB
par votre image Luminance. A ce stade, un post-traitement supplémentaire peut étre souhaité,
comme l'utilisation de CurvesTransformation pour le réglage final, ou la réduction de la taille des
étoiles.

En ce qui concerne les fonctions de transfert mentionnées, le tableau ci-dessous montre la méme
combinaison de luminance avec mon image couleur RVB, mais avec une légére augmentation de la
luminosité et une augmentation de la saturation.

A mon avis, ce qui précéde est exagéré, mais il s'agit simplement d'une démonstration de la
fonctionnalité fournie par les fonctions de transfert dans le processus LRGBCombination.




V. Calibration des Images couleurs

En I'absence de cellules de détection des couleurs suffisamment sensibles dans notre rétine, la seule
mesure de la couleur réelle dans l'espace profond provient de nos images d'objets tels que les
nébuleuses et les galaxies. Cela exclut bien sir les images a bande étroite qui introduisent de
fausses couleurs. Lorsque nous disons gu'une image couleur prise avec un appareil photo CCD ou
DSLR couleur en une seule prise, ou une image LRGB prise avec un appareil photo CCD
monochrome, est calibrée en couleur, nous avons essentiellement neutralisé I'arriere-plan en un gris
tres clair et défini le point blanc. Si cela est fait correctement, nous pouvons dire que notre image est
une représentation fidele de la couleur réelle de I'objet de I'espace profond.

Ceci est essentiel pour travailler avec des images en couleur qui ne sont pas des images a bande
étroite, si I'on veut que les images paraissent réalistes. PixInsight dispose d'un certain nombre de
procédés qui nous permettent d'effectuer ce calibrage des couleurs sur des images en couleur. Ce
tutoriel traite précisément de ces procedeés. Il est également mentionné comment cette procédure se
rapporte aux images a bande étroite pour ceux qui ont des caméras CCD monochromes.

Pré-supposé pour ce tutoriel :

e Connaissance du fonctionnement de PixInsight, en rapport avec le traitement des images et
des processus (Lire ce qui suit, sections 3 et 4).

e Vos images ont déja été entierement prétraitées (Lire ceci).

e Sivos images sont monochromes, elles ont été entierement préparées en les enregistrant, en
recadrant les bords noirs, en soustrayant les dégradés de fond et en faisant correspondre
leurs niveaux de luminosité (Lire ceci). Vous les avez combinées en couleur pour obtenir une
image en couleur (Lire ceci).




1. Neutraliser 'arriere-plan avec BackgroundNeutralization

Nous commengons par présenter l'image que nous utiliserons pour ce tutoriel. Cette image provient
de trois images monochromes distinctes, rouge, verte et bleue. Conformément a la liste d'hypothéses
ci-dessus, les images monochromes ont été entierement prétraitées, alignées avec StarAlignment,
recadrées avec DynamicCrop, gradiant de l'arriere-plan extrait avec DynamicBackgroundExtraction
et mises en correspondance avec LinearFit. Les images monochromes ont ensuite été combinées en
couleur avec ChannelCombination. Ci-dessous, cette image, dans son état linéaire, est auto-étirée
dans PixInsight.

Ce qui précede ne présente peut-étre pas un scénario tres clair quant a la nécessité de calibrer les
couleurs de l'image, car celle-ci semble déja assez naturelle (avec une légére teinte globale a
l'arriere-plan). C'est le cas parce quelle a été extraite de [larriere-plan avec
DynamicBackgroundExtraction et qu'elle a ensuite €té mise en correspondance avec LinearFit avant
la combinaison des couleurs. La fonction LinearFit fait correspondre le niveau de luminosité moyen
de l'arriére-plan et du signal sur les images et, par conséquent, elles correspondent déja bien.

Néanmoins, il y a certains avantages a effectuer une routine de calibrage des couleurs, d'autant plus
gue cela ne prend pas beaucoup de temps. Il est important de noter que cette procédure doit étre
effectuée sur une image linéaire, avant tout étirement. Nous commencgons par neutraliser l'arriére-
plan. Pour cela, nous utilisons le procédé BackgroundNeutralization.

Ce processus bénéficie grandement de la création d'une petite boite de prévisualisation dans votre
image qui ne couvre que le fond. Par arriere-plan, j'entends I'absence de nébulosité, de galaxies et
d'étoiles - simplement I'espace en arriere-plan. Choisissez une zone qui est dépourvue de tout intérét
et qui a une teinte de fond plus ou moins moyenne. Cela permet de zoomer et de faire un
panoramique autour de I'image. Une fois que vous avez trouvé une zone appropriée, créez une boite
de prévisualisation autour de celle-ci - n'incluez aucune étoile si vous le pouvez !

La fenétre de prévisualisation ne doit pas étre tres grande, alors ne vous inquiétez pas. Votre image
peut étre plus difficile a travailler si vous avez beaucoup d'étoiles dans le champ de vision. Une fois
gue vous avez cree votre boite de prévisualisation, revenez en Readout Mode dans PixIinsight, car
Nnous pourrions en avoir besoin.

Une fois la boite de prévisualisation créée, cliquez sur le petit bouton a coété de la boite de texte pour
Image de référence dans le processus BackgroundNeutralization, sélectionnez la boite de
prévisualisation dans la liste et cliquez sur OK.

Si vous avez capturé quelques étoiles dans votre fenétre de prévisualisation parce qu'elles sont
totalement inévitables, ou une nébulosité qui est également totalement inévitable, vous pouvez
modifier Upper limit dans BackgroundNeutralization pour exclure ces pixels problématiques. Si votre
fenétre de prévisualisation est exempte d'étoiles ou de nébulosité (ou presque, comme le montre la
mienne ci-dessus), ne modifiez pas les parametres par défaut car ils fonctionnent trés, tres bien avec
les images linéaires. Si vous identifiez des pixels problématiques dans votre fenétre de
prévisualisation, cliquez et laissez le bouton de la souris cliqué et Readout Mode apparaitra.

A gauche de Readout Mode output, vous verrez les valeurs R, G et B. Upper limit dans
BackgroundNeutralization devrait idéalement étre inférieure a cette valeur si ce que vous pointez se
distingue vraiment de l'arriére-plan (ce n'est pas le cas dans ma boite de prévisualisation !). Comme
il y a trois valeurs données (R, G et B), ch?isissez Ha plus petite des trois pour fixer votre limite

( ] 66




supérieure légérement en dessous. S'il y a plusieurs pixels problématiques dans votre fenétre de
prévisualisation, vérifiez-les tous avec le mode Readout, trouvez la plus petite valeur et utilisez-la
pour définir Upper limit. Vous pouvez laisser la Lower limit par défaut.

N'oubliez pas que si vous faites attention en créant votre boite de prévisualisation, cela peut ne pas
étre nécessaire du tout, dans la plupart des cas (sauf si votre image ne comporte absolument aucune
zone non couverte de nébulosité). S'il n'y a effectivement aucun arriere-plan dans votre image (c'est
extrémement rare, a moins qu'il ne s'agisse d'une image a champ trés étroit d'une grande nébuleuse
avec une neébulosité globale brillante), vous n'avez pas du tout besoin dappliquer
BackgroundNeutralization et pouvez passer a la section 2.

Une fois que vous étes satisfait de vos paramétres BackgroundNeutralization, cliquez sur le bouton
Apply et votre image prendra un ton légérement différent. A ce stade, vous devrez réappliquer
I'étirement automatique pour voir vraiment la différence apportée a votre image (car I'étirement
automatique que vous aviez était applicable lorsque l'arriere-plan n'était pas neutralisé).

Il est clair que LinearFit et DynamicBackgroundExtraction ont fait un excellent travail de concordance
des images avant la combinaison des couleurs, mais la neutralisation de l'arriére-plan a en soi été
quelque peu bénéfigue pour limage. A ce stade, vous pouvez fermer le processus
BackgroundNeutralization. Laissez la boite de prévisualisation en place, car nous en aurons besoin
pour la prochaine section.

2. Effectuer le calibrage des couleurs avec ColorCalibration

Le calibrage des couleurs peut étre effectué avec I'un des deux processus suivants : ColorCalibration
ou PhotometricColorCalibration (nouveau a partir de la version 1.8.5). Cette section couvre le
premier et la section suivante couvre le second. Vous pouvez choisir d'utiliser I'un ou l'autre pour vos
images, mais veuillez noter que I'utilisation des deux n'est pas la procédure correcte pour le calibrage
des couleurs.

Le processus de calibrage des couleurs nécessite deux boites de prévisualisation - une sur le fond et
une autre sur ce qui est essentiellement une référence blanche. Les références blanches en
astrophotographie sont essentiellement des étoiles de type G2V, mais Pixlnsight differe dans la
facon dont il effectue la calibration des couleurs - il choisit plutét d'échantillonner toutes les couleurs
sur une image. En fin de compte, il est tres efficace dans son travail. Nous ouvrons maintenant le
processus ColorCalibration.

Comme nous disposons déja d'une fenétre de prévisualisation créée sur l'arriere-plan, celle-ci nous
servira de référence pour l'arriére-plan. Il doit donc étre sélectionné comme tel. Il suffit de cliquer sur
le bouton situé a c6té de la zone de texte Image de référence sous Référence d'arriere-plan et de
sélectionner la zone de prévisualisation sur l'arriére-plan.

Nous devons maintenant créer une boite de prévisualisation dans notre image qui représente une
référence blanche. Si votre image contient une galaxie assez importante, il suffit de créer une fenétre
de prévisualisation sur toute la galaxie et de désactiver Structure Detection dans ColorCalibration.
Cela oblige le processus a utiliser la galaxie entiere comme référence blanche, ce qui est en effet
excellent car les galaxies contiennent tous les types d'étoiles et conviennent en moyenne pour le
blanc. Si toutefois votre image, comme la mienne, n'a pas le luxe de contenir une galaxie assez
importante, nous devons utiliser des étoiles p?ur notre géférence blanche.
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Dans ce scénario, nous maintenons Structure Detection activée et les parametres par défaut
fonctionnent bien. Cette fonction force essentiellement le processus a détecter les étoiles dans
I'image (ou la boite de prévisualisation) et a les utiliser comme référence blanche, par opposition a la
nébulosité, au fond, etc. Le fait de garder les couches de structure a 5 échantillons permet
d'échantillonner la plupart des étoiles de l'image, en particulier les petites. Vous pouvez porter ce
nombre a environ 6 pour inclure des étoiles plus grandes, mais au risque d'inclure des structures
telles que la nébulosité. Maintenez les couches de bruit a 1 car cela permet d'ignorer le bruit a petite
échelle dans l'image lors de la détection d'étoiles pour la référence blanche.

Comme mon image contient une bonne quantité d'étoiles, il est facile de créer une boite de
prévisualisation assez grande sur la plus grande partie de l'image.

Veuillez noter que vous pouvez en effet faire chevaucher la boite de prévisualisation de la référence
blanche sur la boite de prévisualisation de l'arriere-plan - Structure Detection garantira que seules les
étoiles sont utilisées comme référence blanche de toute facon. Une fois que vous avez créé votre
boite de prévisualisation de référence blanche, cliquez sur le bouton a c6té de la boite de texte pour
Reference image sous White Reference et sélectionnez cette nouvelle boite de prévisualisation.

A ce stade, ColorCalibration est correctement configuré et vous pouvez cliquer sur Apply avec votre
image sélectionnée. Une fois que vous avez terminé, réappliquez I'étirement automatique pour voir
vraiment les effets de la calibration des couleurs (comme I'étirement automatique précédent appliqué
a limage telle qu'elle était avant la calibration des couleurs). Vous pouvez également fermer
ColorCalibration et supprimer toutes les boites de prévisualisation.

Iy a eu un effet prononcé sur les couleurs de mon image et elle semble bel et bien naturelle
maintenant. Mieux encore, I'image est toujours a I'état linéaire et il est possible d'effectuer d'autres
post-traitements (comme la réduction du bruit, I'étirement, I'amélioration du contraste, etc.) ). Il se
peut qu'une couleur verte soit ajoutée a votre image a ce stade, c'est ce dont nous parlerons plus
loin. Mais avant cela, nous introduisons dans Pixinsight un autre processus de calibrage des
couleurs (nouveau a partir de la version 1.8.5), qui peut étre utilisé a la place du ColorCalibration
utilisé dans cette section.

3. Effectuer le calibrage des couleurs avec PhotometricColorCalibration

PhotometricColorCalibration a été introduit dans la version 1.8.5 de PixIlnsight comme nouvelle
méthode de calibrage des couleurs. Cette résolution astrométrique résout votre image afin de
déterminer une véritable référence de blanc pour votre image en fonction d'une sélection faite par
l'utilisateur, comme une galaxie spirale, une galaxie elliptique ou une étoile de type G2V. L'utilisation
du PhotometricColorCalibration est censée étre plus scientifique, mais elle peut ou non aboutir & un
résultat que vous appréciez plus que celui produit par le processus de ColorCalibration mentionné ci-
dessus. Utilisez I'un ou l'autre de ces procédés, mais il est recommandé d'essayer les deux avant de
vous décider.

En l'absence de boites de prévisualisation dans notre image, mais avec le fond neutralisé par
BackgroundNeutralization, nous ouvrons le processus PhotometricColorCalibration.




La premiére étape consiste a indiquer & PhotometricColorCalibration les coordonnées de déclinaison
et d'ascension droite de votre image. Le centre du champ de vision de I'image est idéal, mais tout
objet contenu dans I'image a proximité du centre suffit. S'il y a un objet nommé prés du centre de
I'image, il suffit de cliquer sur le bouton Coordonnées de recherche, d'entrer la désignation ou le nom
de I'objet et de cliquer sur Search.

Comme indiqué ci-dessus, les désignations ou les noms communs fonctionnent bien. Cependant, il
ne suffit pas d'entrer une téte de cheval et I'outil ne peut pas récupérer les coordonnées de l'objet -
veuillez en tenir compte. Une fois que l'outil a récupéré votre objet, cliquez sur le bouton Get et les
coordonnées de déclinaison et d'ascension droite seront mises a jour dans
PhotometricColorCalibration.

Veuillez noter que le PhotometricColorCalibration utilisera les coordonnées de déclinaison et
d'ascension droite saisies en méme temps qu'une estimation de votre champ de vision pour résoudre
votre image. Cela suppose toutefois que le champ de vision se situe autour des coordonnées de
déclinaison et d'ascension droite de votre cible, c'est-a-dire que ces coordonnées sont le centre de
votre champ de vision. C'est pourquoi il est préférable de choisir un objet qui se trouve au centre ou
prés du centre de votre image (il y a une certaine marge de manceuvre pour que la résolution soit
correcte).

S'il n'y a pas d'objet au centre ou prés du centre de votre image, vous devez déterminer les
coordonnées réelles de déclinaison et d'ascension droite du centre de votre image. Pour cela, vous
pouvez télécharger I'image sur Astrometry.net pour sa résolution. Il est conseillé de télécharger
une seule image brute. Si vous travaillez avec une mosaique qui comporte un panneau au centre,
téléchargez une seule brut & partir de ce panneau central. Si votre mosaique n'a pas de panneau
central, vous pouvez télécharger un canal prétraité de votre mosaique terminée, mais en télécharger
un sans aucun post-traitement (toujours a I'état linéaire). Une fois I'image téléchargée, la résolution
sera automatiquement. Une fois le téléchargement terminé, la page indiquera "Success" et vous
pourrez acceder a la page des résultats. Dans la colonne de droite de la page de résultats, vous
trouverez les coordonnées du centre de votre image téléchargée.

Dans mon cas, comme la nébuleuse de la Téte de cheval est si proche du centre de l'image, les
coordonnées sont tres proches. Cependant, aprés avoir pris la peine de résoudre I'image en ligne, je
peux aussi bien mettre a jour mes coordonnées pour qu'elles correspondent au vrai centre.

Ensuite, nous devons fournir a PhotometricColorCalibration |'échelle du pixel de l'image. Si vous
n'utilisez pas DrizzleIntegration pendant le prétraitement (qui augmente artificiellement la résolution
de vos images), alors la saisie de la distance focale de votre télescope et de la taille en pixels de
votre appareil photo fera parfaitement l'affaire. Dans mon cas, cependant, jai également utilisé
Drizzlelntegration pour le prétraitement. Astrometry.net a calculé que mon échelle de pixels était de
1,04 arcsecondes/pixel alors qu'en réalité elle est le double, 2,08 arcsecondes/pixel. Tout cela
signifie que si j'entre la longueur focale correcte du télescope de 450 mm et la taille de pixel correcte
de 4.54um, PhotometricColorCalibration ne parviendra pas a résoudre l'image car |'échelle de pixel
sera considérablement différente de celle de l'image ci-dessus.

La meilleure fagcon de contourner ce probleme est d'entrer la taille correcte en pixels de votre
appareil photo, dans mon cas 4.54um. Ensuite, pour la longueur focale du télescope, vous devez
entrer une valeur plus élevée en fonction du parameétre DrizzleIntegration que vous avez utilisé.
Comme j'utilise toujours Drizzlelntegration a x2, I'échelle de pixels de I'image résultante est la moitié
de la valeur réelle, telle que mesurée par Astrometry.net. Pour obtenir la moitié de I'échelle des
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pixels, au lieu d'entrer ma distance focale réelle de 450 mm, j'entre 900 mm. Sinon, je pourrais entrer
450 mm pour la distance focale mais la moitié de la taille du pixel, 2.27uym. Dans tous les cas, cela
donnera une échelle de pixels correcte de 1,04 arcsecondes/pixel et permettra a la fonction
PhotometricColorCorrection de fonctionner correctement.

Enfin, il suffit de modifier, si nous le voulons, la référence blanche utilisée par
PhotometricColorCalibration. La valeur par défaut de Average Spiral Galaxy est en fait celle
recommandée par PixInsight, car elle semble fournir les meilleurs résultats globaux. Vous pouvez
cependant essayer la Galaxie Elliptique ou celle qui devrait donner une bonne balance des blancs,
G2V Star. Pour linstant, je vais garder la Galaxie spirale moyenne sélectionnée par défaut. Le
serveur de base de données par défaut devrait faire le travail (c'est la que le processus téléchargera
les fichiers d'index astrométriques de résolution de plaques pour résoudre votre image avec). Si,
lorsque vous lancez le processus, la résolution échoue parce qu'elle ne peut pas télécharger les
fichiers d'index astrométriques, il suffit de changer le serveur de base de données pour autre chose.
Nous lan¢ons maintenant le processus et vérifions le résultat final.

Le résultat final semble excellent et tres naturel. Vous remarquerez qu'une série de graphiques
s'affichent, qui vous montrent a quel point les données de calibrage des couleurs correspondent aux
références utilisées. Vous pouvez fermer la fenétre des graphiques si vous le souhaitez.

Si la résolution astrométriquez a échoué, nous pouvons ajuster certains parametres de
PhotometricColorCalibration pour l'aider a fonctionner. Si vos étoiles sont lIégerement déformées,
vous pouvez activer Distortion correction sous Plate Solving Parameters. Si vous souhaitez que le
processus détecte davantage d'étoiles, vous pouvez développer la section Advanced Plate Solving et
faire glisser le curseur Log(sensivity) jusqu'a la gauche pour que la valeur soit de -3,00 (cette valeur
est plus sensible a la détection d'étoiles car il s'agit d'une échelle logarithmique). Si votre image
contient également beaucoup de bruit, vous pouvez augmenter la réduction du bruit a 1 afin que la
premiére couche de pixels (ou réside la grande majorité du bruit a petite échelle) soit ignorée dans la
détection des étoiles.

Voici les résultats finaux produits par PhotometricColorCalibration sur la base des trois principales
options de référence du Blanc - Galaxie spirale moyenne, Galaxie elliptique et Etoile G2V,
respectivement. Aprés chaque option, j'ai effectué un étirement automatique pour montrer le résultat
réel.

Il vaut certainement la peine d'essayer ces trois options de référence pour le blanc, ainsi que le
processus ColorCalibration décrit précédemment. Une fois que vous étes satisfait de I'étalonnage
des couleurs effectué, nous passons a l'élimination de la dominante verte qui est probablement
présente dans votre image.

4. Suppression du bruit vert avec SCNR

Il est assez courant d'avoir une couleur verte sur les images, mais comme nous le savons, en
général, les objets de I'espace lointain ne sont pas de couleur verte (il existe certaines nébuleuses
planétaires qui ne seraient pas d'accord avec cette affirmation !) Bien que certaines images ne
montrent pas une tres forte dominante verte, celle-ci est parfois clairement visible en zoomant.

Pour supprimer ce bruit vert, il est facile de le faire avec le processus SCNR.

SCNR est I'un de ces processus que vous pouvez appliquer et oublier, car il est simple a utiliser. Les
parameétres par défaut fonctionnent extrémePent bieq dans la grande majorité des cas, Average
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Neutral étant sélectionné sous Protection method et Green étant sélectionné sous la couleur a
supprimer. La valeur peut étre laissée a 1,00 si vous souhaitez conserver l'image colorée sans buit
vert, ou étre inférieure si vous souhaitez un mélange entre l'image colorée traitée et I'image originale
(par exemple, 0,50 vous donnera un résultat final qui correspond a 50 % de I'image originale avec 50
% de l'image traitée). Maintenez Preserve lightness activée afin de ne pas modifier la luminosité de
limage. Un simple clic sur le bouton Apply avec les parametres par défaut donne une nette
différence (apres une nouvelle application de I'étirement automatique).

Mais dans la plupart des cas, vous souhaiterez peut-étre conserver une partie du vert afin de
préserver les belles couleurs de sarcelle fournies par certaines nébuleuses planétaires. Si vous
souhaitez le faire, au lieu de Average Neutral sélectionné sous Protection method, sélectionnez
Maximum Neutral. C'est tout ce qu'il y a a faire. Vous trouverez ci-dessous le résultat avec Maximum
Neutral.

Bien sdr, la différence est tres faible pour cette image, mais choisissez celle qui correspond le mieux
a votre goQt et a votre image particuliéere.

Cela conclut toute la procédure de calibrage des couleurs avec un résultat final trés efficace qui a
I'air tres naturel. Mieux encore, l'image est toujours a |'état linéaire, préte pour un post-traitement
ultérieur (par exemple, réduction du bruit, étirement, amélioration du contraste, etc.) Nous terminons
maintenant par une bréve discussion sur la fagon dont le calibrage des couleurs s'applique aux
images a bande étroite.

5. Notes sur les images a bande étroite

Le Narrowband peut généralement étre utilisée de deux maniéres :

1. Pour produire des images a bande étroite avec de fausses couleurs (par exemple, la palette
Hubble).

2. Pour améliorer un canal de couleur spécifigue d'une image couleur RVB réguliére (par
exemple, H-Alpha dans le canal Rouge).

Examinons chacun des canaux énumérés ci-dessus séparément.

D'abord, les images a bande étroite avec de fausses couleurs. On dit que ces images ont des
couleurs fausses tout simplement parce que les images monochromes utilisées pour produire I'image
couleur n'échantillonnent pas du tout une grande partie du spectre. Les largeurs de bande des filtres
a bande étroite utilisés pour leur capture varient généralement entre 8,5 nm et 3 nm, ce qui
représente une partie minuscule du spectre. De plus, certains des filtres utilisés échantillonnent des
raies spectrales trés proches les unes des autres dans le spectre. Par exemple, la célébre palette de
Hubble utilise une image de soufre Il dans le canal rouge, une image d'hydrogene alpha dans le
canal vert et une image d'oxygéne lll dans le canal bleu. Si I'on peut dire que le soufre Il se trouve
dans la partie rouge du spectre, il en va de méme pour I'hydrogéene alpha ! L'image Oxygéne-lll est
également plus sarcelle, car elle se situe entre le vert et le bleu. Le résultat final de la combinaison
des couleurs de ces images monochromes a bande étroite ne va pas donner un ensemble de
couleurs réalistes pour l'objet de I'espace profond.




Ce n'est pas un probleme, vraiment, et en fait les gens ont inventé toutes sortes de palettes
intéressantes pour combiner différentes images monochromes a bande étroite en une image couleur.
Il'y a un équilibre entre la valeur scientifique (par exemple, les distributions de gaz spécifiques) et la
valeur artistique (est-ce que ca a l'air bien et est-ce que ca attire l'attention ?). Il est certain que
certains produisent méme des images en couleur a partir de deux images monochromes a bande
étroite, généralement H-Alpha et Oxygéene-Ill (c'est ce qu'on appelle la palette bicolore). Il va sans
dire que I'étalonnage des couleurs n'‘est méme pas un concept qui intervient dans ce type d'image.
BackgroundNeutralization est le seul processus nécessaire, effectué dés que les images
monochromes sont combinées en couleur. En fait, la neutralisation de I'arriere-plan est nécessaire si
vous voulez voir a quoi ressemble I'image combinée des couleurs.

Deuxiemement, des images monochromes a bande étroite combinées a des canaux d'images
couleur RVB réguliers. Les images en couleurs RVB ordinaires nécessitent la procédure
d'étalonnage des couleurs décrite dans ce tutoriel. Cependant, lorsque vous combinez une image
monochrome a bande étroite avec un canal de couleur spécifique, cet étalonnage des couleurs est
perdu. Essayer de calibrer a nouveau les couleurs est en fait contre-productif car une partie
importante des améliorations apportées par les données a bande étroite sont perdues lorsque vous
calibrez a nouveau les couleurs. Cependant, comme pour les images a bande étroite, l'utilisation du
BackgroundNeutralization en soi présente de grands avantages pour neutraliser l'arriere-plan tout en
conservant les améliorations apportées par les données a bande étroite.

En résumé, voici ce qu'il faut faire avec les images a bande étroite en ce qui concerne le calibrage
des couleurs :

 Pour les images a bande étroite, une fois les couleurs combinées, utilisez uniquement
BackgroundNeutralization, conformément a la section 1 de ce tutoriel.

e Pour les images a bande étroite utilisées pour améliorer les canaux de couleur dans une
image couleur RVB normale, des que vous produisez l'image couleur RVB, calibrez la couleur
conformément & I'ensemble de ce tutoriel, puis combinez-la avec I'image a bande étroite. Une
fois que I'image a bande étroite a été combinée avec I'image couleur RVB, utilisez uniquement
BackgroundNeutralization, comme indiqué dans la section 1 de ce tutoriel.

o Ceci devrait résumer la relation entre le calibrage des couleurs et les images a bande étroite.




VI. Produire des masques

Quiconque a déja traité des images auparavant, que ce soit dans PixInsight ou Photoshop,
comprendra l'importance des masques. Il s'agit d'images de taille identique qui servent de protection.
Par exemple, vous pouvez post-traiter une image d'une galaxie entourée d'étoiles et avec beaucoup
de fond. Lorsque vous appliquez une réduction de bruit, l'intention est normalement de I'appliquer a
I'arriére-plan et non a la galaxie. Un masque peut étre utilisé dans cette situation, pour protéger la
galaxie de l'application de votre technique de réduction du bruit. De méme, il peut étre utilisé pour
protéger l'arriere-plan contre les augmentations de la netteté, car vous pouvez ne vouloir affiner que
les détails fins dans la galaxie elle-méme.

Les masques sont utilisés dans de nombreuses étapes du post-traitement et PixInsight dispose d'un
certain nombre de procédés et de techniques qui vous permettent de produire des masques.
Différents masques peuvent étre utilisés pour différentes étapes du post-traitement et pour
I'application de différentes techniques. Ce tutoriel couvre un certain nombre de fagons de produire un
masque dans PixInsight ainsi que la facon de les modifier pour les rendre plus appropriés. Pour
chaque méthode proposée pour la production d'un masque, un ensemble de suggestions est donné
pour savoir ou ce type de masque est le plus applicable.

Pré-supposé pour ce tutoriel :

e Connaissance du fonctionnement de PixInsight, en rapport avec le traitement des images, les
processus et le travail avec les masques (Lire ce qui suit, sections 3, 4 et 6).

e Vos images ont déja été entierement prétraitées (Lire ceci).




Produire des masques en dupliquant des images monochromes

+ Fonctionne aussi bien avec des images linéaires que non linéaires.
+ Peut étre produit avec tres peu d'efforts.

+ Offre des degrés de protection variables en fonction de la luminosité de l'image dans différentes
zones, ce qui est parfait pour la réduction globale du bruit.

+ Comprend tout - les étoiles, la nébulosité et les galaxies.

- n'est pas sélectif de structures particuliéres car il s'agit d'une simple copie.

Lorsqu'on travaille avec des images monochromes comme une image de luminance, on peut
produire trés rapidement un masque, qui remplit trés bien son réle pour la réduction initiale du bruit.
Voici une image monochrome a luminance linéaire ouverte dans PixInsight, auto-étirée.

Nous pouvons produire un masque efficace en faisant un clic droit sur lI'image et en cliquant sur
Duplicate.

L'étirement automatique est également dupliqué par défaut, mais je le réinitialise sur l'image
dupliguée. Une image a l'état linéaire n'a pas, par définition, beaucoup de contraste. Une image
masque devient plus efficace lorsqu'il y a beaucoup de contraste, car le blanc pourrait protéger
complétement et le noir ne protégerait donc pas du tout, les nuances de gris variant le degré de
protection. L'étirement automatique n'altére pas l'image et nous devons donc appliquer I'étirement
automatigue de maniére permanente. Pour ce faire, nous ouvrons le processus
ScreenTransferFunction, responsable de I'étirement automatique. Une fois le processus ouvert, nous
sélectionnons l'image en double et cliquons sur le bouton d'étirement automatique.

Nous devrons transférer ces parametres d'étirement stockés dans ScreenTransferFunction vers
HistogramTransformation, le processus responsable de la production d'étirements permanents. Pour
ce faire, nous ouvrons le processus HistogramTransformation

(en maintenant ScreenTransferFunction ouverte) et faites glisser le bouton "New instance" de la
fonction ScreenTransferFunction sur la barre inférieure de la fonction HistogramTransformation.

Nous pouvons maintenant supprimer [I'étirement automatique de [Iimage dupliquée de
ScreenTransferFunction en cliguant sur son bouton Reset, puis sur Apply sur
HistogramTransformation avec l'image dupliquée sélectionnée. Ceci appligue le méme étirement
mais de maniere permanente.

Les processus ScreenTransferFunction et HistogramTransformation peuvent étre fermés deés
maintenant. L'image dupliquée est maintenant une image de masque préte. En l'appliquant a I'image
luminance linéaire, on peut voir comment elle protéege avec des degrés d'intensité variables selon la
luminosité d'une zone de l'image.

Il peut étre utilisé comme un masque extrémement efficace pour la réduction du bruit. Vous devrez
inverser le masque lorsqu'il sera appliqué afin d'attaquer le fond plus que les zones a haut signal.

Si votre image originale est déja non linéaire parce qu'elle a été étirée, vous pouvez simplement la
dupliguer et l'image de votre masque sera instantanément préte a I'emploi (étant une copie de
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l'original, elle est déja étirée et non linéaire, fournissant le contraste élevé nécessaire pour agir
comme un masque efficace).

2. Produire des masques en extrayant la luminosité d'images en couleur

+ Fonctionne aussi bien avec des images linéaires que non linéaires.
Peut étre produit avec trés peu d'efforts.

+ Offre des degrés de protection variables en fonction de la luminosité de l'image dans différentes
zones, ce qui est parfait pour la réduction globale du bruit.

+ Comprend tout - les étoiles, la nébulosité et les galaxies.
- n'est pas sélectif de structures particulieres d'intérét car il s'agit d'une simple copie.

Les masques fonctionnent mieux lorsqu'ils sont simplement des images monochromes. Si vous
travaillez déja avec une image couleur, vous devrez en extraire une image monochrome de
luminance pour l'utiliser comme masque. Il se peut que vous ayez une image en couleur car :

1. vous l'avez capturé avec un appareil photo CCD couleur ou un appareil photo DSLR,

2. vous avez déja combiné les images monochromes Rouge, Vert et Bleu en une image couleur
RVB,

3. soit vous avez produit une image couleur RVB a partir dimages monochromes a bande
etroite.

Dans les deux cas, le masque devrait idéalement étre monochrome. Vous trouverez ci-
dessous une image couleur RVB linéaire ouverte dans PixInsight, auto-étirée.

Votre image couleur peut ou non avoir été calibrée a ce stade - le processus d'extraction d'une image
de luminance pour faire office de masque est le méme quoi qu'il arrive. Nous devons d'abord indiquer
a PixInsight que les trois canaux de couleur, rouge, vert et bleu, de notre image couleur RVB sont
pondérés de maniére égale et compléte pour I'extraction d'une image de luminosité. Ceci est fait
avec le processus RGBWorkingSpace.

Il suffit d'entrer 1.0 dans les trois cases (pour le rouge, le vert et le bleu) ou de faire glisser les
curseurs jusqu'a la droite. Une fois que vous avez terminé, cliquez sur le cercle Apply Global et
fermez-le.

Nous utilisons maintenant le processus ChannelExtraction, réglé sur le mode CIE L*a*b*.

Comme nous ne voulons qu'extraire la luminance de cette image, nous désactivons a et b et ne
laissons que L activé. Une fois que vous avez terminé, cliquez sur Apply.

Comme notre image couleur RVB est toujours linéaire, I'image de luminance extraite est également
linéaire. Elle a été automatiquement étirée dans la troisieme capture d'écran ci-dessus pour
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démontrer sa nature monochrome. Ce sera notre image de masque, mais pour maximiser son
efficacité, elle doit étre étirée de facon permanente plutdt qu'auto-étirée, exactement comme sur la
section 1 ci-dessus. Nous réinitialisons I'étirement automatique ici et utilisons ensuite le processus
ScreenTransferFunction pour produire un étirement automatique en cliquant sur son bouton Auto
Stretch.

Nous devons maintenant transférer ces parametres d'étirement stockés dans
ScreenTransferFunction vers HistogramTransformation, qui produira I'étirement permanent. Pour ce
faire, ouvrez HistogramTransformation, puis faites glisser le bouton New Instance de
ScreenTransferFunction sur la barre inférieure de HistogramTransformation.

Nous cliguons maintenant sur Reset dans ScreenTransferFunction pour supprimer [|'étirement
automatique et sur Apply dans HistogramTransformation pour appliquer I'étirement de fagon
permanente.

Les processus ScreenTransferFunction et HistogramTransformation peuvent maintenant étre fermés
et notre image monochrome Luminance est préte a étre utilisée comme masque. En l'appliquant a
notre image couleur RVB, on obtient un bon niveau de protection en fonction de la luminosité dans
des zones particulieres. Comme l'image Luminance a été extraite avec les trois canaux de couleur
ayant leur pondération complete et égale, elle représente une évaluation juste de la luminosité
variable de I'image et peut donc étre utilisée comme un masque.

Il peut étre utilisé comme un masque extrémement efficace pour la réduction du bruit. Vous devrez
inverser le masque lorsqu'il sera appliqué afin d'attaquer le fond plus que les zones a haut signal.

Si votre image originale est déja non linéaire parce qu'elle a été étirée, vous pouvez simplement
extraire une image de Luminance et ne pas vous soucier de I'étirer car I'image de votre masque sera
déja étirée et sera donc instantanément préte a étre utilisée.

3. Produire des masqgues avec StarMask

+ Fonctionne aussi bien avec des images linéaires que non linéaires.
+ Exclut trés efficacement les grandes structures et ne conserve que les étoiles.

+ Peut produire des étoiles lisses pour une bonne protection, des noyaux des étoiles jusqu'aux bords
extérieurs.

+ Peut produire des masques de contour d'étoile afin de réduire leur taille.

+ Peut étre combiné efficacement avec d'autres images de masques pour personnaliser la
protection.

- Cela peut nécessiter un certain nombre de modifications pour obtenir les meilleurs résultats.

- Il peut parfois étre difficile d'inclure certaines étoiles au-dessus de nébulosité trés brillante ou de
structures galactiques.




Le procédé StarMask est tout a fait capable de produire des images de masque pour la protection
des étoiles, ou peut-étre pour attaquer les étoiles seules (par exemple pour la saturation des
couleurs ou pour réduire la taille des étoiles). La configuration de ce processus est rapide une fois
gue vous savez ce que chaque parameétre fait et que vous l'expérimentez vous-méme. Vous
trouverez ci-dessous notre exemple dimage monochrome a luminance linéaire, auto-étirée dans
PixInsight paralléelement au processus StarMask :

Pour produire une image de masque d'étoile, nous devons garder Working mode réglé sur Star Mask
par défaut. Le premier parametre, Noise Threshold, est tres important. Il définit le seuil de bruit. S'il
est réglé trop bas, les taches de bruit autour de I'image peuvent étre captées comme s'il s'agissait de
petites étoiles. S'il est réglé trop haut, les étoiles faibles valides seront ignorées. La meilleure facon
de régler ce paramétre est de vérifier votre image avec Readout Preview. Pour ce faire, zoomez sur
votre image, effectuez un panoramique sur une section avec de petites étoiles péles que vous
souhaitez inclure dans votre image de masque d'étoile et maintenez le bouton gauche de la souris
enfoncé. Effectuez cette opération sur le coeur des petites étoiles pales que vous souhaitez inclure.

Comme l'image est monochrome, le paramétre de luminosité K indiqué dans Readout Preview nous
donne une valeur a viser. Cette valeur, légerement inférieure, inclura des étoiles comme celles-ci
dans limage de masque d'étoile générée. Il est évident qu'avec une valeur aussi faible que 0,009, il
est possible que des taches de bruit soient également présentes dans votre image de masque
stellaire. C'est une chose que vous pouvez modifier - testez-la et si elle ne convient pas, augmentez-
la un peu. En regardant votre image avec l'apercgu de lecture, vous pouvez vérifier la luminosité réelle
de vos taches de bruit.

Si vous avez affaire a une image en couleur, au lieu de K, votre apercu de lecture affichera trois
valeurs, pour R, G et B. Il s'agit des niveaux de luminosité correspondant a chaque canal de couleur.
Il est un peu plus difficile de choisir une valeur de seuil de bruit parmi celles-ci, mais vous pouvez
choisir d'utiliser la plus petite des trois valeurs qui vous sont données (R, G ou B) ou de prendre une
moyenne des trois et de l'utiliser. Vous pouvez également produire une image de luminosité a partir
de votre image couleur, comme détaillé dans la section 2, et utiliser cette image de luminosité pour
produire votre image de masque d'étoile avec StarMask.

En réglant le seuil de bruit de mon image a 0,009 et en gardant le reste par défaut, j'applique le
processus a mon image pour voir ce qui en ressort.

Veuillez noter que, que votre image originale soit linéaire ou non, limage du masque stellaire
produite par le procédé StarMask sera étirée, ce qui est parfait car elle est effectivement préte a étre
appliguée comme masque. En inspectant I'image produite, le StarMask a détecté beaucoup d'étoiles,
mais il semble avoir raté beaucoup de petites étoiles peu lumineuses, du moins d'apres ce que nous
pouvons voir ci-dessus. Un examen plus approfondi montre que ces étoiles ont effectivement éte
captées mais qu'elles sont trés, tres faibles dans I'image du masque stellaire. Une facon de remédier
a ce probleme dés le début est de réajuster le parametre Midtones du processus StarMask. Si hous
diminuons ce parametre, nous étirons effectivement I'image du masque stellaire lorsqu'elle est
produite. Des valeurs de 0,25 a 0,1 ont tendance a bien fonctionner, mais vous pouvez souhaiter
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descendre jusqu'a 0,05 pour en tirer le maximum d'étoiles. N'en faites pas trop, car certaines des
taches de bruit les plus brillantes de votre image originale captées par le StarMask commenceront a
apparaitre.

Ce qui précede représente une excellente image de masque d'étoile a utiliser pour protéger (ou
attaquer) les étoiles de l'image. Si vous constatez que les plus grandes étoiles semblent avoir été
exclues de votre image de masque d'étoile, vous devrez augmenter légerement le paramétre Scale.
Une valeur de 6 ou 7 peut suffire, mais si elle est trop grande, vous pourriez commencer a voir des
structures nébuleuses apparaitre dans votre image de masque d'étoile, surtout si vous étirez I'image
de fagon agressive avec le paramétre Midtones comme je l'ai fait ci-dessus. A linverse, si vous
diminuez I'échelle, vous ignorerez les plus grandes étoiles. Le réglage par défaut de 5 fonctionne trés
bien pour la plupart des tailles d'étoiles, mais ne permet normalement pas de voir de tres grandes
étoiles dans vos images.

En examinant de prés votre image de masque d'étoile, vous remarquerez peut-étre que les étoiles
peuvent apparaitre un peu plus grandes dans limage de masque d'étoile que dans votre image
originale. Bien que cela puisse généralement étre utile, en raison de la bonne protection des halos
d'étoiles faibles et des zones environnantes, vous pouvez souhaiter étre plus brusque dans la fagon
dont les étoiles sont protégées (ou attaquées). C'est le travail des parameétres de croissance de la
structure dans StarMask. Pour que les plus grandes étoiles captées augmentent encore de taille,
augmentez le parametre Large scale. Si vous voulez que les plus grandes étoiles captées diminuent
de taille, diminuez le paramétre Large scale, ou mettez-le a 0 pour forcer ces étoiles a conserver leur
taille d'origine.

La taille des étoiles a clairement été réduite. On peut faire exactement la méme chose avec les plus
petites étoiles captées en modifiant de la méme facon le réglage Small-scale. Le parametre
Compensation peut également étre utilisé pour modifier la taille des petites étoiles de la méme
maniere, bien que ce parameétre puisse étre laissé a la valeur par défaut de 2 la plupart du temps.
Les réglages Large scale, Small-scale et Compensation doivent étre réglés en méme temps que
Midtones, pour aider a faire ressortir les étoiles. Vous pouvez également utiliser
HistogramTransformation pour étirer I'image du masque stellaire apres sa production par StarMask.
Etant donné qu'un réglage a grande échelle de 2, un réglage a petite échelle de 1 et un réglage de
compensation de 2 ont bien fonctionné pour mon image, je les laisse tels quels.

Smoothness est un autre parametre qui peut étre modifié. Cela permet de modifier la netteté des
étoiles reproduites dans I'image du masque stellaire. Si vous diminuez la valeur, vous obtenez des
etoiles qui apparaissent plus nettes, moins lisses sur le fond et avec des bords plus nets. Cela peut
étre utile pour soustraire I'image du masque d'étoile d'une autre image de masque, pour éliminer
efficacement les étoiles du masque. La combinaison des images de masque est le sujet d'une
discussion dans une section ultérieure. En général, la valeur par défaut de 16 fonctionne tres bien.
Modifiez cette valeur en fonction de vos besoins.

Il'y a deux paramétres importants a cocher dans StarMask que nous devons couvrir. L'activation de
Binarize transformera tout ce qui est sélectionné par StarMask en blanc pur - pas de transitions
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douces d'aucune sorte, que ce soit en noir pur ou en blanc pur. Cependant, une fois que cela est fait,
I'image est lissée selon votre réglage de Smoothness et cela permet d'obtenir un certain niveau de
transitions douces dans l'image de votre masque stellaire.

L'image du masque d'étoile est nettement plus lumineuse dans I'ensemble, ce qui peut étre trés bien
guand on veut étre tres protecteur des étoiles. Comme nous l'avons déja dit, il peut étre nécessaire
d'augmenter Smoothness pour produire une belle image de masque lissée. Vous remarquerez que
j'ai d0 augmenter Noise Threshold a 0,1 pour le résultat ci-dessus. Cela s'explique par le fait que tout
ce qui est capté par StarMask est binarisé avec ce paramétre active, ce qui signifie qu'il transformait
les tres, trés faibles points de bruit captés en pixels blancs purs avant le lissage. Le résultat final était
une image blanche assez simple en raison du réglage agressif du seuil de bruit de 0,009 que
jutilisais auparavant.

L'autre parametre important a cocher dans StarMask est Contours. Activer cette option ne produira
pas une image de masque d'étoile - elle produira une image de masque de contour d'étoile. Le
lissage devra cependant étre réduit de maniére significative, car sinon les contours produits sont trop
lissés et ils finissent par ressembler a de véritables étoiles. En regle générale, il convient également
de réduire la taille de I'image a grande et a petite échelle, ou de la mettre a zéro, car cela garantira
que les contours des étoiles produites ont bien la taille prévue et ne seront pas non plus lissés.

Notez & nouveau que Noise Threshold a été augmenté a 0,1 pour obtenir I'image du masque de
contour des étoiles produite ci-dessus. Ceci était nécessaire pour éviter de produire des contours
autour de tout, y compris des taches de bruit. La section suivante est une section zoomée pour
montrer les contours de I'étoile :

Ce type de masque est trés utile pour réduire la taille des étoiles. Les contours cernent efficacement
les étoiles pour réduire leur taille.

D'une maniere générale, un masque d'étoiles peut étre trés, tres utile et vous en aurez sans doute
besoin a un moment donné. La protection des étoiles contre I'application de certains procédés peut
étre critique.

Une derniére remarque concernant l'utilisation de StarMask : lorsque l'image originale pour laquelle
vous essayez de créer une image de masque d'étoile est étirée (non linéaire), les mémes parameétres
peuvent ne pas s'appliquer. Plus précisément, le seuil de bruit change considérablement et vous
devrez revoir votre image pour obtenir un bon réglage. La valeur par défaut de 0,1 fonctionne bien
avec la plupart des images étirées, mais vous devrez peut-étre I'augmenter a 0,15 ou méme 0,2 pour
vraiment exclure le bruit et les structures nébuleuses brillantes, et n'inclure que les étoiles.

Quoi qu'il en soit, nous pouvons constater que StarMask est a la fois tres puissant et trés
personnalisable, malgré le nombre relativement limité d'options qu'il présente a l'ouverture. Ces
masques sont extrémement utiles, seuls ou en combinaison avec d'autres masques, pour ajouter ou
supprimer la protection des étoiles.




4. Production de masques avec RangeSelection

+ Peut étre produit avec peu d'efforts.

+ Offre des degrés de protection variables en fonction de la luminosité de I'image dans les différentes
zones.

+ Comprend tout - les étoiles, la nébulosité et les galaxies.
+ Exclut trés efficacement l'arriere-plan, en fonction des parametres de I'utilisateur.
+ Peut étre sélectif dans ce qui est réellement inclus, mais cela dépend uniquement de la brillance.

- Ne peut pas exclure les étoiles par lui-méme, ce qui rend son utilisation impropre a I'amélioration du
contraste de la nébulosité (si elle est utilisée par lui-méme).

- Ne fonctionne bien que sur des images non linéaires (étirées).

RangeSelection est un excellent procédé pour produire des images de masque a partir de simples
informations de luminosité sur I'ensemble de l'image, avec de belles transitions lissées entre les
détails fins. Le probléme est qu'en raison de son mode de fonctionnement (sélection des valeurs de
luminosité), il fonctionne rarement avec des images linéaires et exige que vous étiriez votre image
pour la rendre non linéaire avant d'utiliser la sélection de plage. Voici une image monochrome étirée
non linéaire de Luminance ouverte dans PixInsight avec RangeSelection ouverte a coté :

Ce processus nécessite pratiquement que nous utilisions I'apercu en temps réel pour en tirer le
meilleur parti, c'est pourquoi nous le rendons possible.

Par défaut, tout apparaitra en blanc car la plage par défaut de la limite inférieure a 0 et de la limite
supérieure a 1 inclut I'image entiere. Ces parametres définissent la part de l'image qui est prise en
compte pour limage du masque. La fagon de le personnaliser est de faire glisser le curseur Lower
limit vers la droite, petit a petit (ou d'entrer des valeurs légérement plus grandes a chaque fois).

Ce faisant, vous remarquerez que de plus en plus de zones de l'image deviennent noires et vous
verrez apparaitre les détails de votre objet. Si vous allez trop loin, tout devient noir. Cependant, dans
I'état actuel des choses, lI'image du masque est assez nette et les images nettes font rarement de
bons masques car les transitions douces entre les éléments sont une bonne chose. Pour cela, il suffit
d'augmenter les parametres Fuzziness et Smoothness. Ce qui suit est avec le parametre Fuzziness
réglé a 0,15 et le paramétre Smoothness réglé a 5 :

Une fois que vous aurez modifié les parametres "Fuzziness" et "Smoothness", vous devrez peut-étre
modifier Lower limit pour inclure des détails supplémentaires (en diminuant légerement Lower limit).
Essayez les trois réglages pour obtenir un masque qui vous montre ce que vous voulez protéger (ou
attaquer), quel que soit le but pour lequel vous souhaitez utiliser cette image de masque.




Une fois que vous étes satisfait, fermez la fenétre de Real-Time Preview et appliquez le processus a
votre image pour produire l'image du masque.

Vous remarquerez peut-étre que les noyaux des étoiles les plus brillantes sont noirs en raison de
votre réglage de Fuzziness. Ce réglage est bon pour lisser les détails fins de votre image de masque
afin de produire des degrés de protection plus variés, mais il a l'inconvénient d'exclure certaines
zones saturées comme les noyaux d'étoiles brillantes. Il est toutefois facile de corriger ce probleme
en le combinant avec une image de masque d'étoile, ce qui fait I'objet de la section suivante.

Ce qui suit montre a quel point ce masque peut protéger les zones a faible signal comme le fond, ou
les zones a signal élevé comme la nébulosité et les étoiles brillantes.

Enfin, si votre image est linéaire et que vous souhaitez utiliser RangeSelection, vous pouvez
simplement dupliquer votre image, appliquer les parametres d'étirement automatique comme un
étirement permanent en utilisant HistogramTransformation, puis créer votre image de masque avec
RangeSelection sur cette copie non linéaire. L'image du masque peut ensuite étre appliquée a votre
image linéaire tout de méme. Vous pouvez essentiellement appliquer les techniques décrites dans
les sections 1 et 2 ci-dessus pour obtenir un duplicata monochrome non linéaire pour créer votre
image de masque.

5. Modifier et combiner les masques

+ En fonction de ce qui est utilisé (c'est-a-dire pas RangeSelection), cela peut fonctionner avec des
images linéaires et non linéaires.

+ Peut combiner plusieurs images de masque tres différentes en une seule qui est plus efficace pour
la tache a accomplir.

+ Peut offrir les avantages de plusieurs types d'images de masque, tels que différents degrés de
protection et I'exclusion des étoiles.

+ Extrémement efficace pour la tache a accomplir, en fonction de I'effort de l'utilisateur.

- Selon les besoins, peut nécessiter des efforts pour la construction.
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Parfois, les images de masque en elles-mémes ne sont pas parfaitement adaptées a notre
application. Il peut étre nécessaire de les modifier ou de les combiner avec d'autres images de
masques pour produire quelque chose que nous pouvons réellement utiliser pour ce que nous
voulons faire. Cette section couvre un certain nombre de modifications différentes que I'on peut
appliquer aux images de masques et comment nous pouvons combiner les images de masques pour
produire une seule image de masque plus appropriée.

Pour couvrir une grande partie des techniques, proposons une situation. Vous avez une image dont
vous souhaitez améliorer le contraste dans la seule nébulosité. Pour cela, vous produisez une image
de masque avec la fonction RangeSelection pour sélectionner les parties les plus brillantes de la
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nébulosité, mais cela inclut malheureusement aussi les étoiles. Il suffit de créer une image de
masque d'étoile avec StarMask, de la soustraire de notre image de masque RangeSelection et le
tour est joué. Cependant, il reste quelques grandes étoiles au-dessus de la nébulosité que vous
voulez exclure, alors nous les peignons simplement avec CloneStamp pour les enlever et une fois
gue c'est fait, nous floutons l'image du masque combiné pour donner des transitions douces.

Commencgons par limage pour laquelle nous voulons créer un masque. Il s'agit d'une image
monochrome non linéaire :

Nous utilisons d'abord la fonction RangeSelection pour produire une image de masque n'englobant
que les parties les plus brillantes de la nébulosité, car c'est dans ces parties que nous voulons
améliorer le contraste.

Remarquez gu'il n'a pas été lissé de maniere agressive (Smoothness n'est réglée qu'a 2). C'est
parce que nous allons de toute facon flouter I'image plus tard. Nous avons mis cette image du
masque de RangeSelection sur le c6té pour une utilisation ultérieure. Pour l'instant, nous voudrions
exclure les étoiles de I'amélioration du contraste, tant celles qui se trouvent au-dessus de la
nébulosité brillante que celles qui se trouvent a I'extérieur et qui errent autour de l'arriere-plan. Pour
cela, nous utilisons StarMask sur notre image originale.

Par défaut, I'image du masque d'étoile apparait un peu faible, aussi nous allons I'étirer avec
HistogramTransformation.

Afin de maximiser l'effet de la soustraction de cette image de masque d'étoile de I'image de masque
RangeSelection, nous pouvons utiliser MorphologicalTransformation pour dilater un peu les étoiles et
augmenter leur taille globale. Le meilleur opérateur pour cela est MorphologicalTransformation, c'est
pourguoi nous la sélectionnons.

Pour obtenir de meilleurs résultats, augmentons la taille du filtre appliqué et donnons lui une forme
plus étoilée. Pour ce faire, sélectionnez 5 (25 éléments) dans Size et cliquez sur les trois carrés noirs
en haut, en bas, a gauche et a droite pour obtenir une forme d'étoile comme indiqué ci-dessous :

Si vous faites une erreur, vous pouvez maintenir la touche CTRL enfoncée et cliquer sur un carré
pour le rendre a nouveau noir. Une fois que vous avez termin€, nous attirons votre attention sur le
parametre de sélection. Un réglage de 0,50 n'a aucune incidence sur la taille des étoiles. Un réglage
inférieur a 0,50 diminue la taille des étoiles et un réglage supérieur a 0,50 augmente la taille des
etoiles. L'opérateur Morphological Selection est une combinaison d'érosion et de dilatation (il
s'applique aux deux en tandem avec des forces différentes pour produire un résultat final plus lisse et
plus dilaté qu'érodé, ou plus érodé que dilaté). Une sélection fixée a moins de 0,50 érode
essentiellement plus qu'elle ne dilate et, inversement, une sélection supérieure a 0,50 dilate plus
gu'elle n'érode. Vous souhaitez généralement éviter les valeurs extrémes comme 0 ou 1 en faveur
des décimales pour produire un certain niveau de dilatation et d'érosion, car I'effet combiné est plus
doux.

Nous fixons une valeur de 0,75 et augmentons les itérations a 3. La valeur peut étre modifiée a
qguelque chose comme 0,50 si vous souhait(laz que Ielrésultat final soit un mélange de 50% entre
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I'image originale et I'image modifiée. 0,30 mélangerait 30 % de l'image modifiée avec 70 % de
I'image originale. Comme il ne s'agit que d'une image de masque, nous gardons le montant a 1.

L'effet sur l'image du masque d'étoile est clair - la taille des étoiles a été augmentée en douceur.
Notre image de masque d'étoile étant préte, nous la mettons de c6té et ouvrons PixelMath, qui sera
utilisé pour combiner les deux images de masque en une seule.

Comme nous souhaitons créer une image entierement nouvelle en combinant les deux images de
masque, nous seélectionnons Create new image, puis nous sélectionnons Grayscale dans Color
space. Dans RGBI/K, nous tapons l'opération que nous souhaitons effectuer - soustraire I'image du
masque d'étoile de I'image du masque RangeSelection :

range_mask - star_mask
Cela produit alors le nouveau masque combiné suivant une fois que nous cliquons sur Apply :

La majorité des étoiles de fond ayant maintenant disparues, nous nous concentrons sur |'élimination
des étoiles les plus prononcées qui sont au-dessus de la nébulosité et qui n'ont pas été captées par
StarMask. Vous constaterez que les étoiles les plus prononcées ont déja un cercle noir présent dans
la nébulosité, mais cette zone d'exclusion est rarement suffisante car elles ne représentent
normalement que le noyau des étoiles, plutét que I'étoile entiere et son halo environnant (méme s'il
est petit). Nous allons maintenant utiliser CloneStamp pour découper des segments de l'image du
masque combiné - afin de produire une marque noire plus grande la ou se trouvent les étoiles
prononceées pour une meilleure protection.

Pour cela, nous devrons faire un zoom avant et un panoramique sur l'image. Nous inspectons une
étoile assez brillante que nous voulons enlever.

Nous allons cloner une zone noire de l'image au-dessus de cette étoile. Pour ce faire, maintenez la
touche CTRL enfoncée et cliqguez sur une zone purement noire. Il n'est pas nécessaire qu'elle soit a
proximité - vous pouvez faire un zoom arriere et le faire entierement ailleurs. Le Radius par défaut de
5 est trés petit pour cette étoile, je 'augmente donc a 30. Maintenant, il suffit de faire quelques clics
ici et la pour supprimer la zone qui correspond a cette étoile.

Ne vous inquiétez pas des transitions brutales que cela impliqgue. Nous flouterons toute lI'image du
masque combiné avant application afin que ces transitions soient bien lissées. Une fois satisfait,
cliquez sur le bouton Execute du programme CloneStamp pour appliquer l'opération a votre image.
Vous pouvez continuer votre mission de balayage pour trouver d'autres étoiles problématiques a
supprimer. Vous devrez peut-étre modifier le rayon pour qu'il soit plus grand ou plus petit selon votre
application de CloneStamp.

Nous nous intéressons maintenant a certaines des étoiles les plus visibles sur la nébulosité. Nous
savons ou elles se trouvent car elles apparaissent sous forme de cercles noirs dans la nébulosité.
Ces cercles noirs correspondent a leurs noyaux, mais nous avons besoin d'une zone d'exclusion plus
large pour les protéger de maniére adéquate.




Comme il n'y a pas de zone noire a proximité, nous devons effectuer un zoom arriére et faire notre
sélection par clic CTRL pour le clonage en dehors de cette zone. Une fois fait, nous fixons un rayon
approprié pour approximativement doubler la taille de ce cercle noir, nous visons le centre et
effectuons un simple clic.

Nous répétons ce processus pour les étoiles plus prononcées autour de nos zones nébuleuses
brillantes de I'image jusqu'a ce que nous estimions avoir une protection suffisante contre les étoiles.

Veillez a cliquer périodiguement sur Execute pour appliquer les modifications a votre image de
masque combiné.

Avec une meilleure protection globale des étoiles et une plus grande concentration sur les zones
nébuleuses brillantes de l'image, nous procédons maintenant au lissage de l'image du masque
combiné afin de supprimer les transitions brutales introduites par nos modifications. Le processus
choisi ici est la transformation ATrousWavelet.

Comme PixInsight travaille avec des couches d'ondelettes pour les images, chaque numéro de
couche représentant des structures de plus en plus grandes en taille de pixel, tout ce que nous
devons faire pour flouter l'image est de supprimer les détails sur les plus petites couches
d'ondelettes. Pour ce faire, nous laissons le parametre Layers sur la valeur par défaut de 4 et
sélectionnons simplement chacun d'entre eux et désactivons le Detail Layer pour les quatre numeéros
1, 2, 3 et 4. Vous pouvez également double-cliquer sur la coche verte a co6té des numéros de couche
pour les désactiver, ce qui les transforme en croix rouges. Assurez-vous de garder la couche R
(résiduelle) activée car elle représente le reste des couches d'ondelettes que nous n'avons pas
traitées. L'application de ce processus supprimera les détails des structures a petite échelle mais
conservera les structures a grande échelle intactes.

N'hésitez pas a appliquer le procédé deux ou méme trois fois pour obtenir un flou adéquat et une
protection plus adéquate de l'image du masque combiné.

Le résultat ci-dessus provient de l'application de ATrousWaveletTransform avec ces parametres
deux fois de suite. Cette image de masque combinée est maintenant préte a étre appliquée comme
masque a notre image.

Ce que nous voyons ici, c'est une protection tres adéquate du fond et des étoiles , y compris celles
au-dessus de la nébulosité, tout en nous permettant d'attaquer les zones nébuleuses brillantes. Ce
type de masque est excellent pour obtenir ce contraste supplémentaire sur les zones nébuleuses ou
galactiques brillantes d'une image sans nuire a l'arriere-plan ou aux étoiles, y compris les étoiles
situées au-dessus des zones d'intérét. Sa production nécessite un certain travail, mais le résultat
final en vaut généralement la peine.

Enfin, et en marge du flux de travail ci-dessus, nous passons a une simple modification qui peut étre
apportée aux images de masquage pour rendre leur fonction de protection plus prononcée. Imaginez
pour l'instant que nous ayons suivi la section 1 ou 2 et produit une image monochrome non linéaire
en double (ou Luminance) pour servir dimage de masque. La fonction HistogramTransformation a
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une fonction intéressante qui permet de découper les ombres et les lumieres pour rendre le tout plus
prononceé. Nous ouvrons d'abord le processus et sélectionnons notre image de masque dans la liste.

Les deux boutons qui nous intéressent sont Auto clip shadows et Auto clip highlights. Nous cliquons
sur les deux et les points noirs et blancs sur HistogramTransformation changent en fonction de
I'nistogramme affiché.

Cliguer sur Apply nous montre l'image de masque la plus prononcée produite en coupant les ombres
et les lumieres.

Cela permet de protéger plus efficacement les zones a haut signal, car elles sont plus éloignées de
l'arriere-plan, qui est lui-méme assez noir. De ce fait, Iimage de masque résultante peut étre
extrémement efficace pour la réduction initiale du bruit sur les zones d'arriére-plan d'une image.

En conclusion, nous renforcons l'idée que les masques sont essentiels au post-traitement d'une
image. Les procédés et techniques présentés ici produiront toutes sortes de masques applicables a
presque toutes les images, voire a toutes, selon les parametres de l'utilisateur pour les produire.




VIl. Réduction du bruit

La réduction du bruit est l'une des procédures considérées comme essentielles pour le post-
traitement des images. C'est également I'un des points forts de Pixinsight. Il existe un certain
nombre de procédés capables de réduire le bruit dans Pixinsight. Les principaux sont la
transformation linéaire multi-échelle, la transformation meédiane multi-échelle, I'ACDNR et le
TGVDenoise. ATrousWaveletTransform est classiquement excellent pour la réduction du bruit, mais
il est en train d'étre progressivement abandonné au profit de MultiscaleLinearTransform, plus
performant mais similaire. Chacune de ces méthodes est efficace en soi, mais les utilisateurs
peuvent choisir d'utiliser un procédé ou un autre, ou une combinaison de plusieurs procedés. Cette
analyse particuliére est utile pour déterminer les performances de chacun. Un point essentiel a
souligner des le début est que I'objectif est la réduction du bruit, et non son élimination. La meilleure
facon d'obtenir un faible niveau de bruit dans les images est simplement de capturer plus
d'expositions a empiler. Tenter d'éliminer le bruit a pour effet secondaire de donner aux images un
aspect cireux et de produire des taches de plus grande taille autour du fond qui sont essentiellement
dues a un bruit tres atténué. Il est donc préférable de laisser un peu de bruit & petite échelle pour
produire de la netteté.

Ce tutoriel expligue comment utiliser chacun des quatre procédés de réduction du bruit
susmentionnés, en se référant a la fois aux images monochromes et aux images en couleur.
Toutefois, pour simplifier, I'image utilisée pour la plus grande partie de ce tutoriel est monochrome et
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a été débarrassée des dégradés d'arriere-plan grace a DynamicBackgroundExtraction.

Pré-supposé pour ce tutoriel :

- Connaissance du fonctionnement de PixInsight, en rapport avec le traitement des images, les
processus et le travail avec les masques (Lire les, sections 3, 4 and 6).

- Vos images ont déja été entierement prétraitées (Lisez ceci).
- Connaissance de la production de différents types de masques (Lisez ceci).



http://www.lightvortexastronomy.com/tutorial-producing-masks.html
http://www.lightvortexastronomy.com/tutorial-pre-processing-calibrating-and-stacking-images-in-pixinsight.html
http://www.lightvortexastronomy.com/tutorial-introduction-to-pixinsight-and-its-interface.html

1. MultiscaleLinearTransform

+ Fonctionne aussi bien avec des images linéaires que non linéaires.

+ Les résultats sont trés reproductibles avec des réglages trés similaires entre les différentes images,
ce qui facilite I'application.

+ La réduction du bruit peut étre effectuée en douceur sans étre trop agressive, ce qui donne
d'excellents résultats.

+ La réduction du bruit peut étre appliquée indépendamment a la luminosité et a la chrominance
(couleur) de I'image.

- A tendance a brouiller les petits détails le long des bords s'il n'est pas appliqué de maniére
conservatrice et avec une image de masque décente comme protection.

MultiscaleLinearTransform est un processus qui fonctionne directement avec des couches
d'ondelettes, en s'occupant de la taille de structure des pixels spécifigues via des couches
d'ondelettes individuelles. Cela rend ce processus tres puissant dans la mesure ou la réduction du
bruit peut étre appliquée a une échelle de pixel spécifique, ou a plusieurs échelles de pixel avec des
degrés  d'agressivité¢  variables.  MultiscaleLinearTransform  est le  remplacant de
ATrousWaveletTransform et fonctionne de la méme maniere dans son algorithme par défaut de
transformation des starlets.

MultiscaleLinearTransform comprend quatre couches numérotées de 1 a 4 et une derniére couche
nommée R. A coté des noms des couches se trouvent des numéros d'échelle. La couche 1
correspond en fait a des structures de pixels dont la taille est de 1 pixel. La couche 2 correspond aux
structures de pixels dont la taille est de 2 pixels. La couche 3 correspond aux structures de pixels
dont la taille est de 4 pixels. La couche 4 correspond aux structures de pixels dont la taille est de 8
pixels. Enfin, la couche R représente le reste (appelé Residual pour cette raison) - toutes les échelles
de structures de pixels plus grandes qui ne sont pas couvertes par les couches 1 a 4. Nous pouvons
personnaliser le nombre de couches traitées par MultiscaleLinearTransform en sélectionnant
simplement un certain nombre de couches dans le menu déroulant Layers.

Avec les couches réglées sur 6, nous pouvons traiter individuellement des structures de pixels de
taille allant jusqu'a 32 pixels, la couche R (résiduelle) représentant désormais tout ce qui est au-
dessus. Nous pouvons effectivement supprimer les structures de pixels de certaines tailles en
sélectionnant la couche concernée et en la désactivant. Pour ce faire, il suffit de désactiver la couche
Detail pour la couche sélectionnée ou de double-cliquer sur cette couche dans la liste.

Le bruit dans les images a tendance a dominer la premiere couche, avec des échelles de 1 pixel. Les
plus grandes couches sont également quelque peu affectées, mais a un degré décroissant a mesure
gue l'on monte dans I'échelle des couches. La réduction du bruit a tendance a fonctionner
extrémement bien lorsqu'elle est appliguée de maniéere décroissante, c'est-a-dire aux couches 1 a 4,
inclusivement.




MultiscaleLinearTransform est trés polyvalent et fonctionne extrémement bien avec les images
linéaires et non linéaires. En réinitialisant le processus, nous appliquons maintenant un masque de
protection sur lI'image affichée, qui est linéaire mais auto-étirée. Le masque appliqué est généré en
dupliguant l'image linéaire et en appliquant les parametres d'étirement automatique de facon
permanente pour rendre l'image du masque non lin€aire. Si vous travaillez avec une image en
couleur, la méme procédure s'appligue mais il est préférable d'extraire une image Luminosité de
Iimage en couleur et d'effectuer ensuite un étirement permanent sur celle-ci en utilisant les
parameétres d'étirement automatique. Les détails de ces procédures de génération de masque font
I'objet d'un autre tutoriel.

Au-dessus, le masque a été appliqué et inverseé afin d'attaquer les zones plus sombres plutét que les
zones plus claires (et donc d'attaquer l'arriere-plan). Ce type de masque est excellent pour la
réduction générale du bruit car il permet de réduire le bruit avec différents degrés de protection sur
I'ensemble de I'image (le degré de protection dépend de l'intensité du signal dans la zone particuliere
de I'image).

Pour appliquer la réduction de bruit avec MultiscaleLinearTransform, il suffit de sélectionner la
couche a laquelle on souhaite appliquer la réduction de bruit et d'activer la réduction de bruit pour
cette couche. Comme la réduction du bruit est efficace pour les quatre premiéres couches, nous le
faisons pour les couches 1 a 4.

Il est possible de réduire le bruit sur un plus grand nombre de couches, bien sar, mais le bruit domine
de toute facon les plus petites échelles de pixels, donc les quatre premieres suffisent. Faire cela au
tout début du post-traitement est un excellent moyen d'améliorer le rapport signal-bruit de votre
image alors qu'elle est encore linéaire. Comme la premiére couche est plus dominée par le bruit que
la seconde, et la seconde plus que la troisieme (et ainsi de suite), c'est la premiére couche que nous
attaquerons le plus. Nous diminuerons l'agressivité de la réduction du bruit au fur et & mesure que
nous progresserons vers des couches plus importantes.

Pour cette image, je seélectionne la couche 1 et je régle Threshold a 3.000, Amount a 0.50 et
Iterations a 3. Threshold définit I'intensité de la réduction du bruit. Amount définit un mélange entre
I'image réduite en bruit et I'image originale. Le réglage par défaut de 1 signifie qu'une fois que vous
avez reduit le bruit de limage, le résultat final sera une image sans bruit. Un réglage de 0,50 est en
fait un mélange de 50 % de l'image originale et de 50 % de l'image avec réduction du bruit. Cela
permet d'obtenir des résultats plus fluides et une réduction globale du bruit plus agréable. Les
itérations définissent combien de fois I'algorithme est exécuté sur cette couche. Comme la premiére
couche est la plus affectée par le bruit, nos valeurs de seuil et d'itérations sont les plus élevées ici.

Pour la couche 2, je régle le Threshold a 2 000, Amount a 0,50 et les itérations a 2. Pour la couche 3,
je régle le Threshold & 1 000, le Amount & 0,50 et les itérations a 2. Enfin, pour la couche 4, je regle
le Threshold a 0 500, le Amount & 0,50 et les itérations a 1 seulement. L'application du procédé
produit une image a bruit réduit, le masque supportant I'endroit ou il applique la réduction de bruit la
plus importante.




Les captures d'écran ci-dessus montrent une section de l'image zoomée vers le centre, avec une
zone sombre dont le bruit a été joliment réduit par MultiscaleLinearTransform. La deuxieme capture
d'écran montre le résultat de la réduction du bruit.

Les résultats peuvent étre personnalisés si vous n'étes pas satisfait de la quantité de réduction du
bruit, qu'elle soit trop importante ou trop faible. Par exemple, je peux produire un résultat plus réduit
en modifiant quelques parametres.

J'ai augmenté le seuil a 4 000 et les itérations a 4 pour la couche 1. Pour les couches 2, 3 et 4, jai
gardé le seuil aux mémes valeurs mais j'ai augmenté les itérations a 3, 3 et 2, respectivement. En
appliquant a nouveau le processus, on obtient une réduction du bruit plus importante.

En effet, en jouant avec les valeurs de seuil et les itérations, vous obtiendrez des résultats optimaux
pour votre image. La valeur peut également étre modifiée, mais il est généralement recommandé de
la maintenir en dessous de 1,00 pour obtenir un bon mélange entre I'image a bruit réduit et I'image
originale. Cela permet d'obtenir une bonne réduction du bruit plutét qu'une élimination agressive du
bruit (qui donne des résultats d'aspect cireux). N'oubliez pas qu'avec une réduction de bruit assez
agressive, votre image peut sembler avoir des trous de la taille d'un seul pixel (pixels noirs laissés
dans le bruit & petite échelle lissé€). L'ACDNR est particulierement utile pour éliminer ces trous a I'état
non linéaire. Il s'agit donc d'un exemple d'utilisation de plusieurs procédés de réduction du bruit en
association.

MultiscaleLinearTransform peut étre appliqué aussi bien aux images linéaires gu'aux images non
linéaires, ce qui signifie que son utilisation pendant les premiéres étapes linéaires de la réduction du
bruit est une excellente idée. Cela se fait avant I'étirement de I'image a un état non linéaire. Une fois
étirée, vous pourriez appliquer le procédé a nouveau mais de maniere beaucoup moins agressive
(puisque l'image a déja eté réduite en bruit). Un nouveau masque serait bénéfique une fois I'image
modifiée, mais c'est un bon conseil pour tout procédé appliqué.

Une derniere remarque pour ceux qui travaillent avec des images en couleur
MultiscaleLinearTransform peut étre appliquée a l'image entiére telle quelle, le canal de luminosité
(qui régit la luminosité monochrome sur limage) seul ou le canal de chrominance (qui régit la
distribution des couleurs sur limage) seul. Pour modifier le mode dapplication de
MultiscaleLinearTransform, il suffit de sélectionner la cible souhaitée dans le menu déroulant Cible.

Cela peut étre utilisé pour réduire le bruit dans la répartition des couleurs de votre image en couleur
mais pas la luminosité de votre image, par exemple. Laissée a son mode par défaut, la réduction du
bruit est appliquée de la méme maniere a tous les canaux de couleur RVB.

L'algorithme utilisé par MultiscaleLinearTransform peut étre modifié en Multiscale linéaire plutét qu'en
transformée Starlet par défaut dans le menu déroulant du haut. PixInsight signale toutefois que, bien
que cet algorithme soit bon, Starlet a tendance a étre plus souple lorsqu'elle est appliquée a
différentes échelles de pixels dans une image.




2. MultiscaleMedianTransform

+ Fonctionne aussi bien avec des images linéaires que non linéaires.

+ Les bons résultats sont tres reproductibles avec des réglages trés similaires entre les différentes
images, ce qui facilite I'application.

+ La réduction du bruit peut étre effectuée en douceur sans étre trop agressive, ce qui donne
d'excellents resultats.

+ La réduction du bruit peut étre appliquée indépendamment a la luminosité et a la chrominance
(couleur) de limage.

- A tendance a laisser derriére elle des pixels de bruit noir sur l'arriere-plan qui doivent étre lissés
plus tard, en particulier si I'on utilise l'algorithme MultiScale Median.

MultiscaleMedianTransform peut sans doute étre meilleur que MultiscaleLinearTransform en termes
de réduction du bruit dans certaines situations. Cela est d0 a une réduction du bruit globalement
moins agressive qui, bien que pouvant sembler produire une réduction du bruit [égérement moindre,
maintient mieux les bords et peut donc sembler moins brouiller les petits détails que
MultiscaleLinearTransform. Pour |'utilisateur final, MultiscaleMedianTransform fonctionne en fait a
peu prés de la méme maniére - en adressant des couches d'ondelettes spécifiques pour attaquer
des structures de taille différente. Voici le processus MultiscaleMedianTransform ouvert a coté de la
méme image dans son état linéaire, auto-étiré.

On observe rapidement que la MultiscaleMedianTransform ressemble beaucoup a la
MultiscaleLinearTransform. Par défaut, les couches 1 a 4 sont listées ainsi que la couche R
résiduelle. Les mémes principes que pour la MultiscaleLinearTransform détaillée dans la section 1
s'appliquent ici. La encore, comme nous savons que le bruit domine la plus petite échelle de pixels,
nous devons étre plus agressifs en ce qui concerne la réduction du bruit dans la couche 1. Nous
appliguerons la réduction du bruit aux couches 1 a 4, mais dans un ordre décroissant d'agressivite,
comme nous l'avons fait avec MultiscaleLinearTransform. Cependant, pour protéger les zones a
signal élevé, nous appliquons d'abord un masque. Le masque appliqué est généré en dupliquant
I'image linéaire et en appliquant les paramétres d'étirement automatique de fagcon permanente pour
rendre l'image du masque non linéaire. Si vous travaillez avec une image en couleur, la méme
procédure s'appligue mais il est préférable d'extraire une image Luminosité de l'image en couleur et
d'effectuer ensuite un étirement permanent de celle-ci en utilisant les parameétres d'étirement
automatique. Les détails de ces procédures de génération de masque font I'objet d'un autre tutoriel.

Pour appliquer la réduction du bruit, il suffit de sélectionner la couche concernée et d'activer la
réduction du bruit.

Vous remarquerez qu'il n'y a pas de parametre Itérations dans MultiscaleMedianTransform. Nous
contrélons donc l'agressivité de la réduction du bruit uniquement par les parameétres Threshold et
Amount, de la méme maniére qu'avec MultiscaleLinearTransform. Tout d'abord, j'active la réduction
du bruit pour les couches 1 a 4, inclusivement.
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Comme MultiscaleMedianTransform est apparemment moins agressif en matiére de réduction du
bruit, les valeurs seuils utilisées ici devraient étre généralement plus élevées que pour la
MultiscaleLinearTransform. Par exemple, je régle la couche 1 sur un seuil de 5,0000, la couche 2 sur
un seuil de 3,0000, la couche 3 sur un seuil de 2,0000 et la couche 4 sur un seuil de 0,5000. Amount
est fixé a 0,75 pour que les couches 1 a 4 soient plus agressives et le processus est appliqué.

La réduction du bruit est prononcée, mais nettement moins qu'avec la MultiscaleLinearTransform.
Les détails des bords sont un peu plus préserves avec la MultiscaleMedianTransform, mais pas de
facon notable. De plus, bien que des réglages puissent faciliter ce processus,
MultiscaleMedianTransform semble plus enclin & produire des pixels de bruit noir en arriére-plan.
Ces derniers peuvent bien sir étre supprimés avec ACDNR, en particulier lorsque l'image est non
linéaire, mais cela mérite d'étre noté lorsque nous comparons MultiscaleLinearTransform et
MultiscaleMedianTransform.

Une fois de plus, Threshold et Amount peuvent étre ajustés par couche. Ces parametres ont les
mémes significations que dans MultiscaleLinearTransform - Threshold définit l'agressivité de la
réduction du bruit et Amount définit le degré de fusion entre I'image originale et I'image a bruit réduit
qui est reproduit comme résultat final. Le réglage de Amount a 1,00 donne une image purement
réduite en bruit, tandis qu'un réglage de 0,50 donne un mélange de 50 % de I'image réduite en bruit
avec 50 % de limage originale. Ceci est utile pour obtenir un résultat final plus lisse apres la
réduction du bruit, de sorte qu'une valeur de 1,00 est normalement évitée si possible. Le paramétre
Adaptative peut étre utile pour dépasser la valeur par défaut de 0,0000 pour les plus petites couches
si vous constatez que les structures de bruit que vous souhaitez supprimer subsistent encore. En
général, cela n'est fait qu'une fois que vous avez déterminé de bonnes valeurs pour Threshold et que
vous n'étes toujours pas en mesure de vous débarrasser de certains bruits.

MultiscaleMedianTransform est tout aussi capable de réduire le bruit dans les états linéaires et non
linéaires de I'image. Cela signifie qu'elle peut étre appliquée aussi bien par post-traitement pour une
approche en plusieurs étapes de la réduction du bruit, tout comme la transformée linéaire multi-
échelle. D'une maniére générale, des masques pour une protection adéquate de la zone de signal
élevé sont essentiels pour une application optimale de la réduction du bruit.

Pour ceux qui travaillent avec des images en couleur, la méme remarque finale qu'avec
MultiscaleLinearTransform  s'applique a MultiscaleMedianTransform. L'application de la
MultiscaleMedianTransform peut étre modifiee sur une cible différente de limage entiére en
sélectionnant la cible souhaitée dans le menu déroulant Target.

Cela vous permet de réduire le bruit dans la distribution des couleurs de votre image (en
sélectionnant la chrominance) plutét que la luminosité de votre image, par exemple. En laissant le
mode par défaut, vous réduisez le bruit de maniére égale sur tous les canaux RVB.

Jusqu'a présent, MultiscaleMedianTransform a été utilisé avec son algorithme par défaut de
Multiscalemediantransform. Un autre algorithme est disponible dans le menu déroulant du haut,
Medianwavelettransform. Pixlnsight signale qu'il s'agit essentiellement d'un algorithme hybride qui

combine la réduction du bruit a différentes écfhelles de] pixels (couches d'ondelettes) avec le filtrage
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médian des structures significatives au sein d'une image. Le résultat final est censé réduire
davantage le bruit la ou c'est important, tout en protégeant les zones lumineuses d'une image qui
n'‘ont pas besoin d'une réduction importante du bruit. En effet, I'application des mémes parametres de
réduction du bruit aux couches 1 a 4 que ci-dessus, mais l'utilisation de l'algorithme de Median-
wavelet donne de meilleurs résultats.

Le fond semble étre moins encombré de pixels de bruit noir et la réduction du bruit est plus douce,
bien que moins prononcée qu'avec l'algorithme de transformation médiane multi-échelle.




3. ACDNR

+ De bons résultats peuvent étre obtenus avec quelques ajustements, mais il est conseillé d'étre
prudent.

+ Peut étre utilisé efficacement en conjonction avec d'autres réductions de bruit pour aplanir les
choses en fin de post-traitement.

+ La réduction du bruit peut étre appliquée a la luminosité et a la chrominance (couleur) de lI'image
indépendamment.

- Ne fonctionne pas du tout bien avec les images linéaires.

L'ACDNR est radicalement différent deMultiscaleLinearTransform et de MultiscaleMedianTransform,
du moins en apparence pour l'utilisateur final. Voici le processus ACDNR ouvert & cété de la méme
image dans son état linéaire, auto-étiré.

ACDNR n'est pas considéré par beaucoup comme aussi bon que la MultiscaleLinearTransform ou la
MultiscaleMedianTransform, mais il est néanmoins efficace. Elle est moins efficace avec les images
linéaires qu'avec les images non linéaires, mais elle peut étre utilisée dans les deux cas. Cependant,
['utilisation recommandée pour I'ACDNR est lorsque limage est non linéaire, pour un but
supplémentaire de réduction du bruit (aprés application d'un des autres procédés, par exemple). Ici,
nous démontrons d'abord l'application de 'ACDNR a une image linéaire, puis nous passons a son
application a une image non linéaire.

Nous commencons par explorer le processus lui-méme. Il comporte deux onglets - intitulés Lightness
et Chrominance. L'ACDNR fonctionne en convertissant une image dans l'espace colorimétrique
L*a*b*, en y appliqguant une réduction du bruit, puis en la reconvertissant dans l'espace
colorimétrique RVB. Si votre image est monochrome, la réduction du bruit sera également appliquée
au canal L dans l'espace couleur L*a*b*. Il est important de noter que les deux onglets sont
applicables lorsque vous cliquez sur Appliquer sur ACDNR, et pas seulement I'onglet sur lequel vous
vous trouvez. De ce fait, ACDNR dispose d'une option Appliquer sur les deux onglets. Désactiver
cette option pour I'un ou l'autre des onglets n'appliquera pas la réduction du bruit a la luminosité ou a
la chrominance (selon votre sélection).

Comme nous travaillons avec une image monochrome, nous désactivons le filtre de chrominance
pour ACDNR, mais si vous travaillez avec une image couleur, vous pouvez le garder activé et
modifier ses parameétres individuellement a partir des parametres appliqués a la luminosité. Pour
protéger les zones a signal élevé, nous appliquons d'abord un masque. Le masque appliqué est
généré en dupliguant l'image linéaire et en appliquant les paramétres d'étirement automatique de
facon permanente pour rendre I'image du masque non linéaire. Si vous travaillez avec une image en
couleur, la méme procédure s'applique mais il est préférable d'extraire une image Luminosité de
I'image en couleur et d'effectuer ensuite un étirement permanent sur celle-ci en utilisant les




parametres d'étirement automatique. Les détails de ces procédures de génération de masque font
I'objet d'un autre tutoriel.

Le paramétre StdDev (ou Standard Deviation), définit approximativement la taille de la structure du
bruit que vous souhaitez éliminer. Pour le bruit habituel & petite échelle, vous pouvez utiliser des
valeurs comprises entre 1,5 et 2,5 environ par défaut. La quantité a ici la méme définition que dans
les deux autres processus couverts jusqu'a présent. Un réglage de Amount de 1,00 conserve comme
résultat final une image purement réduite en bruit. Le réglage par défaut de 0,90 conserve 90 % de
I'image a bruit réduit avec 10 % de l'image originale, ce qui donne un résultat final plus lisse. Je vais
changer ma valeur StdDev a 2.0 et régler Amount a 0.50 pour produire un résultat final plus lisse et
étre moins agressif.

De maniére générale, les parametres par défaut pour la Robustness et Structure size fonctionnent
extrémement bien (pour les deux modes, Lightness et Chrominance). Les itérations peuvent étre
modifiées de la méme maniére que pour les deux autres processus couverts jusqu'a présent. Cela
définit le nombre de fois que l'algorithme est appliqué, donc plus la valeur est élevée, plus la
réduction du bruit est forte. Une fois que vous avez atteint une bonne valeur pour StdDev qui attaque
le bruit que vous cherchez a éliminer, le réglage de la quantité et des itérations donne généralement
les meilleurs résultats pour votre image. Avec des itérations laissées a 3 (ce qui tend & bien
fonctionner - je ne régle normalement qu'entre 2 et 4), j'applique le processus & mon image linéaire.

En examinant de plus pres les résultats de la réduction du bruit (voir la deuxieme capture d'écran ci-
dessus), nous constatons que la réduction du bruit n'a pas été aussi efficace qu'avec
MultiscaleLinearTransform et MultiscaleMedianTransform. Le bruit a petite échelle semble subsister
en grande partie et limage vient de prendre un aspect globalement plus flou, les étoiles étant
agrandies avec des halos plus grands (comme si elles avaient été étalées vers |'extérieur a partir de
leur centre). Et ce, malgré le masque de protection ! C'est la que I'on commence a voir que I'ACDNR
peut étre moins efficace que les deux autres procédés de réduction du bruit mentionnés ci-dessus
lorsqu'il s'agit d'images linéaires.

En théorie, les parametres de Bright Sides Edge Protection sont utilisés pour ajuster l'impact du
processus ACDNR sur les étoiles, parfois au point de ne pas étre négatif du tout. Cependant, dans
une image linéaire, méme un ajustement de ces parametres peut donner des résultats moins
probants. Nous passons donc a l'utilisation de 'ACDNR sur une image non linéaire. La méme image
monochrome a maintenant été étirée avec HistogramTransformation.

Un nouveau masque de protection est maintenant appliqué a cette image non linéaire. Dans ce cas,
le masque consiste en un double de l'image qui a été traité par HistogramTransformation avec
utilisation des ombres et des hautes lumiéres Auto-clip, pour accentuer davantage les zones claires
et sombres. Si vous travaillez avec une image couleur, vous pouvez également le faire, mais
idéalement avec une image de luminance extraite de votre image couleur. Les détails de la
production de ces images de masque et de leur modification avec HistogramTransformation font
I'objet d'un autre tutoriel.




A des fins de démonstration, nous appliquons & nouveau I'ACDNR avec les mémes paramétres
gu'auparavant - StdDev réglé a 2.0, Amount réglé a 0.50 et Iterations réglé a 3.

En examinant de pres la réduction du bruit (voir la deuxieme capture d'écran ci-dessus), nous
constatons tout d'abord qu'elle n'était en fait pas du tout agressive. Elle a cependant nettement
mieux fonctionné qu'avec l'image linéaire précédente - les étoiles ne sont pas affectées et le fond est
un peu moins bruité. Il semble que nous puissions étre un peu plus agressifs avec notre réduction de
bruit, c'est pourquoi nous avons choisi d'augmenter Amount a la valeur par défaut de 0,90 et de
régler les itérations a 5. StdDev est laissé a 2.0 parce qu'il semble s'adresser a I'échelle de pixels de
bruit qui nous intéresse (bruit a petite échelle).

C'est peut-étre un peu trop agressif, mais c'est clairement la meilleure fagon d'utiliser TACDNR - en
réglant le StdDev pour traiter le bruit que vous souhaitez supprimer, en réglant la quantité et les
itérations pour modifier l'agressivité et en utilisant généralement 'ACDNR sur des images non
linéaires uniquement.

Compte tenu de la maniére dont 'ACDNR opére sa réduction de bruit, qui semble mélanger les
points de bruit avec les pixels de bruit noir laissés en arriére-plan, il est généralement bon de ne pas
étre trop agressif avec I'ACDNR car il peut transformer votre bruit a petite échelle en bruit a grande
échelle (parfois décrit par les gens comme des taches lisses). Le meilleur moyen de faire apparaitre
ce lissage est d'appliquer le masque, mais de le cacher, en le montrant avant la réduction du bruit
(premiére capture d'écran) et aprés la réduction du bruit (deuxiéme capture d'écran).

Cela illustre pourquoi il est préférable de considérer toute cette procédure comme une réduction et
non une élimination du bruit - il vaut mieux laisser quelques points de bruit a petite échelle dans
I'image que de les lisser au point de les transformer en taches. Néanmoins, la capacité de 'ACDNR a
lisser le bruit peut étre utilisée a notre avantage. Par exemple, MultiscaleMedianTransform a
tendance a laisser quelques pixels de bruit noir en arriere-plan lors de I'application de la réduction du
bruit. On peut parfois dire la méme chose de la MultiscaleLinearTransform. L'un ou l'autre de ces
deux processus pourrait étre utilisé pour réduire le bruit dans I'état linéaire de l'image et ensuite
appliquer un peu de ACDNR a l'image une fois qu'elle est non linéaire. Par exemple, ci-dessous,
nous voyons limage dans son état linéaire aprés avoir regu la réduction du bruit avec
MultiscaleMedianTransform (le masque est actif mais caché).

Une fois étirée a son état non linéaire, I'image conserve ces pixels de bruit noir.

ACDNR peut étre tres utile a ce stade, surtout maintenant que l'image est non linéaire. Le masque
de protection utilisé est a nouveau un double qui a été modifié avec la transformation de
I'histogramme avec les ombres et les hautes lumiéres Auto-clip. LACDNR a été appligué uniqguement
a la luminosité et avec un réglage StdDev de 2.0, comme auparavant. Nous essayons de ne pas étre
aussi agressifs que dans I'exemple précédent, mais suffisamment pour lisser ces pixels de bruit noir
laissés par MultiscaleMedianTransform.




Personnellement, j'estime que cette procédure de réduction du bruit a été appliquée de maniere trop
agressive des le début, mais elle illustre I'idée que s'il reste des pixels de bruit noir apres la réduction
initiale du bruit, 'ACDNR peut effectivement les lisser une fois que l'image est non linéaire.

Enfin, puisque I'ACDNR lisse le bruit, il est courant que les utilisateurs doivent réajuster
I'histogramme de leur image avec HistogramTransformation aprés l'application de 'ACDNR. Un
simple ajustement du point noir dans HistogramTransformation suffit.

Notez ci-dessus qu'aucun pixel n'est coupé par cet ajustement du point noir, il s'agit donc d'un
ajustement du point noir jugé nécessaire. Comme il est certain que vos images ne seront pas
linéaires lorsque le systeme ACDNR est appliqué, considérez l'ajustement du point noir comme
faisant partie du processus d'application du systeme ACDNR a votre image.

4. TGVDenoise

+ Fonctionne aussi bien avec des images linéaires que non linéaires.

+ De bons résultats peuvent étre obtenus en apportant quelgues modifications et en utilisant le
processus statistigue comme aide.

+ La réduction du bruit peut étre appliqguée indépendamment a la luminosité et a la chrominance
(couleur) de l'image.

- Il faut parfois un certain temps pour ajuster les parameétres afin de produire des résultats
acceptables.

- Peut facilement devenir trop agressif au niveau de la réduction du bruit et produire des résultats
indésirables.

- est particulierement lent a s'exécuter sur des images entieres (l'utilisation de boites de
prévisualisation pour tester les réglages est conseillée).

Un évaluation officielle des algorithmes de réduction du bruit a été réalisée il y a quelques années
afin de déterminer lequel semblait le plus efficace et le plus adaptable. Le TGVDenoise s'est révélé
extrémement efficace dans son travail, parfois bien plus que les autres algorithmes disponibles
(détaillés dans les sections ci-dessus). Le probléeme que les utilisateurs ont tendance a avoir avec
TGVDenoise est tout simplement son comportement apparemment sauvage avec des changements
subtils de ses paramétres. Voici comment utiliser au mieux TGVDenoise, que vous le trouviez
préférable ou non a d'autres algorithmes de réduction du bruit. Voici le processus TGVDenoise
ouvert a coté de la méme image dans son état linéaire, auto-étiré.

Le TGVDenoise est un procédé trés flexible et peut en effet étre utilisé avec des images linéaires et
non linéaires, bien que les parametres pour I'un ou l'autre de ces états d'image varient beaucoup. En
haut de TGVDenoise, on trouve deux réglages pour le mode.



http://pixinsight.com/tutorials/nr-comparison/index.html

Le mode RVB/K est le réglage par défaut, ce qui permet de conserver l'image dans l'espace de
couleur RVB standard. Dans ce mode, lI'image entiére, telle quelle, est traitée avec une réduction du
bruit. En mode CIE L*a*b*, cependant, nous sommes en mesure de cibler séparément la luminosité
et la chrominance (couleur) d'une image avec différents parametres de réduction du bruit. Si vous
avez affaire a une image en couleur, ce mode peut étre utile si vous souhaitez réduire le bruit plus
efficacement.

Comme dans cet exemple nous avons affaire a une image monochrome, nous conservons le réglage
par défaut du mode RGB/K. Dans la partie supérieure, nous trouvons nos parametres de contréle de
Strength ('ampleur de I'effet de réduction du bruit a produire), de la protection des bords (Edge, la
marge de manceuvre dont dispose le processus pour attaquer le bruit lorsqu'il détecte des bords) et
de la douceur (Smoothness, le degré de douceur de la réduction du bruit). Les itérations ont pour
signification standard le nombre de fois qu'il faut appliquer I'algorithme sur l'image. Plus le nombre de
fois qu'il est appliqué, plus la réduction du bruit est importante. Cependant, il y a toujours un point de
convergence apres lequel I'application d'un plus grand nombre d'itérations n'apporte que trés peu de
réduction de bruit supplémentaire.

En plus de Strength, de Edge et de Smoothness, vous avez des curseurs. Ceux-ci définissent les
valeurs que vous définissez, bien qu'elles puissent étre entrées manuellement dans la plus petite des
deux zones de texte a gauche des curseurs. Les chiffres & droite des curseurs sont des exposants,
qui sont essentiellement des puissances de dix et qui définissent I'ampleur globale de vos valeurs.
Par exemple, une valeur de 3 et un exposant de -2 signifient que votre valeur réelle est de 0,03. De
méme, une valeur de curseur de 3 et un exposant de 2 signifie que votre valeur réelle est de 300. La
valeur réelle peut également étre saisie avec précision dans la plus grande des deux zones de texte
situées a gauche des curseurs.

Local Support est en fait tres nécessaire, et c'est ici que vous fournissez au processus une image a
utiliser comme référence pour les endroits ou la réduction du bruit est plus importante (c'est-a-dire
sur les zones de faible signal - le fond).Avant de commencer, nous devrions en fait créer une image
que Support Local pourra utiliser. Nous utiliserons simplement le double standard de limage
originale, avec les parametres d'étirement automatique appliqués en permanence. Si vous travaillez
avec une image en couleur, la méme procédure s'applique, mais il est préférable d'extraire une
image de luminosité de l'image en couleur et d'effectuer ensuite un étirement permanent sur celle-ci
en utilisant les parametres d'étirement automatique. Les détails de ces procédures de génération de
masque font I'objet d'un autre tutoriel.

Pour les algorithmes de réduction du bruit précédents, lI'image du masque était en effet appliquée
comme un masque. Dans le cas du TGVDenoise, nous définissons plutot I'image du masque sous la
rubrique Support local. Pour ce faire, nous développons et activons le Support Local, nous cliquons
sur licéne du dossier a coté de la zone de texte pour lI'image de support, nous sélectionnons notre
image de masque et nous confirmons.




Nous pouvons laisser par défaut tout le reste dans le cadre du Local Support. Comme nous n‘avons
pas besoin d'étirer davantage l'image (ou de la découper), nous n'avons pas besoin de toucher les
curseurs Midtones, Shadows ou Highlights. Si nous augmentons la valeur de la réduction du bruit,
nous supprimons effectivement des couches de notre image de support local, mais aprés quelques
tests, j'ai constaté que cela était contre-productif en matiére de réduction du bruit a ce stade, c'est
pourquoi je conseille de la maintenir a 0.

Pour commencer, définissons une valeur pour la protection des bords. Heureusement, c'est quelque
chose que nous pouvons déduire de notre image. Nous aurons d'abord besoin d'une boite de
prévisualisation sur le fond du ciel (pas de nébulosité ni d'étoiles). Il n'est pas nécessaire qu'il soit
énorme - un petit segment de votre image sulffit.

A ce stade, nous utilisons le processus des statistiques pour faire une analyse. Une fois ouvert,
sélectionnez votre boite de prévisualisation dans la liste.

Par défaut, le processus Statistics ne vous donne pas la mesure de I'écart type, et nous en avons
besoin. Pour 'activer, il suffit d'aller dans les options statistiques (bouton de l'icone de I'outil en haut a
droite) et d'activer I'écart type, puis de confirmer.

Pour obtenir des valeurs que nous pouvons utiliser dans TGVDenoise, nous devons changer le
processus statistique pour nous montrer les valeurs des pixels en Réel Normalisé [0, 1], ce qui
signifie que les valeurs des pixels se situent entre 0 et 1 plutdét que dans leur plage habituelle de
profondeur de bits (par exemple, les 16 bits se situent entre 0 et 65 535). Il suffit de sélectionner Réel
normalisé [0, 1] dans le menu déroulant en haut a gauche.

Nous voyons ci-dessus que stdDev est calculé a 1,865619 avec un exposant de -4. C'est en effet la
valeur qui doit étre entrée dans la protection de I'aréte en TGVDenoise. Une fois cela fait, fermez le
processus Statistiques et supprimez la boite de prévisualisation car nous n‘en avons plus besoin.

Ci-dessus, nous voyons que PixInsight a complété ce que j'ai saisi, mais la précision est plus que
suffisante. Comme indiqué précédemment, I'exécution d'un algorithme de réduction du bruit sur de
nombreuses itérations est utile jusqu'au point de convergence, ou un plus grand nombre d'itérations
ne produit que trés peu d'avantages. Une valeur de convergence s(re pour les itérations est de 500
mais nous devrions commencer plus bas pour tester les choses, donc nous fixons 250. Avant de voir
comment les choses se passent, nous notons que les parametres par défaut de TGVDenoise sont de
traiter les images non linéaires. Notre image est actuellement linéaire et ces réglages sont donc
beaucoup trop agressifs. Voici l'effet sur I'image de l'application des parameétres par défaut pour
Strength et Smoothness avec des itérations a 250 a I'ensemble de I'image.

Si vous voyez quelque chose de ce genre, votre valeur de Strength est fixée trop haut et devrait étre
abaissée, probablement par un exposant entier. Il est habituel d'utiliser des exposants négatifs pour
la protection de Strength et de Edge (par exemple, de -1 a environ -4). En abaissant I'exposant de la
force de 1 a -1, on obtient le résultat suivant, bien meilleur (la deuxieme capture d'écran montre une
zone de I'image aprées l'application) :




Il s'agit en fait d'une réduction du bruit déja assez excellente, méme si elle est encore un peu trop
forte. Il est bon de réduire la valeur de Strength mais de garder I'exposant a -1 pour le moment. Une
valeur de Force de 1,5 est bien meilleure, avec un exposant de -1.

Cela a l'air bien mieux, avec moins de perte de détails. Cependant, nous perdons encore un peu de
détails sur la nébulosité et si nous continuons a diminuer Strength, nous allons commencer a obtenir
une réduction du bruit moins importante (alors qu'elle fonctionne actuellement tres bien). Ce que
nous devrions donc abaisser pour maintenir le détail, c'est Smoothness. Comme une intuition, je vais
abaisser I'exposant de Smoothness a -1 et ensuite augmenter la valeur a 8 (c'est encore plus bas
parce que nous l'avons abaissé d'une magnitude).

Le niveau de détail préservé ainsi que l'excellente réduction du bruit sont tres évidents ici, montrant
une excellente application du TGVDenoise. Lorsque vos réglages sont bons, il est conseillé de porter
les itérations a 500 pour que l'application de réduction du bruit soit compléte. Pendant les tests, vous
pouvez appliquer TGVDenoise uniquement sur une petite boite de prévisualisation montrant une
zone avec un fond et une nébulosité (avec quelques étoiles mélangées). Le processus de test est
ainsi plus rapide, car TGVDenoise ne fonctionne que sur une petite partie de l'image entiére. Une
fois que vous étes satisfait de votre application finale de TGVDenoise, vous pouvez fermer le
processus et également fermer l'image de masque utilisée dans le support local sans l'enregistrer.

Si l'on étire I'image pour la rendre non linéaire, on finit parfois par voir des taches de bruit résultant
de la réduction du bruit. Cela se produit lorsque la réduction du bruit est un peu trop agressive.

Comme a ce stade, I'image est non linéaire, 'ACDNR est un excellent procédé pour traiter ces
taches de bruit et adoucir un peu les choses. TGVDenoise peut également étre utilisé avec des
images non linéaires et, en effet, ses parametres par défaut sont plus applicables aux images non
linéaires qu'aux images linéaires. Néanmoins, le réglage des parameétres de Strength et de
Smoothness apres avoir défini la valeur appropriée pour Edge protection (en utilisant une boite de
prévisualisation sur l'arriere-plan et en trouvant stdDev avec le processus Statistics est la clé d'une
réduction du bruit réussie, que votre image soit linéaire ou non linéaire.

5. Analyse du bruit des couches d'ondelettes

A ce stade, vous aurez été initié aux différents processus de réduction du bruit dans PixInsight et
vous devriez maintenant pouvoir les appliquer a vos images. En particulier, pour les procédés
MultiscaleLinearTransform et MultiscaleMedianTransform, qui fonctionnent avec des couches
d'ondelettes pour différentes tailles de structure de pixels, nous avons traité les images en couches
de taille de pixel. Cela souléve la question suivante : comment savoir quelles couches contiennent
réellement notre bruit et avec quelle intensité ? Heureusement, PixInsight peut également répondre
a cette question avec diligence.

Nous utiliserons le script ExtractWaveletLayers afin d'analyser notre image a différentes échelles de
pixels. Ce script se trouve dans la rubriqgue Analyse d'images.
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Notre image ouverte étant toujours a |'état linéaire (mais auto-étirée), nous pouvons utiliser ce script
pour produire de nouvelles images qui correspondent aux différentes échelles de pixels présentes.
Comme la réduction du bruit est généralement appliguée aux couches 1 a 4 (pas au-dela), nous
pouvons réduire le parametre Nombre de couches a 4. Si nous maintenons l'option Extraire la
couche résiduelle activée, une autre image sera produite correspondant a la couche R - le reste des
échelles de pixels de limage tout en un. Comme nous n'en avons pas besoin pour pouvoir analyser
le bruit dans les quatre premieres couches, nous pouvons le désactiver. La fonction de mise a
I'échelle par défaut fonctionne trés bien. Avant de cliquer sur OK, assurez-vous que l'image correcte
est sélectionnée dans le menu déroulant Image cible.

Une fois que vous avez cliqué sur OK, quelques secondes plus tard, quatre nouvelles images
apparaissent, qui correspondent a chaque échelle de pixel. Elles seront nommées layer00, layer01,
etc. L'image layer00 correspond a la couche 1, I'image layerO1 correspond a la couche 2, etc. Voici
les quatre images avec l'auto-étirement renforcé appliqué, disposées l'une a cété de l'autre.

En haut gauche est la couche 1 (échelle de pixels 1), en haut droit est la couche 2 (échelle de pixels
2), en bas gauche est la couche 3 (échelle de pixels 4) et enfin, en bas droit est la couche 4 (échelle
de pixels 8). On peut voir gu'a mesure que I'on augmente I'échelle des pixels, des structures de
I'image deviennent visibles. C'est normal, car en augmentant I'échelle des pixels, on peut voir les
plus grandes structures présentes. C'est précisément la raison pour laguelle la réduction du bruit est
appliguée de maniere plus agressive a la couche 1 qu'a la couche 4, par exemple - la couche 1 est
dominée par le bruit tandis que la couche 4 a peu de bruit mais possede beaucoup de structures
d'image valides.

L'extraction des couches d'ondelettes d'une image peut étre utile pour déterminer le degré
d'agressivité nécessaire pour chaque couche lors de l'application de transformations telles que la
transformation linéaire a plusieurs échelles ou la transformation médiane a plusieurs échelles. Ce
script peut également étre appliqué avant et apres la réduction du bruit, a des fins de comparaison, si
vous le souhaitez. Veuillez noter que le script ExtractWaveletLayers fonctionne aussi bien avec des
images linéaires que non linéaires. Vous pouvez toujours utiliser les fonctions d'auto-étirement ou
d'auto-étirement renforcé de PixInsight pour analyser vos images de couches d'ondelettes extraites,
méme si elles proviennent d'une image non linéaire (juste pour mieux voir le bruit et les structures).
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VIll. Affiner les détails

Comme on image a travers l'atmosphére, le seeing et la transparence jouent un réle dans la
distorsion de l'image qui serait autrement tres nette (en théorie). La déconvolution est une opération
mathématique qui peut étre appliquée pour annuler une partie de cette distorsion, en la modélisant
d'abord avec quelques étoiles dans l'image. Cette opération est effectuée trés tét dans un processus
de post-traitement, a I'état linéaire de l'image. Plus tard, lorsque l'image n'est plus linéaire, il est
possible d'accentuer les détails fins a des niveaux de détail spécifiques (échelles de pixels), et c'est
le travail de MultiscaleLinearTransform. Dans I'ensemble, le résultat final est une image beaucoup,
beaucoup plus nette avec un potentiel de détails fins a trés fort contraste.

Ce tutoriel a pour but de présenter les deux principaux procédés utilisés pour accentuer les détails
fins d'une image a l'aide de PixInsight. |l s'agit de la Déconvolution et de MultiscaleLinearTransform.
Classiguement, la transformation ATrousWavelet peut également étre utilisée, mais elle est
progressivement rendue obsolete par les développeurs de Pixinsight. Cependant,
MultiscaleLinearTransform utilisant l'algorithme de transformation de Starlet fonctionne de maniere
identique et ce tutoriel couvre donc cela. Il est important de noter que ces techniques fonctionnent de
maniére identique entre les images monochromes et les images en couleur. De plus, comme pour
tout type de post-traitement ciblé des images, les masques sont la clé de la protection des zones qui
n'‘ont pas besoin d'étre affinées. La production de masques n'est pas le sujet de ce tutoriel (un autre
tutoriel couvre ce sujet - voir la liste ci-dessous), mais sont brievement abordés pour étre complets.

Supposé pour ce tutoriel :

» Connaissance du fonctionnement de PixInsight, en rapport avec le traitement des images, les
processus et le travail avec les masques ( Lire les sections 3, 4 et 6).

» Vos images ont déja été entierement prétraitées ( Lire ceci).

« Connaissance de la production de différents types de masques (Lire ceci).
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1. Deconvolution avec DynamicPSF

+ Grace aux mathématiques qui le sous-tendent, peut effectivement annuler une partie de la
distorsion introduite par I'atmosphére.

+ Les résultats sont trés reproductibles avec des réglages quelque peu similaires entre les
différentes images, de sorte que l'application est relativement facile.

- A tendance a produire des cernes sur les étoiles si la protection du masque n'est pas bonne. Le
deringing peut aider a prévenir ce phénomene.

- Prend un certain temps a mettre en place car il faut d'abord réaliser le modele d'image PSF.

- L'utilisation de petites boites de prévisualisation pour tester les réglages est donc presque
essentielle.

La déconvolution, bien qu'elle soit un nom de processus a part entiére, est une opération
mathématique qui peut étre effectuée sur des fonctions (ou des images, dans ce cas). La théorie de
base est que la lumiere provenant de l'espace profond est pure et peut produire une image
parfaitement nette en soi. Malheureusement, comme cette lumiére a traversé notre atmosphere, la
vision et la transparence ont faussé sa capture et il se peut que votre égquipement ait également
faussé quelque peu sa capture. Nous pouvons accepter que ces distorsions se combinent pour
donner ce qui pourrait en théorie étre modélisé mathématiquement. La déconvolution tente de
modéliser cette fonction de distorsion totale a partir d'un certain nombre d'étoiles échantillons et tente
ensuite de défaire la distorsion totale. Le résultat final efficace est une image plus nette. Le bénéfice
gue vous tirez de l'application de la déconvolution dépend de la résolution de votre image. Pour une
longue distance focale et des configurations de petite taille, la déconvolution peut étre trés
révélatrice, alors que pour une courte distance focale et des configurations de grande taille, elle peut
ne pas ajouter de détails significatifs. Il est évident que l'avantage que vous en tirez dépend
également des conditions du ciel nocturne dans lequel vous prenez vos images.

Il est tres important de noter des maintenant que la déconvolution ne fonctionne vraiment que sur
des images linéaires. En effet, nous allons créer un modéle de distorsion avec le processus
DynamicPSF et cela nécessite des données linéaires pour modéliser correctement la fonction de
distorsion. D'une maniére générale, la déconvolution est appliquée trés tot dans le processus de
post-traitement. Cela peut étre fait au tout début d'un flux de travail de post-traitement, juste aprés
gue tout le prétraitement ait été effectué et avant la réduction du bruit a I'état linéaire (certainement
avant d'étirer I'image en non-linéaire !).

En raison de ce qui précede, nous ne travaillerons gu'avec une image linéaire. Cependant, avant
d'ouvrir le processus de déconvolution, nous devons créer un modeéle d'étoile basé sur lI'image elle-
méme. Ceci est fait avec le processus DynamicPSF, montré ouvert ci-dessous a c6té d'une image
monochrome H-Alpha dans son état linéaire et auto-étiré.
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Comme ce processus est de nature dynamique, il ouvre une session sur l'image sur laquelle vous
étes. Il nous faut maintenant cliquer sur un certain nombre d'étoiles dispersées autour de l'image.
Les étoiles que vous sélectionnez ne doivent pas étre trop grandes ou trop petites, ou avoir un halo
excessif autour d'elles. Je préfére sélectionner les étoiles le long du centre de l'image, puis de
chacun des quatre coins et certaines du centre des quatre cétés. En général, je finis par sélectionner
environ 80 a 100 étoiles, bien que nous en excluions un certain nombre plus tard. Il est utile de faire
un zoom avant et de faire un panoramique autour de l'image. Cliquez sur les centres des étoiles pour
les sélectionner correctement. Pendant que vous faites cela, DynamicPSF modélise I'étoile dans sa
sélection et la liste avec les parametres calculés.

Ci-dessus, j'ai sélectionné 124 étoiles, ce qui est excessif, mais j'ai correctement échantillonné toutes
les zones de l'image. N'oubliez pas que la vie est trop courte pour passer une demi-heure a faire cela
I Nous allons maintenant exclure un certain nombre des étoiles sélectionnées. Pour ce faire, nous
agrandissons la fenétre DynamicPSF.

Les cercles ci-dessus sont A (amplitude), r (rapport d'aspect) et MAD (différence absolue moyenne).
Ce sont les paramétres que nous utiliserons pour sélectionner nos étoiles pour le modéle. Nous
utiliserons d'abord MAD, mais trions toutes les étoiles par ordre de valeur MAD. Pour ce faire, cliquez
sur le bouton Trier, sélectionnez Mean Absolute Difference et cliquez sur OK.

Maintenant que je regarde ma liste de valeurs MAD, elles se situent entre 1,185e-003 et 1,446e-002
(ce qui est un peu plus de 10 fois plus élevé). Nous devons éviter les valeurs trop différentes, c'est
pourquoi, dans cette étape, nous exclurons un grand nombre d'étoiles. Ce que jai tendance a faire,
c'est de regarder la liste et d'estimer approximativement quel ensemble de valeurs de MAD comporte
le plus d'étoiles. Je limite également ma fourchette de valeurs a la limite inférieure de la fourchette
MAD, dans l'idéal. Je peux voir qu'entre mon étoile de valeur MAD la plus basse avec 1,185e-003 et
environ 2,3e-003, j'ai un assez bon nombre d'étoiles. Cela correspond a mes 26 premieres étoiles
par ordre croissant de valeur MAD. Par conséquent, je sélectionne toutes les étoiles que je veux
exclure. Le mieux est de cliquer sur la premiére étoile que vous voulez exclure, de faire défiler la liste
jusqu'en bas et de cliquer sur la derniere étoile que vous voulez exclure tout en maintenant la touche
SHIFT enfoncée. Une fois que toutes les étoiles que vous voulez exclure sont sélectionnées, cliquez
sur le bouton Delete.

C'est ainsi que mes 26 étoiles les mieux assorties ont été répertoriées dans le DynamicPSF. Nous
allons maintenant filtrer sur la base de A (Amplitude). Une fois de plus, nous les classons par ordre
de valeur A en cliquant sur le bouton Sort, en sélectionnant Amplitude et en cliquant sur OK.

Mes 26 étoiles sont maintenant classées par ordre de valeur A croissante. Une bonne ligne directrice
consiste a choisir des étoiles entre une valeur A d'environ 0,25 et 0,75. Toutes les autres peuvent
étre exclues. Donc, encore une fois, cherchez les étoiles qui ne correspondent pas a cette fourchette,
sélectionnez-les individuellement ou en groupe (au-dessus et au-dessous de vos bonnes étoiles) et
cliquez sur le bouton "Supprimer" pour les exclure.
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Il ne reste plus que 16 étoiles et nous allons filtrer davantage, cette fois par la valeur r (Aspect Ratio).
Cliquez a nouveau sur le bouton "Sort", sélectionnez "Aspect ratio" et cliquez sur OK.

Nous excluons maintenant les étoiles dont la valeur r est trop difféerente. Une bonne gamme de
valeurs de r a rechercher se situe généralement entre 0,6 et 0,8. Vous pouvez sélectionner les autres
et cliquer sur le bouton "Supprimer” pour les exclure.

Nous sommes enfin arrivés a un bon échantillon d'étoiles a utiliser dans la modélisation. A ce stade,
il ne reste plus qu'a sélectionner toutes les étoiles répertoriées et a cliquer sur le bouton Export pour
produire une petite image correspondant & notre étoile modéle (sur la base de celles qui sont
répertoriées).

Cette image est appelée PSF par défaut et peut étre utilisée comme référence dans le processus de
déconvolution. Vous pouvez maintenant fermer le processus DynamicPSF mais gardez cette image
PSF ouverte car nous en aurons besoin.

Nous utiliserons un masque pour la protection de l'arriere-plan et des étoiles afin que la netteté soit
appliguée aux zones de signal fort (la nébulosité brillante). Le masque utilisé ici est le méme
quauparavant. Il a été realisé en faisant d'abord un clone de limage linéaire. Les paramétres
d'étirement automatique lui ont ensuite été appliqués sous forme d'étirement permanent avec
HistogramTransformation pour rendre le clone non linéaire. Le processus RangeSelection a été
utilisé pour sélectionner uniquement les zones de nébulosité les plus claires, a I'exclusion de l'arriére-
plan et des zones sombres, comme je l'ai jugé bon. Une fois que I'image du masque de portée a été
produite, j'ai utilisé StarMask pour produire un masque avec seulement des étoiles. Celui-ci a été
étiré et un peu tronqué avec HistogramTransformation pour faire ressortir les étoiles les plus faibles,
y compris celles qui sont au-dessus de la nébulosité la plus brillante. Une fois cela fait, Iimage du
masque d'étoile a été soustraite de I'image du masque de portée pour produire une nouvelle image
de masque qui n'a que la nébulosité brillante visible, avec l'arriere-plan et les étoiles exclus (y
compris les étoiles au-dessus de la nébulosité brillante). Bien que cela puisse sembler trop
complexe, la production ne prend pas beaucoup de temps et est absolument nécessaire pour tirer le
meilleur parti de la netteté des détails fins. Les détails de ces procédures de génération de masques
font I'objet d'un autre tutoriel.

La figure ci-dessus montre le masque appliqué a l'image linéaire pour une protection adéquate du
fond et des étoiles (y compris les étoiles au-dessus d'une nébulosité brillante). L'image du masque
d'étoile produite pour réaliser 'image combinée du masque ci-dessus a été conservée afin de I'utiliser
dans le processus de déconvolution, pour la protection contre les cernes des petites étoiles. Nous
ouvrons maintenant le processus de déconvolution et le mettons en mode PSF externe, car nous
allons lui fournir notre modéle (I'image PSF).

La premiére chose a faire est de sélectionner notre modéle sous View Identifier for External PSF. |l
suffit de cliquer sur le bouton situé a coté de la zone de texte, de sélectionner I'image de la FSP et de
cliquer sur OK.
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Grace au modele actuellement appliqué, nous pouvons personnaliser les parametres requis.
L'algorithme Richardson-Lucy régularisé sélectionné par défaut est excellent et doit étre utilisé. Sous
Iterations, nous devrions fixer une valeur beaucoup plus élevée. Cependant, a chaque fois qu'une
itération est exécutée, la suivante s'affine de moins en moins. Cela signifie qu'au bout du compte,
nous convergeons pour ne plus avoir besoin de nouvelles itérations. En général, une valeur
d'itérations d'environ 50 suffit dans la plupart des cas, mais nous devrions commencer avec 10 pour
expérimenter les réglages. Une boite de prévisualisation peut étre créée et rendue active dans notre
image afin de réduire le temps nécessaire a l'application des parameétres, ce qui nous permet
d'arriver rapidement a un bon ensemble, avant d'appliquer la déconvolution a l'image entiére. Vous
pouvez laisser le parametre Cible réglé sur Luminance (CIE Y) - le parametre par défaut - méme
lorsque vous travaillez avec des images en couleur, car la netteté est fonction de la luminosité de
I'image s'il s'agit d'une image en couleur. N'hésitez pas a expérimenter également le réglage des
composantes RGB/K si vous le souhaitez.

Nous activons maintenant Deringing et ensuite Deringing local. A partir de la, nous devons
sélectionner notre image de masque d'étoile pour servir de support au deringing local. Vous pouvez
choisir de désactiver le deringing local si vous souhaitez qu'il soit appliqgué a I'ensemble de l'image,
mais en geénéral, un masque d'étoile utilisé dans le deringing local permet d'éviter les cercles
sombres autour des étoiles. Pour sélectionner I'image du masque d'étoile dans le Local deringing, il
suffit de cliquer sur le bouton a coté de la zone de texte, de sélectionner I'image du masque d'étoile
et de cliquer sur OK.

Comme nous voulons éviter que les étoiles ne soient entourées de cercles sombres, nous devons
modifier le parametre "Global dark" de Deringing. Le réglage par défaut de 0,1000 est généralement
trop agressif et les valeurs comprises entre 0,0100 et 0,0500 sont généralement les meilleures. J'ai
réglé le mien sur 0,0100.

Vous pouvez conserver Amount local fixé par défaut a 0,70 car cela fonctionne tres bien dans
I'ensemble. La luminosité globale peut également étre laissée a la valeur par défaut de 0,0000 car,
en général, le pourtour est plus sombre que lumineux.

Sous Wavelet Regularization, nous avons une certaine réduction de bruit appliquée aux deux
premieres couches, par défaut. Les parameétres par défaut fonctionnent tres bien ici et comme le bruit
existe généralement dans la premiére couche et un peu sur la deuxiéme couche, vous pouvez garder
seulement ces deux premiéres couches activees. Pour des raisons de seécurité, vous pouvez
augmenter le seuil de bruit de la couche 2 jusqu'a 3,00 et régler la réduction du bruit a 1,00 la aussi.

Nous sommes maintenant préts a lancer la déconvolution sur notre image. Comme nous l'avons déja
mentionné, vous pouvez ne l'exécuter que sur une petite boite de prévisualisation active pour
inspecter les parameétres et ainsi réduire le temps d'exécution. Ci-dessous, j'ai zoomé sur un
segment de l'image et caché le masque (mais je l'ai laissé actif), pour plus de clarté. La deuxieme
capture d'écran montre lI'image modifiée apres application de la déconvolution.
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Si pendant que vous exécutez la déconvolution, vous remarquez dans la console de processus de
PixInsight qu'il est écrit "Local Divergence", cela signifie qu'elle a atteint le point de convergence ou
un plus grand nombre d'itérations ne va pas apporter de réel avantage. Cela signifie que vous
pouvez essentiellement réduire la valeur des itérations au point ou ces avertissements commencent
a apparaitre (la console de processus vous indique quelle itération est en cours d'exécution a ce
moment-la).

Les parametres définis ont produit un bon résultat final qui montre des détails plus fins, sans cercles
sombres visibles autour des étoiles. Il est intéressant de noter que l'image est toujours dans son état
linéaire, qui est strictement I'état de Iimage dans lequel la déconvolution doit étre utilisée. A ce stade,
sachant que les réglages fonctionnent bien, la pratique générale consiste a augmenter les itérations
a 30 ou 50 et a les refaire, juste pour étre shr que I'image est aussi nette que possible. Les boites de
prévisualisation sont utiles pour tester les changements, comme les itérations ou l'obscurité globale
sous Deringing, avant d'appliquer le processus de déconvolution a I'image entiére, car ce processus
prend beaucoup de temps a exécuter.

bY

N'oubliez pas que, comme la déconvolution est appliquée a une image linéaire, elle doit étre
effectuée trés tdt dans le processus de post-traitement. Le prétraitement doit étre effectué dés que
possible. De cette facon, vous travaillez avec une image qui est naturellement plus nette grace a
l'annulation d'une partie de la distorsion introduite par I'atmosphere. Comme nous allons le voir
maintenant, MultiscaleLinearTransform est un autre processus qui peut étre utilisé pour accentuer les
détails fins et nous verrons que celui-ci fonctionne effectivement mieux sur les images non linéaires.
Cela signifie qu'en ce qui concerne le post-traitement, vous pouvez utiliser la déconvolution au début
et plus tard accentuer les détails fins en utilisant la transformation linéaire multiscalaire, une fois que
l'image a été étirée en non-linéaire. L'utilisation des deux procédés dans un flux de travail vous
donnera des images plus nettes dans leur ensemble.

2. MultiscaleLinearTransform

+ Fonctionne extrémement bien avec les images non linéaires et, avec une protection adéquate du
masque, peut bien fonctionner avec les images linéaires.

+ Les résultats sont trés reproductibles avec des réglages trés similaires entre les différentes images,
donc l'application est facile.

- Tend a produire des cernes sur les étoiles si la protection du masque n'est pas bonne, en particulier
sur les images linéaires. Deringing peut aider a prévenir ce phénomene.

MultiscaleLinearTransform est un de ces processus qui fonctionne généralement trés bien avec les
images qui sont soit linéaires soit non linéaires, étant donné son fonctionnement. Cependant,
comme nous le verrons, lorsque I'on affine les détails d'une image en utilisant son réglage de Bias,
les images linéaires peuvent étre plus difficiles a travailler. Ce n'est pas vraiment un probleme, car
ce procédé est généralement utilisé pour accentuer les détails fins a la fin d'un processus de post-
traitement, lorsque votre image est non linéaire.
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Ce qui suit est la méme image monochrome H-Alpha a I'état linéaire, auto-étirée, ouverte en méme
temps que le processus MultiscaleLinearTransform que nous allons utiliser.

MultiscaleLinearTransform est un excellent procédé a utiliser pour affiner les détails fins en raison de
son mode de fonctionnement. Ce processus cible des échelles de pixels particulieres par le biais de
couches. Par exemple, la couche 1 cible des échelles de pixels d'une taille de 1 pixel. Inversement,
la couche 3 vise des échelles de 4 pixels. Cela signifie que nous pouvons effectivement accentuer
les détails fins seulement, tout en laissant de coté les structures plus grandes d'une image (et en fait
la plupart du bruit aussi !). La couche R est appelée la couche résiduelle, et contient tout ce qui ne
figure pas individuellement au-dessus d'elle (par défaut, les échelles de pixels de 16 pixels et plus).
Si nous sélectionnons une valeur plus importante pour les couches dans la liste déroulante, la liste
en contient davantage et la couche R est alors tout ce qui se trouve au-dessus.

Comme les détails fins existent a de petites échelles de pixels, nous n'avons pas besoin d'augmenter
le nombre de couches par rapport au réglage par défaut de 4. De plus, nous utiliserons l'algorithme
par défaut pour MultiscaleLinearTransform, appelé transformation en étoile, qui est précisément la
facon dont le processus ATrousWaveletTransform fonctionne dans son ensemble.

La meilleure facon d'accentuer les détails fins d'une image est de la protéger avec un masque.
Idéalement, le masque ne devrait montrer que les zones claires d'une image qui sont pertinentes,
avec des coupures dans les zones sombres (ces bords fins seraient également accentués, de sorte
gue les transitions entre I'obscurité et la lumiére seraient plus prononcées). En outre, pour éviter
d'accentuer le bruit, le fond doit étre exclu par ce masque. Idéalement, les étoiles devraient
également étre exclues, car sinon le processus d'accentuation des détails fins produira des cercles
sombres autour des petites étoiles (ce qui se produit plus fréquemment lorsque I'on travaille avec des
images linéaires).

Le masque que j'ai réalisé pour cette image particuliére a nécessité quelques étapes et est identique
a celui utilisé pour la déconvolution ci-dessus. Tout d'abord, un clone de l'image linéaire a été réalisé.
Les parametres d'étirement automatique lui ont ensuite été appliqués sous la forme d'un étirement
permanent avec HistogramTransformation pour rendre le clone non linéaire. Le processus
RangeSelection a été utilisé pour sélectionner uniquement les zones de nébulosité les plus claires,
en excluant l'arriere-plan et les zones sombres comme je l'ai jugé bon. Une fois que l'image du
masque de portée a été produite, j'ai utilisé StarMask pour produire un masque avec seulement des
étoiles. Celui-ci a été étiré et un peu tronqué avec HistogramTransformation pour faire ressortir les
etoiles les plus faibles, y compris celles qui sont au-dessus de la nébulosité la plus brillante. Une fois
cela fait, I'image du masque d'étoile a été soustraite de I'image du masque de portée pour produire
une nouvelle image de masque qui n'a que la nébulosité brillante visible, avec l'arriere-plan et les
étoiles exclus (y compris les étoiles au-dessus de la nébulosité brillante). Bien que cela puisse
sembler trop complexe, la production ne prend pas beaucoup de temps et est absolument nécessaire
pour tirer le meilleur parti de la netteté des détails fins. Les détails de ces procédures de génération
de masques font l'objet d'un autre tutoriel.
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Ci-dessus, nous voyons l'image du masque produite pour une protection adéquate de l'arriere-plan et
des étoiles. Cette image est maintenant appliquée comme un masque sur l'image linéaire originale.

L'arriere-plan et les étoiles étant désormais correctement protégés et les zones de nébulosité
brillantes exposées, nous pouvons librement affiner les détails fins. Pour ce faire, nous examinons le
réglage du biais

MultiscaleLinearTransform. Ce paramétre s'applique a des couches individuelles, de sorte que vous
pouvez appliquer un nombre différent a chaque couche individuellement. Nous notons que la couche
1 est dominée par le bruit et nous évitons donc toujours d'accentuer la netteté dans cette échelle de
pixels. Cependant, les couches 2 et 3 sont celles qui ciblent toujours les détails fins. Les couches 4
et supérieures ne sont pas nécessaires pour l'accentuation car ces échelles de pixels dépassent ce
qgue nous souhaitons normalement accentuer, mais n'hésitez pas a faire des expériences. N'affinez
pas la couche R, car cela ne ferait qu'affiner tout ce qui se trouve au-dessus de votre plus grande
couche individuelle. I suffit de sélectionner une valeur plus élevée pour les couches afin de cibler
individuellement les couches situées au-dessus de la couche 4.

Pour les couches 2 et 3, je sélectionne simplement chaque couche et, ce faisant, je fixe une valeur
de 0,100 pour le biais pour les deux.

Gardez a l'esprit que les valeurs inférieures a 0 brouilleront en fait ces échelles de pixels et que les
valeurs supérieures a 0 les rendront plus nettes. Gardez également a l'esprit que le biais peut
devenir trop important tres, tres rapidement. Je n'utilise jamais de valeurs supérieures a 0,100 et j'ai
méme tendance a m'en tenir a environ 0,075. L'expérimentation est cependant essentielle, car les
avantages varient selon les images. N'hésitez pas a utiliser des valeurs différentes dans les couches
2 et 3. En général, la plus petite couche devrait recevoir la plus petite valeur de Bias car plus la
couche est petite, plus vous étes proche du bruit. Par conséquent, des valeurs de biais de 0,050 pour
la couche 2 et de 0,075 pour la couche 3 peuvent étre idéales dans de nombreux cas. Une fois ces
valeurs fixées, nous cliqguons sur Apply et vérifions les changements en zoomant sur les détails fins
(la deuxieme capture d'écran ci-dessous montre I'image modifiée sur un segment zoomeé de celle-ci,
avec le masque caché, mais actif, pour plus de clarté).

C'est une amélioration trés sensible de la netteté globale des détails fins, mais nous remarquons que
certaines des petites étoiles au-dessus de la nébulosité ont souffert de cernes sombres autour
d'elles, malgré la protection du masque. On peut y remédier Iégérement en activant le parameétre
Deringing dans MultiscaleLinearTransform.

Comme nous sommes confrontés a des cernes, il vous suffit de définir une valeur appropriée
(supérieure a 0) pour le paramétre Dark sous Deringing. N'oubliez pas que Deringing s'applique a
I'ensemble du processus et non a chaque couche. De plus, les choses peuvent devenir moches et
rapidement. Le tableau ci-dessous montre les résultats de l'application de MultiscaleLinearTransform
avec les mémes parametres de biais, mais avec Deringing activé et avec les parametres par défaut.
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En effet, le réglage par défaut de Dark under Deringing est trop agressif pour les images linéaires.
Réduire ce parametre a 0,0100 donne de meilleurs résultats.

Le résultat final est certainement bien meilleur, bien que des cernes soient encore visibles si vous
zoomez sur les petites étoiles, mais il s'est nettement amélioré.

Nous passons maintenant a une image non linéaire. En effet, nous n'avons fait qu'appliquer les
parametres d'étirement automatique de fagcon permanente a limage en utilisant la transformation
d'histogramme, mais l'image est maintenant non linéaire. C'est I'état de l'image dans lequel vous
serez le plus souvent pour accentuer les détails fins en utilisant MultiscaleLinéaire Transformation .
Ce qui suit montre limage non linéaire avec le méme masque que celui qui lui a été appliqué
auparavant.

Nous allons maintenant appliquer les mémes paramétres de biais qu'auparavant - 0,100 aux
couches 2 et 3 - mais avec Deringing désactivé. J'ai zoomé sur un segment particulier de l'image et
jai gardé le masque caché, mais actif, pour plus de clarté (la deuxieme capture d'écran ci-dessous
montre I'image modifiée).

Bien que les cernes soient légéerement visibles sur les plus petites étoiles, il s'agit d'une amélioration
considérable de la performance de I'image non linéaire par rapport a une image linéaire. Si vous le
souhaitez, le Deringing peut étre activé et utilisé avec une valeur appropriée sous Dark
(généralement une valeur trés faible). Cependant, en général, la netteté des détails fins et I'évitement
des cernes autour des petites étoiles est un processus de réglage fin entre le choix de valeurs de
Bias qui produisent une bonne netteté et n'affectent pas agressivement les petites étoiles, et le choix
de valeurs de Deringing Dark qui compensent un peu sans affecter négativement l'image. La
protection du masque contribue certainement a alléger le fardeau que représente la recherche de cet
equilibre délicat.

Je n'utilise normalement pas du tout Deringing car je trouve que les valeurs de bias que j'utilise sont
tres appropriées et jutilise toujours MultiscaleLinearTransform sur des images non linéaires.
J'accentue toujours les détails fins sur les couches 2 et 3 et seulement Iégerement avec des valeurs
de biais comprises entre 0,050 et 0,100. J'ai tendance a trouver un équilibre entre une netteté
suffisante et le fait de ne pas nuire aux petites étoiles aux cernes sombres, bien que jaccepte tres
peu de choses si je dois le faire.

Dans I'ensemble, l'utilisation de la déconvolution dans I'état linéaire d'une image et, plus tard, de la
transformation linéaire multiscalaire dans I'état non linéaire d'une image peut fournir un niveau
étonnant de netteté des détails fins que vous ne pouviez pas apprécier lors du prétraitement de votre
image. En raison de cet avantage, l'utilisation de ces procédés, ou du moins de la transformée
linéaire multiscalaire (si la résolution de votre image et les conditions du ciel nocturne ne présentent
pas d'avantages visibles avec la déconvolution), est considérée comme essentielle dans un flux de
travail de post-traitement.
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IX. Ameéliorer le contraste

Le post-traitement des images tend a passer par un régime standard de processus pour les amener
des images prétraitées aux résultats finaux qui sont publiés. Cela implique généralement une
réduction du bruit, une combinaison de couleurs (si I'on travaille initialement avec des images
monochromes), un étirement non linéaire et méme un accentuation des détails fins. Dans tous les
cas, le résultat final peut bénéficier d'un traitement supplémentaire, dans ce cas, pour améliorer le
contraste des traits, dont certains peuvent étre cachés dans une nébulosité brillante.

Ce tutoriel présente le processus d'amélioration du contraste des éléments d'une image non linéaire.
Une image couleur est utilisée car elle illustre mieux les techniques, mais il est souligné qu'une
image monochrome peut recevoir les mémes traitements que ceux décrits ici. L'image couleur
utilisée comme exemple dans ce tutoriel est post-traitée de maniére cumulative par les processus et
le script PixInsight appliqués comme une sorte de flux de travail. Les trois processus décrits sont
HDRMultiscaleTransform, LocalHistogramEqualization and CurvesTransformation. Le script
DarkStructureEnhance est également décrit en guise de conclusion.

Supposé pour ce tutoriel :

- Connaissance du fonctionnement de PixInsight, en rapport avec le traitement des images, les
processus et le travail avec les masques (Lire_les sections 3, 4 et 6).

- Vos images ont déja été entierement prétraitées ( Lire ceci).

- Connaissance de la production de différents types de masques ( Lire ceci).

1. HDRMultiscaleTransform

HDRMultiscaleTransform est un processus qui permet d'améliorer de fagon apparemment magique
la gamme dynamique d'une image, en récupérant des détails qui semblent cachés derriére des
zones trop lumineuses. Par exemple, le noyau de la nébuleuse d'Orion M42 ou les bras spiraux
d'une galaxie a proximité de son noyau. Bien que ce procédé puisse étre appliqué aux images
monochromes et en couleur, nous travaillerons avec une image en couleur car elle montre plus
clairement les améliorations. En outre, la transformation HDRMultiscale devrait étre appliquée aux
images non linéaires (étirées) et, en tant que telle, I'image sur laquelle nous travaillons est également
non linéaire. Comme ce procédé serait appliqué assez tard dans un flux de travail de post-traitement,
votre image sera sans doute non linéaire a ce stade et peut méme avoir été combinée a des couleurs
LRGB ou a bande étroite a ce stade (si vous travaillez initialement avec des images monochromes).
L'image de travail utilisée ici est donc un bon exemple.

Ce didacticiel va passer en revue l'application de tous les processus et le script énumérés, l'un apres
lautre dans l'ordre indiqué, plutdt que d'appliquer chacun d'entre eux séparément. Nous
commencgons avec une image couleur non linéaire assez post-traitée. Il s'agit d'une image bicolore a

{ } 110


http://www.lightvortexastronomy.com/tutorial-producing-masks.html
http://www.lightvortexastronomy.com/tutorial-pre-processing-calibrating-and-stacking-images-in-pixinsight.html
http://www.lightvortexastronomy.com/tutorial-introduction-to-pixinsight-and-its-interface.html

bande étroite qui a été réduite en bruit, étirée, combinée en couleurs et enfin réduite davantage en
bruit.

Bien qu'il y ait déja beaucoup de détails dans cette image, il est clair que la nébulosité trés brillante
peut en effet cacher certains des fins détails filamenteux en dessous. Pour ceux qui sont familiers
avec MultiscaleLinearTransformation, MultiscaleMedianTransformation ou
ATrousWaveletTransfromation, notez que HDRMultiscaletransformation fonctionne de la méme
maniere, en ciblant les couches correspondant aux échelles de pixels contenant des éléments (d'ou
son nom). Ceci nous amene au premier parametre, le nombre de couches. Le réglage par défaut de
6 signifie que les 6 premiéres couches vont étre ciblées par le processus (ces couches
correspondent a des échelles de pixels de 1, 2, 4, 8, 16 et 32 pixels). Le parametre Nombre de
couches est essentiel pour obtenir un résultat souhaitable, car le modifier d'une seule unité peut
donner des résultats tres différents. Hélas, les différentes images n'en tirent pas toutes le méme
bénéfice. Pour une image telle que celle sur laquelle je travaille ici, je m'attendrais a ce que de
grandes valeurs de Nombre de couches soient bénéfiques car il y a beaucoup de grandes structures
présentes. Pour une image d'une galaxie avec des détails trés petits et fins sur les bras spiraux, des
valeurs plus petites de Nombre de couches peuvent étre plus efficaces. L'expérimentation est la clé.

Pour commencer, nous utiliserons la valeur par défaut de 6 pour le Nombre de couches - c'est une
bonne valeur pour la plupart des cas. Le nombre d'itérations est li€¢ au nombre de fois qu'il faut
exécuter le processus successivement. Comme nous voulons tester les paramétres, nous
conserverons la valeur par défaut de 1.

L'option de la transformation médiane fait que HDRMultiscale Transform utilise un algorithme différent
pour effectuer son travail. En passant le curseur de la souris sur cette option, PixInsight signale
gu'en effet, qu'aucun des deux algorithmes n'est meilleur que l'autre, car ils sont différents, bien que
Median Transform ait tendance a éviter les cernes autour des étoiles, mais qu'elle prenne plus de
temps a traiter. Comme nous voulons éviter les cernes autour des étoiles sans trop nous soucier de
l'utilisation des paramétres de Deringing (qui peuvent étre utilisés si vous souhaitez les modifier),
nous activons Median Transform. Comme il s'agit d'une image couleur sur laquelle nous travaillons, il
est recommandé d'activer I'option To luminosité, qui permettra d'améliorer la gamme dynamique de
la luminosité de l'image et de préserver la couleur. Cette option n'est pas nécessaire si vous
travaillez avec une image monochrome, bien sdr. L'option suivante que nous devrions activer est le
masque de luminosité, qui force HDRMultiscaleTransform a appliquer son algorithme le plus
fortement aux zones les plus lumineuses de l'image. C'est en effet ce que nous voulons car ce sont
les zones claires d'une image qui ont tendance a en bénéficier le plus de toute fagon.

L'option "Midtones Balance" en bas doit étre maintenue a la valeur automatique recommandée, car
elle permet de préserver les détails de lI'image et d'améliorer la gamme dynamique au fur et a
mesure que le processus fait son travail. Cependant, avant d'appliquer le processus a l'image, nous
devons utiliser un masque. Un masque simple et efficace a utiliser pour la transformation
HDRMultiscale est un masque produit avec la fonction RangeSelection, qui permet de sélectionner
uniquement la nébulosité brillante de l'image, et d'exclure certaines étoiles également, avec un
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réglage utilisé pour lisser l'image du masque. Les détails de ces procédures de génération de
masques font I'objet d'un autre tutoriel.

Ci-dessus, nous voyons l'image du masque de portée en elle-méme et son application a I'image que
nous traitons. Il ne reste plus qu'a appliquer la HDRMultiscaleTransform a l'image, les zones de
nébulosité brillante n'étant pas protégees. Ci-dessous, le masque appliqué est toujours actif mais a
été masqué pour plus de clarté.

La deuxieme capture d'écran ci-dessus montre l'image altérée. Il est clair qu'une grande partie de la
luminosité globale de la nébulosité a été noyée et qu'une grande partie des détails filamenteux
préecédemment cachés ont été retirés. Bien que le résultat final semble bon, nous pouvons
expérimenter avec différents réglages pour Number of Layers. Par exemple, ci-dessous, nous
voyons l'image lorsque le Nombre de couches est réglé sur 4, 5, 7 et 8 (dans cet ordre).

En effet, HDRMultiscale Transform prend un certain temps pour s'exécuter sur I'ensemble de I'image,
en particulier avec la transformée médiane activée, méme avec le masque. Les petites boites de
prévisualisation sur les zones d'intérét sont une bonne idée pour tester rapidement différents
parameétres. Quoi gu'il en soit, ce qui précéde montre que la modification du nombre de couches a
des effets spectaculaires sur le résultat final. C'est a vous de choisir le réglage a utiliser, mais il me
semble qu'un réglage de 8 donne a l'image un aspect global beaucoup plus agréable en termes de
gamme dynamique.

Une fois que vous étes satisfait du réglage du Number of Layers, il est temps de penser a modifier le
réglage de Iteration Number. Habituellement, le réglage par défaut de 1 fonctionne bien, mais 2 peut
aussi donner d'excellents résultats sans en faire trop (cela dépend de l'image !). Le paramétre
Overdrive peut également étre augmenté au-dessus de O pour permettre un réglage plus fin. Ce
réglage permet essentiellement d'échelonner de facon trés stricte I'amélioration de la gamme
dynamique par itération. Il est bon de régler d'abord un bon nombre d'itérations et de penser ensuite
a I'Overdrive. Ainsi, nous augmentons le nombre d'itérations a 2 et appliquons le processus avec un
nombre de couches fixé a 8.

Cela semble excellent a ce stade, avec des tonnes de détails filamenteux qui sortent de la brillante
nébulosité. Vous souhaiterez peut-étre utiliser la fonction Overdrive pour étre un peu plus agressif
dans le méme nombre d'itérations, mais c'est & vous de choisir. De petites valeurs d'Overdrive
devraient faire I'affaire, comme 0,100 a 0,200 par exemple. Si, malgré votre masque de protection et
l'utilisation de la transformée médiane, vous obtenez des cernes autour des étoiles, vous pouvez
activer la fonction Deringing et expérimenter avec de petites valeurs pour Small Scale et Large Scale
jusqu'a ce que les cernes ne soient plus un probleme.

En effet, HDRMultiscaleTransform peut étre appligué une fois de plus sur limage, mais
généralement la deuxieme application se fait sur un nombre de couches beaucoup plus petit
(généralement 3 environ) et avec un nombre d'itérations fixé a 1 seulement, généralement sans
Overdrive. L'expérimentation est la clé. Il se peut que vous n'ayez pas besoin d'une deuxiéme
application et que vous n'aimiez pas les résultats de toute facon. Pour l'instant, nous en avons fini
avec HDRMultiscale Transform.
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2. LocalHistogramEqualization

Le prochain processus a appliquer a notre image exemple est LocalHistogramEqualization. Cela
permettra de récupérer une partie de la luminosité des principaux objets de l'image. Ce processus
nécessite que l'image soit non linéaire et améliore fortement le contraste par sa nature méme. |l
fonctionne aussi bien avec des images monochromes que couleur.

LocalHistogramEqualization est I'un des processus les plus faciles a appliquer a une image et
également I'un des plus impressionnants en termes de résultats finaux. Un masque de protection est
recommandé et pour appliquer ce processus, j'ai simplement utilisé exactement la méme image de
masque que j'utilisais avec HDRMultiscale Transform.

Ce masque protége essentiellement le fond du ciel et la plupart des étoiles, ne laissant sans
protection que la brillante nébulosité, dont nous souhaitons renforcer le contraste. Le parametre
Kernel Radius de LocalHistogramEqualization définit le nombre de pixels autour de la cible a utiliser
pour évaluer I'amélioration du contraste. En général, plus cette valeur est faible, plus I'effet global est
fort, mais des valeurs faibles auront tendance a renforcer le contraste dans le bruit a petite échelle et
a provoquer des cercles sombres autour des étoiles. La valeur par défaut de 64 a tendance a bien
fonctionner mais si vous remarquez des cercles sombres autour des étoiles, augmentez cette valeur.
Une valeur que j'ai tendance a utiliser est 150.

Vous pouvez commencer par expérimenter avec des valeurs plus faibles du Kernel Radius. Contrast
Limit contrdle la force avec laquelle le contraste de votre image doit étre amélioré. Le réglage par
défaut de 2.0 doublera essentiellement le contraste. J'ai tendance a trouver le 2.0 trop agressif et je
m'en tiens généralement a des valeurs comprises entre 1.2 et 1.4, bien que généralement les valeurs
entre 1.1 et 2.0 fonctionnent assez bien, en fonction de votre image. Il y a certainement quelque
chose a expérimenter car il y a un sur-traitement et la limite de contraste est I'un de ces réglages qui
montre un sur-traitement lorsque vous le réglez trop haut. J'ai réglé le mien sur 1,3.

La fixation de Amount a exactement la méme signification que pour tous les autres processus. Cela
permet de fusionner l'image originale avec l'image améliorée. Par exemple, un réglage de 0,8 dans
Amount mélangera 20 % de l'image originale avec 80 % de l'image améliorée. Ce réglage peut étre
utilisé pour adoucir le résultat final - en un sens, il permet de régler avec précision l'agressivité avec
laguelle vous améliorez le contraste une fois que vous avez obtenu de bons réglages pour Kernal
Radius et Contrast Limit. La résolution de I'hnistogramme peut généralement étre laissée a 8 bits
(256) car elle donne les meilleurs résultats globaux avec la grande majorité des images. Circular
Kernel est laissé activé pour renforcer la précision de I'amélioration du contraste.
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Une fois les parametres établis, il suffit d'appliquer le processus a notre image. Ci-dessous, le
masque est toujours actif mais a été masqué pour plus de clarté. La deuxiéme capture d'écran
montre lI'image modifiée.

Comme on peut le voir clairement, une grande partie du contraste dans la nébulosité brillante a été
récupérée en appliquant LocalHistogramEqualization, bien que ce qui précéde soit un peu agressif a
mon gout. Une limite de contraste de 1,2 donne de meilleurs résultats dans ce cas.

J'aurais également pu modifier Amount pour affiner le résultat final. Dans I'ensemble, c'est une
question de golt personnel. Ce qui précéde est un résultat final sensible a mon godt personnel.

Maintenant que LocalHistogramEqualization est appliquée, nous passons a l'amélioration de cette
image par un simple ajustement effectué dans CurvesTransformation. Comme auparavant, nos
applications sont cumulatives, car nous continuons avec le résultat final indiqué ci-dessus.

3. CurvesTransformation

Le processus CurvesTransformation permet d'ajuster de nombreux aspects d'une image. Ce
processus est utilisé au mieux vers la fin du post-traitement d'une image sans doute non linéaire.

CurvesTransformation fonctionne selon plusieurs modes. Le mode par défaut, RGB/K, ajuste
directement I'histogramme de l'image. Les réglages peuvent étre effectués individuellement pour
chaque canal de couleur, ou pour la luminosité d'une image, la saturation des couleurs, etc. Le mode
par défaut de RGB/K est celui que nous utiliserons pour ajuster le contraste de I'image. N'oubliez pas
gue ce mode sera appliqué a I'ensemble de l'image et qu'aucun masque n'est actif sur lI'image.

Il est fortement recommandé d'ouvrir la fenétre Real-Time Preview sur CurvesTransformation.
Ajustez la taille de la fenétre afin de pouvoir voir clairement ce avec quoi vous travaillez.

Pour ajuster le contraste global, nous devons créer une courbe en S. Si nous cliquons n'importe ou
sur le graphique dans CurvesTransformation, un point d'ancrage est créé, que nous pouvons faire
glisser n'importe ou et qui modifie la forme de la courbe au fur et a mesure que nous le faisons
glisser. Pour améliorer le contraste, les zones sombres doivent étre un peu plus sombres et les
zones claires un peu plus claires. Par conséquent, cliqguez sur un quart de la ligne droite et faites
glisser le point d'ancrage un peu vers le bas. Ensuite, cliquez sur les trois quarts de la ligne droite et
faites glisser le point d'ancrage un peu vers le haut. Cela produira la courbe en S.

Vous pouvez activer et désactiver le Real-Time Preview pour évaluer rapidement l'effet de
I'ajustement sur I'image. Vous pouvez créer un troisieme point d'ancrage au milieu de la courbe, en le
faisant glisser un tout petit peu vers le coin supérieur gauche du graphique, pour augmenter le
contraste un peu plus.
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Vous pouvez remarquer, selon votre image, que ce processus peut étre trop, trop rapide. De simples
petits ajustements effectués ici sont la clé d'un bon résultat final qui ne semble pas exagéré ou sur-
traité. Faites glisser les points d'ancrage, tout en conservant la courbe en S, jusqu'a ce que vous
soyez satisfait du résultat final proposé, affiché dans la fenétre d'apercu en temps réel.

Une fois que vous étes satisfait, avant d'appliquer le processus, nous pouvons également ajuster un
peu la luminosité. Pour cela, passez en mode Lightness (ou L).

Notez que cela ne fonctionnera que sur les images en couleur car les images monochromes ne
peuvent pas avoir leur luminosité ajustée - juste leur histogramme habituel via le mode RGB/K
comme nous venons de le faire. Pour augmenter un peu la luminosité, il suffit de cliquer sur la ligne
droite au milieu et de faire glisser le point d'ancrage un peu vers le coin supérieur gauche du
graphique.

Cela rend l'image globale nettement plus lumineuse. Comme auparavant, moins c'est plus - n'en
faites pas trop. Un dernier ajustement qui peut étre fait, si vous travaillez avec une image en couleur,
est la saturation des couleurs sur I'ensemble de I'image. Pour cela, on passe en mode Saturation (ou
S).

La encore, il suffit de cliquer au milieu de la ligne droite et de faire glisser le point d'ancrage un peu
vers le coin supérieur gauche du graphique. Un tout petit ajustement permet d'aller loin et bien sar, la
fenétre d'apergu en temps réel est la pour démontrer l'effet.

Une fois que vous étes satisfait de tous vos réglages, il vous suffit de fermer la fenétre d'apercu en
temps réel et d'appliquer le processus de CurvesTransformation.

Le résultat final présente un contraste global beaucoup plus élevé, les détails fins ressortant
davantage, tant en termes de luminosité que de couleur. A ce stade, nous mettons un terme a
l'utilisation de CurvesTransformation et passons a |'étape cumulative finale de notre mission qui
consiste a améliorer le contraste des caractéristiques de I'image.

4. DarkStructureEnhance

DarkStructureEnhance peut étre considéré par certains comme une fonctionnalité Pixinsight un peu
cachée, car elle n'est pas disponible en tant que processus, mais en tant que script. Ceux qui
travaillent toujours avec les processus peuvent l'avoir manqué. Vous la trouverez sous Utility dans le
menu Scripts.

D'une maniére générale, le script DarkStructureEnhance peut étre utilisé a la toute fin d'un flux de
travail de post-traitement et sur I'ensemble de l'image, sans aucun masque. Il peut apporter les
touches finales qui donnent aux détails les plus sombres de votre image un contraste supplémentaire
par rapport aux zones environnantes plus claires. Pour utiliser ce script, il suffit de s'assurer que
I'image correcte est sélectionnée sous Image cible et de cliquer sur OK. Les parameétres par défaut
fonctionnent a merveille.
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Vous pouvez modifier Amount, bien que la valeur par défaut de 0,40 soit excellente car elle mélange
40 % de l'image originale avec 60 % de I'image modifieée, ce qui évite d'en faire trop. Les itérations a
1 sont suffisantes dans la plupart des cas, mais vous pouvez essayer avec 2. Sinon, cliquez sur OK,
attendez un peu et une fois le résultat obtenu, annulez et recommencez sur l'image pour voir les
changements appliqués. Si vous n'étes pas satisfait, annulez, relancez le script et utilisez des
parametres différents. Ci-dessous, j'ai utilisé les parametres par défaut (voir ci-dessus).

Le résultat final montre certainement un contraste beaucoup plus élevé par rapport aux €léments
sombres de l'image, ce qui est le but de ce scénario. Si vous étes trop agressif, vous risquez de
perdre une partie des détails fins de ces structures sombres, alors essayez de l'utiliser de maniere
modérée et vérifiez attentivement les changements avant de continuer.

Pour apporter la touche finale a une image, vous pouvez utiliser CurvesTransformation une fois de
plus pour en tirer le meilleur parti, mais c'est entierement facultatif et une question de golt personnel.
Dans I'ensemble, ces quatre procédés ont permis d'obtenir un contraste beaucoup plus important sur
I'ensemble de l'image que ce qui était visible au début de ce tutoriel.
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X. Reduction de la pollution lumineuse, retirer le gradiant
et correction par flat

Parfois, des circonstances inévitables conduisent a une pollution lumineuse globale qui fait briller les
images. Dans la société actuelle, il peut étre difficile de s'éloigner de toute la pollution lumineuse. Il
existe des filtres de suppression de la pollution lumineuse, qui peuvent aider pour certains types de
pollution lumineuse, mais il peut néanmoins y avoir une lueur dans les images. Cette lueur envahie
les images, généralement dans une teinte orange. L'extraction dynamique de l'arriere-plan est I'un
des procédeés les plus impressionnants de PixInsight et peut étre utilisée pour supprimer cette lueur,
réduisant ainsi efficacement les effets de la pollution lumineuse sur les images.

Non seulement la pollution lumineuse délave les images avec certains gradients d'intensité, mais
d'autres lumiéres externes peuvent produire des gradients qui semblent affecter différentes parties
de l'image avec différents niveaux de gravité. DynamicBackgroundExtraction est tout a fait capable
de s'attaquer a ce probléme, car les gradients sont traités de la méme maniére que la pollution
lumineuse elle-méme. De plus, la technologie DynamicBackgroundExtraction est capable de corriger
artificiellement les images si elles n'ont pas été calibrées avec des flats appropriés. L'inconvénient
est I'absence d'élimination des poussiere, mais le vignettage est néanmoins éliminé de maniére
efficace.

Ce tutoriel couvre le processus de DynamicBackgroundExtraction en détail, en commencant par les
principes fondamentaux de son fonctionnement, puis en passant aux trois principales applications
décrites ci-dessus. Il s'applique aussi bien aux images en couleur qu'aux images monochromes..

Supposé pour ce tutoriel :

- Connaissance du fonctionnement de PixInsight, en rapport avec le traitement des images et des
processus (Lire les sections 3 et 4).

- Vos images ont déja été entierement prétraitées (Lire ceci).
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1. Le processus DynamicBackgroundExtraction

Comme son nom lindique, le processus DynamicBackgroundExtraction est un processus
dynamique. Cela signifie qu'une fois qu'il est ouvert et initialisé sur une image ouverte dans
PixInsight, il ne peut pas étre appliqué a une autre image ouverte sans fermer le processus et le
rouvrir pour l'autre image (ou appliquer une icone de processus enregistré a l'autre image). Ci-
dessous, une image linéaire capturée sur un DSLR (auto-étiré dans PixInsight) avec le processus
DynamicBackgroundEXxtraction ouvert a coteé.

Les onglets importants Sample Generation et Target Image Correction ont été développés pour
montrer leurs parametres, car nous allons travailler avec ceux-ci. Le processus n'est pas encore
initialisé. Ceci est démontré par le fait que toutes les options de réglage sont grisées. Pour l'initialiser,
nous pouvons sélectionner la fenétre du processus puis cliquer n'importe ou dans l'image cible, ou
sélectionner I'image cible puis cliquer sur le bouton Réinitialiser le processus.

Vous remarquerez immédiatement qu'un réticule apparait dans l'image cible. Il définit le centre du
gradient de pollution lumineuse ou d'un autre gradient présent dans limage gue nous visons a
éliminer. En placant la souris au centre du réticule, le curseur de la souris se transforme en un
curseur indiquant que vous pouvez le déplacer. Une fois que le curseur change, il suffit de maintenir
le bouton gauche de la souris enfoncé et de faire glisser le réticule nimporte ou sur I'image. Vous
pouvez faire glisser chaque ligne (verticale et horizontale) individuellement en passant la souris sur
les lignes elles-mémes (n'importe ou le long de chacune), plutdt que sur le centre du réticule. Ceci
est utile si vous remarquez que votre gradient n'est pas centré sur l'image.

En cliquant sur le bouton "Réinitialiser le processus", le réticule revient a sa position par défaut au
centre de lI'image. Comme le gradient de cet exemple est assez centré sur I'image, nous gardons le
réticule au centre de l'image.

Avant d'aborder les paramétres de DynamicBackgroundExtraction, nous allons d'abord présenter les
principes fondamentaux de son fonctionnement. DynamicBackgroundExtraction fonctionne en
générant une image correspondant a des points échantillons placés sur l'image cible. Il n'est pas
surprenant que les points échantillons placés sur limage cible doivent étre placés purement au-
dessus de ce qui devrait étre l'arriere-plan - et non au-dessus des étoiles, de la nébulosité, des
galaxies, etc. Pour que l'image générée soit une représentation exacte des gradients de l'image
cible, celle-ci doit étre échantillonnée a chaque endroit et, si possible, a intervalles assez réguliers.
Cela donne au processus une bonne idée de ce a quoi ressemblent les gradients et donne un
résultat final agréable lorsque I'image générée est soustraite de I'image cible.

Les points d'échantillonnage peuvent étre placés manuellement n'importe ou le long de l'image en
cliguant simplement sur l'image cible une fois que le processus a été initialisé comme indiqué ci-
dessus.

La capture d'écran ci-dessus montre un segment de l'image zoomeée. Les points placés ont été
encerclés pour plus de clarté. lls sont représentés par des carrés dans l'image. Une fois placés, ils
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peuvent étre déplacés et supprimés en cliquant dessus pour les sélectionner et en appuyant sur la
touche DEL de votre clavier. Selon la taille relative de I'image, vous pouvez bénéficier de points
d'échantillonnage plus ou moins importants. Par défaut, la taille des points d'échantillonnage est fixée
a un rayon de 5 pixels. Je trouve que c'est un peu trop petit pour la plupart des tailles d'images de
nos jours. Personnellement, jai tendance a utiliser des parameétres de 10 a 15 pour le rayon
d'échantillonnage par défaut. Si vous souhaitez modifier la taille de vos points d'échantillonnage, il
vous suffit d'entrer une nouvelle valeur sous Default sample radius et de cliquer sur le bouton Resize
All.

La bonne taille des points d'échantillonnage dépend en fait de la taille de l'image elle-méme et de la
densité du champ d'étoiles. Pour les champs d'étoiles extrémement denses, des points
d'échantillonnage de grande taille peuvent poser probléeme. L'image ci-dessous est présentée en
taille réelle (sans zoom) avec une taille de point d'échantillonnage a peu prés correcte, qui s'est
avéree étre de 10.

Maintenant que nous avons couvert les éléments fondamentaux de ce dont le processus a besoin -
les points d'échantillonnage - nous nous rendons compte que cela peut étre trés fastidieux.
Heureusement, le placement automatique des points d'échantillonnage peut faciliter la tache. Une
fois que vous avez déterminé la taille approximative correcte des points d'échantillonnage, vous
pouvez effacer l'image des points d'échantillonnage en cliquant sur le bouton "Reset" du processus.
Cela supprimera votre parameétre de rayon d'échantillonnage par défaut, alors saisissez-le a nouveau
et cliquez sur le bouton Resize All. Dans mon cas ici, il est de 10. Une fois que vous avez terminé,
vous pouvez cliquer sur le bouton Generate, qui placera automatiquement des échantillons sur toute
l'image.

L'image ci-dessus montre immédiatement que peu de points d'échantillonnage ont été placés
automatiquement. Cela n'est pas trés utile. De plus, il y a un grand espace entre les lignes. Cela ne
convient pas pour cette image car il y a des gradients intenses avec des changements rapides. Pour
réduire I'écart entre les lignes, nous entrons simplement une valeur plus importante pour les
échantillons par ligne. 15 a tendance a étre une bonne valeur. Pour entrer une nouvelle valeur ici,
nous devons cliguer a nouveau sur Générer pour appliquer les changements.

Le nombre de points d'échantillonnage placés automatiquement est désormais bien meilleur, avec un
ecart plus petit (et acceptable) entre les lignes. Le probléeme est que de nombreuses zones de
I'image ne sont pas échantillonnées, notamment les coins les plus sombres. En effet, ces zones sont
rejetées par DynamicBackgroundExtraction en fonction de la pondération de I'échantillon et de la
tolérance définie.

Pour aider le processus a placer automatiquement plus de points d'échantillonnage, nous pouvons
réduire le poids minimum de ['échantillon. Le réglage par défaut de 0,750 peut fonctionner
correctement, mais je trouve qu'un réglage de 0,100 est préférable pour placer automatiquement des
points d'échantillonnage. Pour modifier a nouveau ce réglage, il faut cliquer sur le bouton "Générer"
pour placer a nouveau des points d'échantillonnage.
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Nous constatons gu'il nous manque encore des points d'échantillonnage dans les zones clés des
gradients présents - vers les coins les plus sombres. On note aussi que, malgré le fait que de
nombreux points d'échantillonnage soient placés au-dessus, certains sont rejetés. Cela signifie que
ces points d'échantillonnage ne seront pas inclus dans la génération de lI'image modéle, ce qui n'est
pas souhaitable car ces points d'échantillonnage se trouvent dans des zones importantes. Les points
d'échantillonnage rejetés prennent une couleur différente de celle des cases claires. Par défaut, ils
devraient étre de couleur rouge, mais la couleur des dégradés de limage que j'utilise comme
exemple rend difficile la discernement de leur couleur rouge. Néanmoins, les points d'échantillon
rejetés sont clairs et sont encerclés ci-dessous.

b

Le paramétre clé a ajuster maintenant est la Tolérance. La valeur par défaut de 0,500 est
généralement excellente, mais pour des gradients plus intenses comme ceux présenteés ici, il faut
augmenter la Tolérance a une valeur plus élevée. Pour des gradients intenses comme ceux-la, des
valeurs de 1.000 jusqu'a environ 1.500 fonctionnent généralement bien. L'objectif est de fixer cette
valeur a la plus basse possible (mais généralement pas en dessous de 0,500 !) tout en s'assurant
que tous les points de I'échantillon sont acceptés et qu'ils se trouvent sur toutes les zones de
I'arriere-plan de l'image. Pour cette image, j'augmente la Tolérance a 1.000 et je clique a nouveau
sur le bouton Générer pour placer automatiquement les points d'échantillonnage.

Remarquez que beaucoup plus de points d'échantillonnage sont maintenant présents et que l'image
est en grande partie couverte. Remarquez également que les points d'échantillonnage centraux qui
étaient auparavant rejetés sont maintenant acceptés. Vous pouvez cependant remarquer le long des
halos d'étoiles brillantes qu'il y a des points d'échantillonnage et que ceux-ci sont rejetés. Je
n'ajusterai pas la Tolérance pour cela, car ces points d'échantillonnage ne devraient pas étre la pour
commencer - souvenez-vous que les points d'échantillonnage doivent strictement couvrir le fond, et
non les étoiles, la nébulosité ou les galaxies (ou les halos d'étoiles dans ce cas !).

Un léger probleme est que, malgré la valeur de tolérance de 1.000 qui est trés utile, il manque
encore quelques points d'échantillonnage clés - les coins mémes. Le coin inférieur droit a un point
d'échantillonnage a cet endroit, mais il est rejeté. Idéalement, les coins devraient toujours étre
échantillonnés pour que ce processus fonctionne bien (sauf si les coins contiennent des objets que
vous ne voulez pas voir échantillonnés !) Jaugmente donc la Tolérance a 1.300 et je cliqgue a
nouveau sur le bouton Generate pour vérifier.

Les coins sont maintenant couverts par des points d'échantillonnage valables. L'augmentation de la
tolérance peut avoir ajouté des points d'échantillons sur des zones indésirables (telles que les étoiles
brillantes, les halos d'étoiles ou la nébulosité). C'est inévitable, mais nous pouvons de toute fagcon
supprimer ces points d'échantillonnage problématiques. Avant 1.300, j'ai testé des valeurs de 1.100
et 1.200, mais malheureusement un ou deux coins étaient toujours omis ou rejetés. Si un point
d'échantillonnage est placé dans un coin mais qu'il est toujours rejeté, vous pouvez choisir de
déplacer manuellement le point d'échantillonnage, méme légérement hors du coin. Cela est
généralement souhaitable plutét que d'augmenter encore la tolérance, tant que le point
d'échantillonnage se trouve toujours dans le coin. Une derniére remarque avant de poursuivre : la
DynamicBackgroundExtraction ne doit étre utilisée que sur les images qui n‘'ont pas de bords noirs
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autour d'elles (ceux-ci ont tendance a apparaitre en raison des processus d'empilage et
d'enregistrement). Veuillez vous assurer que ces bords sont bien éliminés avant d'utiliser la fonction
DynamicBackgroundExtraction. Cela permettra de s'assurer que limage générée est une
représentation fidele de ce qui est affiché par l'image cible.

Nous en sommes maintenant a un stade ou l'image est bien échantillonnée et ou les gradients
peuvent étre modélisés par I'image générée. Le parametre Facteur de lissage se charge de lisser
I'image générée afin d'éliminer les valeurs aberrantes et de soustraire un modeéle de gradients de
fond doux a votre image cible. Le parametre par défaut de 0,250 fonctionne exceptionnellement bien
dans presque tous les cas. Vous pouvez tester de le diminuer légerement pour obtenir une
soustraction plus ciblée, mais généralement les valeurs inférieures a 0,100 ne fonctionnent pas tres
bien car les points d'échantillonnage sont pris trop au pied de la lettre.

Le réglage de la correction (soustraction ou division) est important en fonction de ce que I'on cherche
a faire. Ce parametre est traité dans les sections suivantes en fonction de I'application.

Le placement automatique des points d'échantillonnage est quelque peu aveugle, en fonction de
votre image cible et des paramétres saisis dans DynamicBackgroundExtraction. Certains de ces
points échantillons se trouveront inévitablement sur des zones qu'ils ne devraient pas se trouver -
étoiles, halos d'étoiles, nébulosité, galaxies, etc. Ces points échantillons peuvent étre Iégérement
déplacés et mis a l'arriere-plan, ou entierement supprimés. Ces points échantillons peuvent étre
légerement déplacés vers l'arriere-plan ou entierement supprimés. Voici une procédure assez
fastidieuse : examiner chaque point échantillon placé et déplacer ou supprimer ceux qui posent
probleme. Il est utile de zoomer un peu et de faire un panoramique ligne par ligne.

Ci-dessus, quelques exemples de points qui posent actuellement probleme . En cliquant sur un point
echantillon, vous le sélectionnerez et afficherez ce qu'il chevauche dans la fenétre du processus
DynamicBackgroundExtraction.

La zone noire dans l'apercu de la fenétre de processus est la zone problématique - une zone trop
lumineuse que le point d'échantillonnage recouvre. En faisant glisser le point d'échantillonnage
légérement vers la gauche et en I'amenant sur un fond pur, on résout le probleme.

Il n'est pas nécessaire que les points d'échantillonnage soient parfaitement alignés les uns par
rapport aux autres en belles rangées. Il suffit de bien échantillonner l'image et de n'échantillonner
gue le fond. Par conséquent, n'hésitez pas a déplacer Iégerement chaque point d'échantillonnage par
rapport a I'endroit ou il a été automatiquement placé.

Lorsqu'il s'agit de points d'échantillonnage qui se trouvent au-dessus d'objets tels que des étoiles
brillantes, des halos d'étoiles brillantes, de la nébulosité ou des galaxies, il aide a les supprimer. Il est
inutile de regrouper trop de points d'échantillonnage, il est donc préférable de faire un trou dans les
rangées en supprimant quelques points d'échantillonnage. Si vous n'étes pas sir a 100 % qu'un
point échantillon recouvre effectivement une faible nébulosité, il est préférable de I'éloigner de I'objet
en question, ou de le supprimer complétement, plutdt que de risquer de le laisser la. Gardez toutefois
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a l'esprit que le lissage effectué sur l'image générée avant la soustraction permet de traiter certaines
de ces valeurs aberrantes.

Pour supprimer des points de I'échantillon, il suffit de cliquer pour les sélectionner et d'appuyer sur la
touche DEL de votre clavier. Le point échantillon suivant dans la ligne est alors sélectionné.

La capture d'écran ci-dessus montre tous les points de I'échantillon bien placés sur le fond, aprés en
avoir déplacé certains. La zone encerclée comportait auparavant un point d'échantillonnage, qui a
été supprimé. Il n'y avait pas beaucoup d'intérét a déplacer ce point d'échantillonnage, car il faudrait
le déplacer trop loin pour le placer en dehors de la zone ou il se trouvait, et les zones environnantes
étaient déja couvertes par d'autres points d'échantillonnage. Il est préférable de supprimer les points
d'échantillonnage problématiques dans ce scénario.

Ici encore, les points d'échantillonnage ont été déplacés hors du chemin des étoiles et les zones
encerclées montrent ou se trouvaient les points d'échantillonnage mais qui ont été supprimés en
raison des halos d'étoiles brillantes et de la nébulosité (méme si elle est faible).

Tout en vous assurant que tous les points d'échantillonnage sont bien placés et ne chevauchent pas
d'autres objets, vous pouvez ajouter des points d'échantillonnage manuellement. N'hésitez pas a le
faire en cliquant sur lI'image cible. Les points échantillons ajoutés manuellement peuvent également
étre déplacés ou supprimés de la méme maniere.

Si, pendant que vous traitez les points d'échantillonnage, vous vous rendez compte que vous
souhaitez augmenter ou réduire leur taille, il vous suffit d'entrer une nouvelle valeur sous Rayon
d'échantillonnage par défaut. Cette fois-ci, cependant, pour éviter d'effacer tout le travail fastidieux
que vous avez effectué, ne cliquez pas sur le bouton "Generate" car le placement automatique se
fera & nouveau. Cliquez plutét sur le bouton Resize All. Cela maintiendra le placement de vos points
d'échantillonnage, mais vous n'aurez qu'a les redimensionner. Le bouton Resize All peut également
étre utilisé pour appliquer les autres parametres tels que les nouvelles valeurs de tolérance. Ceci est
utile si vous vous rendez compte soudainement que vous voulez ajuster la Tolérance mais que vous
ne voulez pas recommencer. Il vous suffit de modifier la Tolérance et de cliquer sur Redimensionner
fout.

Enfin, avant de passer aux applications spécifiques, vous pouvez sauvegarder votre travail. Comme
DynamicBackgroundExtraction est un processus dynamique, la fermeture de la fenétre ne
conservera pas ses parametres - tout votre travail sera perdu. Vous devrez plutét créer une icbne de
processus. Cette opération s'effectue comme pour tous les autres processus de PixIinsight - faites
glisser le bouton "New Instance" de DynamicBackgroundExtraction sur l'espace de travail de
PixInsight. Vous pouvez ensuite fermer la fenétre du processus car un double-clic sur cette icone de
processus vous permettra de visualiser votre travail sur lI'image actuellement sélectionnée. Cette
fonction est particulierement utile si vous travaillez avec des images monochromes et que vous
appliguez ce processus aux autres images individuellement. Apres tout, les étoiles doivent se trouver
aux mémes endroits pour toutes les images monochromes, il est donc inutile de refaire tout le travalil
ci-dessus pour chacune d'entre elles !
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Veuillez noter qu'un double-clic sur l'icbne du processus ouvrira DynamicBackgroundExtraction et
placera les points d'échantillon (tels qu'ils ont été enregistrés) sur lI'image actuellement sélectionnée.
Ceci est utile si vous souhaitez vérifier la correspondance des parametres avec limage avant
d'appliquer le processus. Vous pouvez cliquer sur le bouton "Resize All " apres avoir double-cliqué
sur l'icbne du processus, pour vous assurer que les parametres sont appliqués et que vos points
d'échantillonnage affichent I'acceptation/le rejet, le cas échéant. Si toutefois vous souhaitez
simplement appliquer ce que vous avez déja mis en place, sans avoir a vous occuper de la fenétre
elle-méme, il vous suffit de faire glisser l'icbne du processus lui-méme sur une image cible de votre
choix. Le processus s'exécutera alors directement sur lI'image cible.

2. Réduction de la pollution lumineuse

A ce stade, nous connaissons bien le fonctionnement de la DynamicBackgroundExtraction, mais
nous ne l'avons pas encore appliguée a quelque chose de spécifique. Dans cette section, nous
suivons ce qui précéde, en appliquant le processus a la méme image d'exemple. Voici le modele que
nous avons créeé ci-dessus, avec tous les points de I'échantillon vérifiés individuellement et déplacés/
supprimes, selon le cas.

Il'y a deux réglages sous Correction. |l s'agit de la Subtraction et de la Division.

Pour réduire les effets de la pollution lumineuse, nous voulons soustraire I'image modéle générée de
I'image cible. Pour cela, nous devons sélectionner Subtraction sous Correction.

Comme tous les points d'échantillonnage sont bien placés et que la méthode de correction est
sélectionnée, il ne nous reste plus qu'a appliquer le processus a limage cible. Deux images
apparaissent apres l'application. Elles ont toutes deux été étirées automatiquement en dessous pour
plus de clarté.

L'image de gauche est l'image modéle générée, basée sur les points échantillons de l'image ainsi
que sur les parametres définis. Nous pouvons voir a quel point cela correspond au fond de pollution
lumineuse de l'image cible. L'image de droite est le résultat final de la soustraction - une image qui
affiche beaucoup plus de contraste dans les objets d'intérét au-dessus du fond, grace a la
DynamicBackgroundExtraction.

L'exemple ci-dessus est considéré comme extréme dans le sens ou l'image est noyeé dans une
lueur de pollution lumineuse, ce qui est attribué au fait qu'elle a été capturée sur un DSLR a travers
une lentille standard, sans filtre de suppression de la pollution lumineuse et dans une zone de ciel
nocturne qui présentait un certain degré de pollution lumineuse visible (a I'ceil nu). Malgré cela, le
résultat final est tres satisfaisant par rapport a I'image initiale. Le processus pourrait en théorie étre
appligué plus d'une fois, avec des parametres légérement modifiés. Par exemple, nous pourrions
fermer l'image initiale et ne garder ouverte que l'image finale. En double-cliquant sur l'icbne du
processus que j'ai enregistré, le méme modele apparaitra sur la nouvelle image.
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A la lumiere des détails révélés par la soustraction initiale, on peut maintenant s'aventurer a déplacer
certains points d'échantillonnage, a en supprimer d'autres, a en placer de nouveaux sur des zones
gue I'on souhaite traiter davantage, etc. Dans mon exemple d'image, il y a un point échantillon tout
en haut de I'image (pres du centre) qui se trouve clairement au-dessus d'un halo d'étoiles brillantes.
Au dépatrt, il n'était pas clair qu'il se trouvait au-dessus d'un halo d'étoiles, en raison de la lueur de
pollution lumineuse qui se trouve partout. Depuis, le point échantillon peut étre simplement déplacé
ou supprimé pour la deuxiéme application. De plus, comme la plupart des lueurs de pollution
lumineuse ont maintenant disparu, nous pouvons réduire la valeur de tolérance de maniére
significative. Celle-ci devrait étre ramenée a sa valeur par défaut de 0,500. Vous devrez cliquer sur le
bouton "Resize All' pour appliquer le nouveau parametre.

Etant donné qu'aucun point d'échantillonnage n'apparait sous forme de carré rouge, cela signifie que
rien n'est rejeté en raison de la valeur de tolérance réduite. C'est une bonne chose. Si toutefois un ou
plusieurs points d'échantillonnage étaient rejetés, s'ils ne devraient pas I'étre (c'est-a-dire s'ils sont
effectivement sur fond), vous pourriez augmenter la tolérance légéerement au-dessus de 0,500, ou
déplacer le point d'échantillonnage légéerement de sa zone actuelle.

Pour appliquer la fonction DynamicBackgroundExtraction, nous nous assurons que la fonction
Subtraction est a nouveau sélectionnée dans la fonction Correction. Veuillez noter que si vous voulez
simplement que le résultat final apparaisse, plutét que la deuxiéme image montrant ce qui a été
soustrait, vous pouvez activer I'option Rejeter le modéle d'arriére-plan. Cela ne fera apparaitre que le
résultat final.

L'application du processus donne maintenant le résultat final, qui montre un peu plus d'amélioration.

Il'y a bien sir des rendements décroissants dans les itérations ultérieures. En général, une seule
itération fonctionne exceptionnellement bien. Il est possible que vous souhaitiez appliquer la
procédure une seconde fois (avec une tolérance ramenée a 0,500 ou aussi proche que possible de
ce chiffre) pour vérifier si vous bénéficiez d'un avantage supplémentaire. Veuillez noter que le
résultat final ci-dessus comporte toujours une bande verticale et une bande brillante en bas. Ce ne
sont pas des effets secondaires de la DynamicBackgroundExtraction - ils proviennent du DSLR
utilisé pour capturer cette image.

Avant de passer a d'autres applications de DynamicBackgroundExtraction, voici un autre exemple
d'image digne d'intérét. Il s'agit d'une image linéaire (mais auto-étirée) de la nébuleuse du Pélican en
H-Alpha, capturée a l'aide d'un filtre a bande passante de 3 nm.

L'image est déja tres nette et assez exempte de gradients de pollution lumineuse évidents.
Cependant, il est généralement bon d'appliquer la méthode DynamicBackgroundExtraction une seule
fois, méme sur des images aussi propres. Méme si la correction est mineures elle nettoie les images
et fait ressortir un contraste supplémentaire. En raison de la quantité de nébulosité présente dans
cette image, plutdét que de placer automatiquement des points d'échantillonnage comme indiqué ci-
dessus, j'ai choisi de placer chacun d'entre eux manuellement. J'ai d'abord commencé par en placer
guelques unes, puis je les ai redimensionnées pour m'assurer qu'elles étaient de la bonne taille. Une

fois gqu'ils ont été correctement dimensionnés, j'ai continué a couvrir toutes les zones de l'image qui
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devraient étre en arriére-plan, que mes points d'échantillonnage aient été rejetés ou non car je les ai
placés manuellement, la tolérance et le poids minimum de I'échantillon pouvant étre modifiés
ultérieurement (puis j'ai cliqué sur Resize All pour appliquer les nouveaux parametres) jusqu'a ce que
tous mes points d'échantillonnage soient acceptés.

Cette technique entierement manuelle est bonne lorsque vous avez des tonnes de nébulosité et que
vous ne pouvez placer qu'un petit nombre de points d'échantillonnage pour commencer (il faudrait
plus de temps pour passer en revue les nombreux points d'échantillonnage placés automatiquement
et en supprimer une grande partie !) ). Il est généralement bon de couvrir chaque coin de l'image et
le long des quatre bords, plus plusieurs vers le centre. Cependant, comme dans ce cas, je ne peux
pas placer de points d'échantillonnage dans le coin supérieur gauche en raison d'une nébulosité
excessive a cet endroit. Ce n'est pas un probleme, car il est clair qu'il n'y a pas de fond clair a cet
endroit de toute fagon.

La encore, Subtraction est sélectionnée sous la rubrique Correction parce que nous voulons
soustraire tout fond de pollution lumineuse. En appliquant le processus, on voit les deux images
apparaitre.

L'image de gauche est I'image originale. L'image du milieu est la nouvelle image, apres soustraction
de l'image de droite (I'image modéle générée). L'amélioration des détails et du contraste est tres
nette, méme sur cette image a bande ultra étroite capturée avec de nombreuses heures d'exposition
et dans une zone sombre du ciel nocturne.

3. Extraction du gradiant

On peut dire que nous avons déja couvert I'élimination des gradients avec tout ce qui précede et
c'est effectivement le cas - la pollution lumineuse peut générer certains gradients dans les images,
qui sont éliminés avec la procédure ci-dessus. En outre, le vignettage du systeme optique (et le
mangue de calibrage avec les flats) introduira ces gradients, également clairement supprimés ci-
dessus. Cette section indique cependant ce qu'il faut faire lorsqu'une partie de votre image présente
une lueur clairement localisée et que vous souhaitez la réduire.

L'exemple utilisé pour cette section est la méme image de la nébuleuse du Pélican que ci-dessus,
mais cette fois-ci dans Oxygéne-lll, également capturée a l'aide d'un filtre a bande passante de 3 nm.

Il est tres clair, d'aprés la capture d'écran ci-dessus, que l'image contient de la nébulosité, mais elle
semble également étre noyée dans une certaine lueur du coté droit et du coin supérieur droit. Cette
lueur est en fait due au capteur CCD lui-méme (la fameuse lueur Sony que I'on trouve dans certaines
caméras). Comme il ne s'agit pas de nébulosité, nous pouvons la traiter comme un arriere-plan que
nous souhaitons réduire.

La procédure pour le faire est la méme et comme il y a pas mal de nébulosité, jai choisi de le faire
manuellement en ajoutant simplement des points d'échantillon en cliquant.

{ } 125



Comme vous le remarquerez, certains de mes points d'échantillonnage placés manuellement ont été
rejetés par les paramétres actuels. Cela est d0 a une faible valeur de Tolérance. Cela ne s'est pas
produit avec l'image H-Alpha car le fond était d'intensité assez neutre. Dans cette image Oxygen-Ill,
le fond présente un gradient clair et intense. Augmenter la tolérance et cliquer sur le bouton "Resize
All" pour vérifier est la clé pour que tous les points de I'échantillon soient acceptés.

Certains points de I'échantillon ont également été déplacés tres légérement (les tétus) pour éviter
d'avoir & augmenter encore la tolérance, tout en pouvant garder un point de I'échantillon autour de
cette zone générale.

Avant de poursuivre, nous remarquons que le gradient de fond n'est absolument pas centré dans
cette image. Il est assez décalé vers le coin supérieur droit. Nous déplagons donc un peu le réticule
vers le coin supérieur droit. De plus, nous plagons davantage de points d'échantillonnage dans les
zones ou les gradients sont les plus intenses et ou l'intensité du fond est la plus forte. Cela permet
d'échantillonner de maniére plus appropriée les zones présentant des changements importants et
rapides.

Une fois cette étape franchie, une derniére vérification est effectuée pour s'assurer que tous les
points de prélevement sont bien placés et sont acceptés par les parametres. Subtraction est
sélectionnée sous Correction et le processus est ensuite appliqué.

Le résultat final est bien meilleur, car l'arriere-plan est nettement plus neutre, réduit en intensité et
présente des détails plus profonds et un contraste plus marqué dans la nébulosité (image du milieu,
par rapport a limage de gauche, qui est l'originale).

Certains gradients sont assez tenaces et nécessitent une seconde application du méme modele
DynamicBackgroundExtraction (avec une tolérance réduite, de retour a 0,500 si possible) pour les
éliminer complétement. Parfois, cependant, il suffit d'ajouter des points d'échantillonnage
supplémentaires sur des zones de changements importants et rapides. Le facteur de lissage peut
étre réduit Iégérement en dessous de la valeur par défaut de 0,250 si une soustraction plus ciblée est
souhaitée, mais attention a cela car cela peut rapidement apporter moins de bénéfices qu'attendus
J'ai constaté que des valeurs inférieures a 0,100 pour le facteur de lissage réduisent rapidement les
avantages.

Les gradients tenaces peuvent nécessiter des allers-retours entre la modification des points
d'échantillonnage et des parametres et I'application du processus pour vérifier le résultat final. Il est
utile de permettre a limage du modéle généré de s'afficher aprés la soustraction, car cette image
vous montre précisément ce que DynamicBackgroundExtraction a généré (en fonction de vos points
d'échantillonnage et de vos paramétres) puis soustrait.

4. Flat artificiel

L'étalonnage des images est une technique clé pour produire de bonnes images. Le calibrage avec

des flats est généralement une tres bonne idée car il supprime le vignettage inhérent au systeme
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optique et, avec de bons flats, il élimine les poussiere présentes dans le train optique. Cependant, un
certain nombre de raisons peuvent faire que vous n‘ayez pas de flats appropriés pour une image et
gue vous obteniez ainsi une image avec un vignettage trés clair, comme cette image de la nébuleuse
du Voile en Luminance.

L'image ci-dessus est linéaire (mais auto-étirée), et n'a été calibrée qu'avec un bias (pas de flat,
expres, pour donner cet exemple). La technique suivante montre comment utiliser la fonction
DynamicBackgroundExtraction pour corriger artificiellement vos images. La mise en garde est que
cette technique n'élimine pas les poussiére et ne fonctionne donc bien que pour des images
propres. En suivant cette technique, on peut enlever les poussiére avec l'outil CloneStamp, par
exemple, a moins qu'elles ne soient trés inesthétiques ou que vous en ayez beaucoup.

Ce que nous voulons faire, c'est que DynamicBackgroundExtraction génére une image modele de
l'arriére-plan et, au lieu de la soustraire, la divise en image cible. La division est le processus exact
de calibrage avec des flats. Vous savez peut-étre déja comment cela va fonctionner. Nous
commencgons avec exactement la méme procédure que ci-dessus - en placant des points
d'échantillonnage sur toute l'image, en nous assurant que tous les bords et les coins sont bien
échantillonnés (en particulier maintenant que nous souhaitons générer une image modele qui
corrigera cette image - cela signifie que le modele de vignettage lui-méme doit étre échantillonné
compléetement).

Comme le champ d'étoiles dans cet exemple d'image est tres dense, nous utilisons une petite taille
de point d'échantillonnage. De plus, comme la plus grande partie de I'image est en arriere-plan, nous
choisissons de placer automatiguement les points d'échantillonnage. En raison du vignettage tres
clair, la tolérance doit étre une valeur assez élevée pour placer les points d'échantillonnage partout
ou cela est nécessaire.

Ci-dessus, la couleur des points de I'échantillon a été changée du gris par défaut au violet vif en
cliguant sur I'échantillon de couleur pour la couleur de I'échantillon. Cela a permis de voir plus
facilement les points d'échantillon placés. Les points d'échantillon ont été placés automatiquement
sur la base d'une grande valeur de tolérance de 1.500. Plus tard, chacun d'entre eux a été inspecté
et déplacé hors des étoiles et de la nébuleuse. Une fois que tout était clair, la tolérance a pu étre
abaissée a 1.000 sans rejeter aucun point d'échantillonnage.

Les points échantillons étant préts, nous avons sélectionné la division sous Correction (comme nous
souhaitons aplatir cette image).

A ce stade, nous appliquons le processus et inspectons le résultat final.

Le résultat final est tres clairement corrig€, avec I'augmentation du contraste global que cela apporte.
L'image modéle générée montre également trés clairement le motif de vignettage. Apres la correction
artificielle, vous pouvez supprimer les poussiére évidentes a l'aide de l'outil CloneStamp (non
couvert par ce tutoriel). Ce processus peut s'averer difficile si les grains de poussiere sont treés gros
ou si vous en avez beaucoup répartis sur l'image, en particulier s'ils chevauchent des objets
intéressants. De ce fait, la correction artificiel ne remplace pas un calibrage avec de vrais flats !
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Apres la correction artificiel, on peut appliquer exactement le méme modele dans
DynamicBackgroundExtraction, avec une tolérance abaissée a 0,500 (ou aussi proche que possible)
et avec la Soustraction sélectionnée sous Correction. Cela permet d'éliminer tout gradient restant
dans l'arriere-plan aprés l'avoir artificiellement corrigé.

Cet exemple est assez idéal tout simplement parce que j'ai tendance a garder mon train optique
propre et donc sans poussiéere. Par conséquent, le processus de correction artificiel a été trés réussi.
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XI.  Réduction de la taille des étoiles

Les images de nébuleuse étendue peuvent parfois nécessiter de tres longues expositions et si vous
n'utilisez pas de filtres a bande extrémement étroite (comme la gamme de 3 nm d'Astrodon), les
étoiles peuvent étre considérablement gonflées. Les étoiles gonflées peuvent étre un effet de la
nébuleuse diffuse qui se faufile a travers l'arriére-plan. Réduire la taille des étoiles permet de les
dégonfler efficacement en les pincant vers l'intérieur avec un masque approprié.

Cette technique a déja été documentée par Rogelio Bernal Andreo. Elle est écrite ici a titre de
tutoriel. Au-dela de la réduction de la taille des étoiles, nous passons également en revue une
procédure d'élimination compléte des étoiles, particulierement adaptée aux images a bande étroite.
Les deux procédures utilisent des masques d'étoiles et le processus de transformation
morphologique.

Supposé pour ce tutoriel :

e Connaissance du fonctionnement de PixInsight, en rapport avec le traitement des images, les
processus et le travail avec les masques (lire ce qui suit, sections 3, 4 et 6).

e Vos images ont déja été entierement prétraitées ( Lire ceci).

e Connaissance de la production de masques de contour d'étoile ( Lire ceci, section 3).
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1. Préparer le masque d’'étoiles avec StarMask

Nous commencons par limage dans laguelle nous souhaitons réduire la taille des étoiles. Cette
procédure est généralement appliquée a un certain nombre d'étapes du post-traitement. J'ai
tendance a appliquer cette procédure apres que la combinaison LRGBC a été utilisée pour combiner
mes images RVB de luminance et de couleur. A ce stade, les images sont non linéaires. L'exemple
ci-dessous est la nébuleuse du voile oriental en tant qu'image LRGB non linéaire.

C'est un bon exemple simplement en raison du nombre d'étoiles présentes, et parce que c'est une
image LRGB et que les étoiles sont donc quelque peu gonflées par les longues expositions. Pour
produire le masque des contours des étoiles, nous devons d'abord neutraliser la luminosité sur
I'ensemble de I'image. Cela permettrait au processus StarMask de mieux capter les étoiles, quelle
que soit leur Iluminosité comparative. Pour ce faire, nous ouvrons le processus
HDRMultiscaleTransform.

Bien sOr, nous ne voulons pas appliguer ce processus a notre image elle-méme, donc nous
dupliquons l'image (cliquez dessus avec le bouton droit de la souris et cliquez sur Dupliquer).

Comme nous voulons neutraliser la luminosité de l'image afin de produire un bon masque des
contours des étoiles, nous serons agressifs quant a la maniére dappliquer la
HDRMultiscaleTransform. Réglez le nombre de couches sur 3. Le reste des réglages peut étre laissé
par défaut. Une fois Iimage dupliquée sélectionnée, cliquez sur Appliquer sur
HDRMultiscaleTransform (ou faites glisser le bouton Nouvelle instance sur I'image).

La luminosité de l'image ayant été neutralisée dans notre double, nous pouvons maintenant en tirer
un bon masque de contour d'étoile. Pour cela, nous ouvrons le processus StarMask.

Nous devons d'abord déterminer ou se situe la limite de bruit pour notre bruit de fond. Pour ce faire, il
suffit de zoomer assez fort jusqu'a ce que vous voyiez les plus petites étoiles et votre arriere-plan
(pas de faible nébulosité - l'arriére-plan réel). Cliquez avec le bouton gauche de la souris n'importe
ou sur l'arriere-plan et maintenez le bouton gauche enfoncé. L'apercu de lecture vous donnera les
valeurs de R, G et B (sauf si votre image est monochrome, auquel cas il vous donnera une seule
valeur K).

Les valeurs R, G et B semblent toutes tourner autour de 0,22 pour mon image. Les petites étoiles de
I'image sont nettement plus élevées, juste au-dessus de 0,4 et plus. Si nous maintenons la valeur
seuil de bruit du StarMask a sa valeur par défaut de 0,10000, il captera de petites taches de bruit
comme des étoiles, et nous ne voulons pas que cela se produise. Comme mes plus petites étoiles
semblent planer juste au-dessus de 0,4, je vais entrer 0,4 dans Noise threshold.

Pour inclure des étoiles plus grandes dans le masque des contours des étoiles, nous allons
augmenter I'échelle a 6. Cette valeur inclut les étoiles de I'échelle habituelle que vous voudriez
réduire en taille (il se peut qu'elle n'inclue pas les étoiles massives dans les images et il faudrait donc
l'augmenter davantage pour les inclure). Nous réduirons Large Scale et Small Scale & 0 car cela
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empéchera le masque stellaire d'augmenter artificiellement la taille des étoiles captées (nous voulons
gue les étoiles du masque stellaire aient leur taille réelle par rapport a I'image).

Nous ne voulons pas lisser les contours des étoiles capturées, car les petites seraient lissées pour
ressembler aux vraies étoiles (plutdt qu'aux petits contours des étoiles). Pour éviter cela, nous
réduisons simplement la valeur par défaut de Smoothness a une valeur beaucoup plus faible, par
exemple 5. Nous activons également l'option Contours car c'est le principal objectif du masque que
nous voulons produire. En outre, pour que les contours des étoiles qui apparaissent soient plus
visibles, nous effectuons un étirement de I'image du masque des contours des étoiles en réduisant
les tons moyens a environ 0,10000.

Le procédé StarMask est maintenant appliqué a I'image dupliquée - celle dont la luminosité a été
neutralisée auparavant. Il suffit de sélectionner cette image et de cliquer sur le bouton Appliquer du
StarMask (ou de glisser-déposer le bouton Nouvelle instance du StarMask sur l'image). La nouvelle
image du masque de contour d'étoile apparaitra.

Vous pouvez maintenant fermer le processus StarMask. Vous pouvez également fermer limage
dupliguée qui a été neutralisée en termes de luminosité, car nous n'en aurons plus besoin. Il suffit
d'appliquer le masque de contour d'étoile a I'image originale. Vous pouvez cacher le masque apres
l'avoir appliqué, sinon la plus grande partie de l'image originale apparaitra en rouge et vous ne
pourrez pas voir les effets de la réduction de la taille des étoiles.

La deuxiéme capture d'écran ci-dessus montre que le masque est toujours appliqué a limage
originale, mais qu'il est cacheé.

2. Reduire la taille des étoiles avec MorphologicalTransformation

Avec le masque appliqué a notre image originale, nous procédons maintenant a la réduction effective
de la taille des étoiles. Pour cette procédure, nous utlisons le processus
Morphological Transformation.

Le meilleur opérateur a utiliser a cette fin est Morphological Selection. Cet opérateur effectue une
combinaison d'érosion (diminution de la taille) et de dilatation (augmentation de la taille). L'une de
ces opérations est plus efficace que l'autre, mais le fait qu'elle combine les deux permet d'obtenir un
résultat final plus satisfaisant que la simple érosion.

La valeur par défaut de la sélection 0,50 ne fait rien car elle s'érode autant qu'elle se dilate. Si nous
diminuons la valeur de Sélection en dessous de 0,50, elle s'érodera plus qu'elle ne se dilate.
Inversement, si nous augmentons la valeur de Sélection au-dessus de 0,50, elle se dilatera plus
gu'elle ne s'érode. Puisque nous souhaitons éroder plus que dilater, nous diminuons la valeur de
Sélection. Je trouve qu'une bonne valeur a utiliser a cette fin se situe généralement autour de 0,20.
Amount prend la méme signification que dans d'autres processus. Si nous la laissons a la valeur par
défaut de 1,00, le résultat final sera purement l'image altérée (avec les tailles d'étoiles réduites).
Nous pouvons au contraire choisir de diminuer légérement Amount afin d'obtenir un mélange entre
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I'image originale et l'image a taille d'étoile réduite (pour un résultat final plus beau). Je vais donc
modifier Amount a 0,75. Cela correspond a 75 % de lI'image de taille réduite des étoiles avec 25 %
de l'image originale. Les itérations doivent étre légerement augmentées et une seule demande
(itérations 1) est insuffisante a cet effet. Les bonnes valeurs d'itérations a utiliser ici sont
généralement 3 ou 4. Dans ce cas, j'opterai pour 4.

La seule chose qui reste a modifier est Structuring Element. Celui-ci définit la facon dont
Morphological Transformation est appliquée a votre image. Comme nous avons affaire a des étoiles,
il est préférable de faire ressembler Structuring Element a une étoile dans sa forme. Une fagon
rapide de le faire est d'augmenter la taille a 5 (25 éléments).

Vous remarquerez que Structuring Element & gauche est maintenant de taille 5 par 5. Pour créer une
forme d'étoile, il suffit de cliquer sur tous les carrés noirs, sauf les quatre coins. En cliquant dessus,
iIs deviennent blancs, ce qui les active. Si vous faites une erreur et que vous souhaitez rendre un
carré blanc noir, il vous suffit de cliquer sur le carré tout en maintenant la touche CTRL de votre
clavier enfoncée. Lorsque vous avez terminé, votre élément de structuration devrait ressembler a ce
qui sulit.

Il ne reste plus qu'a appliquer MorphologicalTransformation a l'image originale (avec le masque des
contours de I'étoile). Il suffit de cliquer sur Apply (ou de faire glisser son bouton Nouvelle instance sur
I'image originale). Vous trouverez ci-dessous deux captures d'écran. La premiere est avant
I'application, la seconde est apres l'application.

La difféerence est nettement perceptible, une plus grande partie de la nébuleuse diffuse devenant
visible et la nébuleuse dans son ensemble se démarquant davantage. Si vous souhaitez étre plus
agressif a ce sujet, vous pouvez augmenter davantage les itérations ou diminuer davantage la
sélection. Je recommande de laisser Amount a 0,75 au maximum, afin de produire un résultat final
d'apparence plus naturelle.

Une fois que vous étes satisfait, vous pouvez fermer le processus MorphologicalTransformation et
fermer le masque des contours des étoiles sans le sauvegarder. Il est important de noter que si vous
souhaitez appliquer cette procédure une seconde fois (en conservant les modifications de la
premiéere application), vous devez recréer le masque de contour des étoiles comme décrit dans la
section 1. Ceci doit étre fait parce que les étoiles présentes dans I'image sont maintenant plus petites
et donc leurs contours sont également plus petits, et le masque de contour des étoiles doit étre
représentatif de cela.

3. Retirer complétement les étoiles

La suppression des étoiles est une chose qui peut sembler un peu étrange au début, mais qui peut
aussi produire des images assez étonnantes. Cette procédure est toujours effectuée sur des images
a bande étroite et n'est jamais vraiment effectuée sur des images LRGB. Sur les images a bande
étroite, les étoiles apparaissent naturellement moins gonflées et peuvent étre plus facilement
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enlevées tout en conservant un aspect naturel a lI'image. C'est particulierement le cas des images a
bande étroite qui ont été capturées avec des filtres a bande extrémement étroite, comme la gamme
de 3 nm d'Astrodon. Par exemple, I'image ci-dessous est une image a bande étroite de la palette
bicolore (H-Alpha et Oxygene-Ill seulement) capturée avec les filtres Astrodon 3nm. Elle est assez
avanceée dans le post-traitement et est déja réduite en bruit et non linéaire.

La principale exigence de la suppression des étoiles est un bon masque d'étoiles. Il est
généralement difficile d'extraire toutes les étoiles de l'image si certaines sont au-dessus du fond et
d'autres au-dessus d'une nébuleuse brillante. Ce qui se passe généralement, c'est que votre masque
stellaire ne reproduit pas les étoiles qui sont au-dessus de la nébulosité. Une bonne technique pour
obtenir les étoiles dans une image consiste a supprimer les couches de structure a grande échelle.
Comme nous travaillons ici avec une image en couleur, nous devons d'abord en extraire une image
de Lightness. Si vous travaillez avec une image monochrome, vous pouvez aller un peu plus loin.

Avant d'extraire une image Luminosité de l'image couleur que nous avons ouverte, nous devons
d'abord ouvrir le processus RGBWorkingSpace, régler tous les Coefficients de Luminance (Rouge,
Vert et Bleu) & 1.000000 et cliquer sur le bouton Apply Global.

Ce que RGBWorkingSpace a fait, c'est définir la Luminance de l'image sur laquelle nous travaillons
pour qu'elle soit constituée d'une contribution égale de chaque canal de couleur. De cette facon,
I'image de luminance que nous extrayons est une représentation fidele de ce que nous voyons. Pour
extraire une image Luminosité, ouvrez le processus ChannelExtraction, mettez-le en mode CIE
L*a*b*, désactivez a et b (laissez seulement L activé) et cliquez sur Apply.

Nous pouvons maintenant fermer ChannelExtraction. Pour supprimer la nébuleuse de cette image
tout en y conservant les étoiles, nous devons utiliser le processus MultiscaleLinearTransform pour
supprimer entierement les grandes couches d'ondelettes.

Essayons d'abord avec les 4 couches par défaut. Pour désactiver les structures plus grandes que la
couche 4 (8 pixels), il suffit de double-cliquer sur la couche nommée R (Résidu). Une fois fait,
appliquez le processus a l'image Légereté.

Bien que la nébuleuse semble avoir completement disparu et qu'il reste beaucoup d'étoiles,
beaucoup d'étoiles de taille moyenne (et les plus grandes) ont également disparu. Nous pourrions
vouloir conserver certaines de ces étoiles de taille moyenne dans cette image de masque, au moins.
Par conséquent, nous annulons les modifications apportées a l'image et sélectionnons une valeur
plus grande pour les couches dans MultiscaleLinearTransform. Par exemple, je vais essayer 6. Cela
montrera les 6 premieres couches et donc la désactivation de la couche R (Résidu) supprime
maintenant les structures plus grandes que la couche 6 (32 pixels). En appliquant a nouveau le
processus a l'image de Luminance, on obtient un meilleur résultat, en montrant plus d'étoiles.

Malheureusement, l'inclusion d'étoiles plus grandes s'accompagne de l'inclusion de structures plus
grandes ce qui inclut une part de la nébuleuse. Je peux faire un petit compromis en choisissant plutot
5 pour les couches et en désactivant la couche R (résiduelle), qui supprime les structures plus
grandes que la couche 5 (16 pixels).
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C'est un bon compromis puisqu'il comprend des étoiles de taille moyenne mais peu de nébuleuse.
Comme je suis satisfait de ce masque d'étoile particulier jusqu'a présent, je ferme la
MultiscaleLinearTransform. Le processus HistogramTransformation peut maintenant nous aider a
éliminer la nébulosité restante tout en accentuant les étoiles dans I'image du masque stellaire. Nous
ouvrons donc ce processus, sélectionnons I'image de luminance qui s'y trouve et activons l'apercu en
temps réel sur celle-ci.

L'objectif est d'étirer 'image comme on le fait habituellement - en faisant glisser le curseur des tons
moyens vers la gauche. Vous remarquerez rapidement que la nébuleuse restante commence a
gagner en contraste, ce qui n'est pas bon.

Pour éliminer cette nébuleuse restante, il suffit de faire glisser le curseur du point noir vers la droite,
en coupant complétement ces points faibles. Evitez d'en faire trop, car les petites étoiles disparaitront
également si vous allez trop loin, mais évitez si possible de conserver les principales caractéristiques
de la nébuleuse.

Une fois satisfait, appliquez le processus a l'image Luminance et fermez HistogramTransformation et
sa fenétre de prévisualisation en temps réel. Si nous zoomons sur notre image, nous voyons qu'il
reste en effet une certaine nébulosité.

Il faut maintenant s'attaquer a ce probleme avec CloneStamp pour le supprimer complétement.
CloneStamp va littéralement copier une zone de l'image que vous sélectionnez, par-dessus la zone
gue vous peignez. Nous clonons simplement les zones noires de l'image sur ces parties nébuleuses
pour les supprimer completement, en faisant attention a ne pas supprimer des étoiles ou en ajouter
de nouvelles (en les clonant) accidentellement. Pour utiliser le CloneStamp, il suffit de définir un
Rayon et de cliquer sur une partie noire de l'image tout en maintenant la touche CTRL de votre
clavier enfoncée. Ensuite, il suffit de peindre par-dessus les zones de nébulosite. Vous devrez
continuellement ajuster la zone que vous clonez en cliquant avec la touche CTRL sur les zones
noires de l'image pour éviter de cloner de nouvelles étoiles dans lI'image.

Une fois que toute la nébuleuse a été supprimée, cliquez sur le bouton Exécuter du CloneStamp
(icone verte) pour appliquer les modifications. Comme vous utilisez déja CloneStamp, c'est I'occasion
de supprimer les étoiles que vous ne voulez pas voir disparaitre de votre image originale. Apres tout,
cette image de masque d'étoile que nous créons sera utilisée pour cibler les étoiles de l'image
originale, pour les supprimer. Pour choisir des étoiles spécifiques, il est utile de faire un zoom arriere
complet et de superposer limage du masque d'étoile sur limage originale. La transparence nous
permet de repérer les étoiles que nous voulons laisser intactes.

Ci-dessus, jai entouré les étoiles que je voudrais voir intactes dans l'image originale. J'ai choisi ces
dernieres parce qu'elles sont particulierement brillantes et qu'elles sont peu gonflées. Elles peuvent
étre extrémement fastidieuses a enlever et ne sont normalement pas retirées completement car elles
sont trop grosses pour s'atténuer dans la nébuleuse environnante. Tenter de les enlever tend a
entrainer des discontinuités étranges dans la nébuleuse. Si vous souhaitez vraiment retirer toutes les
étoiles, vous pouvez certainement le faire, mais il est préférable d'éviter de les gonfler trop fortement

lors des expositions et du post-traitement, afin que cette procédure soit plus facile a réaliser sur elles.
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Dans tous les cas, pour éviter d'enlever ces étoiles, je retourne a mon image de masque d'étoile et
jutilise CloneStamp pour les enlever comme je l'ai fait pour la nébulosité visible.

Une fois l'image du masque d'étoile préparée, nous l'appliqguons maintenant comme un masque a
I'image originale. Nous cachons également le masque afin de voir ce qui se passe lorsque nous
enlevons les étoiles.

Avec le masque stellaire en place, tout est protégé sauf les étoiles que nous avons choisi de cibler.
Nous allons d'abord éroder les étoiles en taille plusieurs fois avant de mélanger leurs restes avec la
nébulosité environnante. Pour éroder les étoiles, nous utiliserons MorphologicalTransformation.

Comme dans une section précédente de ce tutoriel, nous gardons Structuring Element ressemblant a
une forme d'étoile, avec une taille fixée a 5 (25 éléments). L'opérateur que nous utiliserons est
I'érosion (minimum). Nous laisserons les parametres par défaut et appliquerons le processus trois
fois a I'image originale (avec I'image du masque d'étoile active). Nous pourrions I'appliquer une seule
fois avec les itérations définies a 3 mais il est bon de I'appliquer trois fois avec les itérations définies
a 1 afin de pouvoir défaire et refaire chaque application pour que vous puissiez regarder les étoiles
s'éroder en taille. Aprés avoir fait cela, il semble y avoir un probleme avec les étoiles, qui est visible
lorsque nous zoomons sur une zone ou elles sont nombreuses.

Ce que nous voyons est le résultat d'un décalage entre la taille des étoiles dans I'image originale et
la taille des étoiles dans I'image du masque stellaire. En effet, les étoiles dans I'image du masque
stellaire sont un peu plus petites que dans l'image originale, ce qui signifie que lorsqu'elles sont
erodées en taille, leur halo est laissé derriére dans I'image originale et cela produit ces discontinuités
gue nous observons. Cette réduction de la taille des étoiles est probablement le résultat de
I'application de HistogramTransformation, qui a noirci les halos d'étoiles plus faibles qui les
entourent, ce qui a eu pour effet de réduire un peu la taille des étoiles. Pour compenser cela, nous
pouvons utiliser MorphologicalTransformation sur I'image du masque stellaire.

Tout d'abord, nous annulons les modifications apportées a l'image originale, puis nous réglons
l'opérateur sur Dilatation (maximum) dans MorphologicalTransformation. Pour augmenter un peu la
taille des étoiles, nous appliquons simplement les paramétres par défaut (avec les itérations laissées
a 1). Ceci est appliqué a l'image du masque d'étoile, et non a l'image originale. Une fois cela fait,
nous retournons a limage originale, nous sélectionnons & nouveau Erosion (Minimum) sous
Opérateur dans MorphologicalTransformation et nous appliquons a l'image originale trois fois les
parametres par défaut.

Cela semble certainement mieux correspondre, mais il reste encore une certaine discontinuité, donc
il est clair que nous devons dilater un peu plus les étoiles dans l'image du masque stellaire. Nous
répétons donc le processus décrit ci-dessus, mais la dilatation dans ce cas ne doit étre que mineure,
c'est pourquoi nous avons réglé Amount a 0,50 pour dilater un peu plus les étoiles dans l'image du
masque stellaire. Une fois cela fait, nous érodons a nouveau trois fois les étoiles de I'image originale.
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Il semble que la correspondance soit beaucoup plus étroite. Les discontinuités restantes sont plus
douces et seront corrigées plus tard. Nous devrions continuer a appliquer I'érosion jusqu'a ce que
nous puissions a peine voir les étoiles. C'est pourquoi nous maintenons Amount a 1,00. Si nous
I'abaissions, il resterait encore quelques étoiles, juste un peu plus faibles. Il suffit de continuer a
appliguer MorphologicalTransformation en mode d'érosion (minimum) encore et encore jusqu'a ce
gue les étoiles ressemblent plus ou moins a ce qui sulit.

I est maintenant temps de lisser ce qui reste. Vous pouvez fermer le processus
MorphologicalTransformation et ouvrir le processus MultiscaleMedianTransform.

Comme nous avons déja produit I'image du masque d'étoile en désactivant la couche R (résiduelle)
apres la couche 5, nous ferons de méme ici. Nous sélectionnons 5 sous Couches, puis nous double-
cliguons pour désactiver les cing premieres couches, en ne laissant active que la couche R (Résidu).

Il s'agit maintenant simplement d'appliquer le processus MultiscaleMedianTransform a notre image
originale plusieurs fois, avec l'image du masque d'étoile toujours active. Ce processus va fusionner
les zones environnantes afin de lisser le résultat final. Appliquez ce processus autant de fois que
vous le jugez nécessaire, mais l'appliquer quatre a huit fois n'est pas aussi rare qu'on pourrait le
penser. Vous n'aurez peut-étre a l'appliquer que trois ou quatre fois - cela dépend de votre image
particuliere et de son aspect. Le tableau ci-dessous montre mon résultat aprés cing applications.

Ce qui precéde montre comment la grande majorité des étoiles (celles que jai choisi de ne pas
laisser de c6té) ont été retirées de lI'image. Si vous étes satisfait des résultats, vous pouvez fermer
MultiscaleMedianTransform et I'image de masque d'étoile que nous avons créée préceédemment.

Quelques notes finales avant de fermer. Il est trés clair que l'image de masque d'étoile est la clé du
succes ici et plus cette image de masque d'étoile ressemble aux étoiles de votre image originale,
mieux la suppression sera faite. Si vous avez des problemes pour exclure la nébulosité tout en
conservant les petites étoiles dans l'image du masque stellaire, vous pouvez en fait utiliser le
processus StarMask pour en faire une image de masque stellaire (apres application de
MultiscaleLinearTransform). HistogramTransformation et CloneStamp peuvent alors étre utilisés
comme ci-dessus, sauf que votre travail d'exclusion de la nébulosité tout en conservant les petites
étoiles peut étre facilité par l'utilisation de StarMask. Il est également tres clair qu'il est difficile
d'éliminer les étoiles présentant un ballonnement important ou des halos colorés sans laisser
d'imperfections dans le résultat final. C'est un effet fantastique sur les images a bande étroite, mais
I'étendue de l'application a ses propres images est laissée a I'entiére discrétion du lecteur.
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Xll.  Recadrage et redimensionnement des images

A un moment donné, nous finissons inévitablement par recadrer les images. C'est généralement au
cours des premiéres étapes du post-traitement, afin d'éliminer les barres noires autour des images
qui ont été enregistrées (ce qui est courant pour les astrophotographes qui réalisent des images en
monochrome). D'autres fois, il s'agit de se débarrasser des parties disgracieuses d'une image
(comme un coma excessif le long des coins) ou simplement de réduire la quantité de fond entourant
la cible visée (si elle apparait petite dans I'image). De plus, nous pouvons vouloir redimensionner les
images pour les rendre plus grandes ou plus petites, tout en conservant tout ce qu'elles contiennent.

Ce tutoriel couvre principalement une fonction de base de PixInsight - le recadrage de vos images. Il
le fait en couvrant deux processus. Il s'agit des processus DynamicCrop et Crop (le premier est
dynamique alors que le second est non dynamique). Chacun de ces processus est couvert en détalil
afin d'apprendre a l'utilisateur comment les utiliser pleinement. Ce tutoriel couvre également le
rééchantillonnage de vos images afin de les redimensionner tout en conservant toutes les
informations affichées. Pour ce faire, vous devez utiliser le processus Resample.

Supposé pour ce tutoriel :

- Connaissance du fonctionnement de PixInsight, en rapport avec le traitement des images et des
processus ( Lire les sections 3 et 4).
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1. Recadrage avec DynamicCrop

DynamicCrop, comme son nom lindique, est un processus dynamique. Cela signifie qu'une fois
initialisé sur une image particuliere, il ouvre une session sur cette image et doit étre entierement
fermé pour pouvoir étre utilisé sur une autre image qui est ouverte. Vous trouverez ci-dessous une
image couleur non linéaire ouverte en méme temps que DynamicCrop.

Pour initialiser DynamicCrop, nous pouvons soit créer une zone dans notre image en cliquant et en
faisant glisser, soit cliquer sur le bouton Reset de DynamicCrop. Si nous cliquons sur le bouton
Reset, I'i'mage entiere est sélectionnée par défaut.

Si nous cliquons sur le bouton Exécuter a ce stade, rien ne se passe car l'image entiere est
sélectionnée et aucun recadrage n'a donc lieu. Pour réduire la zone sélectionnée, il suffit d'aller sur
I'un des quatre cotés de I'image et de cliquer et faire glisser vers l'intérieur pour déplacer la bordure.
Veuillez noter que si vous cliqguez et glissez accidentellement a lintérieur de la zone déja
sélectionnée, vous déplacerez simplement la zone sélectionnée au lieu de modifier sa sélection.
Pour éviter cela, il vous suffit de faire un zoom arriere sur votre image en une seule étape. Si vous
passez la souris sur les limites de l'image, I'icdne de la souris change pour indiquer que nous allons
modifier la zone de sélection. A ce stade, nous pouvons cliquer et faire glisser ce coté vers l'intérieur.

Cette opération peut étre répétéee sur les trois autres cotés pour définir la zone de I'image que vous
souhaitez conserver (les zones en dehors de la sélection seront coupées).

Pour recadrer cette partie de I'image, il suffit de cliquer sur le bouton Exécuter (icone verte) et I'image
est modifiée. DynamicCrop peut étre fermé a ce stade si vous n'avez pas besoin de I'utiliser plus
tard.

Vous pouvez éviter de faire glisser les cotés de la zone sélectionnée vers l'intérieur en ne cliquant
pas sur le bouton Reset de DynamicCrop pour commencer. Si vous ouvrez simplement votre image
puis le processus DynamicCrop, sans cliquer sur son bouton Reset ou cliquer n'importe ou dans
I'image, il suffit de cliquer et de faire glisser une zone a l'intérieur de votre image.

Cette zone peut étre affinée en faisant comme auparavant - en cliquant et en faisant glisser ses
cOtés vers l'intérieur ou vers I'extérieur. Il est également possible de la déplacer en cliquant n‘importe
ou a l'intérieur et en la faisant glisser. Il existe cependant une autre transformation que nous pouvons
lui appliquer - la rotation. Si vous souhaitez faire pivoter la zone sélectionnée, il vous suffit de passer
la souris sur I'un des quatre coins, juste a I'extérieur de la zone sélectionnée. Le pointeur de la souris
changera pour indiquer la rotation et vous pouvez cliquer et faire glisser la zone sélectionnée pour la
faire tourner dans le sens des aiguilles d'une montre ou dans le sens inverse, selon votre choix.

Vous pouvez également définir un angle spécifique et préciser s'il doit étre dans le sens des aiguilles
d'une montre ou non dans la fenétre de processus elle-méme.

En cliquant sur Execute a ce stade, I'image sera recadrée et la rotation sélectionnée sera également
appliguée.
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Les pixels étant carrés, une rotation de 90°, 180° ou 270° nécessite une interpolation de la part de
PixInsight pour que l'image soit comme elle aurait été si elle avait été capturée a I'angle de rotation
gue vous avez défini. Par défaut, DynamicCrop détermine et utilise automatiquement le meilleur
algorithme pour cette interpolation, mais vous pouvez en définir un manuellement a partir de sa liste,
si vous le souhaitez.

Enfin, nous pouvons sélectionner avec DynamicCrop une zone plus grande que l'image elle-méme -
elle peut étre plus grande sur un, deux, trois ou les quatre cétés. Si vous cliquez sur le bouton Reset
et que l'image elle-méme est sélectionnée seule, vous pouvez choisir de faire glisser les cotés vers
I'extérieur plutét que vers l'intérieur, ce qui étend la zone sélectionnée au-dela des limites de l'image.
Vous n'étes pas autorisé a créer manuellement une zone sélectionnée plus grande que l'image elle-
méme (par exemple si vous effectuez un zoom arriére), pour aider les utilisateurs a I'éviter (car il
n'est pas habituel qu'un utilisateur veuille faire cela !). Cependant, une fois que vous avez défini une
zone, elle peut étre étendue manuellement au-dela des limites de lI'image, comme indiqué ci-dessus.

Si nous cliquons sur Execute a ce stade, I'image sera la méme mais avec une bordure noire autour,
selon la zone qui se trouve au-dessus des limites de I'image. Nous pouvons cependant définir une
couleur particuliere pour cette bordure. Cela se fait dans I'onglet Fill Color de DynamicCrop. Ici, hous
pouvons entrer des valeurs R, G et B spécifiques de 0 a 1 correspondant a la couleur de la bordure.

En bas de DynamicCrop, vous voyez un apercu de la couleur qui résulte des valeurs R, G et B
entrées jusqu'a présent. Une fois que vous étes satisfait, cliquez sur Execute pour produire cette
bordure colorée.

Il s'agit de savoir comment utiliser pleinement le processus DynamicCrop. N'oubliez pas que puisqu'il
s'agit d'un processus dynamique, vous devrez le fermer et le rouvrir si vous comptez I'utiliser sur une
autre image que vous avez ouverte. Si toutefois vous souhaitez appliquer le méme recadrage a un
ensemble d'images, vous pouvez faire glisser le bouton New Instance de DynamicCrop sur I'espace
de travail PixInsight et simplement faire glisser cette icbne de processus sur chague image que
Vous avez ouverte, pour appliquer exactement les mémes parameétres de recadrage a chaque image.

2. Recadrage par processus Crop

Le processus de redimensionnement est un processus non dynamique, contrairement a
DynamicCrop. Par conseéquent, il est simplement ouvert sur le c6té et une image ouverte peut étre
sélectionnée dans sa liste en haut (elle lit donc certains paramétres concernant I'image, comme sa
taille actuelle).

Si nous développons les onglets Résolution et Process Mode, nous pouvons mieux voir comment
fonctionne Crop.
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En mode processus, le mode sélectionné par défaut est Absolute Margin in pixels. Cela signifie que
vous allez définir votre recadrage en pixels. Nous pouvons sélectionner plusieurs autres options dans
ce menu.

Si nous sélectionnons une des options liées aux pouces ou aux centimétres, alors ce que nous
faisons a notre image dépendra des valeurs sous Résolution, puisque ces valeurs définissent
combien de pixels il y a par unité de longueur (pouces ou centimétres). Je recommande fortement de
laisser le mode de traitement par défaut des marges absolues en pixels sélectionné car il est
beaucoup plus facile a utiliser que l'unité de longueur réelle (puisque la résolution joue alors un role

dans la valeur réelle de ce que vous entrez dans votre image).

Pour recadrer a l'aide de la fonction Crop, nous avons deux options. Premiérement, nous pouvons
entrer un nombre spécifique de pixels que nous voulons laisser sous Target px pour la largeur et la
hauteur. Si nous choisissons de réduire le nombre de pixels de la largeur de 1000, le recadrage
réduira de 500 pixels a gauche et de 500 pixels a droite (tout ce que vous entrez est divisé par 2 et
est fait de chaque c6té correspondant de l'image). Nous pouvons également entrer une valeur
inférieure a % pour la largeur et la hauteur et les valeurs px cibles sont calculées en fonction de ce
gue nous entrons. Comme le nombre de pixels doit toujours étre un nombre entier, toutes les valeurs
de % ne sont pas autorisées et PixInsight fixera automatiquement la valeur en % la plus proche
autorisée.

Ci-dessus, j'ai recadré mon image d'environ 80% en largeur et en hauteur. Remarquez que l'onglet
Marges/Anchors en haut de I'écran contient des valeurs. Ces valeurs sont automatiquement saisies
par PixInsight lorsque vous choisissez de définir vos parameétres de recadrage sous l'onglet
Dimensions. Vous pouvez cependant saisir vous-méme les valeurs ici. Ceci est nécessaire si vous
souhaitez recadrer davantage le haut que le bas, par exemple, puisque par défaut le recadrage sera
le méme du haut que du bas. Il en va de méme si vous souhaitez couper plus a gauche qu'a droite,
par exemple. Nous pourrions entrer des valeurs telles que :

Les chiffres ont été saisis en tant que nombres négatifs afin de recadrer (soustraire de notre image).
lls ont conduit au recadrage suivant :

Si nous choisissons d'entrer des nombres positifs ici, ou d'entrer des valeurs de Target px ou de %
pour Width et/ou Heigth plus grandes que l'original (par exemple, plus de pixels ou plus de 100 %),
alors nous faisons l'inverse du recadrage. Dans ce scénario, I'image est agrandie au-dela de ses
limites par les quantités spécifiees par l'utilisateur. L'utilisation des marges/anchors permet a
l'utilisateur de définir précisément le nombre de pixels a agrandir de chaque coté. L'utilisation des
dimensions signifie que ce que l'utilisateur choisit d'agrandir, se fait de maniére égale sur les deux
cOtés correspondant a la largeur et a la hauteur. Comme pour DynamicCrop, nous pouvons définir la
couleur de la bordure produite par I'expansion de limage au-dela de ses limites, en entrant les
valeurs R, G et B sous l'onglet Fill Color.

Cela couvre tout ce qu'il faut pour utiliser le procédé non dynamique Crop pour recadrer ses images.
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3. Redimensionner avec Resample

Il est possible de redimensionner ses images pour les publier (en ligne ou sur papier), ou pour
convertir une image binning 2x2 en une image binning 1x1, par exemple. Pour cela, Pixinsight
dispose du processus Resample.

Pour commencer, nous devons sélectionner l'image que nous souhaitons redimensionner dans la
liste de Resample en haut. Le processus sera ainsi alimenté par des parametres lus a partir de
I'image elle-méme, comme sa taille actuelle.

Pour plus de clarté, j'ai développé les onglets Interpolation et Résolution ci-dessus. Le processus
Resample est extrémement simple a utiliser. 1l vous suffit de saisir de nouvelles valeurs sous Target
px pour la largeur et la hauteur, ou des valeurs pour % pour la largeur et la hauteur, correspondant
au redimensionnement que vous souhaitez effectuer. Par exemple, si nous entrons 50 % pour la
largeur et la hauteur, PixInsight nous indiqgue automatiquement combien de pixels cela va
représenter sous Target px.

Tant que le rapport d'aspect "Preserve Aspect ratio" sera activé, nous serons obligés d'entrer les
mémes valeurs en % pour la largeur et la hauteur. De méme, si vous entrez une valeur
personnalisée pour la largeur sous Target px, vous entrerez automatiquement une valeur
correspondante pour la hauteur en fonction du rapport d'aspect de I'image. La désactivation de cette
fonction donne a l'utilisateur la liberté de déformer I'image, bien qu'il soit trés probable que vous ne
voudrez jamais vraiment désactiver la fonction Preserve Aspect Ratio pour un astrophotographe.

Sous l'onglet Résolution, nous pouvons modifier le nombre de pixels par unité de longueur que nous
souhaitons. Ceci recalculera la taille physique de I'image sous Dimensions en conséguence, comme
indiqué ci-dessous.

La réduction de la taille physique de l'image est due au fait que, bien que nous ayons conserve la
méme taille d'image en pixels, nous avons maintenant 300 pixels par pouce, contre 72 a l'origine.

Tout rééchantillonnage de I'image nécessitera un certain niveau d'interpolation afin que PixInsight
recréé votre image fidelement par rapport a l'original. Il existe un certain nombre d'algorithmes
disponibles pour la sélection, si vous le souhaitez, bien que laisser I'algorithme réglé sur Auto sous
Interpolation soit une bonne idée simplement parce que PixInsight sélectionnera automatiquement
un algorithme approprié. Cela a toujours fonctionné exceptionnellement bien pour moi.

Il est probable que vous n'utiliserez vraiment le processus Resample que lorsque vous finaliserez
une image pour la publication, qu'elle soit en ligne ou pour l'impression. Quoi qu'il en soit, ses
parameétres vous permettront de tirer le meilleur parti des images finales en les reproduisant
fidelement sur papier ou en ligne.
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XIll.  Etirer des images linéaires en non-linéaires

Au fur et & mesure de leur capture et méme aprés un prétraitement, les astrophotographies sont
généralement tres peu convaincantes. La nature tres faible de nos cibles rend les images presque
entierement noires, ce qui nous ameéne a nous demander pourguoi hous avons pris la peine de les
faire. En regle générale, tous les astrophotographies recoivent au moins un post-traitement et |'étape
principale de cette procédure est I'étirement des images. Ce qui commence comme une image
linéaire (appelée ainsi car elle est pleinement représentative de ce qui a été enregistré au niveau du
capteur de l'appareil photo) est étiré pour renforcer fortement le contraste entre les régions de
luminosité voisines. Cela produit une image non linéaire car elle détruit la représentation originale de
ce qui a été enregistré par le capteur de l'appareil photo, mais produit ce que nous considérons
comme un astrophotographie viable, digne du temps passé a I'exposition.

PixInsight dispose d'un certain nombre de procédés permettant d'étirer les images linéaires jusqu'a
un état non linéaire, qui peut ensuite étre post-traité. Il s'agit de AdaptiveStretch, AutoHistogram,
HistogramTransformation et MaskedStretch. HistogramTransformation est considéré comme le
processus principal de PixInsight pour cette tache, mais les autres sont également couverts pour
des raisons d'exhaustivité.

Supposé pour ce tutoriel :

e Connaissance du fonctionnement de PixInsight, en rapport avec le traitement des images et
des processus ( Lire ce qui suit, sections 3 et 4).

e Vos images ont déja été entierement prétraitées ( Lire ceci).
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1. Etirement avec AdaptiveStretch

AdaptiveStretch est un procédé trés simple de Pixinsight, qui vise a améliorer le contraste dans les
zones d'une image au-dessus d'un seuil de bruit défini. Le tableau ci-dessous montre le processus
ouvert a coté d'une image RVB en couleur actuellement linéaire.

Pour commencer avec AdaptiveStretch, nous ouvrons la fenétre de prévisualisation en temps réel,
qui nous donne une vue en temps réel de ce que les changements de paramétres vont faire a
I'image si nous cliquons sur Apply. Nous activons également le graphique de courbe en temps réel
pour voir a quoi ressemble I'étirement pour les parametres définis.

Pour que l'étirement soit approprié, nous devrions activer la protection contre les contrastes, qui
visera a protéger les zones claires de l'image contre la perte de contraste lorsqu'elles sont étirées.
Pour ce faire, il suffit de cocher la case située a c6té de la protection contre les contrastes.

L'activation de la protection contre les contrastes va probablement modifier votre vue de
prévisualisation en temps réel d’AdaptiveStretch (comme cela a été le cas pour moi, comme indiqué
ci-dessus), puisque le parametre est maintenant introduit dans le stretch. Nous commencons par
deéfinir un seuil d'exposant au bruit appropri€, qui définit I'ampleur du bruit. Pour la plupart des
images, il semble que -4 soit un bon point de départ. Ensuite, nous pouvons ajuster le curseur pour
définir la valeur précise que nous voulons. La prévisualisation en temps réel est suivie de prés
pendant que nous procédons a I'ajustement.

Nous avons maintenant défini ou le bruit vit dans notre image, ce qui indique a AdaptiveStretch de ne
pas I'étirer, mais plutdt de l'atténuer quelque peu. Cela semble rendre l'arriere-plan plus sombre tout
en faisant ressortir les détails des étoiles et la nébuleuse de l'image. L'étirement actuel peut ne pas
sembler idéal, c'est pourquoi nous ajustons maintenant la protection contre les contrastes de la
méme maniere. L'exposant étant a -2 par défaut, nous ajustons le curseur pour voir comment son
changement modifie notre image.

Il est clair qu'en augmentant légerement la valeur de la protection contre les contrastes, on a ajouté
une protection supplémentaire contre les contrastes (comme prévu), ce qui donne un meilleur
contraste sur les zones brillantes comme les étoiles et la nébulosité. Si I'on augmente trop cette
valeur, I'étendue semble étre entierement perdue.

En se rappelant que l'exposant est essentiellement une puissance de dix, nous constatons que
réduire I'exposant pour dire -3 nous permettra un ajustement plus fin. Plus I'exposant est grand, plus
les changements effectués sont brusques compte tenu de la valeur fixée sur le curseur. Par
conséguent, un exposant trop faible peut entrainer des changements invisibles lorsque vous ajustez
le curseur. Je trouve que la valeur par défaut de -2 permet un ajustement important de I'étirement
résultant, mais vous pouvez souhaiter réduire I'exposant de protection de contraste a -3 (ou choisir -1
si vous avez besoin d'une protection de contraste plus importante).
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Les valeurs de Noise Threshold et de Contrast Protection utilisent actuellement l'image entiere
comme mesure pour définir comment I'étirement sera appliqué (selon les valeurs définies). Nous
pouvons cependant définir une petite zone dans limage qui servira de mesure pour
I'AdaptiveStretch. Pour ce faire, il suffit de créer une boite de prévisualisation autour de la zone
souhaitée de lI'image, d'activer la région d'intérét, de cliquer sur le bouton "Preview", de sélectionner
la boite de prévisualisation créée dans la liste et de cliquer sur OK.

Il est évidemment utile d'utiliser la fonction d'autostretch de PixInsight pour voir ou vous devez
deéfinir votre boite de prévisualisation. Il est généralement judicieux de définir la fenétre de
prévisualisation autour d'une zone contenant une nébulosité diffuse et une nébulosité brillante a peu
prés au méme degré. L'activation de la prévisualisation en temps réel donne maintenant un apergu
legerement différent de celui que nous avions auparavant, malgré les mémes parametres. Cela est
simplement d0 au fait que la zone de la boite de prévisualisation est maintenant la métrique
permettant de définir le type d'étirement qui sera appliqué.

Il s'agit a nouveau de trouver un équilibre entre le choix du seuil de bruit et la protection contre les
contrastes, afin d'obtenir un bon étirement qui tienne l'arriére-plan a distance, mais qui permette
d'étirer correctement les caractéristiques intéressantes de l'image sans en faire trop. Le seuil de bruit
est généralement ajusté en premier afin de donner un bon arriére-plan, puis la protection contre les
contrastes est ajustée par la suite afin d'obtenir un bon contraste dans les étoiles et la nébulosité.

N'oubliez pas que la définition d'un cadre de prévisualisation n'est pas nécessairement une bonne
idée, car elle pourrait restreindre votre étirement d'une maniére particuliere qui ne donnerait pas un
bon étirement pour I'ensemble de votre image. Il peut étre nécessaire de redéfinir la zone de
prévisualisation utilisée comme région d'intérét, ou d'utiliser lI'image entiere comme métrique (en
désactivant la région d'intérét), comme c'était le cas par défaut. Dans le cas de mon image, jai
obtenu les meilleurs résultats en n'utilisant pas de fenétre de prévisualisation. J'ai donc désactive la
région d'intérét et j'ai procédé au réglage du seuil de bruit et de la protection contre le contraste a
partir de la.

Le tableau ci-dessous montre le meilleur résultat que j'ai pu obtenir en utilisant AdaptiveStretch avec
I'image entiere utilisée comme métrique :

Mon opinion personnelle sur AdaptiveStretch est qu'il n'obtient pas d'aussi bons résultats que
d'autres procédés, ou méme que l'autostretch de PixInsight, qui semble généralement beaucoup
plus naturel. Néanmoins, si vous obtenez un résultat acceptable avec AdaptiveStretch, il vous suffit
de cliquer sur Apply et vous pouvez alors fermer la fenétre d'apercu en temps réel et la fenétre du
processus lui-méme.
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2. Etirement avec AutoHistogram

L'AutoHistogram est un processus tres performant, bien qu'il ne dispose pas d'une fonction de
prévisualisation en temps réel pour controler I'effet réel des ajustements sur le résultat final (avant
d'appliguer ses parameétres). Ci-dessous, la méme image dans son état linéaire, avec
I'AutoHistogram ouvert a cote.

Le processus AutoHistogram vise a produire une valeur médiane spécifique du pixel sur I'ensemble
de lI'image. Si l'utilisateur a affaire & une image RVB en couleur, comme je le fais ci-dessus, il peut
sélectionner des canaux RVB/K individuels pour régler chague canal de couleur séparément, bien
que cette opération ne soit pas courante lorsque l'image a déja subi une procédure de calibrage des
couleurs (qui neutralise l'arriére-plan dans le cadre de celle-ci). Par défaut, AutoHistogram fonctionne
en mode canaux RVB/K conjoints, pour ajuster l'image entiere par le méme étirement (ce qui est
beaucoup plus courant).

Par défaut, la plupart des images auront une valeur médiane inférieure au réglage par défaut
d’AutoHistogram, soit 0,12000000. Nous pouvons Vvérifier cela en ouvrant le processus de
statistigues et en sélectionnant l'image dans la liste, avec Normalized Real [0,1] sélectionné
également.

En fait, si nous cliquons sur le bouton Set As Active Image dans AutoHistogram alors que notre
image est sélectionnée, elle prendra les valeurs médianes actuelles telles que lues par le processus
de statistiques. Comme l'image est détectée comme une image RVB en couleur, le mode de canaux
RVB/K individuels est également défini automatiquement.

Nous pouvons alors forcer I'AutoHistogram a fonctionner avec une seule valeur en sélectionnant
simplement nous-mémes le mode de canaux RGB/K conjoints.

Pour étirer I'image avec AutoHistogram, il suffit de fixer une valeur plus élevée ici, de sorte que le
processus étire suffisamment lI'image pour atteindre la valeur médiane que vous avez fixée. N'oubliez
pas que ces valeurs ne sont pas des valeurs de pixel, mais des valeurs normalisées (0 signifiant noir
et 1 blanc). Pour déterminer a quelle valeur de pixel cela se réfere, il suffit de multiplier par 65 535
(pour une profondeur de 16 bits). Essayons la valeur par défaut saisie par AutoHistogram de
0,12000000. Il suffit de la définir et de cliquer sur Appliquer pour voir notre image étirée.

Bien qu'il ne soit pas mauvais au départ, il est un peu faible. Nous annulons donc I'étirement et
augmentons la valeur RGB/K pour dire, 0,20000000. Nous cliquons ensuite a nouveau sur Apply.

Nous remarquons que bien que lI'image soit un peu plus lumineuse, il y a peu de contraste gagné en
ayant augmenté la valeur RGB/K. Cela s'explique par le fait qu'en fin de compte, limage est
principalement dominée par le fond et que ce dernier est étiré le long des étoiles et de la nébulosité
(pour atteindre la valeur médiane souhaitée). Plutdét que d'augmenter davantage la valeur RVB/K,
Nnous pouvons Vvoir ce qui se passe lorsqu'au lieu d'utiliser le mode par défaut Gamma Exponent de
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I'AutoHistogram, nous utilisons Logarithmic Transformation puis Rational Interpolation (MTF). Celles-
ci sont indiquées ci-dessous pour les mémes valeurs RGB/K de 0,20000000.

Nous observons tres clairement que Rational Interpolation (MTF) produit le plus de contraste des
trois, tandis que Gamma Exponent produit le moins de contraste et que Logarithmic Transformation
se situe entre les deux. Il est donc recommandé d'utiliser Rational Interpolation (MTF) dans la plupart
des cas, voire dans tous les cas. Aprés avoir déterminé cela, nous pouvons augmenter encore le
RGB/K avec Rational Interpolation (MTF) sélectionnée. Essayons une valeur de 0,30000000.

Cela a permis d'atteindre un trés bon niveau de détail dans les étoiles et la nébulosité, mais
malheureusement nous revenons au méme probléme de l'arriere-plan ayant été rendu un peu trop
lumineux. Afin de résoudre ce probleme, nous activons le paramétre Histogram Clipping en haut de
I'AutoHistogram.

Histogram Clipping permet essentiellement d'ajuster le point noir sur [I'histogramme pendant
I'étirement. Il suffit de préter attention a la section Shadows Clipping car nous voulons ajuster le point
noir et non le point blanc (Highlights Clipping). Essayez avec la valeur par défaut de 0,010 sur RGB/
K sous Shadows Clipping avant d'ajuster (si nécessaire).

Le résultat final est bien meilleur avec un contraste plus élevé dans la nébulosité ainsi qu'un fond
plus sombre, bien qu'il puisse encore faire l'objet de quelgques modifications. Pour assombrir
davantage l'arriere-plan, jaugmente simplement la valeur RGB/K sous Shadows Clipping, a 0,100 a
titre d'essai.

Bien que cela ait quelque peu amélioré le contexte et donc le contraste, nous pouvons clairement
l'augmenter encore. Comme la nébulosité est également un peu trop brillante, nous pouvons nous
permettre de diminuer le RGB/K sous les valeurs médianes cibles. A titre d'essai, je l'ai fixé a
0,30000000 et j'ai augmenté le RGB/K sous Shadows Clipping & 0,300.

L'étirement ci-dessus donne a l'image un aspect beaucoup plus naturel, en ne surchargeant pas le
contraste et en gardant l'arriére-plan a distance. Une fois que vous étes satisfait de I'étirement
appligué, vous pouvez simplement fermer la fenétre du processus AutoHistogram.

3. Etirement par HistogramTransformation

HistogramTransformation est le principal procédé de PixInsight pour I'étirement des images, et pour
cause. HistogramTransformation permet a l'utilisateur de contréler I'étirement qui est appliqué, avec
des ajustements simultanés du point noir et du point blanc. Il dispose également d'une interface
graphique qui montre a l'utilisateur a quoi ressemblera I'histogramme aprés I'étirement, ainsi que
d'une fonction de prévisualisation en temps réel.
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La premiére étape de l'utilisation de HistogramTransformation consiste a sélectionner l'image que
vous souhaitez étirer dans la liste, puis a activer la fenétre d'apercu en temps réel afin que nous
puissions voir ce qui se passe pendant que nous réglons les parametres d'étirement.

Les chiffres des quatre cases du haut (par défaut, tous les 1) sont les niveaux de zoom horizontal et
vertical pour les deux apercus de I'histogramme (celui du haut et celui du bas). En augmentant ces
chiffres, vous pouvez simplement zoomer sur l'une ou lautre de ces prévisualisations,
horizontalement, verticalement ou les deux (selon celles que vous augmentez). Notez que la
prévisualisation de I'histogramme du haut correspond a ce a quoi ressemblerait I'nistogramme si
nous appliquions I'étirement que nous avons mis en place. L'apercu de I'histogramme du bas est un
apercu de I'état actuel de I'nistogramme dans I'image sélectionnée. Dans l'apercu de I'histogramme
du bas, vous trouverez trois curseurs. L'un d'eux, tout a fait a gauche, est noir. Un autre tout a droite,
qui est blanc. Et enfin un autre au milieu, qui est gris.

Le curseur le plus a gauche est le curseur du point noir. Le curseur le plus a droite est le curseur du
point blanc. Enfin, le curseur du milieu est le curseur des tons moyens. Pour étirer une image, il suffit
d'ajuster le curseur des tons moyens en le déplagant vers la gauche. Cela permet de courber la ligne
droite affichée par défaut. En déplacant le curseur des tons moyens vers la gauche, on augmente le
contraste. Inversement, en déplacant le curseur des tons moyens vers la droite, on diminue le
contraste. Cela peut en fait étre utile pour diminuer le contraste en arriere-plan uniquement, si vous
protégez les étoiles et la nébulosité avec un masque.

Ce faisant, vous remarquerez plusieurs choses. Tout d'abord, I'apercu de I'histogramme du haut
change radicalement. Il vous montre a quoi ressemblerait I'histogramme de limage si nous
appliguions I'étirement que nous avons mis en place. Deuxiemement, I'apercu de I'histogramme du
bas ne change pas (puisque I'histogramme de l'image est toujours ce qu'il est a l'origine), mais la
ligne droite se courbe. Cette courbe définit I'étirement non linéaire. Troisiemement, le réglage du
curseur des tons moyens modifie la valeur des tons moyens du bas en conséquence. Vous pouvez
en fait entrer une valeur manuellement et le curseur des tons moyens se déplacera en conséquence
(produisant une courbe pour un étirement). Enfin, la fenétre de prévisualisation en temps réel affiche
rapidement les étoiles et la nébulosité.

Avant d'appliquer I'étirement, nous notons que par défaut, le mode RGB/K est sélectionné. C'est
généralement ce que vous voudrez étirer car il étire toute limage telle quelle (qu'il s'agisse d'une
image RVB en couleur ou d'une image monochrome). Pour les images RVB en couleur, vous pouvez
étirer differemment les différents canaux de couleur en les sélectionnant individuellement (via les
modes R, V et B) et en réglant le curseur des tons moyens pour chacun d'entre eux.

Lorsque vous étes satisfait de votre étirement, que ce soit en mode RVB/K sur I'ensemble de l'image
ou sur un ensemble d'étirements de canaux de couleurs individuels, cliquez sur le bouton Apply pour
appliquer I'étirement. Veuillez toutefois noter que dés que vous aurez fait cela, I'apercu en temps réel
deviendra principalement blanc.
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Cela se produit parce que nous avons toujours le méme étirement paramétré dans
HistorgamTransformation, de sorte que l'apercu en temps réel vous montre ce que ce serait si nous
l'appliquions a nouveau (une deuxiéme fois). Il suffit de cliquer sur le bouton Reset dans
HistogramTransformation pour voir a quoi ressemble l'image maintenant, apres notre étirement
initial.

Remarquez que l'apercu de I'histogramme du bas est maintenant trés différent - c'est ce a quoi
ressemble I'histogramme de l'image apres I'étirement initial. En général, vous devrez effectuer deux
ou trois étirements pour obtenir le meilleur résultat final, bien que le premier soit de loin le plus
agressif. Les deux étirements suivants sont trés mineurs, avec quelques ajustements du point noir
pour tenir l'arriére-plan a distance.

Effectuons maintenant un second étirement, moins agressif. Nous déplacons a nouveau le curseur
des tons moyens vers la gauche pour augmenter le contraste, mais pas autant que nous l'avons fait
précédemment.

Plus le contraste est élevé, plus l'arriere-plan est lumineux. Nous allons donc maintenant ajuster le
point noir avant d'appliquer I'étirement. Pour ce faire, il suffit de déplacer le curseur du point noir vers
la droite. Cela aura pour effet net de déplacer I'ensemble de I'histogramme vers la gauche, puisque
nous redéfinissons essentiellement ce qui constitue le noir. Nous le redéfinissons comme étant une
valeur de pixel plus grande, de sorte que le fond plus clair devienne plus sombre a mesure qu'il se
rapproche du noir. Cependant, en déplacant le curseur du point noir vers la droite, nous prétons une
attention particuliere aux chiffres affichés dans les ombres.

Non seulement la zone de texte Shadows modifie sa valeur en fonction de I'endroit ou vous placez le
curseur du point noir (vous pouvez entrer une valeur manuellement ici si vous le souhaitez !), mais
nous voyons également quelques chiffres a droite de cette zone de texte. lls nous indiquent combien
de pixels sont coupés. Il est généralement considéré comme une mauvaise pratique de découper
des pixels car cela les rend noirs purs (ou blancs purs si nous découpons en blanc) et donc les
informations de l'image sont perdues (le contraste est détruit au niveau de ces pixels). Cependant,
VOus ne pourrez généralement pas éviter de découper quelques pixels ici et |a, si vous voulez obtenir
un bel arriere-plan. Ci-dessus, je découpe 63 pixels au total, ce qui représente une minute 0,0003%
de limage entiére. Etant donné le fond beaucoup plus beau, jaccepte la perte et japplique
I'étirement. Encore une fois, une fois appliqué, je clique sur Reéinitialiser pour voir a quoi ressemble
I'image maintenant.

La question se pose inévitablement : jusqu'a quel point considérons-nous que l'image est étirée et ne
devons-nous pas répéter ce processus ? En régle générale, le sommet de I'histogramme de l'image
doit étre placé a environ 1/4 du chemin vers I'extréme droite (c6té blanc). Cela permet généralement
d'obtenir le meilleur contraste global des éléments tout en conservant un bel arriére-plan. A partir du
deuxiéme étirement, les étirements appliqués sont mineurs et seront normalement accompagnés
d'un ajustement du point noir (si cela est jugé nécessaire ou bénéfique). Voici mon troisieme et
dernier étirement.
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Vous remarquerez peut-étre que certains pixels noirs sont a nouveau coupés, mais c'est une perte
acceptable pour maintenir I'arriere-plan a distance tout en augmentant le contraste des étoiles et la
nébulosité a un niveau souhaitable. Il y a des limites a tout. Le clair de lune ainsi que la pollution
lumineuse présente dans les images éclairciront l'arriere-plan et vous perdrez une faible nébulosité
dans l'arriere-plan plus clair. Aucun étirement de fantaisie ne permettra de récupérer cela sans que
l'arriére-plan paraisse trés artificiellement brillant ou trés artificiellement noirci. A ce stade, il est
préférable de simplement capturer des images lorsque le clair de lune n'est pas un facteur (ou
autant) et a partir d'un site de ciel sombre (ou en utilisant un filtre de suppression de la pollution
lumineuse dans le train optique).

Une fois que vous étes satisfait de I'état non linéaire de votre image (aprés deux ou trois étirements,
tres probablement), vous pouvez fermer la fenétre du processus de transformation de I'histogramme
et sa fenétre de prévisualisation en temps réel. Je ne saurais trop insister sur le fait qu'une image est
plus belle lorsque le fond est laissé a une luminosité mineure, au lieu d'essayer de le noircir
completement. Je pense que nous sommes tous d'accord pour dire que le résultat final ci-dessus est
bien meilleur que l'atrocité suivante :

Il est certain que plus vous acquérez d'expérience dans le post-traitement des images, plus vous
vous en offusquerez. Comme pour la réduction du bruit, moins c'est plus. Un dernier point est qu'il
devrait étre clair pour vous a ce stade que HistogramTransformation est de loin le plus polyvalent des

procédés de Pixinsight pour I'étirement d'images linéaires a un état non linéaire. Bien que
I'AutoHistogram se réveéle assez efficace, il ne remplace pas I'HistogramTransformation.
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4. Etirement avec MaskedStretch

Le dernier procédé de larsenal de Pixinsight pour ['étirement des images linéaires est
MaskedStretch. Ce procédé fonctionne en appliquant de petits étirements de maniére itérative a
l'aide de masques. L'idée est qu'il produit un contraste tout en respectant les éléments brillants
comme les étoiles. Voici la méme image linéaire que celle que nous avons utilisée jusqu'a présent,
en plus du procédé MaskedStretch.

Avant tout, nous devrions définir une petite fenétre de prévisualisation sur le fond afin que
MaskedStretch puisse fonctionner efficacement, en lui fournissant une référence de fond.
L'autostretch de PixInsight est la clé pour trouver une zone appropriée de I'image. Il est parfois utile
de faire un zoom arriére pour trouver un endroit ou il y a un manque d'étoiles. Choisissez une zone
qui n'a rien d'autre que l'arriere-plan - pas d'étoiles ou de nébulosité diffuse.

Une fois la boite de prévisualisation préparée, nous enlevons l'autostretch et retournons a
MaskedStretch. Ici, cliquez sur le petit bouton a c6té de la boite de texte pour la référence de fond.
Sélectionnez la boite de prévisualisation dans la liste et cliquez sur OK.

La référence de fond étant maintenant définie dans MaskedStretch, nous passons a l'examen des
autres parametres. Le nombre d'itérations est de 100 par défaut, ce qui est généralement plus que
suffisant pour produire un résultat final lisse. Vous ne devriez pas vraiment avoir besoin d'y toucher,
mais si vous voulez accélérer le traitement, abaissez ce chiffre a environ 50. La valeur maximale
autorisée est de 1000, mais elle est considérée comme tres excessive. 100 est plus que suffisant
dans la grande majorité des cas. Le fond du ciel est la principale valeur que nous modifions pour
obtenir un étirement acceptable. N'oubliez pas qu'il s'agit de valeurs normalisées (0 a 1), donc
multipliez par 65 535 si vous voulez savoir a quelle valeur de pixel cela se réféere. Les valeurs de fond
cibles comprises entre 0,10000000 et 0,20000000 ont tendance a trés bien fonctionner. Laissons la
valeur par défaut de 0,12500000 pour l'instant et testons I'étendue.

Nous constatons que I'étirement a tres bien fonctionné. Le fond est trés bien tenu a distance, les
couleurs des étoiles semblent naturelles et non saturées et la nébulosité présente un bon contraste.
Cependant, limage globale est un peu sombre et n'a pas le contraste saisissant produit par des
éléments comme HistogramTransformation. Nous pouvons annuler I'étirement et essayer une valeur
plus élevée de Target background pour obtenir un étirement plus important. Par exemple,
0,20000000.

L'étirement semble beaucoup mieux, sinon un peu plat. La encore, bien que I'étirement global ait
produit une image plus lumineuse, il manque encore de contraste percutant. Cependant, un point
trés important est qu'en raison de I'étirement trés conservateur, l'information sur les couleurs est
fantastique. Toutes les couleurs des étoiles sont conservées et la nébulosité présente également une
bonne couleur non saturée.
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Afin de produire une image globale plus lumineuse avec un arriere-plan contrélé, nous avons
maintenant modifié la valeur de clipping. Celle-ci définit la proportion de pixels noirs a supprimer. La
valeur par défaut de 0,00050000 fonctionne exceptionnellement bien dans presque tous les cas.
Cependant, nous pouvons essayer une valeur dix fois plus grande, 0,00500000. Le fond cible est
maintenu a 0,20000000.

Il ne faut pas aller trop loin dans l'augmentation de la fraction d'écrétage car le fond finit par étre trop
noirci et semble également plus bruyant. Le résultat ci-dessus est déja excellent. Aprés tout, ce n'est
pas forcément la seule méthode pour étirer I'image. Vous pouvez faire suivre MaskedStretch d'une
touche de HistogramTransformation. Vous pouvez également profiter du fait que MaskedStretch
respecte tellement la fidélité des couleurs et I'utiliser pour étirer votre image RVB en couleurs. Vous
pouvez ensuite utiliser HistogramTransformation pour étirer votre image Luminance et les combiner
ensuite ensemble. En utilisant MaskedStretch pour I'image RVB, vous garantissez que l'image étirée
est riche en couleurs, y compris les étoiles jusqu'a leur noyau. En fait, voici la combinaison LRGB de
ces éléments (image de luminance étirée avec HistogramTransformation et image RGB en couleurs
étirée avec MaskedStretch, comme ci-dessus) :

bY

C'est certainement une chose a laquelle il faut réfléchir. Il n'y a aucune raison d'utiliser
HistogramTransformation pour tous vos étirements si MaskedStretch fait un bon travail avec la
couleur. En outre, MaskedStretch fonctionne également avec des images non linéaires, vous pouvez
donc l'utiliser pour donner un petit coup de pouce supplémentaire a votre image. Une fois que vous
utilisez MaskedStretch, vous étes libre de fermer sa fenétre de traitement et de supprimer toute
fenétre de prévisualisation de votre image (comme celle utilisée comme référence d'arriére-plan).
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XIV. Retoucher la couleur dans les images

Habituellement, vers la fin du post-traitement d'une image, un astrophotographe a tendance a vouloir
améliorer la saturation des couleurs afin de les rendre plus attrayantes. Ceux qui réalisent des
images a bande étroite peuvent également souhaiter modifier davantage la palette de couleurs de
leur image afin de donner précisément les couleurs qu'ils veulent, quelle que soit leur palette de
départ (bicolore, Hubble, etc.).

Ce tutoriel expliqgue comment ajuster sélectivement le niveau de saturation de certaines couleurs
dans vos images et comment améliorer globalement la saturation des couleurs. En outre, ce tutoriel
expligue également comment effectuer un changement de teinte, c'est-a-dire transformer un
ensemble de couleurs en un ensemble de couleurs différent ou en différentes nuances de la méme
couleur. Les processus couverts pour tout cela sont ColorSaturation et CurvesTransformation.

Supposé pour ce tutoriel :

* Connaissance du fonctionnement de PixInsight, en rapport avec le traitement des images et
des processus ( Lire ce qui suit, sections 3 et 4).

e Vos images ont déja été entierement prétraitées ( Lire ceci).
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1. Améliorations de la saturation sélective avec ColorSaturation

Il est courant de vouloir améliorer la saturation des couleurs dans certaines zones de ses images,
notamment vers la fin du post-traitement. C'est généralement le cas lorsque I'image est non linéaire
et qu'elle a déja subi un certain nombre de procédures de post-traitement. Prenons par exemple
I'image suivante de la nébuleuse de la trompe de I'éléphant, sur une palette bicolore a bande étroite.

On peut souhaiter produire des bleus plus profonds, par exemple. L'utilisation de masques est
facultative, car vous pourriez par exemple utiliser un masque d'étoile pour protéger les étoiles des
améliorations de la saturation des couleurs. Pour cet exemple, je ne m'embéterai pas avec les
masques. L'image ci-dessus montre l'image non linéaire ouverte en méme temps que le processus
de saturation des couleurs. Ce processus nous permet de saturer des couleurs particulieres a des
degrés différents. La ligne jaune horizontale affichée dans ColorSaturation est par défaut plate a une
valeur de saturation de 0,00000. Par conséquent, rien n'est fait a I'image pour le moment. Nous
devons d'abord déterminer plus ou moins ou se situent les bleus dans le spectre des couleurs. Pour
cela, il suffit de cliquer sur l'image, en laissant le bouton gauche de la souris enfoncé, et de faire
passer le pointeur de la souris sur une zone d'intérét (que nous aimerions saturer davantage).

Le réticule qui apparait dans ColorSaturation indique que notre domaine d'intérét se situe dans cette
zone du spectre des couleurs. Par conséquent, afin d'améliorer la saturation des couleurs de l'image,
nous cliquons sur le graphique dans ColorSaturation au-dessus de la gamme de couleurs qui nous
intéresse. Nous activons également I'apercu en temps réel afin de voir ce qui se passe lorsque nous
effectuons des ajustements.

Le fait de cliquer a créé un point qui courbe la ligne vers le haut, culminant plus ou moins a I'endroit
ou lI'on a cliqué. Nous pouvons apporter d'autres ajustements a cette courbe pour qu'elle n'améliore
vraiment que la saturation des couleurs autour des bleus. Pour cela, nous cliquons pour créer
d'autres points le long du spectre des couleurs qui aplatissent la courbe a ces endroits.

Pour supprimer les minima restants dans la courbe (ce qui réduit la saturation de ces couleurs), on
cligue pour créer quelques points supplémentaires (ou se trouvent les minima). Si vous faites une
erreur et ajoutez un point la ot vous ne vouliez pas en ajouter un, vous pouvez simplement cliquer et
faire glisser le point pour le déplacer ailleurs. Si vous souhaitez supprimer le point, il vous suffit de
cliquer sur le point lui-méme tout en maintenant la touche CTRL enfoncée sur votre clavier.

Maintenant qu'il n'y a qu'un seul sommet dans la courbe, situé au-dessus des bleus, et que le reste
est plus ou moins plat, nous pouvons affiner davantage la courbe pour nous assurer qu'elle fait
exactement ce que nous voulons. Par exemple, la courbe que je viens de décrire ne se limite pas au
bleu, et nous déplacons donc le point gauche de la créte vers la droite pour limiter I'amélioration au
seul bleu. Pour déplacer un point, il suffit de cliquer et de le faire glisser a I'endroit souhaité.

La courbe ressemblant maintenant davantage a ce que nous voulons, nous nous assurons que les
autres points qui devraient offrir une amélioration a saturation zéro, offrent réellement une
ameélioration a saturation zéro. Nous pouvons essentiellement naviguer a travers chaque point
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individuel en utilisant les boutons fléchés gauche et droit de ColorSaturation. Une fois qu'un point est
sélectionné, sa valeur de saturation actuelle s'affiche. Une valeur de 0,00000 ne permet pas
d'améliorer la saturation. Une valeur positive augmente la saturation. Inversement, une valeur
négative diminue la saturation.

Il suffit de cliquer plusieurs fois sur la fleche de gauche pour que le premier point soit sélectionné.
Dans mon cas, puisqu'il y a 7 points, ColorSaturation indique maintenant 1 / 7, donc mon premier
point est définitivement sélectionné. En vérifiant la valeur de Saturation, il indique 0,00000, ce qui est
ce que je veux pour ces couleurs. Maintenant, je clique une fois sur la fleche droite de sorte que
ColorSaturation indique 2 / 7 (mon deuxiéme point est sélectionné).

La valeur de la saturation a ce deuxieme point semble étre de 0,00909. J'avais l'intention de fixer
cette valeur a 0,00000 car je ne veux pas augmenter la saturation de ces couleurs. Par conséquent,
je modifie simplement la valeur de la saturation a 0,00000 et j'appuie sur la touche TAB de mon
clavier (ou je cligue sur une autre zone de texte dans ColorSaturation) pour m'assurer que les
changements sont appliqués au point sélectionné.

Le deuxieme point n‘améliore pas la saturation a son emplacement. Il ne reste plus qu'a cliquer sur la
fleche droite une fois de plus (pour aller au point 3 / 7) et faire de méme - s'assurer que la saturation
est a 0,00000 si le point sélectionné ne correspond pas au pic de bleu que je souhaite. Le tableau
suivant montre le résultat final de cette opération pour chaque point, sauf pour le point 4 / 7, qui se
trouve étre le point le plus élevé du blues.

Tout ce qu'il reste a faire, c'est de s'assurer que c'est bien la quantité d'amélioration que nous
souhaitons apporter au bleu & mon image. Puisque j'ai le dernier point sélectionné actuellement (7 /
7), je clique sur le bouton fleche gauche jusqu'a ce que jatteigne le point culminant (4 / 7). Sa valeur
de saturation actuelle est de 0,49091.

Bien que le bleu soit plus profond, il est peut-étre un peu trop par rapport au reste de l'image.
Comme nous procéderons plus tard a des améliorations universelles de la saturation des couleurs,
nous pouvons nous permettre de saturer un peu moins les bleus a ce stade. Par conséquent, je
diminue simplement la saturation pour ce point a 0,30000 et j'appuie sur la touche TAB de mon
clavier (ou je clique sur n'importe quelle autre zone de texte dans ColorSaturation) pour que les
changements soient appliqués.

Vous pouvez cliquer sur le bouton "Real-Time Preview" de ColorSaturation pour activer ou désactiver
I'apercu. La fenétre restera ouverte et affichera I'image, sauf si vous la désactivez, qui vous montrera
l'image originale (sans aucune amélioration de la saturation des couleurs). Par conséquent, en
l'activant et en la désactivant, vous obtiendrez une image avant et apres, ce qui vous permettra de
vérifier si vous étes satisfait des changements proposés. Vous pouvez ajuster davantage votre valeur
de saturation a votre godt, ou ajouter un autre pic ailleurs, ou encore réduire la saturation d'une
couleur particuliere en ajoutant un point minimum sous la ligne plane.

Une fois que vous étes satisfait de vos changements, cliquez sur le bouton Appliquer. N'oubliez pas
que l'apercu en temps réel vous montrera alors a quoi ressemblerait le résultat si vous appliquiez a
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nouveau la méme amélioration (une deuxieme fois). Par conséquent, pour voir a quoi ressemble
votre image maintenant, il vous suffit de cliquer sur le bouton Réinitialiser de ColorSaturation (ou, si
Vous souhaitez conserver ses parametres, il vous suffit de déplacer la fenétre d'apercu en temps réel
ou de la fermer).

Ci-dessus, jai fermé la fenétre de prévisualisation en temps réel pour voir l'image apres lui avoir
appligué la saturation des couleurs. Avec le bleu aussi profond que je le souhaite pour l'instant, je
ferme ColorSaturation et je passe a autre chose.
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2. Amélioration de la saturation et changement de teinte avec «
Curves Transformation »

Comme c'est souvent le cas pour les images a bande étroite, étant donné leurs fausses couleurs, il
appartient a l'utilisateur de choisir la palette de couleurs qu'il souhaite donner a son image. Les
combinaisons PixelMath de données a bande étroite vous permettent d'obtenir des combinaisons
approximatives qui produisent la palette de couleurs que vous souhaitez, mais parfois des
ajustements mineurs sont souhaitables. Par exemple, je peux vouloir rendre les oranges de mes
images plus rouges, de sorte que l'image prenne davantage une palette de couleurs rouge-bleu
plutdt qu'une palette de couleurs orange-bleu. L'objectif mérite ce que nous appelons un changement
de teinte.

L'image ci-dessus montre mon image aprés qu'elle ait recu lI'amélioration ColorSaturation pour le
bleu dans la section précédente. Elle est ouverte en méme temps que le processus de
transformation des courbes. Pour effectuer un changement de teinte, nous passons en mode Hue.
Nous ouvrons également la fenétre Real-Time Preview, comme précédemment.

Avant de commencer, nous constatons qu'il existe déja une ligne droite dans CurvesTransformation.
Sur les axes horizontal et vertical, nous avons tout le spectre des couleurs. Le fait que la ligne soit
droite signifie que chaque couleur correspond a elle-méme, c'est-a-dire qu'l n'y a pas de
changement de teinte pour le moment. Mon objectif de rendre les oranges plus rouges exige que je
déplace la ligne de sorte que les oranges soient déplacées vers les rouges. On remarque également
gue l'axe horizontal est I'axe DE et |'axe vertical est I'axe DE. Par exemple, si hous plagons un point
au-dessus des bleus sur I'axe horizontal et que nous le déplacons vers les violets le long de l'axe
vertical, les bleus deviendront violets.

Par conséquent, pour effectuer le changement de teinte des oranges vers les rouges, je clique pour
faire un point sur le graphique au-dessus des oranges sur I'axe horizontal, mais je place le point tres
loin sur l'axe vertical pour qu'il corresponde aux rouges sur l'axe vertical. Si vous voulez savoir ou
certaines couleurs de votre image apparaissent dans le spectre des couleurs, il vous suffit de cliquer
et de maintenir le bouton gauche de la souris enfoncé sur cette zone de l'image. Le méme réticule
qui apparait dans ColorSaturation apparaitra dans CurvesTransformation, ce qui vous aidera a
identifier les couleurs que vous visez.

Cela a clairement provoqué un changement de teinte de notre image, rendant les oranges plus
rouges, comme souhaité. Malheureusement, en raison de la courbure introduite dans
CurvesTransformation, cela déplace également le reste des couleurs. Les bleus deviennent des
bleus plus clairs, par exemple. Pour corriger cela, il suffit de cliquer pour créer un certain nombre de
points supplémentaires le long de la courbe afin de la redresser apres le décalage de la teinte rouge-
orange.

A ce stade, vous pouvez ajouter un certain nombre de points supplémentaires pour redresser
davantage la ligne, ou pour effectuer un léger changement de teinte ailleurs dans le spectre des

couleurs. Vous pouvez également déplacer le premier point créé pour vous donner précisément la
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nuance de couleur souhaitée. Si vous créez un point que vous souhaitez supprimer, il vous suffit de
le cliquer tout en maintenant la touche CTRL de votre clavier enfoncée.

Ci-dessus, j'ai ajusté les oranges et les jaunes pour produire une plus belle nuance de rouge qui est
un peu moins intense. J'ai également créé un point au-dessus des bleus et je I'ai déplacé vers le haut
pour rendre les bleus un peu plus fonceés.

Vous pouvez cliquer sur le bouton Apercu en temps réel de CurvesTransformation pour activer et
désactiver l'apercu. La fenétre restera ouverte et affichera l'image, sauf si vous la désactivez, qui
vous montrera l'image originale (sans aucun ajustement). Par conséquent, si vous l'activez et la
désactivez, vous obtiendrez une image avant et aprés afin que vous puissiez vérifier si vous étes
satisfait des changements proposés. Lorsque vous étes satisfait des changements proposés, il vous
suffit de cliquer sur le bouton "Apply". Assurez-vous de cliquer ensuite sur le bouton Reset afin de
voir votre image telle qu'elle est apres le réglage, ou déplacez/fermer la fenétre d'apercu en temps
réel.

Nous allons maintenant saturer davantage toutes les couleurs de l'image. Bien que nous puissions
simplement faire cela en augmentant la valeur de la saturation dans ColorSaturation sur les deux
points par défaut qui forment la ligne droite horizontale, nous pouvons également le faire ici dans
CurvesTransformation. Il suffit de passer en mode Saturation et de s'assurer que l'apercu en temps
réel est actif.

Comme l'axe horizontal est I'axe FROM et l'axe vertical est I'axe TO, comme auparavant, pour
ameliorer la saturation globale des couleurs, il suffit de cliquer pour créer un point au milieu de la
ligne droite et de le faire glisser vers le coin supérieur gauche du graphique. Un petit ajustement fait
une grande différence, alors soyez prudents ici.

Inversement, si vous voulez désaturer un peu les couleurs, il suffit de faire glisser ce nouveau point
vers le bas, vers le coin inférieur droit du graphique. Comme les couleurs sont affichées en tandem
avec la luminance, vous pouvez également procéder a un ajustement mineur de la luminosité de
I'image. Cela se fait en mode Lightness.

La méme théorie s'applique ici. Cliquez pour créer un point au milieu du graphique, puis faites-le
glisser vers le coin supérieur gauche du graphique pour augmenter la luminosité. Inversement, faites-
le glisser vers le bas en direction du coin inférieur droit du graphique pour diminuer la luminosité.
Encore une fois, vous devrez faire preuve de prudence. Ci-dessous, je donne a mon image un petit
coup de pouce a la luminosité.

Comme je n'ai encore appliqué ni le renforcement de la saturation des couleurs ni le renforcement de
la luminosité, les deux courbes sont affichées dans CurvesTransformation (bien qu'elles soient trés
proches dans mon cas). Une fois que vous étes satisfait des changements proposeés, cliquez sur le
bouton Appliquer. N'oubliez pas que la fenétre d'apercu en temps réel vous montrera alors ce que
vous ferez si vous appliquez les changements a nouveau (une deuxieme fois). Pour voir votre image
telle qu'elle est, cliquez sur le bouton Réinitialiser ou déplacez/fermer la fenétre d'apercu en temps
réel.
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Vous pouvez fermer le processus CurvesTransformation une fois que vous avez fini d'appliquer les
changements. Vous pouvez toutefois procéder a un deuxieme ajustement une fois le premier
ajustement appligué. Il n'est pas rare de le répéter une fois de plus, mais généralement de maniére
moins agressive.

Apres tout, votre image doit produire les couleurs que vous voulez représenter, avec le niveau
d'intensité que vous souhaitez. Cette procédure est particulierement utile pour ajuster la palette de
couleurs et la fidélité des couleurs dans les images a bande étroite.
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XV. Preparer les Images pour Publication

La fin du post-traitement d'une image sera toujours suivie d'une ruée vers la sortie. Nul doute que
vous aurez envie de montrer aux autres ce que votre travail a donné, que ce soit en ligne ou sur
papier. Il y a un certain nombre de choses que vous souhaiterez peut-étre faire a votre image avant
de la publier en tant que produit fini. Ce tutoriel couvre précisément ces aspects. Vous n'étes pas
obligé de faire tout ce qui est indiqué ici (ou quoi que ce soit d'ailleurs ), mais ce tutoriel suit une
procédure assez compléte pour la publication de vos images.

Le profil de couleur est d'abord converti en utilisant ICCProfile Transformation, en fonction de I'endroit
ou I'image se retrouvera. L'image est ensuite redimensionnée en fonction des exigences en matiére
de pixels et/ou de résolution, a l'aide de la fonction Resample. Une bordure est ajoutée autour de
I'image pour indiquer votre nom et votre site web, en utilisant la fonction Crop. Les objets d'intérét
dans l'image ainsi que votre nom et l'adresse de votre site web sont annotés sur l'image a l'aide de la
fonction Annotation. Enfin, lI'image est enregistrée dans des formats appropriés pour différents
supports de publication.

Supposé pour ce tutoriel :

e Connaissance du fonctionnement de PixInsight, en rapport avec le traitement des profils de
couleur, des images et des processus ( Lire ce qui suit, sections 2, 3 et 4).

* Votre image a été entierement pré et post-traitée et est considérée comme terminée a toutes
fins utiles.
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1. Conversion du profil de couleur avec
ICCProfileTransformation

PixInsight utilise par défaut un profil de couleur pour afficher les images qui s'y trouvent. Si vous
avez suivi le tutoriel Introduction a PixInsight, vous aurez probablement défini le profil de couleur
Adobe RVB (1998) par défaut. Il ne s'agit toutefois pas du profil de couleur officiel pour I'Internet, ni
nécessairement du profil de couleur utilisé par un imprimeur que vous pourriez vouloir utiliser pour
imprimer vos images. Nous commengons par le produit fini ouvert dans PixInsight.

Nous allons supposer que cette image sera publiée en ligne. La procédure sera identique pour une
image destinée a l'impression, outre le choix idéal du profil de couleur de l'imprimante. Avant tout,
nous enregistrons une nouvelle copie de l'image avec un nom différent afin que toute modification
apportée a celle-ci ne le soit pas au produit fini proprement dit.

La nouvelle copie de l'image est toujours enregistrée en tant qu'image FITS 32 bits, tout comme le
produit fini. Il n'y a aucune raison réelle de changer cela jusqu'a la fin. Ensuite, nous ouvrons le
processus ICCProfile Transformation.

Ici, nous sélectionnons notre image ouverte dans la liste supérieure sous Source Profile. Cela nous
indiquera le profil de couleur que I'image utilise actuellement.

Comme nous allons publier cette image en ligne, nous allons choisir le profil de couleur standard
pour l'Internet. Tout d'abord, activez l'option Convert au profil spécifié sous Target Profil. Dans la
liste, sélectionnez sRGB IEC61966-2.1. Si votre intention était d'imprimer l'image et que vous aviez
un profil de couleur configuré pour I'imprimante de votre choix, vous pouvez sélectionner celle-ci a la
place. Votre imprimante peut vous suggérer de continuer a utiliser le profil de couleur Adobe RVB
(1998) si possible. Si c'est le cas, assurez-vous que c'est bien le profil de couleur que vous avez
choisi (s'il n'est pas déja défini par défaut, comme le mien I'était). Quoi qu'il en soit, pour I'Internet,
SRGB IEC61966-2.1 est le profil de couleur correct.

Avant d'appliquer le changement de profii de couleur, sélectionnez Perceptuel (images
photographiques) dans la liste Rendering Intent et et assurez-vous que les deux options Black point
compensation et Floating point transformation sont activées. Une fois cela fait, il suffit de cliquer sur
Appliquer et de fermer la fenétre du processus.

Le profil couleur de I'image est maintenant prét pour la publication.

2. Redimensionner avec Resample

Nous abordons maintenant l'idée que nous pourrions vouloir redimensionner limage avant sa
publication. Au minimum, vous voudrez peut-étre ajuster la résolution (pixels par centimétre/pouce)
pour que l'impression reproduise fidélement I'image sur le papier. Pour ce faire, on utilise le procédé
Resample.
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Nous commencons par sélectionner limage dans la liste du haut, afin que les valeurs originales
soient automatiquement renseignées et que vous sachiez avec quoi vous travaillez.

Il est tres rare que quelqu'un veuille réduire délibérément la taille en pixels de ses images avant leur
publication, a moins qu'il ne cherche a réduire la taille des fichiers ou a cacher des imperfections qui,
une fois réduites, deviennent moins visibles. Si vous souhaitez réduire la taille en pixels de votre
image, il vous suffit d'entrer une nouvelle valeur sous Target px pour la largeur ou la hauteur (I'autre
s'ajustera automatiquement pour maintenir le rapport hauteur/largeur). Je maintiendrai la taille en
pixels de mon image constante, mais jaugmenterai la résolution de 72 a 300 pixels par pouce (par
défaut).

La taille de I'image en centimeétres et en pouces est ajustée en conséquence, puisque je force plus
de pixels a tenir dans un pouce en augmentant la résolution. La taille des pixels reste cependant de
8002 x 5330. Une fois que vous étes satisfait de vos réglages, cliquez simplement sur Appliquer et
fermez la fenétre du processus.

5. Ajouter une bordure avec Crop

En vue d'annoter mon nom et mon site web sur lI'image, j'y ajouterai une bordure. Le procédé Crop

est particulierement adapté a cette fin car il vous permet de spécifier le nombre de pixels et de
travailler avec des coétés individuels, avec un réglage de la couleur de la bordure inclus.

Avant de commencer, nous nous assurons que l'image est sélectionnée dans la liste du haut. Les
propriétés de I'image seront alors intégrées au processus. Je voudrais ajouter ma bordure au bas de
limage. Etant donné que la hauteur de l'image est de 5330 pixels, j'estime la hauteur de la bordure
appropriée a 200 pixels. Par conséquent, je saisis 200 (positif, afin d'agrandir I'image plutdt que de la
recadrer !) dans la zone de texte inférieure sous Margins/Anchors. Ce faisant, la hauteur sous Target
px est automatiguement augmentée a 5530. Si elle était réduite a 5130, je la recadrerais plutdt que
de l'agrandir.

Par défaut, la résolution de Crop est fixée a 72 pixels/pouce. Puisque nous avons modifié la
résolution de notre image a 300 pixels par pouce, je vais devoir ajuster le parameétre dans Crop pour
m'assurer que ce que jai fait plus tét n'est pas annulé. Pour cela, nous développons l'onglet
Résolution et nous entrons 300 dans les deux zones de texte. En outre, je voudrais que la bordure
soit de couleur gris foncé, au lieu du noir par défaut. Pour ajuster la couleur de la bordure, nous
développons l'onglet Fill Color.

Sous R, G et B, nous pouvons entrer des valeurs de Rouge, Vert et Bleu entre 0 et 1 pour créer la
couleur que nous voulons. Toutes les nuances de gris sont simplement des couleurs qui ont les
mémes valeurs R, V et B et comme 0 représente le noir (1 représente le blanc), je dois simplement
entrer les mémes valeurs basses pour les trois. Par exemple, des valeurs R, V et B de 0,150000
conviennent. La barre en bas (par défaut, le noir) prendra la couleur correspondant aux valeurs que
vous entrez (comme un apercu). Une fois satisfait, on clique sur Apply.
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Avec la bordure gris foncé ajoutée au bas de I'image, le processus de recadrage peut étre fermé et
I'image sauvegardée.

6. Annoter avec Annotation

PixInsight dispose d'un procédé peu utilisé - I'annotation. Ce processus fait exactement ce que le
nom suggere - permettre a l'utilisateur d'annoter du texte sur des images. Comme je souhaite ajouter
mon nom et l'adresse de mon site web dans la bordure inférieure de l'image, je vais utiliser ce
procede.

Le texte que vous souhaitez ajouter est simplement saisi dans Text. L'option Show leader est
désactivée par défaut. Elle n'est activée que si vous souhaitez que le texte soit accompagné d'une
ligne de pointage (pour pointer vers des objets dans l'image). Nous examinerons cette fonctionnalité
dans un instant, mais pour linstant, mon nom ne nécessite pas de ligne de pointage. Sous la
rubriqgue Font, vous pouvez sélectionner la police de votre choix et définir une taille. Vous pouvez
également ajouter des options de style telles que Bold, Italic, Underline et Shadow. Une couleur peut
également étre sélectionnée dans la liste des préréglages. Si vous souhaitez une couleur
personnalisée, il vous suffit de cliquer sur le rectangle coloré situé a cété de la liste des couleurs
prédéfinies. Les valeurs R, G et B peuvent ensuite étre entrées manuellement. Une Opacité peut
également étre saisie pour que le texte soit invisible (0), transparent/translucide (1 a 254) ou opaque
(255).

Pour ajouter le texte a votre image, cliquez n'importe ou sur l'image pendant que le processus
d'annotation est ouvert. Au fur et a mesure que vous personnalisez les options telles que celles de la
rubrique Police (ou que vous modifiez le texte lui-méme), des changements seront apportés au texte
de l'image. Vous pouvez cliquer et faire glisser le texte sur I'image pour le déplacer ou vous le
souhaitez.

Lorsque vous étes satisfait de I'emplacement et du style du texte, il vous suffit de cliquer sur le
bouton "Execute" de I'Annotation (icbne coche verte). Le texte sera ainsi ajouté de facon permanente
a votre image. Vous pouvez évidemment annuler les modifications apportées a l'image si vous n'étes
pas satisfait par la suite. Une fois qu'une chaine de texte est ajoutée, vous pouvez cliquer a nouveau
sur I'image n'importe ou pour ajouter une autre chaine (dans ce cas, j'ajouterai I'adresse de mon site
web).

Nous pouvons également ajouter des étiquettes a limage elle-méme, pour indiquer les
caractéristiques individuelles telles que les noms des nébuleuses et les numéros de catalogue. Dans
ce cas, nhous activerons Show Leader. Pour pointer la ligne a I'endroit de votre choix, il vous suffit de
passer le pointeur de la souris sur son point et vous pourrez cliquer et faire glisser la ligne n'importe
ou sur l'image. Le texte peut également étre placé n'importe ou. Vous vous rendrez vite compte que
les lignes de pointage ne sont pas particulierement grasses et peuvent étre tres difficiles a voir, sauf
lorsqu'elles sont sur le fond. Il n'est donc généralement pas judicieux de les utiliser avec des images
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lumineuses. C'est cependant une bonne facon de présenter plusieurs petites galaxies, amas d'étoiles
ou étoiles individuelles sur un fond sombre.

Une fois que vous étes satisfait d'avoir ajouté toutes les chaines de texte que vous vouliez, il vous
suffit de fermer le processus d'annotation et d'enregistrer votre image.

7. Enreqistrer dans des formats d'image appropriés

Votre image étant préte a étre enregistrée dans un autre format que le 32 bits FITS, nous
considérons maintenant comment cette image se comportera. Pour maintenir le contraste, l'idéal
serait d'enregistrer a une profondeur de bits minimale de 16 bits. Un format particulierement adapté
pour conserver ce niveau d'information est le TIFF.

Lors de I'enregistrement sous forme de TIFF 16 bits, sélectionnez un entier non signé 16 bits et None
sous Compression. Vous pouvez également saisir ici la description de l'image et vos informations de
copyright. Les images TIFF 16 bits sont particulierement bien adaptées a une impression ultérieure,
car elles conservent une large gamme dynamique et ne présentent pas de pertes de compression
visibles.

Si toutefois vous avez l'intention de publier cette image en ligne, comme c'est le cas ici, le TIFF 16
bits produira une taille de fichier trop importante. Certains sites d'hébergement d'images
n'accepteront pas des fichiers aussi volumineux, ou introduiront leur propre compression par-dessus,
ce qui ruinera vos bonnes intentions initiales. Les deux principaux formats pour la publication en ligne
sont le PNG et le JPEG. Les deux sont en 8 bits, ce qui signifie que beaucoup d'informations dans la
gamme dynamique sont compressées. Cependant, vous ne verrez peut-étre pas la différence avec
VOS Yyeux, car votre moniteur est probablement un moniteur 8 bits de toute facon (il comprime donc
déja visuellement les images 16 bits). Cependant, le format JPEG a tendance a introduire des
gradients bizarres en raison des pertes de compression, méme lorsqu'il est réglé sur une qualité de
100 %. Le PNG est donc un excellent format 8 bits a utiliser, & moins que vous ne souhaitiez

vraiment réduire la taille des fichiers (alors le JPEG réglé a 100% de qualité est votre meilleur choix).

Si vous enregistrez au format PNG, on ne vous demandera rien. Le fichier sera simplement créé. Si
vous enregistrez au format JPEG, il vous sera demandé de définir une valeur de qualité. La valeur
par défaut est 80, ce qui correspond a 80%. Augmentez toujours cette valeur a 100 pour 100%
(qualité maximale JPEG).

Enfin, nous vous rappelons d'utiliser le format TIFF 16 bits pour I'impression et le format PNG ou
JPEG a 100 % pour la publication en ligne. Si vous pouvez choisir le PNG, allez-y. Si vous souhaitez
réduire la taille des fichiers, utilisez le JPEG réglé sur une qualité de 100 %. Une autre facon de
réduire davantage la taille des fichiers consiste a réduire la taille en pixels de l'image. Pour ce faire,
utilisez simplement le processus Resample mais réduisez les valeurs sous Target px. Assurez-vous
gue les valeurs saisies sous Résolution sont appropriées a vos besoins. La valeur par défaut de 72
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pixels/pouce est parfaitement adaptée a la publication en ligne. Une valeur supérieure n'est vraiment
avantageuse que pour l'impression.

[ } 164



XVI.  Préparer une mosaique

Il arrive un moment ou chacun envisage de photographier une cible et réalise qu'elle ne rentre pas
dans le cadre, ou qu'il souhaite capturer quelque chose de voisin, ensemble, dans une image. On
peut parfois utiliser un télescope a courte focale ou un capteur de caméra plus grand pour cadrer la
ou les cibles de maniére appropriée, mais cela n'est pas toujours possible. De plus, on peut
souhaiter profiter de longueurs focales plus longues pour obtenir une image de plus haute résolution.
Inévitablement, on finit par devoir créer une mosaique.

Les mosaiques consistent essentiellement a capturer des expositions de deux ou plusieurs zones
adjacentes du ciel nocturne, a prétraiter chacune de ces images et a les réunir en une seule grande
image. Un post-traitement supplémentaire est ensuite effectué sur cette image jointe. Ce tutoriel vise
a combler I'écart entre le prétraitement de chaque image individuellement et le post-traitement de
I'image jointe en décrivant, en détail, la procédure par laquelle nous utilisons PixInsight pour joindre
les images en une mosaique. Etant donné que ce tutoriel ne fait que combler cette lacune, il est
demandé a I'utilisateur de préter une attention particuliére a la liste de suppositions suivante, car il y
a deux choses a faire pour chaque image de votre mosaique avant de commencer ce tutoriel. Notez
également que ce tutoriel fonctionne aussi bien pour les images monochromes que pour les images
en couleur.

Enfin, je voudrais mentionner que ce tutoriel de David Ault pour la construction de mosaiques dans
PixInsight est une lecture fantastique et en particulier, il inclut son propre script DNALinearFit qui fait
un meilleur travail que le propre processus LinearFit de PixInsight lorsque vous avez des problemes
pour faire correspondre le fond de vos images individuelles de mosaiques. De plus, la technique
décrite ici pour supprimer les étoiles pincées est tout a son honneur.

Supposé pour ce tutoriel :

e Connaissance du fonctionnement de PixInsight, en rapport avec le traitement des images et
des processus (Lire ce qui suit, sections 3 et 4).

» Vos images ont déja été entierement prétraitées (Lire ceci).

e Les bords noirs de vos images ont tous été supprimés grace au prétraitement par
DynamicCrop et les dégradés d'arriere-plan présents ont été supprimés par
DynamicBackgroundExtraction (Lire ce qui suit, sections 2 et 3).
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1. Créer une mosaique avec StarAlignment

Nous commencons par les images que nous allons transformer en mosaique. Conformément a la
liste supposée en haut, elles ont toutes deux été entierement prétraitées. Bien qu'il ne soit pas
important a ce stade d'éliminer les bords noirs résultant du processus d'empilement, la
DynamicBackgroundExtraction fonctionne mieux lorsqu'il n'y a pas de bords noirs dans les images.
C'est pourquoi les bords noirs résultant du prétraitement ont été supprimés avec DynamicCrop, puis
tous les dégradés d'arriere-plan ont été supprimés avec DynamicBackgroundExtraction. Voici les
images. Elles sont toujours linéaires mais ont été étiréees automatiguement dans Pixlnsight a des
fins de démonstration.

Les images ci-dessus sont celles de la nébuleuse du Voile. L'image de gauche est censée aller en
dessous de l'image de droite. Il y a un chevauchement évident entre les deux, ce qui correspond au
haut de limage de gauche et au bas de l'image de droite. Le chevauchement est d'environ 15%,
selon mon plan d'imagerie sur le Sequence Generator Pro.

Vous vous demandez peut-étre pourquoi nous voulons créer une mosaique grossiere alors que nous
pourrions simplement créer une grande mosaique. Ce que nous allons faire, c'est assembler
rapidement les images en une mosaique, mais inévitablement cette mosaique peut avoir des
coutures ou les images individuelles se confondent. Nous utiliserons cette mosaique grossiere pour
préparer nos images individuelles de maniére a ce qu'un autre processus crée en fait une mosaique
sans couture. Nous avons toutefois besoin de cette mosaique brute comme référence. C'est
notamment le cas lorsque vous avez plus de deux images pour créer votre mosaique.

Commencons par ouvrir le processus StarAlignment.

Nous allons maintenant sélectionner une image de référence. Je vais utiliser ma premiere image
(celle de gauche). Il n'y a aucune raison de choisir l'une plutdét que l'autre a ce stade, puisque nous
venons de commencer. Cliquez simplement sur le bouton a cété de Image de référence en haut de
StarAlignment, sélectionnez une de vos images dans la liste et cliquez sur OK.

Pour obtenir les meilleures performances dans la construction de mosaiques, nous sélectionnons 2-
D Surface Splines sous Registration model. Nous permettons également la correction de la
Distorsion et augmentons les itérations de Distorsion a environ 100. L'augmentation des itérations de
distorsion par rapport a sa valeur par défaut de 20 permet de résoudre les cas difficiles ou la
correspondance des étoiles n'est pas adéquate, de sorte que vous n'aurez peut-étre pas du tout
besoin de modifier cette valeur. Dans Working mode, nous sélectionnons Registre/Union - Mosaic et
activons Frame adaptation.

La correction des distorsions tente de compenser les distorsions introduites en faisant correspondre
les images lorsqu'il y a une Iégere rotation entre elles (ce qui est courant). L'adaptation des images
est importante car elle tente de faire correspondre la luminosité globale des images lorsqu'elle les
fusionne, ce qui donne un arriere-plan plus régulier qui minimise les raccords.
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Nous allons maintenant ajuster certains parametres de détection des étoiles pour optimiser la
correspondance des images pour la construction de la mosaique. Pour cela, nous développons
l'onglet Star Detection. Comme les images sont encore linéaires et qu'aucune réduction de bruit n'a
été appliquée, il y aura beaucoup de bruit a petite échelle. Comme ce bruit est principalement dans la
premiere couche d'ondelettes (échelle du plus petit pixel), nous pouvons augmenter I'échelle de bruit
a 1 afin que la premiere couche d'ondelettes soit ignorée lorsqu'il s'agit de la détection d'étoiles.
Veuillez noter qu'il ne s'agit pas d'une exigence, sauf si la correspondance des étoiles pour la
construction de la mosaique pose un probléeme, alors ne vous embétez pas a la régler s'il n'y a pas
de probleme. Si vous rencontrez de tels problémes, le paramétrage de cette option pourrait vous
aider a obtenir une correspondance d'étoiles appropriée.

Nous développons maintenant l'onglet "Star Matching". Pour assouplir les parameétres de détection
d'étoiles afin que davantage d'étoiles soient détectées facilement, nous augmentons la tolérance du
RANSAC a 6,00 (bien que vous puissiez également I'augmenter a son maximum de 8,00). Si la
fusion de la mosaique échoue a cause d'un manque de détection d'étoiles, vous pouvez
certainement essayer une valeur de 8,00 ici, ainsi qu'une valeur plus élevée pour les itérations
RANSAC (disons 3000 ou 4000). Assurez-vous que l'option "Restrict to previews" est activée, car
nous indiquerons a StarAlignment a peu pres ou les images se fusionnent.

Nous pouvons maintenant donner un coup de main a StarAlignment pour savoir ou les deux images
se rejoignent. Pour cela, nous créons des boites de prévisualisation dans les deux images, englobant
plus ou moins la zone de chevauchement entre les deux. Il n‘est pas nécessaire d'étre précis a 100
%, il suffit de créer une fenétre de prévisualisation sur les deux images, comme indiqué ci-dessous.
Veuillez noter une fois de plus que cela permet de résoudre les cas difficiles de correspondance
d'étoiles. Dans la plupart des cas, vous n'aurez pas besoin de vous embéter & créer des boites de
prévisualisation car StarAlignment fera parfaitement son travail sans elles.

Nous sommes maintenant préts a appliquer le processus StarAlignment. Comme l'image de gauche
est mon image de référence, je dois appliquer le processus a limage de droite (la cible). Cela
permettra de fusionner la deuxieme image avec la premiére. Cette opération produit une nouvelle
image apres un certain traitement.

Cela semble déja pas mal, mais il y a quelques coutures visibles si nous zoomons. Quoi gu'il en soit,
il existe un autre procédé qui permet de mieux fusionner les images en une mosaique. Nous avions
juste besoin de ce résultat pour travailler avec cela.

A ce stade, si vous avez d'autres images qui vont dans votre mosaique, vous devez régler l'image de
référence dans StarAlignment sur l'image fusionnée de la mosaique actuelle (la nouvelle ci-dessus).
Vous devez ensuite appliquer a nouveau le processus StarAlignment & la troisieme image. Avant de
le faire, vous devez toutefois créer des boites de prévisualisation dans limage fusionnée de la
mosaique actuelle et dans votre troisieme image. L'application du processus fera apparaitre une
autre image fusionnée en mosaique, mais cette fois avec trois images. Cette procédure est répétée
encore et encore jusqu'a ce que toutes vos images aient été fusionnées en une seule mosaique.
Comme je n'en avais que deux au départ, j'ai terminé au point indiqué ci-dessus. Nous passons
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maintenant a I'étape suivante, qui consiste a enregistrer nos images individuelles avec la mosaique
brute que nous venons de créer, en vue de les utiliser dans un autre processus.
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2. Alighement des images de la mosaique avec StarAlignment

La mosaique brute étant préparée et ouverte dans Pixinsight (a c6té de nos images individuelles),
nous avons maintenant placé limage de la mosaique brute comme image de référence dans
StarAlignment. Nous pouvons laisser tous les parametres intacts, mais nous devons changer le
mode de travail pour Register/Union - Separate.

Ce que nous devons faire maintenant, c'est simplement appliquer le processus StarAlignment a
chacune de nos images individuelles, une par une. Chaque fois que vous le ferez, deux nouvelles
images apparaitront. Auto-étirée, I'une d'elles est en fait la méme image individuelle gqu'auparavant,
mais placée dans une image plus grande (de la méme taille que la mosaique brute), le noir
remplissant la zone qui n'est pas occupée par cette image individuelle. L'autre est comme la
mosaique grossiére - vous pouvez fermer celle-ci. Vous devez enregistrer les images individuelles
qui apparaissent avec un remplissage noir en tant que nouveaux fichiers car le prochain processus
que nous utiliserons nécessite des fichiers réels pour travailler. J'ai enregistré la mienne simplement
sous la forme 1.fit et 2.fit dans le méme dossier que le reste.

A ce stade, aprés avoir enregistré toutes nos images individuelles avec la mosaique brute, nous
pouvons fermer chaque image qui est ouverte et fermer également le processus StarAlignment. Si
Vous avez enregistré votre image brute de la mosaique sous forme de fichier, vous pouvez la
supprimer aussi bien que nous n'en avons plus besoin.

A ce stade, nous avons couvert un cas général de construction de mosaique - un cas qui
fonctionnera aussi bien pour deux segments que pour seize segments. Il s'agit de créer une
mosaique grossiere qui servira de base pour préparer vos segments individuels dans la méme taille
gue votre mosaique complete. Cependant, si votre mosaique ne comporte que deux segments, il n'y
a aucune raison de créer une mosaique grossiere. Vous pouvez simplement paramétrer
StarAlignment comme dans la section 1, mais avec le mode de travail réglé sur Register/Union -
Separate, en l'appliquant au segment qui ne sert pas de référence. Cela générera automatiquement
deux nouvelles images - les deux segments de mosaique préparés dans la méme taille que votre
mosaique compléte. Vous pouvez ensuite les enregistrer et passer a la section 4 ci-dessous. En
d'autres termes, vous sautez completement I'étape de la mosaique grossiere, car vous n'en avez pas
besoin lorsqu'il n'y a que deux segments concernés. Veuillez noter cette astuce car elle vous fera
sans doute gagner du temps et de l'effort lorsque vous travaillez avec des mosaiques a deux
segments.

3. Méthode alternative utilisant l'astrométrie et les catalogues
d'étoiles

Jusqu'a présent, nous avons suivi la méthode de préparation des différents segments de la
mosaique en vue de leur fusion avec GradientMergeMosaic, dont il est question plus loin dans la
section 4. Cette méthode a consisté a créer une mosaique grossiére afin d'enregistrer chaque
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segment de mosaique individuel séparément. Il a également été discuté que si votre mosaique ne
comporte que deux segments, vous pouvez sauter |'étape de production d'une référence de
mosaique brute et simplement enregistrer chague image de segment de mosaique I'une avec l'autre.
Dans cette section, cependant, nous présentons une méthode alternative pour préparer ses images
de segments de mosaique pour une utilisation ultérieure dans GradientMergeMosaic (décrite ci-
dessous dans la section 4). Cette méthode est recommandée par Juan Conejero de I'équipe
PixInsight, et est couverte par David Ault dans son tutoriel. Cette méthode est particulierement
recommandée pour les mosaiques constituées de plus de deux segments, car elle nous empéche
d'effectuer deux procédures d'enregistrement (une pour la mosaique brute et une autre pour les
segments individuels de la mosaique avec la mosaique brute). De ce fait, les distorsions et les
imprécisions globales introduites dans le résultat final sont minimisées grace a une manipulation
réduite.

Nous recommencgons, avec les deux images de segments de mosaique ouvertes dans PixInsight,
auto-étirées a des fins de démonstration. Elles ont été entierement prétraitées, leurs bords noirs ont
été découpés et ont été traitées avec la fonction DynamicBackgroundExtraction pour supprimer tout
dégradé de l'arriere-plan.

La méthode que nous allons utiliser consiste a créer une fausse image des étoiles autour de la
région du ciel nocturne correspondant aux images de la mosaique. Cette image peut agir comme
notre mosaique brute I'a fait précédemment, afin de permettre aux images individuelles des
segments de la mosaique d'étre enregistrées avec elle. Grace a cette méthode, elle fonctionnera de
maniere équivalente, quel que soit le nombre de segments composant votre mosaique. Ce tutoriel
couvre la méthode utilisée avec deux segments, mais elle est la méme pour tout nombre arbitraire de
segments.

Nous devons d'abord déterminer les coordonnées d'Ascension et de Déclinaison droites du centre de
la mosaique. Il n'est pas nécessaire qu'elles soient exactes, mais une bonne estimation est
essentielle pour préparer notre fausse image d'étoiles. Je remarque que dans ma mosaique
particuliere, le haut de l'image de gauche (ou le bas de l'image de droite) est le centre de la
mosaique. Cela peut vous aider a les disposer de maniere a pouvoir déterminer ou se trouve le
centre. Si votre mosaique est constituée d'un nombre impair de segments, le centre de l'une de vos
images de segments de mosaique sera effectivement le centre de la mosaique. Comme ma
mosaique se compose de deux segments, je choisis arbitrairement l'image de gauche pour
déterminer le centre de la mosaique. Je ferme donc l'image de droite, car je n'en ai pas encore
besoin.

Je voudrais effectuer une résolution astrométrique sur cette image, qui me donnera un certain
nombre de parameétres, dont I'angle de rotation de I'image, ses propres coordonnées, etc. Cela se fait
a l'aide du script ImageSolver, ouvert par le menu Script -> Analyse d'image -> ImageSolver.

La sélection de la fenétre active sous Target Image est la bonne option, car nous n‘avons que l'image
qui contient le centre de la mosaique ouverte. Si vous en avez d'autres ouvertes, vous devrez
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d'abord cliquer pour les sélectionner, puis ouvrir le script. Nous devons maintenant fournir au script
les coordonnées de ce que contient I'image sélectionnée. Dans mon cas, il s'agit de la nébuleuse du
voile oriental NGC6992. On peut parfois trouver les coordonnées de I'Ascension droite et de la
Déclinaison a travers une multitude de sources - Wikipédia, Stellarium, Cartes du Ciel, Starry Night,
etc. Le probleme est que les coordonnées saisies doivent étre contenues dans l'image pour que le
script fonctionne. Par conséquent, un objet aussi grand que la Nébuleuse du Voile peut étre génant
parce que les coordonnées du centre de la Nébuleuse du Voile ne sont pas contenues dans l'image
gue j'ai sélectionnée, par exemple. Je dois donc rechercher les coordonnées de la nébuleuse du
voile orientale NGC6992 en particulier, car elle est clairement contenue dans l'image.

Si vous avez des difficultés a trouver des informations, peut-étre parce que l'image que vous avez
sélectionnée ne contient rien d'intéressant, alors vous devriez télécharger l'image sur Astrometry.net
pour la résolution astrométrique. Veuillez noter que parfois, le téléchargement d'une seule exposition
brute plutdét que de votre image prétraitée permet une résolution plus rapide (ou une résolution
réussie lorsque votre image prétraitée ne peut pas étre résolue). Une fois limage téléchargée, la
résolution est automatique. Une fois le téléchargement terminé, la page indiquera "Success" et vous
pourrez acceder a la page des résultats. Dans la colonne de droite de la page de résultats, vous
trouverez les coordonnées du centre de votre image téléchargée. Celles-ci peuvent étre entrées
dans le script, avec Epoch (ymd) laissée par défaut car elle indique I'époque J2000 (si vous n'avez
pas obtenu vos coordonnées d'Astrometry.net, assurez-vous que les coordonnées que vous avez
sont J2000, bien sdr, sinon changez le parameétre de I'époque (ymd) en conséquence).

La case S est laissée désactivée, car elle n'est activée que lorsque les coordonnées de déclinaison
sont censées étre négatives, ce qui s'applique aux cibles de I'hémisphere sud. Il est important de
définir la bonne taille de pixel et la bonne distance focale ou résolution pour que le résolveur de
plaques puisse faire son travail. Comme l'image a été obtenue avec un capteur CCD Sony ICX694,
la taille de pixel correcte pour moi est de 4,54. Le télescope utilisé a une distance focale de 368 mm,
ce qui permet de I'entrer dans la rubriqgue Distance focale. Cependant, il y a un probléme - cette
image n'est pas dans la résolution de capture originale. Cette image a été arrosée pendant sa
procédure de prétraitement. Une distance focale de 368 mm avec le capteur CCD Sony ICX694
donne une résolution de 2.545 arcsecondes/pixel. Cependant, si je résous l'image prétraitée, les
résultats de la résolution astrométrique me disent que la résolution est en fait de 1,272 arcsecondes/
pixel. C'est la moitié de la valeur prévue. Cela s'explique par le fait que l'algorithme de Drizzle a
artificiellement augmenté la taille des pixels de I'image de deux fois, ce qui donne l'impression que la
résolution est deux fois plus élevée. Il est donc important que j'entre 1,272 dans la résolution plutot
que 2,545, et que j'évite d'entrer 368 sous la distance focale. De cette fagon, le script dispose des
informations correctes de l'image.

Le catalogue d'étoiles VizieR par défaut de PPMXL est bon pour tous les cas avec lesquels jai
essayé cette méthode. Il suffit d'augmenter la magnitude limite de 15 a 20 pour obtenir plus d'étoiles
pour la résolution de plagues. J'ai entré 15 dans mon cas.
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Le script ImageSolver est maintenant prét. Il suffit de cliquer sur OK et de regarder la console de
processus car elle affichera les informations d'état. Une fois terminé, les résultats seront également
affichés a cet endroit.

On note que la rotation relevée par la résolution astrométrique est de -88,898 degrés. Cette valeur
sera utilisée plus tard lors de la génération de notre image de fausses étoiles. En effet, la valeur
correcte de la résolution est également déterminée ici, a savoir 1,277 arcsecondes/pixel. Cette valeur
est également notée pour une utilisation ultérieure.

Comme je sais que le centre de la mosaique se trouve au sommet de cette image, il est peu utile de
connaitre les coordonnées du centre de cette image particuliere de segment de mosaique. Nous
avons besoin de connaitre, plus ou moins, les coordonnées du centre de la mosaique entiere. Le
script qui nous y aidera est le script Annotatelmage, accessible par le menu Script -> Render ->
Annotatelmage.

Sous Layers list, il suffit d'activer Grid, car cela nous montrera la grille des coordonnées d'ascension
et de déclinaison correctes superposées a notre image. Si seule la grille est activée et sélectionnée
dans Layers list, nous définissons une taille de police plus grande, soit 40. Nous augmentons
également la densité de la Grille & environ 10.

En général, le reste des parametres par défaut fonctionnent parfaitement bien, bien que vous
puissiez souhaiter modifier la couleur de la grille. Avant de cliquer sur OK, assurez-vous que le
parameétre Epoch (ymd) correspond a celui que vous avez utilisé dans le script ImageSolver. La
valeur par défaut est J2000, ce qui est correct pour moi. Cliquer sur OK dans le script annote la grille
de coordonnées sur une copie clonée de l'image.

Nous pouvons maintenant utiliser la grille pour déterminer plus ou moins ou se trouve le centre de la
mosaique, étant donné que je sais que le haut de cette image est le centre de ma mosaique. Je
détermine que c'est comme encerclé et indiqué ci-dessous.

Cela correspond plus ou moins aux coordonnées d'Ascension droite de 20h 51m 22.5s et aux
coordonnées de Déclinaison de +31° 20" 0.0". Avec une résolution de 1,277 arcsecondes/pixel et une
rotation de -88,898 degrés, nous avons tout ce gu'il faut pour produire une image de fausses étoiles
appropriée pour l'enregistrement de la mosaique. Toutes les images ouvertes sont maintenant
fermées, et le script CatalogStarGenerator est ouvert, via le menu Script -> Render ->
CatalogStarGenerator.

Ici, nous entrons les coordonnées d'Ascension et de Déclinaison droites que nous avons trouvé étre
plus ou moins le centre de toute la mosaique. Nous nous assurons également que le réglage de
I'époque (ymd) correspond a ce que nous avons utilisé jusqu'a présent (J2000 dans mon cas, j'entre
donc 2000, 1 et 1). La encore, la case S n'est activee que si vos coordonnées de déclinaison sont
négatives car il s'agit d'une cible de I'hémisphére sud.
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Dans Rotation, nous entrons l'angle déterminé précédemment par le script ImageSolver. Dans mon
cas, c'était -88,898 degrés. Dans Résolution sous Scale Image, nous entrons également ce qui a été
déterminé précédemment par le script ImageSolver. Dans mon cas, c'était 1,277 arcsecondes/pixel.
Nous devons maintenant déterminer la taille de I'image des fausses étoiles en pixels. La valeur par
défaut de 1024 x 1024 ne suffira probablement pas - certainement pas dans mon cas. Ma mosaique
se compose de deux segments et chaque image a une taille d'environ 5474 x 4380 (I'un est
légerement, 1égérement plus petit). Bien sdr, il y a un chevauchement d'environ 15% entre elles,
mais il vaut mieux en avoir plus que moins. Par conséquent, nous ignorons le chevauchement et
nous additionnons simplement toutes les dimensions de toutes nos images. Cela donne des pixels
supplémentaires, mais il vaut mieux en avoir plus que moins. J'arrondis également mon résultat final
pour qu'il soit encore plus compact. Cela me donne un total de 11000 x 9000 pixels. Encore une fois,
ces valeurs sont volontairement arrondies a la hausse. En fait, comme un de mes segments se
trouve au-dessus de l'autre, je n'ai pas besoin techniquement d'ajouter les largeurs, mais par par
paresse, Vous pouvez exagérer vos valeurs comme je l'ai fait. N'hésitez pas a étre plus calculé a ce
sujet. Gardez simplement a I'esprit que si vous choisissez une valeur un peu petite, une image de
segment de mosaique sera légérement plus grande que l'autre et cela posera des problemes plus
tard lorsque vous essaierez de les fusionner. Par conséquent, assurez-vous toujours d'avoir des
pixels supplémentaires.

Sous Stars, nous pouvons maintenant sélectionner jusqu'a deux catalogues difféerents. Celui par
defaut PPMXL fonctionnait clairement bien auparavant, nous pouvons donc le conserver. Vous
pouvez sélectionner TYCHO-2 pour le Catalog2, juste pour ajouter quelques étoiles supplémentaires
dans la fausse image d' étoiles. Réglez la magnitude maximale a ce que vous avez défini plus tot,
soit 15 a 20. Une fois que vous l'avez définie, cliquez sur le bouton OK et PixInsight téléchargera et
générera une fausse image d'étoiles en fonction de vos paramétres. La deuxiéme capture d'écran ci-
dessous montre cette image auto-étirée.

Cette image est en fait notre mosaique brute, avec laquelle nous enregistrons toutes nos images
élémentaires de la mosaique en vue d'une fusion ultérieure avec GradientMergeMosaic. Par
conséquent, nous ouvrons les maintenant toutes ainsi que le processus StarAlignment. Le processus
StarAlignment est configuré exactement comme il I'était dans la section 2 ci-dessus, avec le mode de
travail Register/Union - Separate. L'image de référence est maintenant paramétrée sur l'image
CatalogStars générée. Ce que nous n'activons pas, cependant, c'est Frame adaptation. C'est un
excellent réglage a conserver, mais il dépend du fait que l'image de référence soit I'une des images
de la mosaique. Comme notre image de référence est cette fois-ci la fausse image d'étoiles, nous ne
voulons pas y adapter les images de la mosaique.

I ne nous reste plus qu'a appliquer le processus StarAlignment a chacune de nos images de
segments de mosaique, une par une. Sur chaque application, deux images apparaitront. L'une sera
a nouveau votre image CatalogStars, que vous pouvez fermer (ne fermez cependant pas l'image
CatalogStars originale car vous pourriez en avoir besoin pour d'autres images de segments de
mosaique), et l'autre est votre image de segment de mosaique enregistrée. Celle-ci est montrée ci-
dessous, autostretched.
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Il est enregistré correctement, et il se trouve dans un cadre surdimensionnée avec un remplissage
noir. Il est clair que, comme prévu, la taille de 11000 x 9000 pour l'image de CatalogStars était une
exagération. J'aurais pu faire avec moins de largeur car je n'avais pas besoin de sommer les largeurs
de mes images. Néanmoins, cela a parfaitement fonctionné. Ci-dessous, vous trouverez les deux
images de mes segments de mosaique enregistrées.

A ce stade, une fois que toutes vos images de la mosaique sont enregistrées et qu'elles se trouvent
toutes entourées noir, il apparait que votre image CatalogStars était suffisamment grande. Vous
pouvez alors fermer vos images de mosaique originales ainsi que CatalogStars image (sans la
sauvegarder). Vous devez ensuite enregistrer toutes vos images de mosaique enregistrées sous
forme de fichiers d'images individuelles, pour les fusionner avec GradientMergeMosaic, dont il est
guestion dans la section suivante.

Un probléme que vous pourriez rencontrer avec cette méthode d'enregistrement de vos images
individuelles de segments de mosaique est que vous n'avez pas pu utiliser l'adaptation de cadre
dans StarAlignment. Par conséquent, la luminosité globale de chaque image peut ne pas étre bien
adaptée, méme si vous les fusionnez avec GradientMergeMosaic. Malheureusement, le processus
LinearFit ne fonctionnera pas avec ces images de segments de mosaique enregistrées. C'est la que
les efforts de David Ault s'avérent utiles. Dans le tutoriel de David Ault, faites défiler vers le bas
jusqu'a la section Intensity Matching et téléchargez son script, appelé DNALinearFit. Vous devrez
ajouter ce script a votre liste de scripts PixInsight, qui apparaitra alors sous le menu Script ->
Utilities -> dnaLinearFit. 1l est extrémement simple a utiliser. Il suffit de sélectionner une de vos
images de segments de mosaique comme vue de référence et de définir la vue cible pour chacune
de vos autres images de segments de mosaique, une par une (avec le réglage par défaut de
Moyenne / Médiane sous la méthode LinearFit).

Vous remarquerez que les images des segments de la mosaique changent de luminosité une fois
gue le script leur est appliqgué. Vous devrez réappliquer I'autostretch pour les voir correctement. Ce
script aura fait le travail d'adaptation des images, malgré votre incapacité a l'utiliser plus tét avec
StarAlignment. En fait, j'ai parfois trouvé gu'il faisait un meilleur travail, donc il vaut la peine de
l'utiliser. Une fois que vous avez terminé, enregistrez les images des segments de mosaique que
Vous avez enregistrées pour que ces changements soient sauvegardés. N'oubliez pas que vous
devez enregistrer tous ces éléments sous forme de fichiers d'images individuels pour les utiliser avec
GradientMergeMosaic dans la section suivante.

4. Créer une Mosaique sans raccords avec GradientMergeMosaic

Nous en arrivons maintenant a la derniére étape - la création d'une mosaique sans faille. Cela se fait
grace au processus GradientMergeMosaic, que nous ouvrons maintenant.

Il nous suffit de cliquer sur le bouton "Ajouter des fichiers" et d'ajouter toutes nos images individuelles

(que nous avons sauvegardées dans la sectilon précétljente) a la liste. J'ai appelé la mienne 1.fit et
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2 fit. Il se peut que vous ayez d'autres images. N'oubliez pas que ces images sont celles enregistrées
avec la mosaique brute (ou l'image des fausses étoiles) qui sont remplies de noir.

L'ordre de cette liste a en fait de l'importance et plus vous avez d'images dans votre mosaique, plus
I'ordre de la liste a de limportance. Il n'a d'importance qu'en termes de distorsions introduites par leur
fusion dans une mosaique. Si vous avez des étoiles brillantes sur les bords ou les images
fusionnent, elles pourraient apparaitre déformées. De plus, vous pouvez obtenir de meilleurs
résultats en superposant la deuxiéme image sur la premiere, plutét que l'inverse, par exemple. Il est
utile de savoir quel numéro d'image correspond a quel segment de votre mosaique, de sorte que si
vous identifiez des distorsions, vous pouvez inverser l'ordre d'au moins deux images de cette liste.
Pour ce faire, il suffit d'en sélectionner une et de cliquer sur les boutons "Monter" ou "Descendre".
Les images sont superposées de haut en bas, donc dans mon cas ci-dessus, ma deuxieme image
(2.fit) se superpose a la premiere image (1.fit) a I'endroit ou elles se croisent.

Pour procéder a la fusion, sélectionnez Superposition sous Type de combinaison. Nous devrions
tester et voir a quoi ressemble notre image en mosaique avec les parametres par défaut. Nous
discuterons un peu plus loin du Shrink radius et Feather radius. Pour lancer le processus, il suffit de
cliquer sur le bouton Appliquer global.

Le résultat ci-dessus semble tres bon et assez homogéne. Si vous constatez que vous voyez encore
des raccords dans vos images, vous pouvez essayer d'augmenter Feather raduis au-dessus de 10.
Cependant, si GradientMergeMosaic ne parvient pas a produire I'image de la mosaique en raison de
problemes de repérage, vous pouvez réduire le Feather radius (ou le reculer par rapport a I'endroit
ou vous l'avez placé). Une valeur de 20 pour le Feather radius peut étre plus efficace pour vous,
selon les résultats obtenus avec les parametres par défaut.

Parfois, la fusion en mosaique peut aussi déformer les étoiles aux bords, surtout si elles sont
brillantes. Par exemple, avec les parametres par défaut, j'ai une étoile déformée dans mon image de
mosaique.

On peut éviter cela en augmentant un peu le Shrink radius. Par exemple, si jaugmente le Shrink
radius a 10, j'obtiens le résultat suivant sur cette étoile :

Cela a clairement supprimé la question de I'étoile déformée. L'augmentation du Feather radius
permet également d'obtenir de meilleures raccords entre les images.

Gardez a l'esprit que des conditions d'imagerie différentes ainsi qu'un nombre différent d'images
empilées peuvent produire une légere difféerence de fond entre les images d'une mosaique et
peuvent donner l'impression qu'il y a un Iéger changement d'un segment a l'autre. Cela est inévitable
dans une certaine mesure, mais peut étre traité en post-traitement, car on augmente le contraste et
on applique la réduction du bruit principalement a I'arriere-plan (sur toute I'image de la mosaique).

A ce stade, vous pouvez trés bien étre satisfait de votre image mosaique, mais que se passe-t-il Si
'augmentation du rayon de rétrécissement n'élimine pas une étoile pincée particulierement
persistante ? Cela peut étre traité avec PixelMath. Le probleme réside essentiellement dans le fait

que les deux images ont cette étoile brillante E)rés du b?rd ou les images se rejoignent. Il est possible
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de résoudre ce probleme en inversant l'ordre des images dans GradientMergeMosaic, mais cela peut
aggraver la situation en introduisant plus d'étoiles pincées ! Vous pouvez également résoudre le
probleme en supprimant I'étoile qui pose probléme dans I'une des images (généralement celle qui se
trouve au-dessus sur le recouvrement - dans mon cas, la deuxieme image, correspondant au
segment supérieur et appelée 2.fit).

Pour ce faire, nous ouvrons l'image que nous voulons modifier et nous I'étiquetons automatiquement
afin de pouvoir voir ce avec quoi nous travaillons. Ci-dessous, j'ai choisi d'ouvrir ma premiére image,
le segment inférieur, appelé 1.fit. Une meilleure idée serait de modifier I'image du haut, au cas ou
vous en feriez trop, I'image du bas compensant les pixels perdus.

Vous devrez croiser votre image de la mosaique avec l'image que vous souhaitez modifier pour
identifier I'étoile problématique a supprimer. J'ai identifié la mienne ci-dessous :

Ouvrez le processus PixelMath et copiez-collez la ligne suivante dans la zone de texte RGB/K :
if(x()>x_low && x()<x_high && y()>y_low && y()<y_high, 0, $T)

Nous devrons d'abord identifier les limites des coordonnées de cette étoile, que nous remplagons par
x_low, x_high, y_low et y_high dans ce qui précede. Pour cela, il suffit de cliquer sur I'image et de
maintenir le bouton gauche de la souris enfoncé pour faire apparaitre I'apercu du mode de lecture.
Faites glisser Iégerement le pointeur de votre souris vers le coin supérieur gauche de I'étoile, comme
indiqué. Les coordonnées x ety sont indiquées ici.

Les coordonnées x et y indiquées sont vos valeurs x_low et y_low. Par conséquent, dans la zone de
texte "Symbols" de PixelMath, je saisis ce qui suit :

x_low=2812, y low=4400

Ci-dessus, j'ai volontairement arrondi les valeurs vers le bas. Maintenant, placez le pointeur de votre
souris légéerement en bas a droite de I'étoile, comme indiqué. Les nouvelles coordonnées x et y
seront affichées ici.

Compte tenu de mes coordonnées x et y particulieres, j'étends le contenu de Symbols in PixelMath a
ce qui suit :

x_low=2812, y low=4400, x_high=2832, y_high=4422

Aprés avoir appliqué cette expression PixelMath a mon image, je vois ci-dessous ou se trouvait mon
étoile problématique :

Une fois que vous avez supprimé les étoiles problématiques d'une de vos images, enregistrez les
modifications (ou sauvegardez-les en tant que nouvelles images, au cas ou !). Vous pouvez ensuite
revenir a GradientMergeMosaic et répéter ce qui précéde. Par exemple, voici mon image de
mosaique avec le rayon de rétrécissement laissé par défaut a 1, zoomée sur I'étoile qui posait
probleme auparavant :
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Si vous obtenez des lignes noires autour de votre étoile précédemment problématique, cela signifie
gue vous avez supprimé trop de pixels autour de I'étoile problématique. Soit vous revenez en arriére
et supprimez quelques pixels de moins, soit vous vous assurez de supprimer I'étoile de I'image qui
est superposée (dans mon cas, ma deuxieme image, 2.fit).

L'image de la mosaique ayant été générée de maniére transparente et sans étoile problématique,
nous recadrons maintenant les bords noirs créés lors du processus de construction de la mosaique.
Pour cela, nous utilisons le procédé DynamicCrop. Il suffit d'ouvrir le processus et de cliquer sur son
bouton Reset pour l'initialiser.

Il suffit maintenant de faire glisser les quatre cotés de la zone surlignée vers l'intérieur pour exclure
complétement les bords noirs. Vous pouvez effectuer un zoom arriere d'un pas afin de voir
clairement les limites. Une fois que vous avez sélectionné un recadrage grossier, faites un zoom
avant et vérifiez soigneusement chaque c6té pour vous assurer que vous ne recadrez pas trop (ou
pas assez et que vous ne laissez pas de bord noir !). Une fois que vous étes satisfait, cliquez sur le
bouton Exécuter et fermez le processus DynamicCrop. Ci-dessous, je vous montre mon image de
mosaique apres le recadrage et apres une rotation rapide de 90° dans le sens des aiguilles d'une
montre a l'aide de FastRotation.

Veuillez noter que l'image de la mosaique ci-dessus est toujours linéaire. Rien ne lui a été fait,
officiellement. Elle nécessite encore le régime habituel de réduction du bruit, d'étirement non linéaire,
d'amélioration du contraste, etc. L'idée est de prétraiter toutes les images individuelles des segments
de la mosaique, d'éliminer les bords noirs du prétraitement, de supprimer les dégradés de l'arriere-
plan et d'en faire une mosaique. Une fois la mosaique créée, vous pouvez poursuivre le post-
traitement comme vous le feriez habituellement avec une seule image.

Gardez a l'esprit que si vous obtenez une image monochrome et que vous avez donc plusieurs
segments de mosaique capturés par plusieurs filtres, vous devrez d'abord répéter le processus ci-
dessus pour chaque image de filtre. Une fois que vous avez terminé, vous pouvez utiliser le
processus StarAlignment pour les enregistrer tous ensemble avec l'un d'entre eux comme référence.
Vous pouvez ensuite utiliser le processus LinearFit pour faire correspondre la luminosité de chaque
image filtrée, puis vous pouvez combiner les couleurs et effectuer votre post-traitement habituel.
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XVIl.  Combinaisons de palettes bicolores a bande étroite

L'imagerie a bande étroite présente plusieurs avantages par rapport a lI'imagerie LRGB ou One Shot
Colour. Premiérement, les filtres a bande étroite sélectionnent une partie trés distincte du spectre, qui
correspond a une fréquence particuliere. Cela permet aux astrophotographes d'obtenir des images a
travers une forte pollution lumineuse (sauf la pollution lumineuse des LED blanches a large spectre).
Deuxiemement, les étoiles apparaissent nettement moins étalées et la nébulosité apparait richement
détaillée. Ces images a bande étroite peuvent étre utilisées pour améliorer les images LRGB ou One
Shot Colour, ou pour produire des images a part entiére.

Comme la plus grande partie de l'univers visible est constituée d'hydrogéne, la raie d'émission de I'H-
Alpha est particulierement importante. Les astrophotographes qui produisent des images
monochromes a bande étroite choisissent toujours H-Alpha. Cependant, la plupart de ceux qui
produisent des images a bande étroite ont tendance a capturer des images a travers plusieurs filtres
a bande étroite. Il s'agit notamment des filtres H-Alpha, Hydrogéne-Béta, Azote-l1l, Soufre-Il et
Oxygene-lll. Les plus populaires sont I'nydrogene alpha, le soufre Il et 'oxygéne lll, car ils peuvent
étre utilisés pour produire des images en couleur des images produites par le télescope spatial
Hubble, en utilisant la populaire palette Hubble. Ce tutoriel est toutefois destiné a ceux qui souhaitent
produire des images en couleur de la palette bicolore - des images en couleur n‘impliquant que deux
filtres & bande étroite. Ces filtres sont normalement choisis comme H-Alpha et Oxygene-Ill, mais le
tutoriel peut étre utilisé pour toute combinaison de deux filtres. En outre, la section 4 peut étre utilisée
pour produire des images en couleur a partir d'un nombre quelconque de filtres a bande étroite, car
nous  mélangeons  différents  filtres  pour  différents  canaux de  couleur.

Pré-supposé pour ce tutoriel :

e Connaissance du fonctionnement de PixInsight, en rapport avec le traitement des images et
des processus (Lire ce qui suit, sections 3 et 4).

e Vos images ont déja été entierement prétraitées (Lire ceci).

e Vos images ont toutes été enregistrées les unes par rapport aux autres, les bords noirs
résultant du prétraitement ont été supprimés a l'aide de DynamicCrop et tout dégradé
d'arriere-plan présent a été supprimé a l'aide de DynamicBackgroundExtraction (Lire ce qui
suit, sections 1, 2 et 3).
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1. Préparations Initiales pour des images Narrowband

Il est typique pour les astrophotographes de vouloir combiner les couleurs des images pendant leur
état linéaire, car c'est une pratique courante pour les images LRGB. Cependant, les grandes
différences de luminosité entre les images capturées par les différents filtres de lignes d'émission
rendent difficile le mélange des images linéaires dans les différentes palettes de couleurs. En
général, les images apparaissent lavées dans les nuances de n'importe quel canal de couleur qui est
principalement occupé par I'H-Alpha. Pour que les différentes images filtrées aient une contribution
plus ou moins égale au mélange final des couleurs, on peut étirer ces images pour qu'elles soient
non linéaires avant de les mélanger.

Bien que vos images puissent étre différentes, il est courant d'appliquer une certaine réduction de
bruit aux images a I'état linéaire. Le choix de le faire ou non, ou de le faire de maniere agressive,
dépend du niveau de bruit de vos images. Veuillez noter que cette question dépasse le cadre de ce
tutoriel et est amplement couverte par un autre tutoriel spécialement écrit sur le sujet de la réduction
du bruit. La routine de réduction du bruit que j'ai choisie pour les images que nous sommes sur le
point de post-traiter est la MultiscaleLinearTransform (comme décrit dans le tutoriel sur la réduction
du bruit) avec des copies clonées étirées des images elles-mémes agissant comme des masques.

Les deux images autotractées ci-dessus correspondent a H-Alpha (a gauche) et Oxygene-lll (a
droite). Elles ont été entierement prétraitées, ont été enregistrées l'une avec l'autre, ont vu leurs
gradients d'arriere-plan supprimés avec DynamicBackgroundExtraction et ont été réduites en bruit
avec MultiscaleLinearTransform. Comme indiqué précédemment, pour tirer le meilleur parti de la
combinaison des couleurs de ces images, il est préférable qu'elles soient étirées de maniere non
linéaire. Comme ce sujet fait I'objet d'un autre tutoriel, la procédure d'étirement des images en non-
linéaire ne sera pas abordée en détail. J'utilise généralement soit HistogramTransformation, soit
MaskedStretch, soit une combinaison des deux (d'abord MaskedStretch, puis
HistogramTransformation pour ajuster).

Un avantage de I'utilisation de MaskedStretch par rapport a HistogramTransformation est qu'il permet
de faire correspondre plus précisément la luminosité du fond des deux images a bande étroite. En
effet, MaskedStretch permet a l'utilisateur de définir une luminosité de fond spécifique et de
I'appliquer aux deux images a bande étroite. Cependant, en raison des émissions plus faibles dans
Oxygene-lll, la nébulosité globale sera plus brillante dans I'image H-Alpha. On peut alors exagérer la
luminosité de la nébulosité de limage Oxygéne-lll en ['étirant davantage, peut-étre avec
HistogramTransformation ou méme CurvesTransformation en mode RGB/K.

Le tableau ci-dessous montre le résultat de I'étirement des deux images en mode non linéaire a l'aide
de MaskedStretch avec un arriere-plan cible défini par défaut a 0,12500000, des itérations définies
par défaut a 100, une fraction d'écrétage définie a 0,00000000 et une référence d'arrieére-plan
sélectionnée se référant a une petite boite de prévisualisation sur un simple arriére-plan (pas de
nébulosité), sur chaque image.
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Ayant utilisé les mémes parameétres dans MaskedStretch (outre I'image de référence de l'arriere-plan
qui se réfere a la boite de prévisualisation de l'arriere-plan de chaque image), l'arriere-plan a été
relevé a la méme luminosité dans les deux images. Le probleme est que, naturellement, la nébulosité
de limage Oxygen-lll est également moins lumineuse que celle de I'image Hydrogen-Alpha, ce qui
signifie qu'elle contribue moins a la combinaison de couleurs. Nous pouvons augmenter la luminosité
globale de la nébulosité de I'image Oxygen-lll grace a HistogramTransformation en appliquant un
étirement ainsi qu'un ajustement du point noir, comme indiqué ci-dessous.

En effet, on peut passer de I'histogramme H-Alpha a I'histogramme Oxygene-lll, afin de voir
comment I'histogramme Oxygéne-Ill étiré correspondra a I'histogramme H-Alpha actuel. L'ouverture
de la fenétre de prévisualisation en temps réel de limage Oxygéne-lll a c6té de lI'image H-Alpha
permet également a l'utilisateur d'évaluer visuellement la luminosité entre les deux, tant pour leur
fond que pour leur nébulosité. A ce stade, il est également utile d'avoir une idée de la couleur que
vous souhaitez que vos images individuelles a bande étroite contribuent a l'image combinée. Apres
tout, si vous souhaitez que l'image Oxygene-lll représente le bleu, vous préférerez que l'image
Oxygene-lll soit un peu plus lumineuse que I'image H-Alpha (car I'image H-Alpha est généralement
trop puissante). Le processus de statistiques peut étre utilisé pour comparer les images en
comparant leurs valeurs moyennes et médianes en pixels en mode 16 bits [0,65535].

Quelques ajustements mineurs supplémentaires des images peuvent étre effectués en utilisant
CurvesTransformation en mode RGB/K. La production d'une Iégere courbe en S en créant un point
au quart du graphique et en le faisant glisser un peu vers le bas, et la création d'un point aux trois

quarts du graphique et en le faisant glisser un peu vers le haut, donne lieu a un contraste
supplémentaire dans les zones claires et a une luminosité réduite de l'arriére-plan.

La encore, l'utilisateur peut comparer visuellement I'apercu en temps réel avec l'autre image au fur et
a mesure des ajustements. Le processus Statistics peut également étre utilisé pour comparer les
images apres l'application des ajustements. Quoi qu'il en soit, nous obtenons ce que nous voulions -
des images non linéaires étirées a bande étroite dans H-Alpha et Oxygene-Ill qui seront désormais
utilisées pour produire un certain nombre de combinaisons différentes de palettes bicolores.

Bien que ce ne soit pas strictement le sujet de ce tutoriel, on pourrait faire cet étirement comparatif
des images a bande étroite pour plus de deux images a bande étroite. Il peut s'agir de trois images a
bande étroite différentes, voire plus.

Afin de combiner les couleurs de nos images a bande étroite, nous utiliserons le procédé PixelMath,
qui permet toutes sortes de réglages fins des combinaisons. Cette section se termine par la mise en
place de PixelMath pour les différentes facons de combiner les couleurs des deux images a bande
étroite. Nous ouvrons le processus et désactivons Utiliser une seule expression RGB/K, nous
sélectionnons Créer une nouvelle image et nous sélectionnons la couleur RGB sous Espace couleur.
Cela nous permettra d'entrer des combinaisons d'images séparées pour les canaux Rouge, Vert et
Bleu, et créera une nouvelle image couleur lorsque le processus sera appliqué.
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2. Combinaison de style LRGB

Une bonne fagcon de combiner les données H-Alpha et Oxygene-lll est de simuler I'aspect d'une
image LRGB. Cela permet d'exploiter le fait que la raie d'émission H-Alpha se trouve dans la partie
rouge profonde du spectre et que la raie d'émission Oxygeéne-Illl se trouve entre les parties verte et
bleue du spectre. Par conséquent, I'image H-Alpha (appelée HA) est assignée au canal Rouge et
I'image Oxygene-Ill (appelée Olll) est assignée aux canaux Vert et Bleu, en tant que tels :

R/K: HA
G: Olll
B: Olll

Nous cliquons maintenant sur Appliquer sur PixelMath et la nouvelle image couleur est créée :

Pour avoir une bonne idée de l'aspect réel de l'image, nous devons neutraliser l'arriére-plan. Pour
cela, nous créons une petite boite de prévisualisation autour d'une zone qui ne contient que l'arriére-
plan - pas de nébulosité ni d'étoiles. Nous ouvrons ensuite le processus BackgroundNeutralization et
sélectionnons la boite de prévisualisation dans la liste sous Image de référence. Comme l'image
couleur est non linéaire, nous devons également augmenter le paramétre de limite supérieure. En
général, 0,2000000 fonctionne bien, mais ce parameétre doit étre réglé juste au-dessus de la valeur
maximale du pixel d'arriere-plan. Vous pouvez simplement utiliser le processus Statistiques pour
déterminer ce Maximum dans la boite de prévisualisation de l'arriére-plan, ou simplement utiliser
I'Apercu de lecture en faisant passer le montage autour de la boite de prévisualisation de l'arriere-
plan et en échantillonnant les pixels a l'intérieur. Une fois cette valeur déterminée, appliquez le
processus BackgroundNeutralization a lI'image couleur.

Vous pouvez supprimer la boite de prévisualisation de l'arriére-plan par le menu Preview -> Delete
All aprés avoir appligué BackgroundNeutralization. Comme on peut s'y attendre, l'intensité des
couleurs spécifiques visibles dépend de la luminosité globale de vos images a bande étroite avant la
combinaison des couleurs.

3. Combinaison verte synthétique

En lI'absence d'une troisieme image a bande étroite, on peut également effectuer une combinaison
de couleurs qui suit la célébre combinaison de vert synthétique de Steve Cannistra. Cela est trés
facile a réaliser dans PixInsight en utilisant le procédé PixelMath en multipliant simplement les
images H-Alpha (appelé HA) et Oxygene-Ill (appelé Olll) ensemble pour le canal vert. L'idéal est de
multiplier cette valeur par une constante telle que 1,5 afin d'étendre sa gamme dynamique, puisque
I'image verte synthétique, par défaut, est assez sombre. Le canal rouge est occupé uniqguement par
I'image H-Alpha et le canal bleu est occupé uniquement par I'image Oxygéne-Ill.

R/K: HA
G: (HA*OIIN*1.5
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B: Olll
Nous cliquons maintenant sur Apply sur PixelMath et la nouvelle image couleur est créée :

Pour avoir une bonne idée de l'aspect réel de l'image, nous devons neutraliser l'arriere-plan. Pour
cela, nous créons une petite boite de prévisualisation autour d'une zone qui ne contient que l'arriere-
plan - pas de nébulosité ni d'étoiles. Nous ouvrons ensuite le processus BackgroundNeutralization et
sélectionnons la boite de prévisualisation dans la liste sous Reference Image. Comme limage
couleur est non linéaire, nous devons également augmenter le parametre de limite supérieure. En
général, 0,2000000 fonctionne bien, mais ce parametre doit étre réglé juste au-dessus de la valeur
maximale du pixel d'arriere-plan. Vous pouvez simplement utiliser le processus Statistics pour
déterminer ce Maximum dans la boite de prévisualisation de l'arriere-plan, ou simplement utiliser
I'Apercu de lecture en faisant passer le montage autour de la boite de prévisualisation de l'arriere-
plan et en échantillonnant les pixels a l'intérieur. Une fois cette valeur déterminée, appliquez le
processus BackgroundNeutralization a I'image couleur.

Vous pouvez supprimer la boite de prévisualisation de l'arriere-plan par le menu Preview -> Delete
All aprés avoir appliqué BackgroundNeutralization. Comme on peut s'y attendre, l'intensité des
couleurs spécifiques visibles dépend de la luminosité globale de vos images a bande étroite avant la
combinaison des couleurs.

4. Combinaison de canaux mixtes

Si nous jetons toutes les idées de longueur d'onde des lignes d'émission et de nombre d'images
utilisées pour produire une image de couleur rouge, verte, bleue, nous pouvons vraiment étre
créatifs. Dans un mode de canaux mixtes, nous ajoutons simplement des pourcentages d'images
différentes pour les combiner dans un seul canal. Par exemple, ce qui suit montre l'effet de
I'affectation d'H-Alpha (appelé HA) au canal Rouge et de l'affectation d'Oxygene-IlIl (appelé OIll) au
canal Bleu, le canal Vert prenant un mélange de 40% d'H-Alpha avec 60% d'Oxygene-lll.

R/K: HA
G: (0.4*HA)+(0.6*Olll)
B: Olll

Nous cliqguons maintenant sur Appliquer sur PixelMath et la nouvelle image couleur est créée :

Pour avoir une bonne idée de l'aspect réel de l'image, nous devons neutraliser l'arriére-plan. Pour
cela, nous créons une petite boite de prévisualisation autour d'une zone qui ne contient que l'arriére-
plan - pas de nébulosité ni d'étoiles. Nous ouvrons ensuite le processus BackgroundNeutralization et
sélectionnons la boite de prévisualisation dans la liste sous Image de référence. Comme l'image
couleur est non linéaire, nous devons également augmenter le paramétre de limite supérieure. En
général, 0,2000000 fonctionne bien, mais ce parameétre doit étre réglé juste au-dessus de la valeur
maximale du pixel d'arriere-plan. Vous pouvez simplement utiliser le processus Statistiques pour

déterminer ce Maximum dans la boite de prévisualisation de l'arriére-plan, ou simplement utiliser
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I'Apercu de lecture en faisant passer le montage autour de la boite de prévisualisation de l'arriere-
plan et en échantillonnant les pixels a l'intérieur. Une fois cette valeur déterminée, appliquez le
processus BackgroundNeutralization a I'image couleur.

Vous pouvez supprimer la boite de prévisualisation de l'arriére-plan par le menu Preview -> Delete
All apres avoir appligué BackgroundNeutralization. Comme on peut s'y attendre, lintensité des
couleurs spécifiques visibles dépend de la luminosité globale de vos images a bande étroite avant la
combinaison des couleurs.

Le fait que ce qui vous sépare d'une image en couleur consiste simplement a modifier quelques
chiffres, ou a ajouter d'autres images ensemble, signifie que vous pouvez vraiment faire preuve de
créativité par I'expérimentation. Vous pouvez essayer de renforcer I'hydrogéne alpha et de réduire
I'oxygéne Ill, ou vice versa. Laissons la palette bicolore, si vous avez des données sur le soufre I,
vous pouvez l'ajouter a I'hydrogéne alpha dans le canal rouge. Si vous avez une quatrieme image a
bande étroite (par exemple, Hydrogene-Béta ou Azote-Il), vous pouvez également l'ajouter dans un
canal de couleur spécifique. Vous trouverez ci-dessous un exemple de mélange de canaux de
couleur avec trois filtres (Soufre-Il, H-Alpha et Oxygene-Ill) :

R/K: (0.5*SI1)+(0.5*HA)
G: (0.2*HA)+(0.8*Olll)
B: Olll

Une chose a retenir est que le total de I'addition ne doit pas dépasser 100 %, sinon vous obtiendrez
des données de type "white-clipping" (sursaturation de zones tres lumineuses). Par exemple, si vous
ajoutez H-Alpha a Oxygéne-lll pour le canal vert, comme indiqué ci-dessus, 40 % et 60 %
fonctionnent bien mais évitez les 40 % et 80 % car le total serait de 120 %. L'équivalent de 40% et
80% est de 34% et 66% car le rapport 1:2 est a peu prés maintenu, tout en gardant le total a 100%.

5. Notes sur la couleur

Gardez toujours a l'esprit, lorsque vous produisez des images en couleur a partir de données a
bande étroite pures, qu'il n'y a pas de regles a respecter. L'image couleur que vous produisez est
votre propre représentation artistique et scientifique des fréquences captées. C'est pourquoi on peut
ressentir une liberté totale lorsqu'on expérimente différentes combinaisons de pourcentage de
différentes données a bande étroite dans des canaux de couleur, ou la fagcon dont différentes
données a bande étroite sont effectivement combinées entre elles (comme en utilisant la méthode du
vert synthétique).

Une autre chose a garder a I'esprit est que l'idée de calibrage des couleurs avec des images en
bande étroite pure est dénuée de sens. Nous appliquons le processus de neutralisation de l'arriere-
plan parce que nous souhaitons que le fond ait un ton neutre, comme dans tout type d'image, mais le
processus de calibrage des couleurs, par exemple, n'est utilisé a aucun moment. La base en est tout
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simplement comme ci-dessus - les images a bande étroite pures sont par nature des images en
fausses couleurs.

N'oubliez pas que le degré d'étirement de vos images individuelles a bande étroite en non-linéaire
définit la contribution que ces données apporteront a l'image combinée (qui dépend également des
valeurs de combinaison en pourcentage, le cas échéant). Si votre image Oxygen-Ill est extrémement
lumineuse et qu'elle remplit le canal bleu, vous pouvez vous attendre a ce que l'image ait un ton bleu
vif, dans les zones ou les données Oxygen-lll dominantes sont présentes. Par conséquent,
I'étirement non linéaire des images par rapport aux autres images est modifié en tandem avec les
expressions PixelMath pour la combinaison des couleurs afin de produire un résultat désirable. Aprés
la combinaison des couleurs, il est possible de modifier la palette de couleurs et la saturation d'une
image, mais la retouche des couleurs dans les images fait I'objet d'un autre tutoriel.

Enfin, veuillez noter qu'une fois que les images a bande étroite ont été combinées en couleurs et
produisent un résultat désirable, que vous choisissiez ou non de modifier la palette de couleurs et/ou
la saturation par la suite, un post-traitement supplémentaire peut étre nécessaire pour finaliser
I'image. Par exemple, vous pouvez souhaiter étirer davantage l'image en couleurs en utilisant des
transformations de type histogramme ou courbes. D'autres techniques d'amélioration du contraste
peuvent également étre utilisées pour faire ressortir et accentuer les détails fins. Ces techniques font
toutes I'objet d'autres tutoriels.
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XVIIl. Palette Hubble Narrowband

L'imagerie a bande étroite présente plusieurs avantages par rapport a lI'imagerie LRGB ou One Shot
Colour. Premiérement, les filtres a bande étroite sélectionnent une partie trés distincte du spectre, qui
correspond a une fréquence particuliere. Cela permet aux astrophotographes d'obtenir des images a
travers une forte pollution lumineuse (sauf la pollution lumineuse des LED blanches a large spectre).
Deuxiemement, les étoiles apparaissent nettement moins étzlées et la nébulosité apparait richement
détaillée. Ces images a bande étroite peuvent étre utilisées pour améliorer les images LRGB ou One
Shot Colour, ou pour produire des images a part entiére.

Comme la plus grande partie de l'univers visible est constituée d'hydrogéne, la raie d'émission de I'H-
Alpha est particulierement importante. Les astrophotographes qui produisent des images
monochromes a bande étroite choisissent toujours H-Alpha en conséquence. Cependant, la plupart
de ceux qui produisent des images a bande étroite ont tendance a capturer des images a travers
plusieurs filtres & bande étroite. Il s'agit notamment des filtres H-Alpha, Hydrogéne-Béta, Azote-ll,
Soufre-1l et Oxygene-lll. Les plus populaires sont I'nydrogéne alpha, le soufre Il et I'oxygéne lll, car
ils peuvent étre utilisés pour produire des images en couleur des images produites par le télescope
spatial Hubble, en utilisant la populaire palette Hubble. Ce tutoriel est précisément consacré a cette
palette et a la variété de couleurs que I'on peut réellement obtenir en utilisant cette palette. Comme
pour toutes les images couleur a bande étroite, les astrophotographes exercent une licence artistique
lorsqu'il s'agit de la représentation finale des couleurs dans leurs images. Ce tutoriel explore divers
choix populaires au sein de la palette Hubble. Veuillez noter qu'en raison de fortes similitudes avec
l'autre tutoriel sur les bandes étroites, la premiére section de ce tutoriel contient du texte qui a été
copié.

Pré-supposé pour ce tutoriel :

e Connaissance du fonctionnement de PixInsight, en rapport avec le traitement des images et
des processus (Lire ce qui suit, sections 3 et 4).

* Vos images ont déja été entierement prétraitées (Lire ceci).

e Vos images ont toutes été enregistrées les unes par rapport aux autres, les bords noirs
résultant du prétraitement ont été supprimés a l'aide de DynamicCrop et tout dégradé
d'arriere-plan présent a été supprimé a l'aide de DynamicBackgroundExtraction (Lire ce qui
suit, sections 1, 2 et 3).
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1. Préparation Initiale pour les images Narrowband

Il est typique pour les astrophotographes de vouloir combiner les couleurs des images pendant leur
état linéaire, car c'est une pratique courante pour les images LRGB. Cependant, les grandes
différences de luminosité entre les images capturées par les différents filtres de lignes d'émission
rendent difficile le mélange des images linéaires dans les différentes palettes de couleurs. En
géneéral, les images apparaissent délavées dans les nuances de n'importe quel canal de couleur qui
est principalement occupé par I'H-Alpha. Pour que les différentes images filtrées aient une
contribution plus ou moins égale au mélange final des couleurs, on peut étirer ces images pour
gu'elles soient non linéaires avant de les mélanger.

Bien que vos images puissent étre différentes, il est courant d'appliquer une certaine réduction de
bruit aux images a I'état linéaire. Le choix de le faire ou non, ou de le faire de maniére agressive,
dépend du niveau de bruit de vos images. Veuillez noter que cette question dépasse le cadre de ce
tutoriel et est amplement couverte par un autre tutoriel spécialement écrit sur le sujet de la réduction
du bruit. La routine de réduction du bruit que j'ai choisie pour les images que nous sommes sur le
point de post-traiter est MultiscaleLinearTransform (comme décrit dans le tutoriel sur la réduction du
bruit) avec des copies clonées étirées des images elles-mémes agissant comme des masques.

Les trois images auto-étirées ci-dessus correspondent a H-Alpha (a gauche), Oxygéene-Ill (au milieu)
et Soufre-1l (a droite). Elles ont été entierement prétraitées, ont été enregistrées les unes avec les
autres, ont vu leurs gradients d'arriere-plan supprimés avec DynamicBackgroundExtraction et ont été
réduites en bruit avec MultiscaleLinearTransform. Comme indiqué précédemment, pour tirer le
meilleur parti de la combinaison des couleurs de ces images, il est préférable qu'elles soient étirées
de maniére non linéaire. Comme ce sujet fait I'objet d'un autre tutoriel, la procédure d'étirement des
images en non-linéaire ne sera pas abordée en détail. Jutilise généralement soit
HistogramTransformation, soit MaskedStretch, soit une combinaison des deux (d'abord
MaskedStretch, puis HistogramTransformation pour ajuster).

Un avantage de l'utilisation de MaskedStretch par rapport a HistogramTransformation est qu'il permet
de faire correspondre plus précisément la luminosité du fond des deux images a bande étroite. En
effet, MaskedStretch permet a [l'utilisateur de définir une luminosité de fond spécifique et de
l'appliquer aux deux images a bande étroite. Cependant, en raison des émissions plus faibles dans
Oxygene-lll, la nébulosité globale sera plus brillante dans lI'image H-Alpha. On peut alors exagérer la
luminosité de la nébulosité de limage Oxygeéene-lll en ['étirant davantage, peut-étre avec

HistogramTransformation ou méme CurvesTransformation en mode RGB/K.

Le tableau ci-dessous montre le résultat de I'étirement non linéaire des trois images a l'aide de
MaskedStretch avec un arriére-plan cible défini par défaut a 0,12500000, des itérations définies par
défaut & 100, une fraction d'écrétage définie a 0,00000000 et une référence d'arriere-plan
sélectionnée se référant a une petite boite de prévisualisation sur un simple arriére-plan (pas de

nébulosité), sur chague image.
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Ayant utilisé les mémes parameétres dans MaskedStretch (outre I'image de référence de l'arriere-plan
qui se réfere a la boite de prévisualisation de l'arriere-plan de chaque image), l'arriere-plan a été
relevé a la méme luminosité dans les deux images. Le probleme est que, naturellement, la nébulosité
des images Oxygene-lll et Soufre-Il est également moins lumineuse que celle de I'image H-Alpha, ce
qui signifie gu'elle contribue moins a la combinaison de couleurs. Bien que l'image couleur finale
puisse étre modifiée de maniére significative, si vous n'étes pas satisfait de la contribution globale de
I'oxygene Il et du soufre Il, vous pouvez I'étendre davantage en utilisant HistogramTransformation
jusqu'a ce que vous soyez satisfait.

Les valeurs moyennes et médianes des pixels de chague image peuvent étre visualisées rapidement
grace au processus de statistiques, en sélectionnant chaque image une par une. Cela peut vous
donner une idée de la luminosité d'une image par rapport a une autre.

Comme c'est naturellement le cas pour la grande majorité des nébuleuses, la luminosité globale est
la plus élevée pour I'H-Alpha et la plus faible pour le Soufre-Il, I'Oxygéne-Ill se situant un peu au
milieu. Néanmoins, dans ce cas particulier, les trois images ont une luminosité comparable et
peuvent contribuer de maniére équitable & une image en couleur. Cependant, si vous souhaitez
éclaircir une ou plusieurs images, plusieurs options s'offrent a vous. Pour un réglage manuel, on peut
utiliser HistogramTransformation ou CurvesTransformation. Avant de commencer a utiliser I'un ou
I'autre procédé, cliquez pour sélectionner l'image que vous souhaitez modifier.

Pour HistogramTransformation, il suffit de sélectionner l'image dans la fenétre de traitement, de
cliquer sur le bouton Real-Time Preview et de commencer a déplacer le curseur des tons moyens
vers la gauche et le curseur du point noir vers la droite, jusqu'a ce que vous obteniez le niveau de
contraste souhaité dans l'image. Les petits ajustements sont généralement bons a ce stade (puisque
les images sont déja non linéaires) et assez comparables.

Pour CurvesTransformation, la fagon d'augmenter le contraste est de cliquer sur le bouton Real-Time
Preview apres avoir sélectionné l'image, et dans le mode RGB/K par défaut, de créer un point au
quart de la ligne et de le tirer légerement vers le bas et de créer un point aux trois quarts de la ligne
et de le tirer Iégerement vers le haut. Cela modifie la ligne diagonale droite pour lui donner une
légere forme en S. L'effet est d'assombrir I'arriére-plan et d'éclaircir la nébulosité.

L'une ou l'autre méthode permet de régler manuellement la luminosité et le contraste de l'image.
Vous pouvez utiliser le processus de Statistics pour vérifier la comparaison entre les images apres
guelques ajustements, et peut-étre utiliser cette mesure pour contréler I'ampleur des ajustements
apportés a chaque image.

PixInsight dispose d'un processus qui peut étre utilisé pour égaliser les images. Ce processus est le
LinearFit. Malgré son nom, il fonctionne aussi bien pour les images linéaires que non linéaires.
Ironiqguement, il fonctionne un peu plus efficacement avec les images non linéaires si vous voulez
obtenir essentiellement les mémes valeurs moyennes et médianes de pixels sur vos images. Le
procédé LinearFit est trés simple. Il suffit de sélectionner I'une de vos images comme référence pour
faire correspondre les autres, puis d'appliquer le processus aux autres images.
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La seule chose a laquelle il faut faire attention lorsque vous utilisez LinearFit est que si vos images
moins lumineuses sont nettement moins lumineuses que l'image la plus lumineuse que vous utilisez
comme référence, cela produira une augmentation tres sensible de la luminosité des images
auxquelles vous appliquez le procédé. Cela peut sembler formidable, mais si vos images ne sont pas
tres lumineuses, cela signifie probablement que vous avez un faible rapport signal/bruit (SNR) et
donc que le niveau de bruit augmentera également. Cela éclaircira également le fond, donnant a
votre image couleur un fond non neutre et probablement plein de bruit. Un moyen de contourner ce
probleme, qui n'est pas nécessairement idéal, consiste a utiliser une image de moindre luminosité
comme référence. Ce n'est pas forcément idéal, car cela atténuera essentiellement le contraste sur
votre ou vos images a haute luminosité (par exemple, H-Alpha), qui ont tendance a fournir une
grande partie des détails.

Comme mes images ont déja des valeurs de pixels moyennes et médianes assez comparables au
départ, j'ai simplement appliqué LinearFit a Oxygen-lll et Sulphur-ll en utilisant Hydrogen-Alpha
comme image de référence. Le bruit de fond et les niveaux de bruit étant toujours sous contrdle, j'ai
choisi de ne plus modifier la luminosité sur aucune des trois images et de procéder a une
combinaison des couleurs.
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2. Combinaison de la palette Hubble et neutralisation du fond
du ciel

La combinaison des couleurs dans la palette Hubble est trés simple. Nommée d'aprés les Piliers de
la création du célebre télescope spatial Hubble, cette palette fait correspondre le soufre Il au rouge,
I'nydrogene alpha au vert et I'oxygéne Ill au bleu, sans aucune combinaison spéciale dans aucun
canal. Cette palette est communément appelée palette SHO (en raison de I'affectation des images a
bande étroite aux canaux RVB, respectivement). En raison de la simplicité de la combinaison des
couleurs, nous n'avons pas besoin d'utiliser PixelMath - nous pouvons simplement utiliser le
processus ChannelCombination. Une fois les trois images ouvertes et prétes a étre combinées, nous
attribuons les images a chaque canal comme suit (le RVB par défaut étant sélectionné dans I'espace
couleur) :

R: Sl
G: HA
B: Olll

Une fois sélectionné, nous cliquons sur le cercle Apply global pour produire la nouvelle image en
couleur.

Avec l'image couleur produite, nous pouvons fermer les trois images monochromes a bande étroite
et le processus ChannelCombination.

Bien que le fond de l'image soit assez neutre, il est toujours bon de le neutraliser manuellement.
Pour cela, nous utiliserons BackgroundNeutralization, mais nous devons d'abord créer une petite
boite de prévisualisation englobant une zone qui est essentiellement de l'arriere-plan (pas de
nébulosité, méme pas faible). Vous pouvez zoomer et faire un panoramique autour de votre image
pour identifier une telle zone (elle n'a pas besoin d'étre tres grande). Une fois identifiée, cliquez sur le
bouton "New Preview" de la barre d'outils PixInsight et faites-le glisser pour créer ladite boite de
prévisualisation dans la région d'arriere-plan identifiée.

Avec la boite de prévisualisation créée, parce que l'image est non linéaire, nous devrons mesurer le
niveau maximum trouvé dans le fond. La méthode la plus précise est celle des statistiques. Dans ce
dernier, nous pouvons sélectionner spécifiguement la boite de prévisualisation elle-méme. Il est
préférable de sélectionner ensuite le mode Normalized Real [0,1] afin que les valeurs affichées
soient de 0 a 1 plutbét que des valeurs en pixels. Il suffit que la valeur soit inférieure au maximum.

En regardant les valeurs indiquées sur le maximum, il semble que les miennes soient de 0,194 pour
le rouge, 0,175 pour le vert et 0,196 pour le bleu. Nous n‘avons pas besoin d'étre précis car il vaut
mieux arrondir un peu a la hausse, nous utiliserons donc 0,2. Nous fermons maintenant le processus
de statistiques et ouvrons le processus de neutralisation de l'arriere-plan. Ici, nous sélectionnons la
boite de prévisualisation comme image de référence, nous augmentons la limite supérieure a notre
maximum de 0,2 et nous appliquons ensuite le processus a l'image.
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Le processus BackgroundNeutralization peut maintenant étre fermé et la boite de prévisualisation
peut étre supprimée en passant par les menus de PixInsight Preview -> Delete All. A ce stade, hous
avons une image traditionnelle de la palette Hubble. Elle est principalement verte car le signal H-
Alpha a tendance a étre beaucoup plus fort que celui de I'oxygéne-lll et du soufre-Il. La plupart des
étoiles sont également magenta.

Si vous étes un puriste et que la palette de Hubble est vraiment ce que vous voulez obtenir, vous
pouvez maintenant continuer a post-traiter I'image aussi normalement que la combinaison des
couleurs. Cependant, de nombreux astrophotographes modifient la palette aprés la combinaison des
couleurs. Certaines modifications sont subtiles et d'autres tres prononcées. Une modification
courante de la palette consiste a rendre les bleus plus profonds et a changer les verts en
rouge/orange. Il est également courant de modifier les couleurs des étoiles pour supprimer leur ton

magenta. Les sections suivantes traitent de ces changements courants.

3. Réduire le ton magenta des étoiles

Pour réduire le ton magenta des étoiles, nous devons d'abord sélectionner les zones problématiques
de notre image. Heureusement, nous disposons du script ColorMask que nous pouvons utiliser pour
cibler rapidement ces zones. Ce script se trouve dans les menus Script -> Utilitaires -> ColorMask.
Une fois que le script est ouvert avec votre image en couleur sélectionnée, cliquez sur le bouton
Magenta et réglez le paramétre Mask blur : layers to remove sur 2 (cela lissera un peu le masque),
puis cliquez sur OK.

L'image de masque produite est une image qui cible spécifiguement les zones de l'image avec un ton
magenta. Parfois, cependant, il y a un petit halo autour des étoiles laissées en dehors de l'image du
masque, il est donc généralement bon de dilater un peu le masque afin d'inclure ces zones. Pour
cela, nous utiliserons le processus MorphologicalTransformation. Une fois ouvert, sélectionnez
Morphological Selection sous Opérateur, réglez la Sélection sur 0,90, sélectionnez 5 (25 éléments)
sous Size et cliguez ensuite sur les carrés noirs sous Structuring element pour lui donner une sorte
de forme d'étoile (comme indiqué ci-dessous). Si vous faites une erreur, maintenez la touche CTRL
enfoncée et cliquez sur un carré blanc pour le rendre noir.

Il convient de noter a ce stade que la sélection morphologique est une combinaison de dilatation et
d'érosion, qui donne un résultat plus lisse que I'utilisation d'une seule de ces méthodes. Augmenter
la sélection au-dessus de 0,50 entrainera une dilatation plus qu'une érosion et diminuer la sélection
en dessous de 0,50 entrainera une érosion plus qu'une dilatation. Nous souhaitons dilater pour que
0,90 fonctionne bien. Une fois le réglage effectué comme ci-dessus, appliquez le processus a l'image
du masque et fermez la fenétre du processus.

L'image du masque peut maintenant étre appliquée a notre image. Pour ce faire, cliquez pour
sélectionner l'image en couleur et allez ensuite dans les menus Masque -> Sélectionner le masque
(ou appuyez sur la touche CTRL M de votre clavier). Sélectionnez I'image du masque dans la liste et
cliguez sur OK. Une fois appliquée, votre image en couleur deviendra probablement presque
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entierement rouge. Cela montre que le masque protége tout sauf les zones magenta. Nous pouvons
cacher le masque par le biais des menus Mask -> Show Mask (ou appuyez sur la touche CTRL K de
votre clavier). Le masque restera ainsi actif mais caché pour que nous puissions réellement voir
notre image.

Les zones magenta étant correctement ciblées, nous visons maintenant a réduire la saturation des
couleurs spécifiguement dans le magenta. Pour ce faire, nous utiliserons le processus
ColorSaturation.

Pour réduire la saturation des couleurs sur le magenta, il suffit de cliquer sur la ligne plate pour créer
un point au milieu des violets et de faire glisser ce point vers le bas. Vous remarquerez que les zones
adjacentes sur la ligne plate s'incurvent également vers le bas, mais nous avons besoin que ces
couleurs restent inchangées.

Pour éviter que ces couleurs du spectre ne soient également altérées, on clique pour créer d'autres
points afin d'aplatir la courbe partout sauf autour des violets. La procédure consiste a créer d'abord
un point de chaque coté des violets (le début et la fin, pour ainsi dire) et ensuite, si le reste de la ligne
n'est toujours pas plat, on clique pour créer des points a cet endroit (au-dessus/en dessous des pics)
ainsi que pour l'aplatir. Il est difficile d'aplatir completement la ligne a l'aide d'une souris ou d'un
trackpad, vous pouvez donc simplement utiliser les boutons fléechés gauche et droite de la fenétre
ColorSaturation pour sélectionner chaque point individuellement et régler la saturation a 0,00000 sur
tous les points qui sont censés aplatir la ligne.

Ci-dessus, j'ai sélectionné le point pour réduire la saturation de la couleur des violets et jai réglé
manuellement sa valeur a -1,00000. Une fois le réglage effectué comme ci-dessus, nous pouvons
appliguer le processus a l'image couleur. J'ai tendance a I'appliquer environ trois fois. Ci-dessous,
nous pouvons voir l'avant (image du haut) et I'apres (image du bas) pour une zone avec beaucoup
d'étoiles magenta.

La différence dans la force du ton magenta des étoiles est tres perceptible. Bien sir, elle peut étre
réduite davantage en étant plus agressif sur ColorSaturation avec la valeur de saturation sur les
violets, ou en appliquant le processus quelques fois de plus, ou en s'assurant que l'image du masque
est un peu plus dilatée pour englober de plus grandes zones autour de vos étoiles. Ce que je
déconseille normalement, c'est d'utiliser le processus CurvesTransformation en mode Saturation
pour réduire fortement toute la saturation des couleurs dans des zones magenta sélectionnées. La
raison en est que l'image du masque a tendance a sélectionner des zones de votre image qui n‘ont
pas l'air magenta mais qui contiennent un peu de magenta (dans mon cas, le cceur de la nébuleuse).
Comme vous pouvez l'imaginer, supprimer toute saturation des couleurs dans ces zones ne va pas
donner un résultat trés agréable. C'est pourquoi j'utilise toujours le procédé ColorSaturation tel que
décrit ci-dessus a la place.

Une fois satisfait du résultat, nous pouvons fermer le processus de saturation des couleurs et
supprimer l'image du masque en utilisant les menus Mask -> Remove Mask , puis fermer l'image du
masque sans l'enregistrer car nous n‘en avons plus besoin. Encore une fois, si vous étes un puriste

de la palette Hubble et que vous souhaitez conserver la palette de couleurs telle quelle, avec le ton
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magenta réduit sur les étoiles, alors vous avez terminé a ce stade. Cependant, il est courant pour les
astrophotographes de prendre leur propre licence artistique avec la palette Hubble et d'apporter des
modifications a la palette de couleurs. Ce point est traité en détail dans la section suivante.
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4. Modification de la palette de couleurs

On peut dire que l'outil Selective Color de Photoshop est en fait plus rapide pour effectuer les
changements de palette de couleurs, mais comme il s'agit d'un tutoriel PixIlnsight, nous allons nous
concentrer sur la facon de le faire la. Je dois toutefois admettre que j'ai parfois enregistré lI'image
combinée en TIFF 16 bits, I'ai ouverte dans Photoshop, a effectué les changements de palette de
couleurs, I'a enregistrée puis I'a rouverte dans PixInsight pour poursuivre le post-traitement. Les
outils que nous utiliserons dans PixInsight sont les processus CurvesTransformation et SCNR.

Une version typique de la palette Hubble est une version orange et bleue, avec parfois des touches
de vert. Le processus SCNR peut étre utilisé pour atteindre ce point immédiatement, bien que les
résultats ne soient pas aussi bons que ceux que nous pouvons obtenir avec un peu plus d'efforts.

Pour atteindre rapidement une palette orange-bleu, on peut simplement utiliser les parametres par
défaut de la SCNR. C'est-a-dire avec le vert sélectionné comme couleur a supprimer, neutre moyen
comme méthode de protection, avec 1,00 comme quantité et Preserve lightness activée. La valeur
1,00 garantit que le résultat final est I'image entierement traitée (par exemple, si nous définissons
0,50, le résultat final sera une combinaison de la moitié de I'image originale et de la moitié de l'image
traitée). Il est important de laisser la luminosité activée car sinon les zones vertes seront
extrémement délavées.

Bien que le résultat final puisse vous plaire et que vous soyez heureux de procéder a un post-
traitement supplémentaire, nous pouvons en fait obtenir un résultat final plus brillant et plus détaillé
en utilisant CurvesTransformation. La SCNR, dans son mode "Average Neutral", calculera une
moyenne des valeurs des pixels rouges et bleus et remplacera les pixels verts par cette moyenne si
la moyenne du rouge et du bleu est inférieure a celle du vert. Ceci est surtout visible dans les zones
a prédominance verte de votre image, et donc ces zones vertes sont remplacées par une moyenne
du rouge et du bleu présents dans ces zones, ce qui, parce que le vert est la couleur dominante (plus
lumineuse), finit par faire paraitre I'image un peu délavée dans les zones précédemment vertes.

Nous utiliserons CurvesTransformation en mode teinte pour rapprocher les couleurs de ce que nous
souhaitons obtenir, modifiant ainsi les valeurs des pixels a tel point que les zones vertes sont plus
rouges et bleues qu'avant I'application. Cela signifie que lorsque nous appliquons la SCNR plus tard,
I'effet de nettoyage de I'image dans les zones a prédominance verte est moins destructeur.

L'activation de la fenétre de prévisualisation en temps réel est une bonne idée, tout en permettant
des modifications. Pour se rapprocher de la palette orange-bleu que nous voulons, il suffit de cliquer
pour créer deux points sur la courbe de teinte. L'emplacement précis de ces deux points varie d'une
image a l'autre, mais je trouve qu'en gros, I'endroit ou ils sont indiqués ci-dessous est un bon
compromis pour la plupart des images.

Le changement de teinte généré par la création de ces deux points sur la courbe de teinte a pour
effet de rendre les rouges et les bleus plus intenses, tout en diminuant un peu l'importance des verts.
Cela finit par donner a lI'image une palette de trois couleurs, que vous préférerez peut-étre finir telle
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guelle. Une fois satisfait, appliquez les changements et fermez la fenétre de prévisualisation en
temps réel.

Si vous étes satisfait de votre image, vous pouvez vous arréter ici et continuer avec d'autres post-
traitements. Nous pouvons cependant modifier la quantité de vert dans lI'image en utilisant la SCNR
comme nous le faisions auparavant. Si vous étes satisfait de la suppression de toute trace de vert
dans l'image, vous pouvez simplement appliquer la SCNR comme nous le faisions auparavant - dans
ses parametres par défaut avec la valeur 1.00.

En effet, c'est nettement mieux qu'en utlisant simplement la SCNR sans utiliser
CurvesTransformation au préalable. Vous trouverez ci-dessous une comparaison entre la premiéere
tentative d'utilisation de la SCNR et la nouvelle tentative ci-dessus (CurvesTransformation suivie de
la SCNR). L'image de gauche est la tentative originale et I'i'mage de droite est la nouvelle tentative.

On constate une augmentation trés sensible de la luminosité, des détails et de la profondeur, ce qui
fait de l'utilisation d'un changement de teinte par CurvesTransformation avant l'application de la
SCNR un choix définitif. Bien entendu, si vous choisissez de laisser un peu de vert dans l'image,
vous pouvez diminuer la quantit¢ de SCNR pour son application. Par exemple, une valeur de
Amount de 0,50 donne le résultat suivant.

Pour les fans d'une palette Hubble tricolore qui donne la priorité au bleu-orange, c'est un bon choix.
L'expérimentation avec différentes valeurs de Amount est la clé pour atteindre le résultat souhaité a
ce stade. Plus la valeur de Amount est élevée, moins il y aura de vert dans votre image. On peut
aussi choisir de jouer avec un décalage de teinte plus petit pour ajuster la palette de couleurs
modifiée a la perfection. Par exemple, pour approfondir un peu les bleus, on peut effectuer un petit
décalage de teinte comme suit.

Il s'agit de créer des points le long de la courbe de teinte qui assurent que la ligne est droite, sauf
gu'une petite bosse est produite a mi-chemin qui courbe la ligne vers le haut, seulement un peu. Cela
pousse le bleu clair vers un ton plus foncé. Le méme décalage de teinte peut étre appliqué a une
image sans aucun vert.

Lorsque vous avez atteint un point ou vous étes satisfait de votre image de la palette Hubble, vous
pouvez alors procéder a tous les autres post-traitements que vous souhaitez, tels que I'amélioration
des caractéristiques et du contraste. Ces techniques font toutes I'objet d'autres tutoriels.
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XIX.  Produire une image HDR

Il n'y a pas un nombre effroyable de cibles dans le ciel nocturne qui méritent une image HDR. En fait,
la plupart des objets de l'espace lointain sont trés faibles et de longues expositions suffisent
généralement a elles seules pour faire ressortir tous les détails fins, tant dans les régions
relativement claires que dans les régions relativement faibles. Il existe cependant quelques
exceptions, comme la nébuleuse d'Orion M42 et la galaxie d’Androméde M31l. Ces objets, en
particulier, présentent des zones extrémement lumineuses par rapport aux zones environnantes tres
faibles. Ce sont de tels objets qui bénéficient des images HDR. Il s'agit généralement de capturer
une pile d'expositions courtes et une autre pile d'expositions longues. Certains peuvent choisir de
capturer plusieurs autres piles d'expositions de longueur moyenne entre les deux (par exemple 30
secondes, 1 minute, 2 minutes, 5 minutes et 10 minutes). Tout dépend de la quantité de détails
relatifs que vous souhaitez conserver dans I'image HDR et de la durée pendant laquelle vous étes
prét a travailler sur cette cible.

BN

Pixinsight dispose d'un procédé particulier dédié a la production d'une image HDR - la
HDRComposition. Ce tutoriel expligue comment utiliser ce procédé simple et comment obtenir une
image qui ressemble effectivement a une image HDR (car I'étirement en non-linéaire donne
I'impression que le détail a de nouveau été perdu). Comme pour les autres tutoriels, un certain
nombre d'étapes préparatoires doivent étre franchies pour que les images soient prétes a produire

une image HDR. Ces étapes sont détaillées au début du tutoriel.

Pré-supposé pour ce tutoriel :

e Connaissance du fonctionnement de PixInsight, en rapport avec le traitement des images et
des processus (Lire ce qui suit, sections 3 et 4).

e Vos images ont déja été entierement prétraitées (Lire ceci).

e Vos images ont toutes été enregistrées les unes avec les autres (Lire ceci, section 1).
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1. Préparation Initiale pour les Différentes Exposition des
Images

Les images qui seront utilisées dans votre image HDR doivent toujours étre entierement prétraitées.
En outre, ces images doivent étre enregistrées les unes avec les autres pour que la procédure
fonctionne correctement. Cela signifie que les images doivent étre correctement alignées les unes
par rapport aux autres. Ce n'est pas le sujet de ce tutoriel particulier (il fait partie d'un autre tutoriel)
mais peut étre réalisé rapidement avec StarAlignment, en utilisant peut-étre I'image a plus longue
exposition comme image de référence (car elle aura naturellement plus d'étoiles pour servir de
référence). Notez également que vos images doivent étre dans leur état linéaire et donc non étirées.

Les images ci-dessous sont des images de la nébuleuse d'Orion M42, auto étirées a des fins de
démonstration. L'image de gauche est un empilement d'expositions de 1 minute et I'image de droite
est un empilement d'expositions de 7 minutes. Celles-ci seront utilisées pour produire une image
HDR de la cible.

Ce qui précede montre que l'image de 7 minutes d'exposition (a droite) est beaucoup plus détaillée
dans les zones environnantes plus faibles. Bien que les deux images ci-dessus apparaissent comme
si le noyau était déja saturé, la suppression de l'autostretch montre que l'image d'exposition d'une
minute (a gauche) montre les quatre étoiles trapézoidales dans le noyau de la nébuleuse :

Inversement, le noyau de la nébuleuse est completement saturé dans l'image d'exposition de 7
minutes. C'est la clé de la production d'une image HDR - nous souhaitons afficher des détails a la
fois dans le noyau de la nébuleuse et dans les zones environnantes plus faibles.

Bien que ces deux images soient techniquement prétes a étre utilisées pour produire une image
HDR (puisqu'elles sont entierement prétraitées et enregistrées), il est également judicieux d'éliminer
tout dégradé de l'arriere-plan avec la fonction DynamicBackgroundExtraction. Cette opération est
effectuée sur les deux images individuellement, afin qu'elles soient aussi propres que possible. Ce
sujet dépasse a houveau le cadre de ce tutoriel et est traité dans un autre tutoriel.

Ci-dessus, on voit les deux mémes images apres qu'elles aient été traitées avec
DynamicBackgroundExtraction. Elles sont montrées auto-étirées (en haut) et dans leur état linéaire
d'origine (en bas). Les images sont maintenant entierement préparées pour produire une image
HDR, apres avoir été entierement prétraitées, enregistrées l'une avec l'autre et avoir vu leurs
gradients d'arriere-plan supprimés. Elles sont également toutes dans leur état linéaire. Assurez-vous
gue vos images préparées sont enregistrées sous forme de fichiers d'images car nous aurons besoin
de fichiers d'images réels plutét que d'images ouvertes dans PixInsight.
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2. Création du composite HDR avec HDRComposition

Afin de produire limage HDR, nous devrons ouvrir le processus Pixlnsight dédié a cela -
HDRComposition. Nous n'avons pas besoin d'avoir des images réellement ouvertes dans PixInsight
car ce processus fonctionne avec des fichiers d'images réels.

Nous devons d'abord ajouter les images préparées a la liste des images d'entrée. Pour cela, nous
cliguons sur le bouton Ajouter des fichiers, nous recherchons les images préparées et nous les
ajoutons.

Veuillez garder a l'esprit que les options par défaut dans HDRComposition ont tendance a
fonctionner exceptionnellement bien, mais nous allons explorer ce qu'elles font. L'option Automatic
exposure evaluation doit étre maintenue activée. Elle n'utilisera pas les en-tétes FITS ou autre pour
déterminer quelle image est composée d'expositions plus longues - elle le déterminera rapidement
grace aux statistiques de l'image. Cependant, au cas ou cela échouerait, vous devriez toujours avoir
votre image de plus longue exposition en haut de la liste sous "Input Images”, avec des images de
plus en plus courtes exposition en bas de la liste. Dans mon cas, les images sont listées dans le bon
ordre - I'image avec une exposition de 7 minutes est en haut et celle avec une exposition d'une
minute en dessous. C'est une bonne idée de garder la fonction Rejeter les pixels noirs activée afin
d'éviter que les pixels noirs d'une image a exposition plus courte ne remplacent accidentellement les
pixels saturés dans une image a exposition plus longue (apparaissant ainsi comme des trous de la
taille d'un pixel). De plus, pour produire une image HDR satisfaisante conservant tous les détails,
nous devons garder I'option Générer une image HDR 64 bits activée car la profondeur de 64 bits est
tres avantageuse pour les images HDR (pour les images non-HDR, 32 bits suffisent généralement). Il
est recommandé de garder les masques de composition de sortie activés car ils vous montreront
guelles données des images a longue exposition ont été remplacées par des données dimages a
courte exposition. Ces masques apparaissent lors de la création de la composition HDR et peuvent
étre fermés sans étre sauvegardeés.

Le seuil de binarisation est peut-étre le paramétre le plus important qui puisse étre modifié. La valeur
par défaut de 0,8000 fonctionne trés bien dans la plupart des cas. Ce parametre permet de définir les
zones de pixels d'une image a exposition longue qui sont remplacées par une image a exposition
courte (en termes de luminosité relative). Si la valeur est trop élevée, une image a exposition longue
peut étre insuffisamment combinée avec une image a exposition courte (perte de détails des zones
lumineuses dans l'image HDR). Si la valeur est trop faible, les zones de faible luminosité relevées
dans une image a exposition longue peuvent ne pas contribuer autant & une image a exposition
courte (perte de détails des zones de faible luminosité dans I'image HDR). L'expérimentation est la
clé pour obtenir le meilleur résultat pour vos données, bien qu'il soit bon de tester la valeur par défaut
de 0,800 avant de la modifier.

Mask smoothness définit le degré de lissage du masque qui correspond aux zones lumineuses d'une
image a exposition longue qui sera remplacée par une image a exposition courte. La valeur par
défaut de 7 peut fonctionner correctement mais il y a peu de raisons de ne pas augmenter cette
valeur jusqu'a la valeur maximale de 25. Cela permet d'obtenir une transition douce entre les zones
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lumineuses qui ont été remplacées et les zones environnantes plus faibles de I'image HDR. La valeur
du masque peut généralement étre maintenue a sa valeur par défaut de 1, a moins que vous ne
remarquiez que les zones claires qui ont été remplacées apparaissent entourées de halos sombres
ou d'autres artefacts. Dans ces cas, il peut étre utile d'augmenter Iégérement cette valeur.

Vous trouverez ci-dessous limage HDR que j'ai obtenue en cliquant sur Apply Global dans
HDRComposition. Les parameétres par défaut ont été utilisés, sauf pour le lissage du masque, qui a
été augmenté a sa valeur maximale de 25.

Deux images ont été produites par HDRComposition. L'image de gauche est mon image HDR.
L'image de droite est le masque, montrant quelles zones de l'image a exposition longue ont été
remplacées par lI'image a exposition courte. Grace a mon réglage de 25, le masque est tres lisse. Je
note cependant que bien que la zone remplacée soit en grande partie la zone saturée, une zone
légérement plus grande aurait été préférable. Pour agrandir les zones remplacées, nous abaissons le
seuil de binarisation. Une valeur de 0,600 a donné un meilleur résultat final pour mes données.

Comme la zone remplacée est maintenant montrée par l'image du masque sur la droite pour étre
plus étendue, je suis content de mon résultat final et je ferme a la fois I'image du masque et le
processus de composition HDRC. Ci-dessous, mon image HDR auto étirée :

Nous pouvions clairement voir les quatre étoiles trapézoidales dans le noyau de la nébuleuse a I'état
linéaire de I'image HDR et auto étirée, nous voyons beaucoup de détails dans la faible nébuleuse
environnante. Nous avons ainsi obtenu ce que nous voulions - une image HDR montrant a la fois des
zones trés lumineuses et tres faibles. Le probléme que vous avez peut-étre remarqué est que l'image
ci-dessus, auto-étiree, ne montre plus de détails dans le noyau brillant de la nébuleuse. Nous
pouvons comprimer la gamme dynamique pour corriger ce probleme, mais nous devons d'abord
étirer 'image pour qu'elle soit non linéaire.

3. Etendre limage HDR et comprimer sa gamme
dynamique avec « HDR Multiscale Transform »

Comme ce tutoriel est basé sur la création d'une image HDR, nous n'allons pas passer en revue de
maniére exhaustive le processus d'étirement de l'image en non-linéaire. C'est le sujet d'un autre
tutoriel. Pour cet exemple, j'ai simplement transféré les paramétres d'auto-étirage de la fonction de
transfert d'écran (ScreenTransferFunction) vers la fonction HistogramTransformation et je les ai
appligués a limage sous forme d'étirement permanent. Par conséquent, bien qu'elle ait la méme
apparence, l'image ci-dessous est maintenant étirée et donc non linéaire.

Le processus utilisé pour comprimer la gamme dynamique et donc retrouver les détails HDR dans
I'image HDR est HDRMultiscale Transform.

Pour HDRMultiscaleTransform, nous notons que le paramétre Number of layers définit a quelle
échelle d'ondelettes la compression de la gamme dynamique doit avoir lieu. En termes d'apparence,
plus cette valeur est faible, plus I'image semble étre plate. Plus cette valeur est élevée, moins les
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changements semblent agressifs (en particulier pour les zones claires). Nous pouvons modifier cette
valeur pour obtenir un bon aspect général de Iimage HDR. Ci-dessous figurent les résultats pour les
valeurs de Nombre de couches de 5 a 8. Tous les autres parametres sont maintenus a leur valeur
par défaut.

Une fois que vous avez décidé quelle valeur de Number of layers donne le meilleur aspect global a
votre image HDR, nous pouvons la fixer. Dans mon cas, j'ai pensé que le nombre de couches réglé a
7 donnait un bon apergu, les quatre étoiles trapézoidales du noyau de la nébuleuse étant visibles et
le reste de la nébuleuse n‘ayant pas l'air plat. Une fois que vous avez choisi une bonne valeur pour le
nombre de couches, vous pouvez essayer de régler le nombre d'itérations sur 2 pour voir si vous
obtenez un meilleur résultat final. Pour moi, le nombre d'itérations fixé par défaut a 1 est plus que
suffisant. Le parametre Overdrive peut également étre légerement augmenté pour obtenir une
compression un peu plus agressive de la gamme dynamique. Notez que d'autres processus tels que
LocalHistogramEqualization peuvent étre utilisés pour augmenter encore le contraste dans les
régions claires et sombres, bien que cela soit appliqué plus tard dans le post-traitement.

A ce stade, la composition de votre RDH est terminée. Bien que l'exemple ci-dessus soit
monochrome H-Alpha, cette procédure fonctionne de maniére identigue pour les images
monochromes LRGB ainsi que pour les images One Shot Colour. En fait, si vous imaginez une cible
en monochrome avec lintention de produire une image HDR en couleur a la fin, vous devrez
appliquer cette procédure a l'image de luminance et a I'image RVB en couleur séparément, avant de
poursuivre le post-traitement.

Voici un déroulement général des opérations pour produire une image HDR en couleur d'une cible
imagée en LRGB monochrome :

1. Combiner les couleurs R, G et B pour produire une image RVB en couleur pour chaque
empilement de temps d'exposition.

2. Produire une composition HDR de toutes les images RVB couleur en utilisant la
composition HDRC.

3. Produire une composition HDR de toutes les images de luminance en utilisant la
HDRComposition.

4. Post-traiter les deux images HDR séparément pour les combiner plus tard, comme
d'habitude. Ce post-traitement doit inclure l'utilisation du processus HDRMultiscaleTransform
afin de comprimer la gamme dynamique.

Si vous imaginez une cible en bande étroite, vous devez produire une composition HDR de toutes les
images pour chaque filtre particulier. Une fois cette opération effectuée, toutes ces images HDR
peuvent étre combinées en couleur et post-traitées, comme d'habitude. Ce post-traitement doit
inclure l'utilisation du processus HDRMultiscale Transform afin de comprimer la gamme dynamique.

[ } 199



XX. Combinaison du LRGB et de la bande étroite

L'imagerie d'un objet de I'espace profond en LRGB et en bande étroite tend a produire deux images
tres différentes. En LRGB, on obtient une mesure de la couleur réelle de la cible et en bande étroite,
une image en fausses couleurs donne lieu a des tonnes de détails fins liés aux éléments particuliers
présents. Mais il arrive sans doute un moment ou I'on souhaite combiner ces données en bande
large (LRGB) et en bande étroite, pour obtenir le meilleur des deux mondes. Des images étonnantes
ont été produites par des astrophotographes qui ont fait cela. Généralement, en raison de leurs
longueurs d'onde, H-Alpha est utilisé pour améliorer le canal rouge d'une image LRGB, alors que
parce que Oxygene-lll est entre le vert et le bleu, il est utilisé pour améliorer les canaux vert et bleu
d'une image LRGB. On peut cependant simplement essayer d'améliorer le canal rouge avec H-
Alpha, comme il est normal pour une image d'une galaxie (pour faire ressortir les régions de
formation des étoiles le long des bras spiraux). Les données a bande étroite capturées par des filtres
autres que H-Alpha et Oxygéne-Illl ne sont généralement pas utilisées pour les combiner avec les
données LRGB. Certains choisissent également de combiner la luminance réguliere avec des filtres
de type H-Alpha, par exemple.

PixInsight est tout a fait capable de combiner des données a large bande (LRGB) et a bande étroite
pour produire des images améliorées et le choix du ou des canaux a améliorer, est totalement laissé
a la discrétion de l'utilisateur. Ce tutoriel passe en revue les méthodes courantes d'utilisation des
données a bande étroite pour améliorer une image LRGB - H-Alpha pour le rouge, oxygéne-Ill pour
le vert et le bleu et H-Alpha pour la luminance. La méthode utilisée pour toutes ces combinaisons est
basée sur celle de Vicent Peris de I'équipe PixInsight.

Pré-supposé pour ce tutoriel :

e Connaissance du fonctionnement de PixInsight, en rapport avec le traitement des images et
des processus (Lire ce qui suit, sections 3 et 4).

e Vos images ont déja été entierement prétraitées (Lire ceci).

e Vos images ont toutes été enregistrées les unes avec les autres, ont été recadrées de la
méme maniére et ont été débarrassées des dégradés de fond (Lire ce qui suit, sections 1, 2 et
3)
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1. Préparation Initiale des Images

Les images qui seront utilisées pour ce tutoriel ont été entierement prétraitées, ont été enregistrées
les unes par rapport aux autres, leurs bords noirs ont été recadrés a l'aide de DynamicCrop et les
dégradés d'arriere-plan ont été supprimés a l'aide de DynamicBackgroundExtraction. Les images
monochromes LRGB ont également été mises en correspondance en termes de luminosité avec
image verte comme référence en utilisant LinearFit. Tout ceci est typique des préparations
effectuées sur les images avant la combinaison des couleurs et le post-traitement ultérieur, et est
fortement recommandé avant de procéder. Les images sont toutes encore a I'état linéaire, comme
indiqué ci-dessous.

Nous commencgons par combiner les images rouge, verte et bleue en une image RVB en couleur.
Cette image RVB est ensuite calibrée de maniére a représenter la vraie couleur de la cible. Les
procédures a suivre pour ce faire dépassent le cadre de ce tutoriel, car il existe d'autres tutoriels
basés sur ces sujets (images de combinaison et de calibrage des couleurs). Il est cependant tres
important de calibrer les couleurs de I'image RVB avant de se lancer dans I'amélioration de celle-ci
avec des données a bande étroite.

Ci-dessus, la nouvelle image RVB en couleur a été auto-étirée a des fins de démonstration. Les
images monochromes Rouge, Vert et Bleu ont été fermées car nous n'en avons plus besoin (aprés
les avoir combinées et calibrées). Nous avons maintenant tout ce dont nous avons besoin pour
continuer.

2. Renforcer le rouge avec du I'H-Alpha

Etant donné que la raie d'émission de I'hydrogéne alpha se trouve profondément dans la partie rouge
du spectre, I'hydrogéne alpha est toujours utilisé pour améliorer le canal rouge uniquement. Nous
commencons par ouvrir I'image RVB calibrée en couleur que nous avons créée précédemment ainsi
que l'image H-Alpha. Celles-ci sont montrées ci-dessous auto-étirées a des fins de démonstration.

Afin d'améliorer le canal rouge de l'image couleur avec H-Alpha, nous devons d'abord en extraire le
canal rouge sous la forme d'une image monochrome. Ceci est nécessaire car apres le calibrage des
couleurs, les différents canaux de couleur ont été modifiés en intensité les uns par rapport aux autres
(par rapport aux images monochromes originales en rouge, vert et bleu). Pour cela, nous utilisons le
procédé ChannelExtraction. Dans son mode RVB par défaut, sélectionné sous Espace couleur, ne
gardez que R sélectionné sous Canaux / Images cibles et appliquez le processus a l'image RVB en
couleur.

Comme mon image RVB en couleur a été simplement appelée RVB, la nouvelle image monochrome
qui apparait s'appelle RVB_R, qui est le canal rouge de I'image RVB en couleur. Comme les images
sont toutes dans leur état linéaire, par défaut, le canal rouge extrait est également affiché dans son
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état linéaire. Nous ouvrons maintenant le processus PixelMath, que nous utiliserons pour améliorer
notre canal rouge avec Hydrogen-Alpha.

Au-dessus, I'image du canal rouge extraite est montrée auto-étirée en dessous de l'image H-Alpha
auto-étiree. Afin de les combiner, nous devons d'abord créer une image qui correspond a la
nébulosité seule - une image qui supprime les étoiles et autres continuums apres combinaison. Pour
ce faire, nous sélectionnons Create new image sous Destination dans PixelMath et select Grayscale
sous Color space. Pour commencer, nous saisissons les expressions suivantes dans les zones de
texte RGB/K et Symboles :

RGB/K : ((HA * R_bandwidth) - (R * HA_bandwidth)) / (R_bandwidth - HA_bandwidth)
Symboles : R_bandwidth=100, HA bandwidth=7

Comme mon image H-Alpha est simplement appelée HA, je I'ai laissée telle quelle dans la zone de
texte RGB/K. Cependant, j'ai changé R pour RGB_R car c'est le nom de mon image de canal rouge
extraite. Les nombres 100 et 7 correspondent aux largeurs de bande en nanométres des filtres
Rouge et H-Alpha utilisés lors de Iimagerie de cette cible. En effet, la plupart des filtres Rouge, Vert
et Bleu ont une largeur de bande d'environ 100 nm alors que les filtres & bande étroite varient. Cette
image a été capturée en utilisant un filtre Baader H-Alpha de 7 nm, donc 7 est la valeur correcte a
entrer pour la largeur de bande HA . Cliquer sur Appliquer sur PixelMath crée une nouvelle image,
montrée ci-dessous autostretched.

En effet, il y a moins d'étoiles présentes dans cette nouvelle image, mais il y en a encore pas mal.
Pour étre plus agressif quant a leur suppression (et en effet d'autres continuums sans rapport avec la
combinaison), nous diminuons simplement la valeur entrée pour la largeur de bande R. A I'heure
actuelle, elle est de 100. La réduction de cette valeur & 40 donne un bien meilleur résultat final. Nous
pouvons fermer l'image créée précédemment sans la sauvegarder et vérifier la nouvelle combinaison
avec la valeur de R_bandwidth fixée a 40.

Le fait que les étoiles aient pratiqguement disparu signifie qu'elles conserveront leurs couleurs
naturelles malgré I'amélioration du canal rouge avec I'H-Alpha. Pour une image d'une galaxie, le
réglage de la largeur de bande R supprimera non seulement les étoiles, mais aussi le continuum du
reste de la structure de la galaxie, ne laissant derriere que les régions qui seraient réellement
améliorées par H-Alpha.

Avec la nouvelle image combinée créée, nous l'utiliserons pour améliorer le canal rouge de lI'image
RVB en couleur. Avant de continuer, nous cliquons sur Reset dans PixelMath et nous fermons
Iimage du canal rouge ainsi que l'image H-Alpha originale. Nous ne gardons donc ouvertes que
I'image RVB en couleur et la nouvelle image créée.

PixelMath est a nouveau ouvert. Cette fois, apres avoir cliqué sur Reset, nous ne faisons que
désactiver l'option Use a single RGB/K expression afin de pouvoir entrer des expressions
individuelles pour R/K, G et B (pour chaque canal de couleur). Nous entrons ensuite ce qui suit dans
les zones de texte R/K, G, B et Symboles :
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R/K : $T + ((Combimg - Med(Combimg)) * BoostFactor)
G:$T

B:S$T

Symboles : Facteur d'amplification = 1,0

Ci-dessus, jai remplacé Comblmg par le nom réel de mon image combinée, Image24. L'expression
sur la zone de texte R/K ajoutera essentiellement les données combinées dans le canal rouge de
I'image RVB en couleur. Le fait d'avoir $T dans les zones de texte G et B garantit que les canaux vert
et bleu sont conservés tels quels, sans altération. Le paramétre BoostFactor permet simplement de
déterminer la force avec laquelle le canal rouge est amélioré par les données d'H-Alpha. 1,0 ajoutera
naturellement ce qui est déja la, alors que les valeurs inférieures a 1,0 amélioreront moins le canal
rouge et les valeurs supérieures a 1,0 amélioreront davantage le canal rouge. Afin d'effectuer
I'amélioration, il suffit de sélectionner I'image RVB en couleur et de cliquer sur le bouton Appliquer
dans PixelMath ou de faire glisser le bouton Nouvelle instance de PixelMath sur I'image RVB en
couleur.

Il est clair que I'amélioration a fonctionné, car les rouges sont plus vifs et il y a plus de nébulosité
visible vers les zones extérieures environnantes. Cependant, pour terminer le rehaussement, nous
devrons neutraliser l'arriere-plan dans l'image rehaussée. Pour cela, nous créons une petite boite de
prévisualisation sur le seul espace de l'arriere-plan (pas de nébulosité ni d'étoiles), nous ouvrons le
processus BackgroundNeutralization, nous sélectionnons la boite de prévisualisation dans la liste
sous Image de référence et nous l'appliquons a limage RVB en couleur. La réapplication de
l'autostretch donne le résultat modifié.

Le résultat semble maintenant bien meilleur. Veuillez garder a l'esprit qu'il est inutile d'utiliser le
processus ColorCalibration maintenant, car il annulera une grande partie de notre amélioration du
canal rouge avec I'hydrogéne alpha. BackgroundNeutralization est tout ce dont nous avons besoin. A
ce stade, si vous étes satisfait de votre résultat, vous pouvez fermer l'image combinée que nous
avons créée precédemment (la mienne s'appelle Image24), supprimer la boite de prévisualisation et
enregistrer les modifications apportées a votre image RVB en couleur. Si vous souhaitez améliorer
davantage (ou moins) le canal rouge, il vous suffit d'annuler les modifications apportées a l'image
RVB, de modifier la valeur du BoostFactor dans PixelMath et de réappliquer le processus et de
refaire la neutralisation de l'arriére-plan.

3. Renforcer le vert et le bleu avec I'oxygene Il

Comme la raie d'émission de I'Oxygéne-lll se situe entre les parties verte et bleue du spectre,
I'Oxygéne-Ill est généralement utilisé pour améliorer les canaux vert et bleu d'une image couleur.
Nous allons procéder de la sorte, en reprenant la ou nous nous étions arrétés (aprés avoir ameélioré
le canal rouge avec de I'H-Alpha). Ci-dessous, nous avons notre image en couleur rehaussée par H-
Alpha ainsi que I'image Oxygeéne-lll, toutes deux auto-étirées.
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La procédure que nous suivrons est identique, mais s'applique aux canaux vert et bleu dans ce cas.
Nous utilisons donc le processus ChannelExtraction dans son mode RVB par défaut sélectionné
sous Color Space, avec seulement G et B sélectionnés sous Channels / Target Images. Nous
cliquons sur Appliquer avec l'image couleur sélectionnée.

Les canaux vert et bleu ont été extraits sous forme d'images monochromes séparéees, appelées
HAR_G B G et HAR_G_B_B dans mon cas (puisque l'image couleur est appelée HAR_G_B). Ci-
dessus, ces images extraites sont montrées en mode auto-étiré. Nous les mettons de c6té et
ouvrons le processus PixelMath, en nous assurant de cliquer sur son bouton Reset avant de
commencer. Une fois de plus, nous sélectionnons Create new image sous Destination and Grayscale
de Color space. Dans les zones de texte RGB/K et Symboles, nous entrons :

rvb/k : (( Olll * G_bandwidth) - (G * Olll_bandwidth)) / (G_bandwidth - Olll_bandwidth)
Symboles : G_bandwidth=100, Olll_bandwidth=8,5

Ci-dessus, jai remplacé G par le nom réel de mon image extraite du canal vert - HAR_G_B_G. Les
nombres entrés pour G_bandwidth et Olll_bandwidth correspondent a nouveau aux largeurs de
bande des filtres en nanometres. Nous pouvons a nouveau commencer par dire que la largeur de
bande G est de 100 alors que la valeur de la largeur de bande Olll est de 8,5 car le filtre utilisé pour
capturer cette image était un filtre Baader Oxygen-lll de 8,5 nm. Lorsque nous sommes préts, nous
cliquons sur Apply in PixelMath pour créer une nouvelle image combinée de Green et d'Oxygen-llil.

Comme auparavant, nous pouvons supprimer plus d'étoiles et de continuum en diminuant
simplement la valeur de la bande passante G. Dans ce cas, cependant, 40 était beaucoup trop faible
et a supprimé beaucoup de nébulosité a gauche de I'image en particulier. Un bien meilleur résultat
final a été obtenu avec une valeur de G_bandwidth de 60.

Un résultat satisfaisant ayant été obtenu, nous avons renommeé cette nouvelle image CombG, 'avons
mise de c6té et avons procédé de la méme maniére pour l'image Blue channel extraite. De méme,
nous entrons ce qui suit dans les zones de texte RGB/K et Symboles :

rvb/k : (( Olll * B_bandwidth) - (B * Olll_bandwidth) / (B_bandwidth - Olll_bandwidth)
Symboles : B_bandwidth=100, Olll_bandwidth=8,5

Ci-dessus, j'ai changé B pour HAR_G_B B - le nom de mon image extraite de la chaine bleue. La
encore, une expérimentation avec la valeur fixée pour B_bandwidth a donné le meilleur résultat pour
une valeur de 70.

Avec un autre résultat satisfaisant créé, nous renommons cette nouvelle image CombB, nous la
mettons de c6té et nous fermons les images extraites des canaux vert et bleu, nous fermons 'image
originale Oxygen-IIl et nous cliquons sur le bouton Reset dans PixelMath.
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Afin d'appliquer les améliorations a notre image couleur, nous devons désactiver I'option Utiliser une
seule expression RGB/K dans PixelMath. Nous entrons maintenant ce qui suit dans les zones de
texte R/K, G, B et Symboles :

R/IK : $T

G : $T + ((CombG - Med(CombG)) * BoostFactor)
B : $T + ((CombB - Med(CombB)) * BoostFactor)
Symboles : BoostFactor = 1,0

CombG et CombB correspondent & mes noms d'images combinés Vert et Bleu. Les votres peuvent
différer, modifiez donc les expressions PixelMath en conséquence. Comme précédemment, il nous
suffit d'appliquer le processus PixelMath a I'image couleur en sélectionnant d'abord I'image puis en
cliguant sur Appliquer (ou en faisant glisser le bouton New instance de PixelMath sur limage
couleur).

Avec les améliorations de I'Oxygene-lll appliquées aux canaux Vert et Bleu, nous neutralisons a
nouveau l'arriere-plan. Pour cela, nous créons une petite boite de prévisualisation sur le seul espace
du fond (pas de nébulosité ni d'étoiles), nous ouvrons le processus BackgroundNeutralization, nous
sélectionnons la boite de prévisualisation dans la liste sous Image de référence et nous l'appliquons
a l'image RVB en couleur. La réapplication de l'autostretch donne le résultat modifié.

Le résultat semble maintenant meilleur. Encore une fois, veuillez garder a I'esprit qu'il est inutile
d'utiliser le processus ColorCalibration maintenant, car il annulera une grande partie des
améliorations apportées jusqu'a présent. BackgroundNeutralization est tout ce dont nous avons
besoin. A ce stade, si vous étes satisfait de votre résultat, vous pouvez fermer les images combinées
gue nous avons créées precédemment (les miennes sont appelées CombG et CombB), supprimer la
boite de prévisualisation et enregistrer les modifications apportées a votre image RVB. Si vous
souhaitez améliorer davantage (ou moins) les canaux vert et bleu, il vous suffit d'annuler les
modifications apportées a I'image RVB, de modifier la valeur de BoostFactor dans PixelMath et de
réappliquer le processus et de refaire BackgroundNeutralization.

Ci-dessous, vous trouverez une comparaison avant et apres de limage en couleur. L'image de
gauche est avant et I'image de droite est apres (H-Alpha et Oxygéne-Ill améliorés).

N'oubliez pas que l'amélioration apportée peut étre ajustée a chaque étape avec le parametre
BoostFactor. L'image couleur est encore linéaire a ce stade, ce qui permet a l'utilisateur de
poursuivre le post-traitement comme il le ferait normalement. L'image couleur peut étre post-traitée
seule ou combinée plus tard avec une image de luminance, post-traitée séparément.
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4. Combinaison de la luminance et de I'H-Alpha

Parfois, nous voulons nous assurer que Luminance bénéficie également de la contribution des
données a bande étroite. Méme si nous ne nous donnons pas la peine d'améliorer le canal rouge
avec H-Alpha, la combinaison de la luminance avec H-Alpha fournit une contribution lumineuse
supplémentaire des régions nébuleuses H-Alpha. Cela signifie que lorsque I'on combine l'image de
luminance améliorée avec une image couleur plus tard dans le post-traitement, les émissions d'H-
Alpha sont davantage mises en évidence et éclaircies. La raison principale pour laquelle cette
opération est réalisée uniqguement avec le filtre H-Alpha est le fait que la plus grande partie de
l'univers visible est constituée d'hydrogéne, ce qui signifie qu'un filtre H-Alpha produira presque
toujours la plus grande quantité de données et fournira donc la plus grande contribution.

Comme l'image de luminance est naturellement monochrome telle quelle, nous n'avons pas besoin
d'extraire quoi que ce soit. Nous ouvrons simplement nos images Luminance et H-Alpha, comme
indiqué ci-dessous en mode auto-extensible.

Nous utilisons a nouveau le procédé PixelMath pour effectuer la combinaison. Commencez par
cliquer sur le bouton Réinitialiser, puis sélectionnez Créer une nouvelle image sous Destination et
Niveaux de gris sous Espace couleur. Dans les zones de texte RGB/K et Symboles, entrez ce qui
suit :

RGB/K : ((HA * L_bandwidth) - (L * HA_bandwidth)) / (L_bandwidth - HA_bandwidth)
Symboles : L_bandwidth=300, HA bandwidth=7

Comme mes images Luminance et H-Alpha sont appelées respectivement L et HA, je les garde telles
guelles. Notez que comme la largeur de bande d'un filtre Rouge, Vert ou Bleu est d'environ 100nm,
celle d'un filtre de Luminance est donc d'environ 300nm, d'ou la raison pour laquelle nous entrons
300 pour la largeur de bande L_. Encore une fois, comme cette image a été capturée en utilisant un
filtre Baader H-Alpha 7nm, nous entrons 7 pour la bande passante HA. Nous cliquons sur Apply in
PixelMath et notre nouvelle image apparait, représentée ci-dessous en mode auto-extensible.

A ce stade, nous souhaitons & nouveau produire une image qui laisse de cété la plupart des étoiles
et du continuum. Comme vous pouvez vous en douter, nous devons simplement ajuster la valeur de
la largeur de L_bandwidth jusqu'a ce que nous obtenions un bon résultat. Dans mon cas, 40 était en
fait une bien meilleure valeur. Ne vous inquiétez pas de fixer une valeur aussi basse pour la
luminance - tant que vous obtenez un résultat comme celui ci-dessous, cela fonctionnera bien.

Nous pouvons maintenant fermer l'image originale Hydrogene-Alpha et cliquer sur Réinitialiser dans
PixelMath. Comme l'image de Luminance est monochrome, nous conservons tous les parametres
par défaut dans PixelMath, sauf que nous saisissons ce qui suit dans les zones de texte RGB/K et
Symboles :

RGB/K : $T + ((Comblmg - Med(Comblmg)) * BoostFactor)

Symboles : BoostFactor = 1,0
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Ci-dessus, jai modifiée Comblmg en Imagel0O, le nom de mon image nouvellement créée. Pour
effectuer I'amélioration, il suffit de cliquer sur Apply in PixelMath alors que l'image Luminance est
sélectionnée, ou de faire glisser le bouton New Instance de PixelMath sur lI'image Luminance. Il est
nécessaire de réappliquer I'étirement automatique pour voir I'image Luminance améliorée telle qu'elle
est réellement.

L'amélioration qui en résulte est tres claire car beaucoup de nébulosité environnante est mise en
évidence et éclaircie. Les nébulosités brillantes sont également renforcées par le contraste. La
encore, le parameétre BoostFactor joue un role majeur dans le degré d'amélioration appliqué. A ce
stade, si vous étes satisfait de votre résultat, vous pouvez fermer l'image combinée que nous avons
creée précédemment (la mienne s'appelle Imagel0Q) et enregistrer les modifications apportées a
votre image de luminance. Si vous souhaitez améliorer davantage (ou moins) I'image de luminance,
il vous suffit d'annuler les modifications apportées, d'ajuster la valeur du BoostFactor dans PixelMath
et de réappliquer le processus.

Le tableau ci-dessous montre une comparaison avant et aprés de l'image de luminance. L'image de
gauche est avant et I'image de droite est apres (H-Alpha amélioré avec une valeur de BoostFactor de
0,75).

Il est évident que dans les cibles ou il n'y a pas de zones aussi claires que le coeur de cette
nébuleuse, I'effet est encore plus prononcé et bénéfique. Nous pouvons cependant voir clairement
les avantages le long des zones de faible luminosité environnantes. L'image a luminance améliorée
peut étre post-traitée seule pour étre ensuite combinée avec une image en couleurs, que cette image
en couleurs ait été ameéliorée ou non avec des données a bande étroite.
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XXI.  Exemple : M31 Andromeda Galaxy - DSLR

Ce tutoriel est un exemple de post-traitement d'une image de la galaxie d’Andromede M31 capturée
avec un appareil photo DSLR. L'image est donc une image One Shot Colour (OSC). L'image
entierement prétraitée (ce tutoriel) utilisée ici comme exemple de post-traitement a été fournie par un
ami, Gordon Barrett. C'est donc a lui que revient tout le mérite de l'image. Voici les données
techniques de l'image fournie :

Montage : Skywatcher NEQG6 Pro

Télescope : Celestron C11 XLT SCT avec Starizona Hyperstar Il

Cameéra d'imagerie : Canon EOS 600D DSLR (Full Spectrum Mod)

Filtres : Hutech IDAS LPS D1

Cameéra d'autoguidage : Aucune

Logiciels : Backyard EOS, PHD2 et PixInsight

Détails de I'exposition : 151 x 30 secondes a I''SO800 a partir d'une zone rouge de pollution
lumineuse

Comme pour tous les exemples de post-traitement, le tutoriel est assez autonome dans ses
explications, mais il est préférable que le lecteur ait une idée des concepts impligués dans l'utilisation
de certains des processus et scripts de PixInsight. Vous trouverez ci-dessous une liste compléte
avec des liens vers d'autres tutoriels pour une lecture plus approfondie.

Pré-supposeé pour ce tutoriel :

e Connaissance du fonctionnement de Pixinsight, en rapport avec le traitement des images,
des processus et des masques (Lire ce qui suit, sections 3, 4 et 6).

e Votre image a déja été entierement prétraitée (Lire ceci).

e Une connaissance préalable du recadrage avec DynamicCrop est avantageuse (Lire ceci,
section 1).

« Des connaissances préalables sur [‘élimination de la pollution lumineuse avec
DynamicBackgroundExtraction sont avantageuses (Lire ce qui suit, sections 1 et 2).

e Des connaissances préalables en matiére de calibrage des images sont avantageuses (Lire
ce qui sulit).

» Des connaissances préalables sur I'étirement d'images linéaires en images non linéaires avec
HistogramTransformation sont avantageuses (Lire ce qui suit, section 3).

» Des connaissances préalables sur la production de masques sont avantageuses (Lire ce qui
suit).

» Des connaissances préalables en matiere de réduction du bruit sont avantageuses (Lire ce qui
suit).

o Des connaissances préalables sur l'affinage de détails fins avec MultiscaleLinearTransform
sont avantageuses (Lire ce qui suit, section 2).
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e Une connaissance préalable de l'amélioration du contraste des caractéristiques est
avantageuse (Lire ceci).
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1. Découper les bordures noires et les coins
lumineux, et supprimer les lueurs de pollution
lumineuse

Nous commencgons avec notre image ouverte et auto-étirée dans PixInsight.

Il y a déja quelques détails visibles, ce qui est de bon augure pour notre résultat final. Néanmoins,
nous devons supprimer la lueur de la pollution lumineuse, mais avant cela, nous devons éliminer les
bords noirs présents. Ceux-ci sont le résultat d'un prétraitement qui consiste a aligner les images les
unes par rapport aux autres pour les empiler. Nous utiliserons le processus DynamicCrop pour
recadrer les bords noirs. Il suffit d'ouvrir le processus, de cliquer sur Reset pour l'initialiser, de faire
glisser les bords vers lintérieur pour exclure les bords noirs, puis de cliquer sur Execute pour
effectuer le recadrage. Il peut étre utile de faire un zoom arriere d'une étape afin de pouvoir faire
glisser les bords vers l'intérieur. Il peut étre utile par la suite de faire un zoom avant pour voir si vous
avez completement exclu les bords noirs.

Les bords noirs étant maintenant supprimeés, nous procédons a I'élimination de la lueur de pollution
lumineuse avec DynamicBackgroundExtraction. Nous ouvrons le processus et cliquons sur Reset
pour l'initialiser sur notre image.

Il est normalement préférable de laisser DynamicBackgroundExtraction placer automatiquement des
points d'échantillonnage car cela nous fait gagner du temps, surtout lorsque l'image comporte une
quantité importante de fond. Comme il s'agit d'une image DSLR et qu'en plus elle a été drizzlé
pendant le prétraitement, la taille de I'image est énorme, 10 404 x 6 930 pixels. Par conséquent,
nous devons définir un rayon d'échantillonnage par défaut assez large. 15 est généralement une
bonne valeur, mais pour des images de cette taille, on peut généralement aller jusqu'a 20 sans
probléme. Afin de mieux échantillonner le fond, nous augmentons le nombre d'échantillons par ligne
a 15. Comme le fond est assez lumineux en |'état, une valeur de Tolérance de 0,500 ajoutera
automatiguement un nombre de points d'échantillonnage proche de zéro. Par conséquent, nous
augmentons cette valeur a 1,500. Une fois cela fait, nous cliquons sur le bouton "Générer" pour
placer automatiquement des points d'échantillonnage.

Il ne faut jamais avoir de points d'échantillonnage au-dessus des étoiles ou de la nébulosité, donc
nous devons parcourir I'image pour enlever les points d'échantillonnage qui sont placés au-dessus
des zones contenant des étoiles ou de la nébulosité. Si vous pensez qu'il y a de la nébulosité en
dessous d'un point de prélevement (mais vous pouvez a peine le dire en raison de la luminosité
excessive), il suffit de déplacer le point de prélevement hors du chemin. Si vous n'étes pas du tout
sar, vous pouvez toujours appliquer la méthode DynamicBackgroundExtraction et si vous constatez
gu'un point de prélevement se trouvait effectivement au-dessus d'une étoile ou d'une nébulosité,
VOUS pouvez revenir en arriere et retirer ou déplacer le point de prélévement, avant d'appliquer a
nouveau le processus.

Ci-dessous, jai supprimé quelques points d'échantillon (en cliquant dessus et en appuyant sur la

touche DEL de mon clavier), j'en ai ajouté dle nouvealljx (en cliguant sur I'image) et j'en ai déplacé
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certains (en cliquant et en les faisant glisser). Je me suis assuré qu'aucune ne se trouvait au-dessus
d'une étoile, aussi petite soit-elle, et j'ai laissé le centre de I'image et la zone que je m'attends a voir
couverte par la galaxie d'Andromede M31 sur toute I'image, sans aucun point d'échantillonnage.

Tous les points d'échantillonnage actuellement dans mon image sont gris, ce qui signifie qu'ils sont
acceptés par la valeur de tolérance fixée. L'idéal serait cependant d'utiliser la valeur de tolérance la
plus basse possible (sans descendre en dessous de sa valeur par défaut de 0,500 environ).
Essayons de la diminuer jusqu'a ce que nous obtenions des points d'échantillon rejetés (ils
deviendront rouges). J'abaisse ma valeur de tolérance a 1,250 et je clique sur Redimensionner tout
pour vérifier. Ne cliquez pas sur Générer car cela annulera votre travail de placement manuel des
points d'échantillonnage.

Il est clair qu'aucun de mes points d'échantillon n'est rejeté (carrés rouges), donc cette valeur de
Tolérance est meilleure. Lorsque j'ai essayé 1.000, plusieurs des points d'échantillon dans le coin
supérieur gauche sont devenus rouges, donc ils ont été rejetés. Par conséquent, je maintiens ma
valeur de tolérance a 1,250. Vous pouvez l'affiner davantage, mais ce n'est pas essentiel. Effectuez
une derniere vérification de votre image, ajoutez quelques points d'échantillon supplémentaires si
vous le souhaitez, déplacez d'autres points, etc. Une fois que vous étes satisfait, sélectionnez
Soustraction dans la liste Correction et n'hésitez pas a activer I'option Rejeter le modele d'arriére-
plan si vous ne souhaitez pas que DynamicBackgroundExtraction vous montre ce qui a été soustrait
(ainsi que votre résultat final). Si vous souhaitez voir I'image soustraite, laissez simplement cette
option désactiveée (comme par défaut). Une fois cette option définie, cliquez sur le bouton Exécuter
pour supprimer la lueur de pollution lumineuse.

L'image a maintenant sa lueur de pollution lumineuse soustraite, montrant qu'une énorme quantité de
détails était cachée en dessous, comme le montre le résultat autostretched ci-dessus. Nous pouvons
maintenant fermer le processus DynamicBackgroundExtraction ainsi que l'image originale.

Avant de poursuivre, nous remarquons que l'image nouvellement soustraite du fond montre une
bande lumineuse étrange sur le c6té droit et une certaine lueur dans le coin supérieur gauche. Bien
gque nous puissions essayer de supprimer la lueur du coin supérieur gauche avec
DynamicBackgroundExtraction, il n'y a pas grand chose a gagner ici. De plus, la discontinuité de la
bande sur le c6té droit n'est pas facile a traiter, et cette zone de limage n'ajoute rien dans
I'ensemble. Par conséquent, nous pouvons effectuer un recadrage supplémentaire sur lI'image pour
exclure ces zones génantes. Le processus de choix est a nouveau DynamicCrop, donc nous
I'ouvrons.

Au lieu de cliquer sur son bouton Reset, nous pouvons simplement faire glisser une zone
sélectionnée sur notre image. Si nous cliquons sur le bouton Reset, nous devrons faire glisser
chacun des cotés vers l'intérieur pour exclure les zones que nous voulons recadrer. Parfois, le simple
fait de faire glisser une zone sélectionnée sur l'image est plus rapide. Vous pouvez toujours modifier
la zone sélectionnée créée par glissement, en faisant glisser les cétés ou les coins vers l'intérieur ou
vers I'extérieur. Une fois que nous sommes satisfaits de la zone sélectionnée, nous cliquons sur le
bouton Exécuter.
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Une fois effectuée, nous fermons le processus DynamicCrop. Le résultat ci-dessus conserve toutes
les caractéristiques importantes de l'image tout en excluant les zones d'arriere-plan génantes.

2. Effectuer I'étalonnage des couleurs et la réduction
initiale du bruit

Le fait que l'image ait été capturée avec une caméra One Shot Colour (OSC) ne signifie pas qu'elle
n'a pas besoin d'une procédure de calibrage des couleurs. Nous commencons cette procédure en
créant des boites de prévisualisation adéquates sur l'image. L'une doit étre liée a l'arriere-plan et une
autre doit contenir un grand nombre d'étoiles (y compris la galaxie, de préférence). La fenétre de
prévisualisation de l'arriere-plan ne doit pas étre trés grande et ne doit absolument pas contenir
d'étoiles. Il est utile de faire un zoom avant important pour choisir une zone dépourvue de tout intérét
et montrant un échantillon moyen de ce a quoi ressemble l'arriere-plan de l'image.

Au-dessus, la petite boite de prévisualisation ne contient que le fond alors que la tres grande boite
de prévisualisation contient nos galaxies et la plupart des étoiles de I'image. Le premier procédé que
nous utilisons est BackgroundNeutralization. Dans ce procédé, nous sélectionnons simplement la
boite de prévisualisation de l'arriere-plan (dans mon cas, appelée Preview01) et nous cliquons sur le
bouton Appliquer aux paramétres par défaut. Apreés avoir appliqué le processus, vous devrez peut-
étre appliquer & nouveau votre autostretch, car les modifications apportées a l'arriere-plan peuvent
affecter gravement votre vision de limage. Ne vous inquiétez pas, en appliguant a nouveau
l'autostretch dans PixInsight, vous pourrez a nouveau voir les détails, avec un arriere-plan plus
neutre (comme prévu).

Nous fermons maintenant le processus de neutralisation de l'arriere-plan et ouvrons le processus
ColorCalibration, qui fera lI'essentiel du travail. Dans ce processus, nous sélectionnons notre grande
boite de prévisualisation englobant de nombreuses étoiles dans la liste sous Référence blanche
(pour moi, Preview02) et nous sélectionnons notre petite boite de prévisualisation de l'arriere-plan
dans la liste sous Référence du fond (pour moi, Preview01). Les parametres par défaut fonctionnent
tres bien ici, nous n‘avons qu'a appliquer le processus a limage. Encore une fois, vous devrez
probablement réappliquer votre autostretch PixInsight pour avoir un bon apercu du résultat final.

Les boites de prévisualisation peuvent maintenant étre supprimées car nous n'en avons plus besoin.
Cela se fait rapidement par le menu Preview -> Delete All. Le processus de calibrage des couleurs
peut également étre fermé. Enfin, nous utilisons maintenant le processus de la SCNR pour supprimer
I'habituelle dominante verte qui apparait dans les images. Ce processus est extrémement simple a
utiliser, car en fait les parameétres par défaut fonctionnent parfaitement bien dans la grande majorité
des cas. Il suffit d'ouvrir le processus de la SCNR et de cliquer sur le bouton "Appliquer". Vous
pouvez ensuite fermer la SCNR. Encore une fois, vous devrez probablement réappliquer l'autostretch
PixInsight pour voir vraiment le résultat final.

hY

L'image étant maintenant calibrée en couleur, nous allons maintenant procéder a une premiere
réduction du bruit. 1l faut cibler les zones a faible signal (fond) plus que les zones a signal élevé
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(galaxies et étoiles). Nous devons donc utiliser un masque. Un bon type de masque a utiliser dans
ce scénario est une image de luminance de notre image elle-méme. Avant d'extraire une image
Luminance, nous devons d'abord indiquer a Pixlnsight que les trois canaux de couleur (Rouge, Vert
et Bleu) doivent contribuer a la Luminance de maniere égale. Pour cela, nous utilisons le processus
RGBWorkingSpace. |l suffit de régler les trois, Rouge, Vert et Bleu, sur 1.000000 et de cliquer sur le
cercle Apply Global . Une fois que vous avez terminé, fermez le processus RGBWorkingSpace.

Pour effectuer I'extraction de l'image de luminance, nous utilisons le procédé ChannelExtraction.
Nous mettons ce processus en mode CIE L*a*b* et désactivons a et b (les canaux de chrominance),
en ne laissant que L activé. Nous appliquons ensuite le processus a notre image.

Ci-dessus, limage de luminance extraite, auto-étirée a des fins de démonstration. Nous pouvons
maintenant fermer le processus ChannelExtraction. Nous devrions également supprimer ['auto-
étirement de limage de luminance extraite. Au lieu d'un étirement automatique, nous devons étirer
I'image de luminance. C'est important car I'image agit comme une carte des zones sombres et des
zones claires et fonctionnera donc parfaitement comme un masque (protégeant davantage les zones
claires que les zones sombres).

L'étirement automatique est un bon étirement a appliquer a limage de luminosité, mais il doit étre
appligué de facon permanente, plutét que visuellement comme le fait I'étirement automatique. Pour
cela, nous ouvrons les processus ScreenTransferFunction et HistogramTransformation. Cliquez sur
Reset sur les deux afin que, par défaut, ils soient activés. Pour appliquer un étirement automatique a
limage Luminosité, nous cliquons sur le bouton Etirement automatique de la fonction
ScreenTransferFunction lorsque l'image de Luminance est sélectionnée. Nous pouvons maintenant
transférer les parametres d'étirement automatique a HistogramTransformation, qui se chargera de
'appliquer de maniere permanente. Pour ce faire, faites glisser le bouton New Instance de
ScreenTransferFunction sur la barre inférieure de HistogramTransformation (entre les sept boutons
du bas). Une fois déposé a cet endroit, HistogramTransformation affichera une courbe plutoét qu'une
ligne droite.

Nous cliguons maintenant sur le bouton "Reset" de ScreenTransferFunction et le fermons. Cela
supprimera I'étirement automatique, mais HistogramTransformation est maintenant prét a appliquer
le méme étirement, mais de facon permanente. Pour ce faire, il suffit de I'appliquer a l'image de
luminance. Vous pouvez fermer HistogramTransformation a ce stade.

L'image du masque étant maintenant préparée, nous I'appliguons comme un masque a notre image
originale. Cela se fait par le menu Mask -> Select Mask (ou appuyer sur la touche CTRL M de votre
clavier) et en sélectionnant I'image de luminance dans la liste.

Par défaut, le masque ci-dessus protége l'arriére-plan et non les galaxies et les étoiles, nous devons
donc l'inverser. Pour ce faire, utilisez le menu Mask -> Invert Mask (ou appuyez sur la touche CTRL
MAJ | de votre clavier).

Nous pouvons maintenant appliquer la réduction du bruit & volonté. Le processus de choix a ce stade
est MultiscaleLinearTransform. Comme le bruit est principalement a petite échelle, nous pouvons
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nous en sortir en l'appliquant uniguement aux quatre premiéres couches d'ondelettes. Les DSLR
sont intrinsequement bruyants, donc l'appliquer de maniére un peu agressive a la premiere couche
d'ondelettes est une bonne idée. Cependant, cette image est composée de 151 expositions et est
donc moins bruyante que d'habitude.

Pour utiliser MultiscaleLinearTransform pour la réduction du bruit, nous gardons les Couches réglées
sur 4 (car nous n'avons pas besoin de couches d'ondelettes plus grandes), nous sélectionnons les
Couches 1 a 4 et nous activons la Réduction du bruit dans chaque cas. Comme le bruit est
principalement contenu dans la premiere couche d'ondelettes, c'est la que nous devrions étre les
plus agressifs. Par conséquent, je vais régler le seuil a 4.000 et les itérations a 3 ici. Cependant, le
montant sera réduit a 0,50. Cela permettra de mélanger 50% de l'image originale avec 50% de
I'image réduite en bruit, ce qui donnera un résultat plus lisse. Pour la couche 2, je fixe le seuil a 2.000
et les itérations a 2. Pour la couche 3, je fixe le seuil a 1.000 et les itérations a 2. Pour la couche 4, je
fixe le seuil a 0.500 et les itérations a 1. Dans tous les cas, Amount a été fixé a 0.50.

Il nous suffit maintenant de cliquer sur Appliquer sur MultiscaleLinearTransform, avec notre image
originale sélectionnée (et le masque actif), pour effectuer la réduction du bruit. Vous pouvez cacher
le masque par le menu Mask -> Show Mask (ou appuyer sur CTRL K sur votre clavier). Cela
permettra d'activer et de désactiver la visibilité du masque, tout en le gardant actif et en lui
permettant de faire son travail. Le tableau ci-dessous montre l'effet de la réduction du bruit ci-dessus,
avec le masque masqué.

La réduction du bruit est la bienvenue car elle atténue le bruit a petite échelle, davantage sur le fond
gue sur les galaxies et les étoiles. Elle n'est pas non plus excessive en termes de quantité de
réduction, ce qui donne un bruit de fond plus lisse qui n'est pas artificiellement lisse. Aprées tout, nous
voulons réduire le bruit et non [Iéliminer. Une fois cela fait, vous pouvez fermer
MultiscaleLinearTransform. Vous pouvez également supprimer le masque de votre image par le
menu Mask -> Remove Mask et fermer I'image de luminance sans l'enregistrer.

3. Aller vers une reduction non linéaire et plus
poussee du bruit

Notre post-traitement arrive maintenant au stade ou nous quittons I'état linéaire pour entrer dans
I'état non linéaire, en étirant I'image. Il existe de nombreux procédés capables d'effectuer cette tache,
mais je vais utiliser a ce stade ma méthode préférée, HistogramTransformation. Tout d'abord, nous
supprimons  l'étirement  automatique de notre  image. Ensuite, nous  ouvrons
HistogramTransformation, cliquons sur son bouton Reset, sélectionnons limage dans la liste et
activons la fenétre de prévisualisation en temps réel.

Nous déplagons maintenant le curseur des tons moyens sur HistogramTransformation vers la
gauche pour effectuer un étirement. L'histogramme qui résulterait de I'étirement est affiché sur le
graphique du haut, tandis que le graphique du bas affiche I'état actuel de I'histogramme. Vous
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pouvez zoomer sur le graphique du bas a l'aide de la molette de la souris pour ajuster le curseur des
tons moyens de plus pres.

Une fois que vous étes satisfait de I'étirement, cliquez sur le bouton Appliquer. Veillez a cliquer sur le
bouton Reset immédiatement aprés, sinon la fenétre d'apercu en temps réel vous montrera a quoi
ressemblerait votre image si vous appliguiez a nouveau le méme étirement (sans doute
complétement blanche !).

Votre premier étirement peut étre important, mais ce n'est pas forcément la fin. Vous pouvez vouloir
étirer une ou deux fois de plus, mais évidemment de maniére beaucoup moins agressive. Apres
chaque étirement, assurez-vous de veérifier le point noir. Normalement, il est un peu élevé, ce qui
augmente la luminosité de votre arriére-plan et réduit le contraste des éléments importants. Pour
régler le point noir, déplacez le curseur du point noir vers la droite. Faites bien attention aux chiffres
affichés par les ombres en bas. Cela correspond au nombre de pixels coupés en noir (supprimés en
les mettant en noir, effectivement). Le pourcentage est lié€ au nombre de pixels de I'image entiére.
N'hésitez pas a noircir certains pixels, mais je ne dois généralement jamais dépasser 0,005% pour
obtenir un bon résultat. Pour votre réglage initial du point noir, il se peut que vous n'ayez pas besoin
de découper en noir un quelconque pixel.

Encore une fois cliquez sur Apply, cliguez également sur Reset afin d'obtenir une vue réaliste de
I'état actuel de votre image. Il ressort clairement de mon histogramme et de I'apercu de l'image que
I'image peut se préter a un second étirement (moins agressif). Pour ce faire, il suffit de déplacer le
curseur des tons moyens vers la gauche. En général, le pic de I'histogramme doit étre situé a environ
1/4 de la hauteur du graphique. Ceci tend a fournir le meilleur contraste dans vos images. Avec un
deuxieme étirement, un deuxiéme ajustement du point noir peut étre nécessaire, ce qui peut cette
fois-ci réduire certains pixels au noir (mais pas beaucoup du tout !). Vous pouvez ajuster le point noir
en méme temps que vous effectuez un étirement.

Une fois que vous étes satisfait de I'état non linéaire de votre image, vous pouvez fermer le
processus HistogramTransformation et sa fenétre de prévisualisation en temps réel.

Une réduction supplémentaire du bruit peut étre appliquée lorsque l'image est dans son état non
linéaire. La encore, nous aurons besoin d'un masque approprié. Puisque l'image est déja non
linéaire, nous n'‘avons pas besoin de faire ce que nous faisions auparavant. Nous allons cependant
extraire une nouvelle image de luminance en utilisant le procédé ChannelExtraction. Vous n'avez pas
besoin d'utiliser a nouveau le processus RGBWorkingSpace si vous n‘avez pas fermé PixInsight,
car les parameétres seront toujours les mémes. Dans ChannelExtraction, assurez-vous a nouveau
que vous sélectionnez le mode CIE L*a*b*, en désactivant a et b et en laissant seulement L activé.
Appliquez ceci a I'image elle-méme.

Le processus ChannelExtraction peut maintenant étre clos. Nous allons en effet permettre a
HistogramTransformation de couper automatiquement les ombres et les hautes lumiéres, ce qui
apportera beaucoup plus de contraste a I'image luminance (utile pour servir de masque !). Pour cela,
ouvrez le processus HistogramTransformation, cliquez sur son bouton Reset, sélectionnez l'image
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luminance dans la liste et cliquez sur les boutons Auto clip shadows et Auto clip highlights. Une fois
terminé, cliquez sur Apply avec l'image luminance sélectionnée.

Vous pouvez maintenant fermer HistogramTransformation. Ce qui précede constitue un excellent
masque car il nous permet vraiment d'attaquer le fond pour une réduction du bruit. Appliquez cette
image luminance comme masque a votre image, par le menu Mask -> Select Mask (ou appuyez sur
la touche CTRL M de votre clavier) et sélectionnez-la dans la liste. Vous devrez inverser le masque
une nouvelle fois, via le menu Mask -> Invert Mask (ou appuyez sur CTRL SHIFT | de votre clavier).

Le processus de choix est une fois de plus MultiscaleLinearTransform, puisqu'elle permet un si bon
contréle de la réduction du bruit sur les différentes couches d'ondelettes. Cependant, comme nous
avons appliqué ce processus plus tdt, nous devons étre moins agressifs a son égard maintenant.
Dans cette optique, je maintiens la quantité pour les quatre plus petites couches d'ondelettes a 0,50
mais je réduis le seuil & 3.000 pour la premiere couche d'ondelettes. Je change également les
itérations a 2, 2, 1 et 1 (pour chaque couche d'ondelettes respective).

Cliquez sur Apply une fois le réglage effectué, ce qui réalisera la réduction de bruit supplémentaire
sur votre image. Veillez & ce gu'elle ne soit pas trop agressive, car nous ne voulons pas nous
retrouver avec un bruit de fond atténué. Une fois que vous avez terminé, fermez
MultiscaleLinearTransform et ouvrez ACDNR - notre prochain processus de réduction du bruit.
L'’ACDNR ne fonctionne pas vraiment sur les images linéaires mais peut faire des merveilles sur les
images non linéaires en termes de suppression du bruit a petite échelle. Bien que les paramétres par
défaut fonctionnent généralement bien, j'aimerais cibler un bruit légerement plus important que celui
par défaut, donc jaugmente StdDev a 2.0. J'ai réglé Amount a 0,75 pour gu'il mélange 75 % de
I'image réduite en bruit avec 25 % de l'image originale, ce qui donne un résultat final plus lisse. Le
reste des réglages fonctionne bien, les itérations laissées a 3 étant suffisantes car nous n‘avons plus
beaucoup de bruit a gérer. Sous I'onglet Chrominance, nous laissons les parameétres par défaut car
ils sont bons. Je maintiens définitivement la réduction du bruit de chrominance via ACDNR activée
car elle aide a réduire le bruit de couleur en arriere-plan. Une fois que tout est réglé, cliquez sur

Apply.

Une fois la réduction du bruit appliquée, nous pouvons fermer ACDNR et supprimer le masque de
notre image via le menu Mask -> Remove Mask. Vous pouvez également fermer l'image luminance
sans l'enregistrer.

Apres la réduction du bruit a I'état non linéaire, en particulier aprés avoir utilisé ACDNR, il est utile de
vérifier I'histogramme de l'image avec HistogramTransformation et d'appliquer un ajustement si
nécessaire. Normalement, un ajustement du point noir est nécessaire. Cela peut étre accompagné
d'un étirement treés, trés mineur pour augmenter le contraste global.

Etant satisfait du petit ajustement apporté a I'histogramme de I'image, je clique sur Apply, puis je
ferme a la fois le processus HistogramTransformation et sa fenétre de prévisualisation en temps réel.
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8. 4. Réduire la couleur et le contraste du fond de ciel

L'image est maintenant non linéaire et a bénéficié d'une bonne réduction du bruit. Le contraste est
élevé, mais l'idéal serait que l'arriere-plan soit plus sombre par rapport a la cible, ce qui la rendrait
plus visible. Le bruit de fond est également coloré. Nous allons maintenant aborder ces questions.
Comme nous voulons réduire la couleur et le contraste de l'arriere-plan uniguement, nous aurons
besoin d'un masque pour protéger ce qui compte - les galaxies et les étoiles. RangeSelection peut
fournir un excellent masque a ce stade, c'est pourquoi nous ouvrons ce processus. Vous devrez
travailler avec son apercu en temps réel, alors assurez-vous de l'activer. Sous Fuzziness, j'entre
généralement 0,15 et sous Smoothness, j'entre généralement 5,00. Cela donne un peu de flou a
I'image du masque, ce qui rend les transitions plus fluides. Pour produire votre image de masque, il
suffit de faire glisser lentement le curseur Limite inférieure vers la droite jusqu'a ce que l'arriere-plan
soit exclu (noir) et que les étoiles et les éléments intéressants soient pour la plupart blancs.

Le processus qui consiste a exclure l'arriere-plan tout en incluant les objets intéressants est toujours
un compromis. Il est difficile d'inclure dans le masque des objets qui sont a peine au-dessus du fond
sans inclure également des tonnes de bruit de fond, ce qui est indésirable. L'image ci-dessus montre
un bon compromis pour cette image. Les zones qui sont presque saturées sont naturellement
exclues du masque, comme le noyau de la galaxie et les noyaux d'étoiles brillantes. Nous pouvons
cependant modifier cela maintenant. Une fois que vous étes satisfait de vos parametres de sélection,
cliquez sur Apply, puis fermez le processus et sa fenétre de prévisualisation en temps réel. Votre
nouveau masque de portée est maintenant prét.

Pour modifier le masque , nous pouvons utiliser le processus CloneStamp. Ce procédé nous permet
de copier une zone de l'image et de peindre une autre zone avec. L'idée est de copier une zone
blanche du masque de portée et de peindre par-dessus le noyau et les noyaux d'étoiles brillantes
afin que ceux-ci soient également protégés de notre post-traitement. Ouvrez le processus
CloneStamp et, Iimage du masque étant sélectionnée, cliquez sur son bouton Reset pour l'initialiser.
Je regle généralement le rayon sur une valeur beaucoup plus grande, par exemple 30 a 50. Les
autres reglages fonctionnent bien. Cliquez simplement sur une zone blanche de votre image de
masque de portée tout en maintenant la touche CTRL de votre clavier enfoncée, puis n‘hésitez pas a
peindre les zones noires qui devraient étre blanches.

Vous n'avez pas besoin de peindre toutes les étoiles qui apparaissent au-dessus de la galaxie elle-
méme (sous forme de minuscules trous noirs). Vous pouvez cependant peindre un peu plus le long
des bras spiraux extérieurs ou d'autres éléments de votre image. C'est I'occasion de définir (en
peignant en blanc) les zones de votre image qui doivent rester protégées malgré ce que
RangeSelection a pu repérer. Je peins par exemple les bras extérieurs en spirale en blanc pour que
leur couleur et leur contraste restent protéges.

J'ai personnellement parcouru toute la galaxie en lissant les zones protégées en peignant un contour
blanc par-dessus. Cela signifie cependant que le masque est maintenant un peu abrupt en termes
de protection.
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Une fois que vous étes satisfait de votre travail de peinture, il vous suffit de cliquer sur le bouton
Execute de CloneStamp pour appliquer les changements et fermer CloneStamp. Comme les
changements sont maintenant trés brusques, en raison des bords francs du masque , nous devons le
brouiller pour adoucir les choses afin que la protection soit plus progressive. Pour cela, nous
utilisons le procédé MultiscaleLinearTransform. Cliquez sur Reset une fois que vous l'avez ouvert.
Maintenant, nous désactivons simplement les quatre premiéres couches d'ondelettes en double-
cliquant sur celles-ci dans la liste (ou en sélectionnant chacune d'entre elles et en les désactivant
grace aux cases a cocher de la couche de détails). Ne laissez que la couche R (résiduelle) intacte,
puis cliqguez sur Apply avec I'image du masque de plage sélectionnée. Vous pouvez ensuite fermer
MultiscaleLinearTransform.

Vous pouvez I'appliquer deux ou trois fois si vous le souhaitez, pour rendre le masque encore plus
lisse. J'ai appliqué le procédé trois fois. Le masque de protection est maintenant plus lisse et prét a
I'emploi. Nous appliquons donc cette image comme un masque a notre image originale, par le menu
Mask -> Select Mask (ou appuyez sur la touche CTRL M de votre clavier) et en sélectionnant le
masque de portée dans la liste. Vous devrez également inverser le masque, via le menu Mask ->
Invert Mask (ou appuyez sur CTRL SHIFT I sur votre clavier).

Commencons par réduire la couleur de fond. Cela peut également étre fait avec le processus
MultiscaleLinearTransform, donc ouvrez le a nouveau et cliquez sur Reset. Pour attaquer la couleur
avec ce processus, nous devrons sélectionner Chrominance (restaurer CIE Y) comme cible dans la
liste du bas. Comme la couleur se trouve généralement dans de grandes couches d'ondelettes, j'en
sélectionne 8 sous Couches, de sorte que la liste des couches d'ondelettes disponibles s'agrandit.
Nous sélectionnons maintenant les couches 5 a 8 individuellement et, sur chacune d'elles, nous
entrons la valeur minimale du biais autorisé, -1.000. Cela permettra de ne plus mettre I'accent sur les
couleurs de ces couches d'ondelettes. Une fois que vous avez terminé, cliquez sur Appliquer. Vous
pouvez masquer le masque en passant par le menu Mask -> Show Mask (ou en appuyant sur CTRL
K sur votre clavier) afin de mieux voir le résultat final. Ci-dessous, je montre l'avant et I'apres.

A ce stade, vous réalisez peut-étre combien il est important que votre masque de protection protége
correctement vos caractéristiques intéressantes, sinon vous perdrez beaucoup de couleur. Cette
technique est particuliéerement adaptée aux images capturées avec un DSLR, en raison de leur
nature bruyante, et surtout lorsque les images sont capturées dans une zone assez légerement
polluée. Vous pouvez fermer MultiscaleLinearTransform a ce stade.

Le masque étant toujours appliqué, nous pouvons maintenant réduire quelque peu le contraste de
l'arriere-plan, pour le neutraliser davantage. Pour cela, HistogramTransformation est un bon procédé
a utiliser. Cliquez sur Reset une fois ouvert. Sélectionnez I'image dans la liste et faites glisser le
curseur des tons moyens vers la droite (plutdt que vers la gauche !). Ceci est I'opposé d'un étirement
et réduira le contraste. Comme les éléments intéressants sont protégés par le masque, vous
réduisez essentiellement le contraste sur le seul arriere-plan. Cependant, cela peut étre trés
rapidement exagéré, ce qui donne a l'image un aspect trés artificiel. Assurez-vous de n'appliquer
qgu'un tres petit ajustement a ce stade. Utilisez la fenétre de prévisualisation en temps réel pour
évaluer ce qui se passe.
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Cliqguez sur Apply une fois que vous étes satisfait de la modification mineure apportée a
HistogramTransformation, puis fermez le processus et sa fenétre d'apercu en temps réel. Nous
devons maintenant supprimer le masque de portée de l'image. Pour ce faire, utilisez le menu Mask -
> Remove Mask (Masque -> Supprimer le masque). Cependant, ne fermez pas encore l'image du
masque car nous allons l'utiliser & nouveau momentanément. Vous pouvez le réduire et le mettre de
c6té pour qu'il ne soit pas génant.

Avant de passer a un traitement plus spécialis€, augmentons un peu plus le contraste, y compris en
réduisant davantage l'arriére-plan, mais cette fois-ci a I'échelle de I'image. Le procédé a utiliser pour
cela est CurvesTransformation. Ouvrez-le, cliguez sur Reset et activez son apergu en temps réel.
Dans son mode RGB/K par défaut, nous créons simplement une courbe en S. Cela implique de
cliquer juste en dessous de la ligne droite au 1/4 du graphique et de cliquer au-dessus de la ligne
droite aux 3/4 du graphique. Cliquer crée des points qui déformeront la ligne droite pour la courber.
La courbe doit prendre la forme d'un S, comme indiqué ci-dessous.

Il est important que cela soit fait sur I'ensemble de I'image, sans aucun masque. Notez également
que les points que j'ai créés sont trés proches de la ligne droite. En d'autres termes, n'en faites pas
trop. Cela éclaircira les éléments clairs et assombrira les éléments sombres de votre image. Cela
signifie également que vous saturerez davantage les zones saturées et que vous atténuerez
davantage les éléments faibles qui pourraient étre jugés intéressants. Comme pour tout, il s'agit d'un
compromis. Je suis satisfait de mon réglage indiqué ci-dessus, alors je clique sur Apply et je ferme a
la fois le processus CurvesTransformation et sa fenétre d'apercu en temps réel.

5. Renforcer le contraste des couleurs et des détails fins dans
la cible

Apres avoir réduit la couleur et le contraste de I'arriére-plan, notre cible semble maintenant sortir plus
clairement de I'image. Nous allons maintenant nous aventurer a augmenter la couleur et les détails a
I'intérieur de la galaxie, tout en laissant I'arriere-plan et les étoiles protégés de ce traitement. Pour
cela, il faudra un masque spécialisé, qui est une combinaison de deux masques. Nous avons déja
créé un range masque . Il ne nous reste plus qu'a créer un masque stellaire. Nous allons soustraire
le masque stellaire du range masque, ce qui exclura en grande partie les étoiles de l'image du
masque. Nous pouvons le modifier manuellement pour exclure correctement les étoiles. Pour créer
un masque stellaire approprié, nous utiliserons le processus StarMask, mais nous devons d'abord
cloner notre image et supprimer la plupart de ses informations de luminosité (afin que StarMask
puisse capter les étoiles partout, y compris au dessus de la galaxie).

Pour créer une copie de l'image, il suffit de cliquer avec le bouton droit de la souris et de cliquer sur
Dupliquer. Ensuite, ouvrez le processus HDRMultiscaleTransform, cliquez sur son bouton Reset et
avec les paramétres par défaut, changez le Nombre de couches en 3 et le Nombre d'itérations en 2
(pour que le processus soit agressif) et Appliquez-le a la copie clonée de l'image.
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Nous pouvons maintenant fermer le processus HDRMultiscaleTransform et ouvrir le processus
StarMask. Afin qu'il puisse capter presque toutes les étoiles, nous augmentons Scale a 6. Large-
scale et Small-scale sont réduits a 0, et le Smoothness peut étre laissé a sa valeur par défaut de 16.
Pour que le masque stellaire apparaisse plus brillant des sa création, nous allons permettre au
StarMask de I'étirer. Pour ce faire, réduisez les tons moyens a quelque chose comme 0,01000. Plus
important encore, nous devons augmenter notre seuil de bruit. Si nous ne le faisons pas, des points
de bruit seront considérés comme des étoiles, et nous ne voulons pas cela. Une valeur plus élevée
comme 0,20000 suffit, mais vous pouvez I'augmenter a 0,25000 si vous avez des taches de bruit qui
apparaissent comme des étoiles dans votre image de masque d'étoile. Assurez-vous d'appliquer le
processus StarMask a la copie de votre image - celle dont les informations de luminosité ont été
détruites par HDRMultiscale Transform.

Avec les étoiles qui apparaissent au-dessus des galaxies, cela nous indique que cette image de
masque d'étoile est appropriée. Nous pouvons maintenant fermer le processus StarMask et la copie
de l'image (sans la sauvegarder). Nous devrions étirer davantage I'image du masque stellaire pour
gue les étoiles captées soient plus brillantes. Nous pouvons utiliser HistogramTransformation pour
cela, en lui donnant un étirement assez agressif, comme indiqué ci-dessous.

Une fois que vous avez termin€, vous pouvez fermer le processus HistogramTransformation et sa
fenétre de prévisualisation en temps réel. Nous pouvons maintenant combiner le range masque et le
masque d'étoile, pour produire une image de masque combinée. Pour ce faire, ouvrez le processus
PixelMath et cliquez sur son bouton Reset. Dans la zone de texte RGB/K, entrez ce qui suit :

range_mask - star_mask

Développez l'onglet Destination de PixelMath et sélectionnez Create new image, puis sélectionnez
Grayscale de Color space. Lorsque vous cliquez sur le bouton carré Apply, une nouvelle image
apparaitra, qui est I'image combinée de votre masque. Veuillez noter que mes images de range
masque et de masque d'étoile sont minimisées et se trouvent dans le coin supérieur droit de
PixInsight, elles sont donc a I'écart.

Nous devons maintenant supprimer toutes les étoiles et les halos d'étoiles restants dans l'image du
masque combiné. Pour cela, nous pouvons utiliser CloneStamp a nouveau pour copier les zones
noires de limage par-dessus, en supprimant essentiellement ces étoiles et halos d'étoiles.
Cependant, ce n'est pas une tache pour les ramollos. En fait, je trouve plus facile de simplement
enregistrer I'image de masque combiné en tant qu'image TIFF 16 bits, de l'ouvrir dans Photoshop et
de l'utiliser avec l'outil pinceau (réglé pour peindre en noir). N'oubliez pas que ce qui est noir dans
cette image de masque combiné ne bénéficiera d'aucune amélioration de la couleur ou du contraste
des détails. Veillez a en tenir compte lorsque vous noircissez certaines parties de l'image. L'objectif
est d'éliminer toutes les étoiles et les halos d'étoiles en dehors des structures galactiques.

Avec la pratique sacrilege de peinture faite en dehors de PixInsight, tout va bien dans le monde.
Nous enregistrons les modifications et ouvrons limage modifiée du masque combiné dans
PixInsight. Vous pouvez laisser le format en TIFF 16 bits - il n'y a aucun probléme avec cela. Nous

pouvons maintenant I'appliquer comme un masque a notre image, via le menu Mask -> Select Mask
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(ou appuyez sur la touche CTRL M de votre clavier) et en sélectionnant I'image de masque combiné
dans la liste.

Dans ce cas, nous n'avons pas besoin d'inverser le masque car il protége l'arriere-plan et les étoiles,
ce qui nous permet d'attaquer les caractéristiques des galaxies seules - parfait pour augmenter le
contraste des couleurs et des détails ! Vous pouvez cependant vouloir cacher le masque par le menu
Mask -> Show Mask (ou appuyer sur la touche CTRL K de votre clavier), afin que nous puissions
mieux Voir ce qui se passe, tout en gardant le masque actif.

Augmentons maintenant la couleur dans les galaxies comme nous avons neutralisé la couleur de
I'arriere-plan plus tot, en utilisant le processus MultiscaleLinearTransform. Cliquez sur le bouton
Reset, sélectionnez 8 sous Layers et sélectionnez Chrominance (restaurer CIE Y) sous Target. Nous
abordons & nouveau les couches 5 a 8 des grandes ondelettes. Cette fois, cependant, les valeurs de
bias que nous entrons sont positives et loin d'étre aussi agressives. Je vais entrer 0,150 pour les
couches 5 et 6 et 0,200 pour les couches 7 et 8. Ce qui suit montre l'avant et I'apres.

Apres avoir fait ressortir les informations sur les couleurs des galaxies, nous pouvons maintenant
augmenter leur saturation globale de maniére sélective, grace au procédé ColorSaturation. Cela
permettra de faire ressortir les rouges et les bleus, mais pas tout. Nous fermons
MultiscaleLinearTransform et, l'image du masque combiné étant toujours active, nous ouvrons
ColorSaturation. Ici, nous cliquons pour créer un point au-dessus des bleus, puis nous créons
plusieurs autres points afin d'aplatir tout le reste.

Nous pouvons cliquer sur les fleches gauche et droite de ColorSaturation pour passer d'un point a
l'autre. Cela nous permet de modifier précisément leurs valeurs pour la saturation. Je passe chaque
point en revue, en m'assurant qu'ils sont tous réglés a 0,00000 pour la saturation, sauf le pic au-
dessus du bleu, que je garde a 0,50000 pour la saturation.

Pour améliorer les rouges (et les bruns), je vais simplement au tout premier point et au tout dernier
point et pour chacun, jentre une valeur telle que 0,30000 pour la saturation. Cela augmente la
saturation des couleurs sur les rouges (et les bruns). Ci-dessous, le résultat final affiché dans la
fenétre de prévisualisation en temps réel de ColorSaturation :

Une fois satisfait de la couleur obtenue, il suffit de cliquer sur Apply et de fermer a la fois le
processus ColorSaturation et sa fenétre de prévisualisation en temps réel.

Nous utilisons maintenant HDRMultiscale Transform pour faire descendre un peu le noyau de la
galaxie et augmenter le détail global dans les régions les plus lumineuses de l'image. Ouvrez-le et
cliquez sur son bouton Réinitialiser. Ici, plus la valeur en Nombre de couches est grande, moins
laugmentation HDR est agressive. Une valeur de 10 fonctionne bien pour cette image, avec le
nombre d'itérations restant a 1. Nous activons cependant To lightness et le masque de luminance
afin que la luminosité soit réduite tout en gardant tout le reste cohérent. Une fois fait, cliquez sur
Apply, en vous assurant que cela est appliqué a votre image alors que lI'image du masque combiné
est toujours active.
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Une fois cela fait, fermez le processus HDRMultiscale Transform. Nous allons maintenant affiner les
structures a petite échelle dans la galaxie, en utilisant MultiscaleLinearTransform. Ouvrez le
processus et cliquez sur son bouton Reset. Tout ce que nous allons faire maintenant, c'est
augmenter un peu le Bias pour les couches 2 et 3, qui sont les couches d'ondelettes contenant des
structures a petite échelle. Sous Target, vous devriez avoir les composantes RGB/K par défaut cette
fois. Jai tendance a utiliser des valeurs aussi faibles que 0,100 pour le Bias dans les cas
d'accentuation, mais vous trouverez des valeurs allant jusqu'a 0,150 qui sont généralement correctes
(parfois vous devez cependant utiliser des valeurs aussi faibles que 0,050 ou 0,075, selon le résultat
final). Cliquez sur Apply une fois le réglage effectué. Notez que la couche 1 n'est pas améliorée car
la plupart des bruits a petite échelle vivent dans cette couche. Les couches 2 et 3 sont des structures
a petite échelle généralement situées au-dessus du niveau de bruit. Ce qui suit montre l'avant et
l'apres.

by

Avec l'afftage appliqué a notre godt, nous pouvons fermer MultiscaleLinearTransform. Nous
pouvons également supprimer l'image du masque combiné par le menu Mask -> Remove Mask.
Vous pouvez la garder sur le coté au cas ou vous voudriez l'utiliser a nouveau plus tard.
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6. Amélioration finale du contraste global et de la saturation des
couleurs, et reflet de I'image

Nous arrivons maintenant a la fin des derniéres améliorations de l'image. Nous revisitons le
processus CurvesTransformation afin d'effectuer un dernier rehaussement du contraste global de
Iimage et de la saturation des couleurs (puisqu' aucun masque n'est appliqué, il s'agit d'un
rehaussement global). Ouvrez le processus, cliquez sur son bouton Reset et activez sa fenétre de
prévisualisation en temps réel. Créez a nouveau une courbe en S en mode RGB/K, comme
précédemment, mais de maniere moins agressive.

Avant de cliquer sur Apply, passez en mode Saturation (S) et cliquez pour créer un point au milieu de
la ligne droite. Faites glisser ce point vers le haut, vers le coin supérieur gauche du graphique. Cela
augmentera la saturation globale des couleurs. N'en faites pas trop cependant, car il n'est pas
nécessaire de faire un grand ajustement pour faire une grande différence a I'image, comme indiqué
ci-dessous.

Vous pouvez répéter cette opération pour le mode Lightness (L), ce qui rend l'image plus lumineuse.
Je ne le fais pas car cette image est déja tres lumineuse. Une fois que vous étes satisfait de vos
réglages, cliquez sur le bouton Apply , puis fermez le processus CurvesTransformation et sa fenétre
de prévisualisation en temps réel.

Enfin, si votre image contient des zones de nébulosité sombres, comme cette image avec les bandes
de poussiére sombres, vous pouvez utiliser le script DarkStructureEnhance pour augmenter encore
le contraste. Il suffit d'ouvrir le script par le menu Script -> Utilitaires -> DarkStructureEnhance,
d'entrer un montant et de cliquer sur OK. La valeur par défaut de 0,40 pour Amount fonctionne trés
bien, mais vous pouvez la réduire a quelque chose comme 0,20 ou 0,30 pour qu'elle ne soit pas
aussi agressive. Vous pouvez également modifier les itérations, bien que 1 soit généralement
suffisant. Ci-dessous, vous trouverez les valeurs avant et apres.

Enfin, limage de masque d'étoile que nous avons créée précédemment peut étre extrémement utile
pour faire ressortir les couleurs des étoiles. Pour ce faire, il suffit d'appliquer lI'image de masque
d'étoile comme un masque via le menu Mask -> Select Mask (ou d'appuyer sur la touche CTRL M de
votre clavier) et de sélectionner I'image de masque d'étoile dans la liste. Ne l'inversez pas cette fois,
cachez-la simplement tout en la gardant active (allez dans le menu Mask) -> Show Mask ou appuyez
sur la touche CTRL K de votre clavier).

Au-dessus, nous voyons que tout est protégé sauf les étoiles, ce qui est notre objectif - attaquer les
étoiles. Nous cachons le masque et ouvrons a nouveau le processus CurvesTransformation, en
cliguant sur le bouton Reset dés qu'il est ouvert. En mode Saturation (S), nous créons un point au
milieu de la ligne droite et le faisons glisser vers le haut, vers le coin supérieur gauche du graphique,
comme précédemment. L'impulsion devrait cependant étre assez forte, comme le montre le
graphique ci-dessous. Assurez-vous d'activer I'apercu en temps réel.
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Ci-dessus, nous avons retrouvé les couleurs naturelles des étoiles, mais vous pouvez aussi en faire
trop ici si vous allez un peu loin et que vous sursaturez. Il suffit de cliquer sur Apply une fois satisfait
et de fermer a la fois le processus CurvesTransformation et sa fenétre de prévisualisation en temps
réel. Vous pouvez supprimer l'image du masque d'étoile en passant par le menu Mask -> Remove
Mask (Masque -> Supprimer le masque) juste apres.

Enfin, pour que cette image prenne une pose plus naturelle pour la galaxie d’Androméde M31,
jutilise le processus FastRotation pour refléter verticalement l'image.

L'image est maintenant entierement post-traitée (montrée ci-dessous redimensionnée a 25% de sa
taille originale) :

XXIl.  Exemple : NGC7000 nébuleuse de I'Amérique du
Nord et IC5070 nébuleuse du Pélican - CCD Bicolore
a bande étroite

Ce tutoriel est un exemple de post-traitement d'une palette bicolore a bande étroite, image a grand
champ de la nébuleuse nord-américaine NGC7000 et de la nébuleuse du Pélican IC5070, capturée a
I'aide d'une caméra CCD monochrome avec des filtres de 3 nm H-alpha et oxygene-lll. Les images
utilisées ici ont été entierement prétraitées (selon ce tutoriel). Voici les données techniques des
images :

Monture : Avalon M-Uno

Télescope : Borg 45EDII avec réducteur focal Borg 7870

Cameéra d'imagerie : QSI 660wsg-8

Filtres : Astrodon Hydrogéne-Alpha 3nm, Astrodon Oxygene-Ill 3nm, Hutech IDAS LPS P2
Cameéra d'autoguidage : Starlight Xpress Lodestar X2

Logiciels : Sequence Generator Pro, PHD2 et Pixinsight

Détails de I'exposition : 60 x 900 secondes 1x1 a -10°C

Comme pour tous les exemples de post-traitement, le tutoriel est assez autonome dans ses
explications, mais il est avantageux que le lecteur ait une idée des concepts impliqués dans
l'utilisation de certains des processus et scripts de PixInsight. Vous trouverez ci-dessous une liste
compléte avec des liens vers d'autres tutoriels pour une lecture plus approfondie. .

Pré-supposé pour ce tutoriel :

e Connaissance du fonctionnement de PixInsight, en rapport avec le traitement des images, des
processus et des masques (Lire ce qui suit, sections 3, 4 et 6).
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e Vos images ont déja été entierement prétraitées (Lire ceci).

e Des connaissances préalables sur la suppression des dégradés de fond avec
DynamicBackgroundExtraction sont avantageuses (Lire ceci).

e Des connaissances préalables sur la combinaison de couleurs des images monochromes a
bande étroite sont avantageuses (Lire ceci).

o Des connaissances préalables en matiere de retouche des couleurs dans les images sont
avantageuses (Lire ce qui suit).

 Des connaissances préalables en matiére d'étirement d'images linéaires en images non
linéaires sont avantageuses (Lire ce qui suit).

e Des connaissances préalables en matiére de production de masques sont avantageuses (Lire
ce qui suit).

e Des connaissances préalables en matiere de réduction du bruit sont avantageuses ( Lire ce
qui suit).

o Des connaissances préalables sur l'accentuation des détails fins avec la transformation
linéaire multiscalaire sont avantageuses (Lire ce qui suit, section 2).

e Une connaissance préalable de l'amélioration du contraste des caractéristiques est
avantageuse (Lire ceci).

e Des connaissances préalables en matiére de réduction de la taille des étoiles sont
avantageuses (Lire ce qui suit).

1. Supprimer les gradients du fond de ciel et procéder a une premiere
reduction du bruit

Nous commencgons avec les deux images monochromes linéaires ouvertes - nommées HA et OIIl -
auto-étirees dans PixInsight a des fins de démonstration. Les deux images ont été entierement pré-
traitées, puis enregistrées et leurs bords noirs ont été éliminés.

La premiére étape consiste a supprimer le gradient de fond présent dans les images, ce qui permet
d'améliorer le contraste global. Nous effectuerons cette opération sur chaque image monochrome
individuellement et nous utiliserons le procédé DynamicBackgroundExtraction. Cela permet de baser
le modele d'échantillonnage initial sur l'image qui présente le plus de nébulosité - dans mon cas,
I'image H-Alpha. Dans une image LRGB, il s'agit normalement de la luminance. Nous pouvons placer
les points échantillons a volonté et utiliser les mémes placements sur les autres images. Comme les
autres images présentent moins de nébulosité, nous pouvons simplement utiliser les mémes points
d'échantillonnage mais en ajouter d'autres. Il est plus difficile de trouver des points d'échantillonnage
a enlever et de les enlever un par un que de trouver des zones vierges de fond pour ajouter des
points d'échantillonnage supplémentaires.
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C'est pourquoi, pour linstant, je minimise limage Oxygéne-lll et la mets de coté, et jouvre le
processus DynamicBackgroundExtraction avec l'image H-Alpha sélectionnée. Nous cliquons sur
Reset afin d'initialiser le processus sur l'image Hydrogéne-Alpha.

Comme cette image contient beaucoup de nébulosité , il est plus facile de trouver des zones
sombres pour ajouter des points d'échantillonnage que d'utiliser la fonction de placement
automatique des points d'échantillonnage du processus. Nous devons cependant d'abord définir un
rayon de point d'échantillonnage approprié. Pour cette image particuliere de 8 002 x 5 330 pixels, j'ai
trouvé qu'un rayon de 15 était suffisant, donc j'ai entré 15 dans le champ "Default sample radius" et
jai cligué sur "Resize All' avant de placer les points d'échantillonnage. Une fois fait, les points
d'échantillonnage sont ajoutés manuellement (en cliquant) sur toute I'image pour englober les zones
sombres sans nébulosité claire et en excluant toute étoile. Il est important de noter que les quatre
coins de l'image sont échantillonnés, ainsi que certains au milieu. Si vous faites une erreur en
placant un point d'échantillonnage, vous pouvez le faire glisser vers un autre endroit ou le supprimer
en cliquant dessus pour le sélectionner et en appuyant sur la touche DEL.

Il est important de se rappeler que limage entiere n'a pas besoin d'étre recouverte de points
d'échantillonnage. Ce qui précede est un exemple de points d'échantillonnage suffisants placés dans
des zones importantes. Comme tous les points d'échantillonnage sont acceptés (aucun n'est coloré
en rouge), nous n'‘avons pas besoin d'ajuster le parametre de tolérance. Si certains apparaissent en
rouge et qu'ils se trouvent définitivement sur une zone qui a besoin d'un point d'échantillonnage,
vous devrez augmenter la tolérance a des valeurs telles que 1.000 ou 1.500 pour qu'ils soient
acceptés. L'objectif est de fixer la valeur de tolérance la plus basse possible tout en acceptant tous
vos points d'échantillonnage (en s'en tenant toutefois & environ 0,500 comme minimum absolu).
Lorsque vous modifiez la tolérance, cliquez sur le bouton "Resize All" pour appliquer les
changements. Une fois que tout est défini, nous sélectionnons Soustraction dans le menu déroulant
Correction et nous activons Discard background model si nous ne souhaitons pas voir ce qui a été
extrait (vous pouvez le laisser désactivé si vous souhaitez voir ce qui a été extrait).

Avant d'appliquer le processus DynamicBackgroundExtraction, nous allons créer une icone de
processus pour sauvegarder le modele. Celle-ci sera utilisée dans un instant pour appliquer le méme
modele (avec quelques points d'échantillonnage supplémentaires, sans doute) a l'image Oxygen-lll.
Pour créer licbne du processus, nous glissons et déposons le bouton "New Instance" de la fenétre
DynamicBackgroundExtraction sur I'espace de travail PixInsight. Celui-ci est renommé DBE et mis
de cbté pour une utilisation ultérieure.

Une fois fait, nous cliquons sur Executer et la nouvelle image d'arriére-plan apparait. Auto-étirée, elle
présente un contraste supplémentaire, apreés avoir supprimé tous les gradients de l'arriere-plan.

Le processus DynamicBackgroundExtraction et limage originale sont maintenant fermés. La
nouvelle image H-Alpha est sauvegardée et est maintenant minimisée et mise de cété. L'image
Oxygene-lll est maintenant ouverte.
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L'image Oxygen-Ill étant maintenant ouverte et sélectionnée, nous double-cliquons sur l'icone du
processus DBE pour ouvrir DynamicBackgroundExtraction, en appliquant le modéle précédemment
créé sur cette image. Vous remarquerez que tous les points d'échantillonnage apparaissent et avec
les mémes parameétres.

Il est & noter qu'aucun des points de I'échantillon n'est au-dessus des étoiles ou de la nébulosite,
donc ils sont acceptables. S'il y en avait, en raison de la présence d'émissions dans les longueurs
d'onde de l'oxygene Il alors qu'il n'y en a aucune dans la longueur d'onde de I'hydrogene alpha,
nous pourrions les écarter ou les supprimer. Dans ce cas, il y a des zones supplémentaires de
I'image qui sont considérées comme de l'arriere-plan, nous nous permettons donc d'ajouter d'autres
points d'échantillonnage au modéle.

La encore, comme tous les points de I'échantillon sont acceptés avec une valeur de tolérance de
0,500, nous n'avons pas besoin de procéder a des ajustements. Assurez-vous que VoS points
d'échantillonnage sont acceptés en augmentant la tolérance si nécessaire. Une fois la valeur définie,
nous cliquons sur Execute et la nouvelle image d'arriere-plan apparait. Elle est affichée ci-dessous,
étirée automatiquement a des fins de démonstration.

Il ne s'agit évidemment pas d'un gain massif de contraste, mais cela vaut la peine de le faire pour
supprimer les gradients de fond restants, qu'ils soient faibles ou non. Au moins, les images sont
maintenant considérées comme propres. Nous fermons maintenant DynamicBackgroundExtraction
et limage originale. Nous sauvegardons également la nouvelle image Oxygen-lll. L'icbne du
processus DBE peut maintenant étre supprimée car nous ne l'utiliserons plus.

Nous allons maintenant procéder a une premiere réduction du bruit sur les deux images. Nous
commencerons par I'image H-Alpha, et donc cette image est maximisée et sélectionnée, tandis que
I'image Oxygéne-lll est minimisée et mise de co6té une fois de plus. Comme nous travaillons avec
des images monochromes, le masque que nous allons réaliser pour protéger les zones a haut signal
(nébulosité brillante) et attaquer les zones a faible signal (arriére-plan) est une simple reproduction
de l'image elle-méme. Pour dupliquer I'image, nous faisons un clic droit sur celle-ci et nous cliquons
sur Duplicate.

Ci-dessus, l'autostretch a été supprimé de l'image dupliquée, car nous allons maintenant I'étirer de
facon permanente. Ceci est fait de maniére a ce qu'il fonctionne parfaitement comme un masque,
étant donné le contraste infiniment plus élevé d'une image non linéaire par rapport a une image
linéaire. L'étirement permanent sera tres simple : nous transférerons les paramétres d'auto-étirement
de la fonction ScreenTransferFunction a la fonction HistogramTransformation, et nous l'appliquerons
comme un étirement permanent. Pour ce faire, ouvrez le processus ScreenTransferFunction, cliquez
sur le bouton Auto Stretch avec l'image dupliquée sélectionnée. Ensuite, ouvrez le processus
HistogramTransformation et cliquez sur Reset. Faites glisser le bouton New Instance de
ScreenTransferFunction sur la barre inférieure de HistogramTransformation (entre les sept boutons
du bas). Une fois que vous avez terminé, la ligne de HistogramTransformation se courbe.
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Les parameétres d'autostretch ont maintenant été transférés dans HistogramTransformation. Il faut
maintenant cliquer sur Reset dans ScreenTransferFunction (pour supprimer l'autostretch) et fermer le
processus. Maintenant, cliquez sur Apply dans HistogramTransformation et I'image dupliquée est
étirce de facon permanente en non-linéaire. HistogramTransformation peut étre fermé
immédiatement apres.

Le masque étant préparé, nous l'appliquons maintenant a l'image originale H-Alpha. Pour ce faire,
cliguez pour sélectionner I'image originale et allez dans le menu Mask -> Select Mask (ou appuyez
sur CTRL M), sélectionnez I'image dupliquée dans la liste et cliquez sur OK.

Les zones rouges sont protégées par le masque, ce qui n'est pas idéal car il protege clairement le
fond. Nous devons donc inverser le masque, ce qui se fait par le menu Mask -> Invert Mask (ou en
appuyant sur CTRL SHIFT I).

Nous sommes maintenant préts a appliquer la réduction du bruit, a I'image originale dans son état
linéaire. Le processus de choix est MultiscaleLinearTransform, qui nous permet d'étre progressifs
dans la réduction du bruit - d'agir plus fortement a petite échelle qu'a grande échelle, puisque le bruit
a tendance a étre plus présent a petite échelle. Nous ouvrons la MultiscaleLinearTransform.

Comme le bruit a tendance a étre présent a la plus petite échelle, nous serons plus agressifs dans la
premiére couche de pixels et progressivement moins agressifs dans les trois couches suivantes
(jusqu'a la couche 4). Pour effectuer la réduction du bruit, nous cliquons pour sélectionner chacune
des quatre premieres couches numérotées de 1 a 4 et activer la réduction du bruit dans chaque cas.
Nous fixerons Threshold a 3.000 sur la couche 1, 2.000 sur la couche 2, 1.000 sur la couche 3 et
0.500 sur la couche 4 (progressivement moins agressif avec l'augmentation de la couche a I'échelle
du pixel). De méme, nous fixerons les itérations a 3, 2, 2 et 1 (pour les couches 1 a 4,
respectivement). Enfin, afin de produire un résultat agréable et lisse avec une réduction du bruit,
nous allons mélanger 50 % de l'image originale avec 50 % de l'image a bruit réduit. Pour ce faire,
nous avons fixé la valeur de Amount a 0,50 sur les quatre couches.

Une fois MultiscaleLinearTransform configurée, nous cliquons sur Apply avec limage originale
sélectionnée (avec le masque appliqué). Ci-dessous, vous trouverez l'avant et l'apres dans un
segment zoomé de l'image.

Avec une amélioration notable du bruit & petite echelle sur l'image, nous fermons maintenant
MultiscaleLinearTransform. Nous ne la réinitialiserons pas encore car nous appliquerons les mémes
parametres de réduction du bruit a I'image Oxygen-IIl . Nous supprimons le masque en allant dans le
menu Mask -> Remove Mask. L'image dupliquée qui faisait office de masque peut étre fermée sans
étre sauvegardée. Cependant, nous allons enregistrer les modifications apportées a l'image originale
H-Alpha, aprés lui avoir appliqué la réduction de bruit.

Nous allons maintenant nous occuper de I'image Oxygene-lll. Par conséquent, I'image H-Alpha est
minimisée et mise de coté pendant que nous ouvrons l'image Oxygene-Illl et que nous la retouchons
automatiquement.
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La encore, nous avons besoin d'un masque adapté a cette image et comme il s'agit d'une image
monochrome, un simple duplicata étiré suffira. Nous suivons exactement la méme procédure que
pour lI'image H-Alpha. Cliquez avec le bouton droit de la souris et cliquez sur Duplicate, supprimez
I'étirement automatique, ouvrez les fonctions ScreenTransferFunction et HistogramTransformation,
cliquez sur Réinitialiser dans les deux cas et cliguez sur Auto Stretch dans ScreenTransferFunction
avec l'image en double sélectionnée. Ensuite, transférez les parametres d'étirement automatique en
faisant glisser le bouton "New Instance" de ScreenTransferFunction sur la barre inférieure de
HistogramTransformation. Une fois que vous avez terminé, cliquez sur Reset dans
ScreenTransferFunction  (pour supprimer l'auto-étirage) et cliquez sur Apply dans
HistogramTransformation pour étirer I'image dupliquée en non-linéaire. Vous pouvez ensuite fermer
les deux processus.

BN

L'image du masque est maintenant préte a étre appliquée. On clique pour sélectionner l'image
originale, on va dans le menu Mask -> Select Mask (ou on appuie sur CTRL M), on sélectionne
I'image dupliquée dans la liste et on clique sur OK. Nous inversons a nouveau l'image du masque
afin d'attaquer l'arriere-plan. Cela se fait par le menu Mask -> Invert Mask (ou appuyez sur CTRL
MAJ I).

Nous pouvons maintenant procéder a la méme réduction du bruit qu'auparavant. En fait, I'ouverture
du processus MultiscaleLinearTransform montre qu'il est déja configuré comme il I'était auparavant,
comme prévu. Si vous avez cliqué sur Reset, vous devrez reconfigurer les paramétres. Cela implique
d'activer la réduction du bruit pour les quatre premiéres couches de I'échelle des pixels (numérotées
de 1 a 4), de régler le seuil & 3.000, 2.000, 1.000 et 0.500 et de régler les itérations a 3, 2, 2 et 1,
respectivement. Le montant est fixé a 0,50 pour les quatre. Une fois que vous avez terminé, cliquez
sur Apply avec l'image originale sélectionnée (avec le masque qui lui est appliqué). Vous trouverez
ci-dessous une comparaison avant et aprés du méme segment zoomé qu'auparavant.

Avec la réduction de bruit maintenant appliquée a limage Oxygen-lll, nous pouvons fermer
MultiscaleLinearTransform et supprimer le masque de limage originale par le menu Mask ->
Remove Mask. L'image dupliquée qui a été utilisée comme masque peut étre fermée sans étre
sauvegardée. Les modifications apportées a l'image originale sont maintenant enregistrées, apres
avoir appliqué la réduction du bruit.

L'image ci-dessus montre l'image linéaire Oxygene-lll aprés réduction du bruit, avec l'autostretch
réappliqué, produisant un contraste plus élevé qu'avant la réduction du bruit. La différence est ici plus
prononcée que pour l'image obtenue avec le procédé H-Alpha, étant donné le rapport signal/bruit
initial plus faible commun aux images Oxygen-lll par rapport aux images H-Alpha (en raison des
emissions plus faibles provenant de I'espace lointain).
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2. Etirement non linéaire des images monochromes
et combinaison des couleurs

Il est courant de conserver les images dans leur état linéaire aussi longtemps que possible, méme en
les combinant et en effectuant un étalonnage des couleurs lorsqu'elles sont dans leur état linéaire.
Cependant, quiconque a déja réalisé des images en bande étroite constatera que les différents filtres
captent des intensités d'image trés différentes, méme avec les mémes expositions ultra-longues. Il
est courant que les images H-Alpha soient nettement plus brillantes et plus nébulisées que les
images Oxygene-lll, par exemple. Les intensités relatives dépendent évidemment de la cible en
guestion, mais c'est généralement le cas. Par conséquent, les images a bande étroite combinant les
couleurs alors qu'elles sont a I'état linéaire (original) peuvent ignorer une grande partie de la
contribution a la palette de couleurs fournie par des images comme Oxygene-lll et Soufre-Il. Un
meilleur contrdle des couleurs est possible si I'on étend les images monochromes a bande étroite a
I'état non linéaire et si I'on combine les couleurs seulement dans ce cas.

Nous commencons donc cette section en étendant les images monochromes a bande étroite H-
Alpha et Oxygene-lll a la non-linéarité. Un procédé particulierement efficace pour ce faire est
MaskedStretch. Nous commencerons par l'image H-Alpha, montrée ci-dessous ouverte a coté du
processus MaskedStretch (I'image Oxygéene-lll est ouverte mais minimisée et mise de c6té pour le

moment).

Pour que MaskedStretch puisse faire son travail, nous devrons créer une petite boite de
prévisualisation sur le fond, d'ou la nécessité d'auto-étirer I'image pour voir ou la placer. Pour créer la
boite de prévisualisation, cliquez sur le bouton "New Preview " dans la barre d'outils supérieure,
faites-la glisser dans une zone de l'espace qui ne contient que l'arriere-plan (pas d'étoiles ni de
nébulosité), puis cliquez sur le bouton "Readout Mode" pour quitter le mode d'édition de la boite de
prévisualisation.

Une fois que la boite de prévisualisation est créée, vous devez supprimer l'autostretch sur l'image.
Nous sélectionnons maintenant la boite de prévisualisation sous Background reference dans
MaskedStretch.

En général, les parametres par défaut fonctionnent bien, mais nous allons augmenter Target
background a 0,15000000 afin d'obtenir une image globalement plus lumineuse. Comme il s'agit
d'une image a bande étroite, en particulier une image capturée a l'aide d'un filtre de 3 nm, l'arriere-
plan est déja assez sombre. Par conséquent, nous allons supprimer Clipping fraction en cliquant sur
son bouton X a droite de la zone de texte. De plus, les itérations seront augmentées a 250 pour en
faire un bon étirement global. Une fois le réglage effectué, nous cliquons sur Apply avec l'image H-
Alpha sélectionnée.

L'image ci-dessus montre un excellent étirement non linéaire global de I'image H-Alpha. Une fois
terminé, nous supprimons la boite de prévisualisation de I'arriére-plan par le menu Preview -> Delete
All, nous enregistrons les modifications, nous les minimisons et nous les mettons de coté. L'image
Oxygene-Ill est maintenant maximisée et étirée automatiquement.
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Nous devrons a nouveau créer une boite de prévisualisation de arriere-plan, cette fois-ci dans
I'image Oxygene-lll. Le processus ci-dessus est répété - cliquez sur le bouton "New Preview", faites
glisser une zone de votre image qui ne contient que l'arriere-plan (pas d'étoiles ni de nébulosité) et
cliquez sur le bouton "Readout Mode" pour quitter le mode d'édition de la boite de prévisualisation.

Nous supprimons maintenant l'autostretch et ouvrons le processus MaskedStretch. Les mémes
parametres que précédemment sont utilisés. Il est important de noter que l'arriere-plan cible reste le
méme, a 0,15000000, afin que les deux images soient plus ou moins au méme niveau d'étirement.
Nous devons cependant sélectionner la case de prévisualisation de l'arriere-plan pour cette image
particuliere. Une fois fait, nous cliquons sur Apply avec l'image Oxygen-Ill sélectionnée.

Avec l'image Oxygen-Ill étirée, nous pouvons fermer le processus MaskedStretch, supprimer la boite
de prévisualisation du fond (via le menu Preview -> Delete All) et enregistrer les modifications. Nous
pouvons maintenant comparer les images H-Alpha (a gauche) et Oxygene-Ill (a droite), cbte a céte :

On voit bien que limage Oxygéne-lll est beaucoup plus faible que l'image H-Alpha, malgré les
étirements non linéaires réalisés avec MaskedStretch. A ce stade, elles peuvent étre combinées en
couleur et donner de meilleurs résultats (plus de contribution a la couleur globale par l'image
Oxygen-Ill) que si nous avions combiné les couleurs pendant qu'elles étaient a I'état linéaire. En
mesurant la valeur moyenne des pixels des deux images avec le processus Statistics, j'ai obtenu une
valeur de 17 271 pour H-Alpha et de 12 049 pour Oxygene-lll. Nous pouvons utiliser le procédé
LinearFit pour faire correspondre la luminosité de I'image Oxygen-lll a celle de l'image H-Alpha, ce
qui la rend plus lumineuse. Pour ce faire, nous ouvrons LinearFit et sélectionnons l'image H-Alpha
comme image de référence, puis nous cliquons sur Apply avec l'image Oxygéne-IIl sélectionnée.

La luminosité des images est maintenant beaucoup plus proche, l'image H-Alpha ayant une valeur
moyenne de 17 271 pixels et I'image Oxygene-lll ayant une valeur moyenne de 17 206 pixels. Les
modifications apportées a I'image Oxygen-lll sont enregistrées. Bien que la contribution des couleurs
soit maintenant plus homogene, il serait bon d'améliorer encore le contraste de I'image Oxygen-Il|
pour augmenter artificiellement sa contribution en couleurs, afin d'éviter que les parties les plus
brillantes de la nébuleuse nord-américaine ne deviennent d'un blanc ennuyeux (en raison de
contributions de couleurs égales). Un bon procédé a utiliser est le procédé CurvesTransformation.
Nous I'ouvrons et cliquons sur Real-Time Preview.

Dans son mode RGB/K par défaut, nous pouvons augmenter le contraste global en créant une
courbe en S. Cela implique de cliquer sur un quart du graphique pour créer un point et de le tirer un
peu vers le bas. Ensuite, on clique sur les trois quarts du graphique pour créer un point et on le tire
un peu vers le haut. Pour augmenter encore la luminosité, nous pouvons créer un troisieme point au
milieu de la ligne et le faire glisser vers le coin supérieur gauche du graphique.

Nous l'appliquons a l'image Oxygéne-lll, nous fermons CurvesTransformation (et sa fenétre de
prévisualisation en temps réel) et nous enregistrons les modifications apportées. Les images sont a
nouveau présentées comparées ci-dessous, cote a cote :
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Il est maintenant trés clair que I'image Oxygéne-lll est en fait plus lumineuse que I'image H-Alpha, ce
qui signifie que sa contribution aux couleurs est renforcée.

Les images monochromes a bande étroite étant étirées de maniere non linéaire et assez bien
assorties, et la contribution de I'Oxygene-lll étant renforcée, nous passons a la combinaison des
couleurs. Pour cela, le procédeé PixelMath est idéalement utilisé.

La palette de couleurs que nous utiliserons est la palette bicolore, car cette image couleur sera
composée de deux fréquences et non de trois. Les identificateurs d'images ont été réglés sur HA et
Olll dans PixInsight, pour faciliter la saisie de leurs noms dans PixelMath. Pour créer la nouvelle
image couleur, nous désactivons Use a single RGB/K expression, sélectionnons Create new image,
définissons RVB comme Identifiant d'image et sélectionnons RGB Colour sous Color space. Nous
entrons alors dans la combinaison de la palette de couleurs Bicolore vert synthétique :

R/K: HA
G: (HA*OII)*1.5
B: Olll

Une fois PixelMath configuré, cliquons sur Apply (bouton carré) pour créer la nouvelle image couleur.

Avec l'image couleur créée, nous pouvons fermer les images monochromes a bande étroite et le
processus PixelMath. N'oubliez pas que nous devons encore neutraliser I'arriere-plan sur la nouvelle
image couleur, ce qui hous montrera précisément la palette de couleurs gue nous avons obtenue. Si
le résultat obtenu par la suite n'est pas souhaitable, nous pourrions revenir aux images
monochromes a bande étroite pour ajuster leur luminosité relative avant de combiner a nouveau les
couleurs.

Pour neutraliser l'arriere-plan, nous devons d'abord créer une boite de prévisualisation de l'arriére-
plan. Pour ce faire, il suffit de cliquer sur le bouton "New Preview", de faire glisser une boite de
prévisualisation sur l'arriere-plan (sans étoiles ni nébulosité) et de cliquer sur le bouton "Readout
mode" pour quitter le mode d'édition de la boite de prévisualisation.

En mode lecture, nous devons vérifier la luminosité de l'arriere-plan dans la fenétre de
prévisualisation. Pour ce faire, il suffit de maintenir le bouton gauche de la souris enfoncé et de
survoler l'intérieur de la boite de prévisualisation de l'arriére-plan. Regardez les valeurs R, G et B
indiquées et prenez note de la plus grande que vous voyez.

Il n'est pas nécessaire d'étre précis a 100%. Je note que 0,2000 est juste au-dessus du maximum
observé dans ma boite de prévisualisation, je vais donc utiliser cette valeur. Il suffit d'ouvrir le
processus BackgroundNeutralization, de sélectionner la boite de prévisualisation de l'arriere-plan
dans Reference image et de définir la valeur que nous venons de relever dans Upper limit. C'est trés
important car I'image couleur est non linéaire, et les valeurs des pixels sont donc plus grandes que
ce que les parametres par défaut dans BackgroundNeutralization. Une fois cela fait, nous cliquons
sur Apply sur l'image couleur.

{ } 232



L'image couleur a maintenant été créée et préparée pour un post-traitement ultérieur. La boite de
prévisualisation de l'arriere-plan peut étre supprimée via le menu Preview -> Delete All et le
processus BackgroundNeutralization peut étre fermé. La nouvelle image couleur peut également étre
enregistrée. Si vous n'étes pas satisfait de la palette de couleurs produite, vous pouvez simplement
revenir aux images monochromes a bande étroite et modifier leur luminosité relative avant de les
combiner a nouveau. Il est également possible de modifier les combinaisons de canaux PixelMath a
ce stade. N'oubliez pas que la neutralisation de l'arriere-plan doit étre effectuée avant d'examiner la
vraie couleur reproduite dans la combinaison.

3. Retouche des couleurs et amélioration initiale du
contraste

A ce stade, nous avons une image en couleur et nous pouvons commencer le reste du post-
traitement, afin d'améliorer encore le contraste et de faire ressortir les traits fins. En fonction de vos
préférences concernant I'étirement non linéaire des images monochromes a bande étroite, I'image
couleur peut bénéficier d'un étirement non linéaire supplémentaire. C'est d'ailleurs le cas de la
mienne. Un petit coup de pouce au contraste avec HistogramTransformation est un bon début a ce
stade. Nous ouvrons donc le processus HistogramTransformation, sélectionnons l'image couleur
dans la liste et cliquons sur le bouton "Real-Time Preview".

Notons qu'il faut apporter un ajustement mineur des tons moyens en faisant glisser le curseur des
tons moyens vers la gauche et un ajustement mineur du point noir en faisant glisser le curseur du
point noir vers la droite.

Remarquez le compromis d'écréter 110 pixels (0,0003% de l'image), montré a c6té de Shadows au
bas de HistogramTransformation. L'écrétage des données n'est généralement pas souhaitable, mais
dans ce cas (et dans la plupart des cas), un tout petit peu fournit le meilleur résultat final. L'étirement
non linéaire est appligué et les modifications apportées a l'image sont enregistrées. Ensuite,
HistogramTransformation et sa fenétre de prévisualisation en temps réel sont fermés.

A ce stade, jaimerais effectuer un léger changement de teinte dans limage, afin de modifier
légérement la palette de couleurs. Par exemple, les zones claires de la nébuleuse de I'Amérique du
Nord et de la nébuleuse du Pélican sont pour la plupart blanches, mais avec une légére teinte
violette. Je préférerais que cette Iégere teinte soit bleue et que les reflets orange de I'image soient un
peu plus rouges. CurvesTransformation peut effectuer le changement de teinte, mais si nous le
faisons sur l'image telle quelle, cela se produira partout - y compris sur les étoiles. Compte tenu de la
couleur des étoiles, actuellement assez neutre (et de la teinte bleue d'une ou deux étoiles plus
brillantes), nous ne voulons pas effectuer de modifications de couleur sur I'ensemble de l'image, pour
éviter le risque de faire ressortir ces étoiles. Pour cela, nous devrons produire un masque incluant
uniguement les étoiles. Cela nous permettra de les masquer et de tout modifier sauf les étoiles, ce
qui nous permettra d'effectuer le changement de teinte en toute sécurité.
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Comme l'image présente évidemment des différences de luminosité, le procédé StarMask aura du
mal a capter les étoiles au-dessus d'une nébulosité brillante par rapport aux étoiles au-dessus de
I'arriere-plan. Par conséquent, nous devons neutraliser la luminosité de l'image avant de créer un
masque d'étoile. Pour cela, nous allons dupliquer I'image en couleur en cliquant sur le bouton droit
de la souris et en cliquant sur Duplicate. Nous utiliserons le procédé HDRMultiscaleTransform sur
I'image dupliquée, avec le nombre de couches fixé a 3 et les itérations a 2, ce qui permet d'effectuer
une neutralisation agressive de la luminosité.

Cette image dupliquée est préte a servir de base pour sélectionner de nombreuses étoiles pour un
masque d'étoile. Nous pouvons fermer HDRMultiscaleTransform. Pour produire le masque stellaire,
nous utilisons le procédé StarMask. Nous devons d'abord fixer un seuil en dessous duquel StarMask
doit ignorer les objets. Cela doit étre pris dans une zone de nébulosité la plus brillante, pres des plus
petites étoiles que vous voulez que StarMask détecte. Pour choisir une valeur, il suffit de laisser le
bouton gauche de la souris cliqué et de survoler les petites étoiles dans les zones de nébulosité les
plus brillantes. L'apercu du mode de lecture donne les valeurs de R, G et B. Il suffit de choisir la plus
grande des trois valeurs pour qu'elle soit considérée comme de la nébulosité (et plus faible qu'une
petite étoile que vous voulez capter).

Dans mon cas, il semble que 0,27000 soit une bonne valeur a utiliser pour Noise threshold. Nous
allons également augmenter Scale a 7 pour capter des étoiles plus grandes. Large-scale et Small-

bY

scale sont réduites a O afin d'éviter que les étoiles n'augmentent artificiellement de taille.
Smoothness peut étre réduite a environ 8, bien que les valeurs entre 8 et 12 fonctionnent
généralement bien. Enfin, afin de donner a l'image du masque d'étoile un étirement automatique,
nous réduisons Midtones a 0,05000. Une fois que c'est fait, nous cliquons sur Apply avec l'image

dupliquée sélectionnée.

Le processus StarMask et limage dupliquée peuvent étre fermés puisque l'image du masque
stellaire a été produite. Celle-ci doit étre étendue davantage en utilisant HistogramTransformation,
afin de faire réellement ressortir les petites étoiles. |l suffit d'ouvrir le processus
HistogramTransformation, de cliquer sur le bouton Real-Time Preview et de déplacer le curseur des
tons moyens vers la gauche, puis de cliquer sur Apply une fois que suffisamment d'étoiles ont été
mises en évidence.

Bien que le masque stellaire puisse sembler parfait, il est malheureusement rare que des étoiles
brillantes avec des halos soient bien représentées dans les masques produits dans StarMask. Par
conséqguent, ce que j'ai tendance a faire a ce stade est de survoler I'image du masque d'étoile sur
I'image originale, en corrélant les étoiles les plus brillantes de l'image originale avec l'image du
masque d'étoile. Ci-dessous, j'ai encerclé certaines des étoiles qui ne sont pas si bien représentées
dans lI'image du masque stellaire.

La meilleure option, a mon avis, est d'enregistrer I'image du masque d'étoile en TIFF 16 bits et de
l'ouvrir dans un logiciel comme Photoshop. Ici, vous pouvez peindre des cercles blancs de grand
rayon (avec des bords lisses !) sur les étoiles mal représentées que vous identifiez. Cette image peut
ensuite étre ouverte dans PixInsight et utilisée comme un masque d'étoile modifié.
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La figure ci-dessus montre le masque stellaire modifié. Celui-ci peut maintenant étre utilisé sur
I'image par le menu Mask -> Select Mask (ou en appuyant sur CTRL M), en sélectionnant I'image du
masque d'étoile dans la liste et en cliquant sur OK. Il faudra sans doute aussi l'inverser, via le menu
Mask -> Invert Mask (ou en appuyant sur CTRL SHIFT I).

Les étoiles et leurs halos sont maintenant protégés de maniere adéquate contre le changement de
teinte que nous allons effectuer. Pour cela, le processus CurvesTransformation sera utilisé. Une fois
ouvert, nous cliquons sur le bouton de prévisualisation en temps réel. Nous passons alors en mode
Hue (H).

Personnellement, je veux que la zone lumineuse qui a un ton violet ait un ton plus bleu. Nous
pouvons inspecter I'endroit ou se trouve actuellement le ton en maintenant le bouton gauche de la
souris enfoncé et en survolant les zones que nous souhaitons inspecter. Une ligne verticale apparait
dans CurvesTransformation, nous indiquant I'endroit ou se trouve le ton dans la région que nous
survolons.

Pour faire passer ce ton violet au bleu, il suffit de cliquer pour créer un point ou la ligne verticale
coupe la ligne diagonale droite, puis de faire glisser ce point vers le bas de maniere a ce que le ton
violet sur I'axe des x soit mis en correspondance avec un ton bleu sur lI'axe des'y.

Etant donné la courbure de la ligne, une partie de ce qui était bleu a l'origine est maintenant devenu
bleu clair - plus clair que je ne le souhaite. C'est pourquoi je crée plus de points pour m'assurer que
seule cette région du spectre des couleurs est déplacée. Tous les points créés peuvent étre déplacés
jusqu'a l'obtention d'un résultat désirable. Si vous souhaitez supprimer un point, il vous suffit de
cliquer dessus tout en appuyant sur la touche CTRL.

Ci-dessus, vous voyez trois points supplémentaires créés dans CurvesTransformation pour affiner la
palette de couleurs. Les bleus ont recu un ton plus naturel et les oranges ont été modifiés pour étre
plus rouges. Aprés tout, la couleur est purement subjective dans les images a bande étroite, nous
pouvons donc nous sentir libres de produire la palette de couleurs que nous aimons le plus. Une fois
gue nous sommes satisfaits du changement de teinte, nous cliquons sur Apply.

Avant de fermer CurvesTransformation, nous pouvons réduire la saturation des couleurs sur les
étoiles. Cela permet de supprimer efficacement une grande partie des couleurs que les étoiles ont pu
obtenir par la combinaison de couleurs des images monochromes a bande étroite. Les images
purement & bande étroite ne produisent généralement pas de trés belles couleurs d'étoiles, et il est
parfois préférable d'avoir des étoiles plus blanches que des étoiles aux couleurs bizarres, du moins a
mon avis personnel. Pour ce faire, jinverse mon image de masque d'étoile afin de cibler les étoiles
cette fois-ci (par le biais du menu Mask -> Invert Mask ou en appuyant sur CTRL SHIFT ).

L'image globale étant protégeée et les étoiles révélées, nous réactiverons l'apercu en temps réel dans
CurvesTransformation et cliquerons sur Reset. Le mode de saturation (S) est maintenant le bon
mode a utiliser, car nous allons effectivement désaturer un peu les étoiles. Pour ce faire, il suffit de
cliquer pour créer un point au milieu de la ligne et de le faire glisser vers le coin inférieur droit du
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graphique, mais seulement un peu, en réduisant la saturation des couleurs sur les étoiles mais sans
la supprimer complétement (a moins que nous le voulions !).

Lorsqu'un changement souhaitable est produit, nous cliquons sur Apply dans CurvesTransformation
et enregistrons les modifications apportées a l'image. Je voudrais maintenant saturer davantage les
bleus de maniére sélective dans les nébuleuses. Pour cela, je dois a nouveau réinverser 'image du
masque d'étoile (via le menu Mask -> Invert Mask ou en appuyant sur CTRL SHIFT I). Cette
opération protégera a nouveau les étoiles de lI'image contre les ajustements.

Le meilleur processus est ColorSaturation, car il nous permet de saturer une gamme particuliere de
couleurs de maniere sélective. Nous I'ouvrons donc et cliguons sur son bouton d'apercu en temps
reel.

Afin de renforcer la saturation de la gamme de couleurs bleues, on clique pour créer un point au-
dessus des bleus. Ce point est déplacé vers le haut pour produire une courbe.

Bien que l'apercu ci-dessus semble bon, il n‘faugmente pas la saturation uniquement sur les bleus,
comme le montre la courbe produite dans ColorSaturation. Nous devons créer plusieurs points
supplémentaires afin d'aplatir la courbe partout sauf au-dessus des bleus.

Afin d'aplatir réellement le reste de la courbe, il est utile de sélectionner chaque nouveau point
individuellement et de s'assurer que ses valeurs de saturation sont de 0,00000. Vous pouvez
sélectionner les points soit en cliquant dessus, soit en cliquant sur les fleches gauche et droite de
ColorSaturation. Une fois que nous avons aplati la courbe, nous sélectionnons le point culminant au-
dessus des bleus et nous lui fixons une valeur de Saturation appropriée. Les deux points
environnants peuvent étre déplacés vers la gauche ou vers la droite afin de saturer plus ou moins
sélectivement une gamme de couleurs.

Une fois que la saturation sélective des couleurs a été configurée, nous cliqguons sur Apply dans
ColorSaturation et enregistrons les modifications apportées a limage. Le processus de
ColorSaturation et sa fenétre de prévisualisation en temps réel sont maintenant fermés. Avant de
passer a la section suivante, nous allons augmenter le contraste de la nébulosité, la luminosité et la
saturation générale des couleurs, en utilisant le processus CurvesTransformation. L'image du
masque stellaire est toujours active et protége les étoiles a ce stade. Nous ouvrons a nouveau le
processus CurvesTransformation, cliquez sur son bouton Reset et ensuite sur son bouton Real-Time
Preview. Nous nous assurons également que nous démarrons dans son mode RGB/K par défaut.

Afin de renforcer le contraste global, nous allons créer une courbe en S en mode RGB/K. Cela
implique de cliquer pour créer un point au quart du graphique vers le haut, et de le faire glisser un
peu vers le bas. Un deuxieme point est créé aux trois quarts du graphique et est déplacé vers le
haut. La ligne s'incurve en une courbe en S. Pour augmenter encore un peu plus le contraste, nous
pouvons créer un troisieme point a mi-hauteur du graphique et le faire glisser un tout petit peu vers le
coin supérieur gauche.
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En mode Luminosité (L), nous pouvons augmenter la luminosité globale de l'image. Pour ce faire,
cliguons pour créer un point a mi-chemin du graphique et faisons le glisser un peu vers le coin
supérieur gauche du graphique.

Enfin, nous pouvons augmenter la saturation globale des couleurs en mode Saturation (S) par la
méme méthode - nous cliquons pour créer un point a mi-hauteur du graphique et nous le faisons
glisser un peu vers le coin supérieur gauche du graphique.

Ces trois améliorations ont permis d'accroitre considérablement le contraste, la luminosité et la
saturation des couleurs. Une fois cela fait, nous cliquons sur Apply dans CurvesTransformation et
pouvons alors fermer a la fois le processus et sa fenétre de prévisualisation en temps réel. Les
modifications apportées a l'image sont enregistrées.

A ce stade, nous en avons fini avec le réglage des couleurs et les réglages initiaux du contraste
global. Ainsi, I'image du masque d'étoile peut maintenant étre supprimée par le menu Mask ->
Remove Mask. Cette image de masque d'étoile est cependant conservée car nous l'utiliserons plus
tard.

4. Ameliorer le contraste des caractéeristiques et
accentuer les détails fins

Afin d'améliorer le contraste et d'affiner les détails fins de la nébulosité, nous utiliserons un masque
spécial pour cibler uniquement la nébulosité. Pour cela, il faudra produire un masque a l'aide de
RangeSelection, qui repére tout ce qui est lumineux (au-dela d'un seuil que nous aurons fixé) dans
I'image. Nous pouvons ensuite utiliser notre image de masque d'étoile produite précédemment pour
soustraire les étoiles et donc cibler uniqguement la nébulosité (en protégeant les étoiles et le fond du
post-traitement).

Nous commencgons par ouvrir le processus RangeSelection et cliquer sur son bouton d'apercu en
temps réel.

Afin d'obtenir un masque lisse, nous allons augmenter le Fuziness a 0,15 et Smoothness a 5,00.
Maintenant, nous faisons glisser le curseur Lower Limit vers la droite jusqu'a ce que la fenétre de
prévisualisation en temps réel ne montre que la nébulosité que nous souhaitons attaquer (sans
I'arriere-plan).

La nébulosité étant correctement sélectionnée, nous cliquons sur Apply in RangeSelection et
fermons a la fois le processus et sa fenétre de prévisualisation en temps réel. Cela a maintenant
produit image de masque de gamme requise.

L'image du masque de portée est enregistrée et le processus PixelMath est ouvert. Ce processus
sera utilisé pour soustraire mathématiqguement l'image du masque d'étoile de l'image du masque
range, excluant ainsi les étoiles de notre prochain post-traitement. Dans le processus PixelMath,
nous sélectionnons Create new image sous l'onglet Destination et sélectionnons Grayscale sous
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Color space. Dans la zone de texte Image Id, nous entrons CombMask (le nom de l'image de
masque que nous allons créer). Enfin, dans la zone de texte RGB/K, nous entrons :

RGB/K: range_mask - star_mask

Cette nouvelle image de masque combiné est maintenant sauvegardée. Les images du masque
d'étoile, du masque range et du masque combiné sont toutes maintenues ouvertes, minimisées et
mises de c6té dans PixIlnsight. Nous pouvons maintenant utiliser I'image du masque combiné
comme masque pour l'image que nous sommes en train de post-traiter. Pour ce faire, nous allons
dans le menu Mask -> Select Mask (ou appuyez sur CTRL M), sélectionnez CombMask dans la liste
et cliquez sur OK.

En appliquant I'image du masque combiné (mais pas inversé), nous pouvons voir que l'arriere-plan et
les étoiles sont protégés alors que la nébulosité est disponible pour que nous puissions l'attaquer
avec les techniques de post-traitement. Le masque est maintenu actif mais caché en passant par le
menu Mask -> Show Mask (ou en appuyant sur CTRL K). Il est important de le garder actif pour qu'il
continue d’'étre effectif, mais de le cacher pour que nous puissions voir plus clairement ce qui arrive a
I'image lorsque nous appliqguons un post-traitement supplémentaire.

Le premier procédé que nous utiliserons dans notre régime d'amélioration des caractéristiques est
HDRMultiscaleTransform. Ce procédé nous permet de comprimer la gamme dynamique des parties
les plus brillantes de I'image, révélant les détails les plus fins dans la nébulosité la plus brillante.

Afin de ne pas étre aussi agressif sur la compression de la dynamique, nous allons augmenter le
nombre de couches a 8, en gardant le nombre d'itérations réglé a 1. Nous activons également les
To lightness et Lightness mask car ils garantissent que le processus ne s'applique qu'a la luminosité
de l'image, les régions plus sombres étant mieux protégées. Une fois ces parametres définis, nous
cliquons sur Apply sur notre image (avec le masque combiné caché mais actif).

L'application de HDRMultiscale Transform a révélé de nombreuses caractéristiques nébuleuses fines
dans les régions les plus brillantes de la nébuleuse d'Amérique du Nord, ce qui donne a l'image un
aspect plus détaillé. Les modifications apportées sont enregistrées. Cependant, comme cela a laissé
les éléments les plus brillants un peu bleus clairs, nous pouvons effectuer un autre ajustement rapide
des teintes pour les transformer en bleus plus foncés. Cela se fait avec le processus
CurvesTransformation une fois de plus, en mode Hue (H). Ce processus s'ouvre avec sa fenétre de
prévisualisation en temps réel (en cliquant sur le bouton Real-Time Preview). En mode Hue (H), il
suffit de cliquer pour créer un point au-dessus des bleus clairs sur I'axe x et de faire glisser le point
vers le haut pour le faire correspondre aux bleus plus sombres sur I'axe y. Nous créons également
deux autres points pour redresser la ligne ailleurs.

La balance des couleurs est maintenant plus agréable (a mon avis), et les changements sont donc
appligués puis enregistrés. CurvesTransformation et sa fenétre de prévisualisation en temps réel
sont fermés. Nous affinons maintenant les détails fins avec MultiscaleLinearTransform. Nous vous
rappelons que le masque combiné est toujours actif (mais caché) a ce stade.
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Pour commencer, nous cliquons sur Reset dans le processus pour nous assurer gqu'aucun parametre
précédent n'est reporté. Les détails que nous allons affiner sont trés fins et dominent donc les plus
petites échelles de pixels. Afin d'éviter d'accentuer le bruit, nous évitons toutefois la premiere couche
de I'échelle des pixels. Nous allons cependant accentuer les couches 2 et 3. Pour ce faire, nous
sélectionnons chacune d'elles et ajoutons un petit Bias dans les deux. De tres petites valeurs de
0,050 tendent a suffire, mais nous utiliserons 0,100 dans les deux dans cette image particuliere
(puisque les zones nébuleuses ont un bon rapport signal/bruit). Ci-dessous, nous présentons des
comparaisons avant et apres d'une zone de l'image riche en détails (le centre) :

Grace a des détails beaucoup plus fins, nous enregistrons les modifications apportées a l'image.
Nous allons maintenant améliorer légerement le contraste global, la luminosité et la saturation des
couleurs. Comme cette amélioration s'appliquera a I'ensemble de l'image, nous supprimerons le
masque par le biais du menu Mask -> Remove Mask. Le processus pour effectuer ces améliorations
est CurvesTransformation. Une fois ouvert, nous cliquons sur Reset et passons en mode RGB/K.
Nous cliquons également sur le bouton de prévisualisation en temps réel.

La procédure sera identique a celle qui a été effectuée a la fin de la section précédente. Nous
créerons une légére courbe en S en mode RGB/K pour assombrir les zones sombres et éclaircir les
zones claires, ce qui produira plus de contraste. Nous devons étre prudents a ce stade, car nous
l'avons déja fait auparavant. Il suffit de cliquer pour créer un point au quart de la hauteur du
graphique et de le faire glisser tres légérement vers le bas. Nous cliquons également pour créer un
point aux trois quarts du graphique et nous le faisons glisser tres Ilégérement vers le haut.

Passons ensuite au mode Lightness (L). Pour éclaircir I'image dans son ensemble, cliquons pour
créer un point au milieu du graphique et le faisons glisser Iégerement vers le coin supérieur gauche.

Enfin, nous passons au mode de saturation (S). Pour augmenter légerement la saturation globale
des couleurs, nous cliquons pour créer un point au milieu du graphique et nous le faisons glisser
légerement vers le coin supérieur gauche, comme nous l'avons fait pour la Luminosité.

Lorsque des changements souhaitables sont proposés, nous cliguons sur Apply dans
CurvesTransformation, puis nous fermons le processus et sa fenétre de prévisualisation en temps
réel. Les modifications apportées a l'image sont alors enregistrées.

Nous effectuons maintenant un léger assombrissement des éléments nébuleux sombres avec le
script DarkStructureEnhance. Ce script se trouve dans le menu Script -> Utilities ->
DarkStructureEnhance. Les paramétres par défaut ont tendance a fonctionner exceptionnellement
bien, mais comme les éléments nébuleux sombres sont déja assez foncés, nous pouvons réduire
Amount de sa valeur par défaut de 0,40 & une valeur plus conservatrice de 0,20. L'expérimentation
est bien sOr essentielle, car votre image variera. Vous trouverez ci-dessous des comparaisons avant
et apres l'utilisation du script DarkStructureEnhance avec Amount fixé a 0,20 :

L'image a clairement recu un coup de pouce supplémentaire pour les éléments nébuleux sombres,
renforcant encore le contraste autour d'eux, mais seulement dans une faible mesure (comme prévu).
Les modifications apportées a l'image sont enregistrées.
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Le contraste des éléments ayant été renforcé et les détails fins rendus plus nets, nous passons aux
dernieres étapes du post-traitement de cette image.

7. Réduction de la taille des étoiles et amélioration du contraste.

Afin de réaliser la procédure de réduction de la taille des étoiles dans limage, nous aurons besoin
d'un masque approprié pour les contours des étoiles. Cela nous permettra de cibler les étoiles a
partir de leurs contours et de les pincer vers lintérieur pour réduire leur taille. Afin de créer ce
masque de contour d'étoile, nous utiliserons une procédure similaire a ce que nous avons fait
précédemment pour produire lI'image du masque d'étoile. Tout d'abord, nous dupliquons l'image elle-
méme en cliquant avec le bouton droit de la souris et en cliquant sur Dupliquer. Ensuite, nous
utilisons HDRMultiscale Transform pour détruire ses informations de luminosité en les appliquant de
maniere agressive. Nous cliqguons sur Reset, puis nous réduisons le nombre de couches a 3 et
augmentons le nombre d'itérations a 2. Ensuite, nous cliquons sur Apply (Appliquer) avec l'image

dupliquée sélectionnée.

Nous pouvons maintenant fermer HDRMultiscaleTransform et ouvrir StarMask, le processus qui
produira le masque des contours de I'étoile a partir de I'image dupliquée. Nous cliquons d'abord sur
Reset dans le processus StarMask. Il est maintenant temps de définir une valeur appropriée de seulil
de bruit, comme auparavant. Pour décider, cliquez et maintenez le bouton gauche de la souris
enfoncé. Survolez I'image dupliquée, les zones de nébulosité les plus brillantes et regardez les trois
valeurs R, G et B rapportées. Survolez les plus petites étoiles que vous souhaitez inclure dans le
masque de contour des étoiles, et décidez quelle valeur de fond doit étre définie comme seuil de
bruit.

D'apres ce qui précede, je détermine que 0,40000 est une bonne valeur a fixer pour Noise threshold
car il s'agit du niveau de fond maximum indiqué (les petites étoiles sont au-dessus de cette valeur).
Nous augmentons maintenant Scale a 6, fixons les valeurs Large scale et Small-scale a 0, et
diminuons la valeur Smoothness a 5. Cela permettra d'inclure des étoiles plus grandes et de ne pas
augmenter artificiellement leur taille dans le masque des contours des étoiles. Cela permettra
eégalement d'éviter un lissage excessif, qui serait contre-productif pour la production des contours des
étoiles. Pour s'assurer que le masque produit est celui des contours d'étoiles, nous activons
Contours. Nous réduisons également les tons moyens a 0,05000 pour effectuer un étirement dans
I'image du masque des contours d'étoiles qui en résulte. Une fois cette valeur définie, nous cliquons
sur Apply avec lI'image dupliquée sélectionnée.

Avec l'image de masque de contour d'étoile appropriée produite, nous pouvons fermer le processus
StarMask et l'image dupliquée (sans la sauvegarder). Cette nouvelle image de masque de contour
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d'étoile est ensuite appliquée a l'image originale, via le menu Mask -> Select Mask (ou appuyer sur
CTRL M).

L'inversion du masque n'est pas nécessaire car il protege déja tout sauf les contours de I'étoile,
comme prévu. Cependant, vous devrez sans doute cacher le masque pour voir ce qui est fait a
I'image. Cela se fait par le menu Mask -> Show Mask (ou appuyez sur CTRL K). Le processus utilisé
pour réduire la taille des étoiles est MorphologicalTransformation, nous l'ouvrons donc et nous
cliguons sur Reset. Nous commencgons par sélectionner Morphological Selection sous Operator et 5
(25 elements) sous Size..

Nous devrons créer une forme d'étoile dans Structuring Element. Cela peut étre fait en cliquant sur
les trois carrés noirs au-dessus, en dessous, a gauche et a droite des 9 carrés blancs actuels. Cela
rend tous les carrés blancs, a I'exception des quatre carrés d'angle. Si vous faites une erreur, vous
pouvez cliquer sur un carré blanc tout en appuyant sur la touche CTRL pour le rendre noir. Le
parametre "Selection" définit la réduction de la taille des étoiles. Un réglage de 0,50 érode et dilate
tout autant. Comme nous voulons éroder plus que dilater, nous diminuons la Sélection. Une valeur
de 0,20 a tendance a bien fonctionner. Pour obtenir un résultat final plus lisse, nous réduisons
Amount a 0,50. Cela permet de mélanger 50 % de l'image réduite de la taille de I'étoile avec 50 % de
l'image originale. Nous serons cependant un peu agressifs sur le nombre de fois que nous
appliquons cette réduction, donc nous augmentons les itérations a 5. Ci-dessous, vous trouverez des
comparaisons avant et apres l'application de la réduction de la taille des étoiles :

Cela a produit un affaiblissement tres net des nombreuses étoiles de l'image, ce qui a contribué a
faire ressortir la nébulosité. Les modifications apportées sont donc sauvegardées. Le masque des
contours des étoiles est supprimé via le menu Mask -> Remove Mask. Ce masque est également
fermé sans étre sauvegardé (car nous ne [lutiliserons plus). Le processus
MorphologicalTransformation est maintenant fermé.

Nous effectuons maintenant une derniere retouche de l'image, pour augmenter encore un peu plus
son contraste, sa luminosité et la saturation des couleurs. La méme procédure qu'auparavant est
répétée avec CurvesTransformation, mais en €tant un peu moins agressive. Une trés Iégere courbe
en S est produite en mode RGB/K pour augmenter le contraste. Un point est ensuite créé en mode
Luminosité (L) et Saturation (S) et déplaceé vers le haut-gauche, pour augmenter la luminosité et la
saturation des couleurs. Tout ceci est réalisé sans qu'aucun masque ne soit appliqué a l'image elle-
méme.

Une fois les changements souhaités effectués, nous cliquons sur Apply, puis nous fermons le
processus CurvesTransformation et sa fenétre d'apercu en temps réel. Les modifications apportées
sont enregistrées et limage est maintenant officiellement entierement post-traitée. Elle est montrée
ci-dessous redimensionnée a 40% de sa taille originale :
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